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Hỗ trợ kỹ thuật của Bio-Rad™
Bộ phận Hỗ trợ kỹ thuật của Bio-Rad tại Hoa Kỳ mở cửa từ thứ Hai đến thứ Sáu, từ 5:00 sáng đến 5:00 chiều,
giờ Thái Bình Dương.

Điện thoại: 1-800-424-6723, phím 2

Email: Support@bio-rad.com (chỉ ở Hoa Kỳ/Canada)

Để được hỗ trợ kỹ thuật bên ngoài Hoa Kỳ và Canada, hãy liên lạc với văn phòng hỗ trợ kỹ thuật tại địa
phương của bạn hoặc nhấp vào liên kết Contact us (Liên hệ với chúng tôi) tại www.bio-rad.com.

Thông báo
Không được sao chép hoặc truyền tải bất kỳ phần nào của ấn bản này dưới bất kỳ hình thức nào hoặc bằng
bất kỳ phương tiện nào, theo cách điện tử hay cơ học, trong đó bao gồm sao chép, ghi lại, hoặc bất kỳ hệ
thống lưu trữ hay truy xuất thông tin nào mà không có sự cho phép bằng văn bản của Bio-Rad Laboratories,
Inc..

Bio-Rad có quyền sửa đổi các sản phẩm và dịch vụ của họ vào bất kỳ thời điểm nào. Tài liệu hướng dẫn này
có thể thay đổi mà không cần thông báo. Mặc dù được chuẩn bị để đảm bảo tính chính xác, Bio-Rad không
chịu trách nhiệm về các lỗi hay thiếu sót, hoặc về bất kỳ thiệt hại nào phát sinh từ việc áp dụng hoặc sử dụng
thông tin này.

BIO-RAD là nhãn hiệu của Bio-Rad Laboratories, Inc.

SYBR là nhãn hiệu của Thermo Fisher Scientific Inc.

EvaGreen là nhãn hiệu của Biotium, Inc.

Tất cả các nhãn hiệu được sử dụng ở đây đều là tài sản của chủ sở hữu tương ứng.

Bản quyền © 2022 của Bio-Rad Laboratories, Inc. Bảo lưu mọi quyền.

http://www.bio-rad.com/


Mục đích sử dụng

Mục đích sử dụng
Hệ Thống Real-Time PCR CFX Opus DxTM with Phần mềm CFX Maestro Dx, Phiên bản bảo mậtTM nhằm
thực hiện PCR dựa trên huỳnh quang để phát hiện và định lượng trình tự axit nucleic. Hệ thống và phần
mềm được sử dụng nhằmmục đích để các kỹ thuật viên phòng thí nghiệm được đào tạo thực hiện chẩn
đoán trong ống nghiệm. Các hệ thống được sử dụng với các xét nghiệm chẩn đoán axit nucleic của nhà
sản xuất thứ ba đã được sản xuất và dán nhãn cho mục đích chẩn đoán.

Bảng từ vựng biểu tượng

Nhà sản xuất Số lô

Hạn sử dụng
Dành cho mục đích chẩn đoán trong

ống nghiệm

Giới hạn nhiệt độ Số catalog

Tham khảo hướng dẫn sử dụng Số lần thử nghiệm

Để sử dụng với Số sê-ri

Chỉ sử dụng theo toa Chứa latex
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Dấu CE - Quy Định
(EU) 2017/746 IVDR

Bản dịch
Các tài liệu về sản phẩm có thể được cung cấp bằng các ngôn ngữ khác trên các phương tiện điện tử.
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Lịch sử sửa đổi

Lịch sử sửa đổi

Tài liệu Ngày Mô Tả Sự Thay Đổi

Hướng Dẫn Sử Dụng Phần
mềm CFX Maestro Dx, Phiên
bản bảo mật, 2.0

(ID tài liệu số 10000135653)

Tháng 12 năm
2020

Phiên Bản A, Bản Phát Hành Lần Đầu

Hướng dẫn sử dụng Phần
mềm CFX Maestro Dx, Phiên
bản bảo mật, 2.3

(ID tài liệu số 10000135653)

Tháng 5 năm
2022

n Đã cập nhật để hỗ trợ CFX Opus Deepwell Dx

n Đã cập nhật bảng chú giải biểu tượng

n Đã thêm ghi chú an ninh mạng vào phần Giới thiệu
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Tuân thủ an toàn và quy định
Hệ thống Real-Time PCR CFX Opus 96 Dx, CFX Opus 384 Dx, và CFX Opus Deepwell Dx (được gọi là
Hệ thống CFX Opus Dx trong hướng dẫn này) làm nóng và làm mát rất nhanh trong quá trình hoạt động.
Để vận hành an toàn hệ thống Real-Time PCR, Bio-Rad đặc biệt khuyên bạn nên tuân theo các thông số
kỹ thuật an toàn được nêu trong phần này và xuyên suốt sách hướng dẫn này.

Nhãn cảnh báo an toàn
Các nhãn cảnh báo được dán trên Hệ thống CFX Opus Dx và trong sách hướng dẫn này cảnh báo bạn về
các nguồn gây thương tích hoặc nguy hại. Bảng 1 định nghĩa từng nhãn cảnh báo an toàn.

Biểu tượng Ý nghĩa

Vận hành Hệ thống CFX Opus Dx trước khi đọc sách hướng dẫn này có thể gây
thương tích cá nhân. Việc sử dụng máy này theo cách không được quy định trong
sách hướng dẫn này hoặc bởi Bio-Rad có thể dẫn đến các tính năng bảo vệ của
máy bị suy giảm hoặc vô hiệu hóa.

Không có mối nguy sinh học hoặc nguy cơ phóng xạ nào liên quan đến Hệ thống
CFX Opus Dx. Những mối nguy hại này chỉ trở nên đáng lo ngại khi xuất hiện trong
hệ thống thông qua các mẫu được thử nghiệm. Khi xử lý các mẫu phóng xạ hoặc
nguy hiểm về sinh học, hãy tuân thủ các biện pháp phòng ngừa và hướng dẫn
được khuyến nghị dành riêng cho phòng thí nghiệm và địa điểm của bạn. Các
hướng dẫn này cần bao gồm phương pháp vệ sinh, giám sát và thải bỏ các vật liệu
nguy hiểmmà bạn đang sử dụng.

Ngoài ra, như đã xác định ở trên, có nguy cơ nhỏ về việc phát nổ, hay chất lỏng
hoặc hơi thoát ra khỏi các bình chứa mẫu. Khi làm việc với vật liệu nguy hiểm,
nguy cơ bị thương do vật liệu thoát ra ngoài bao gồm cả nguy cơ chính vật liệu
nguy hiểm có thể bị phân tán trong và xung quanh máy. Người dùng nên thực hiện
các biện pháp phòng ngừa thích hợp cho tình huống như vậy.

Bảng 1. Cảnh báo an toàn chung
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Tuân thủ an toàn và quy định

Biểu tượng Ý nghĩa

Hệ thống CFX Opus Dx hoạt động ở nhiệt độ cao đến mức có thể gây bỏng nghiêm
trọng. Luôn để block mẫu trở về nhiệt độ phòng trước khi mở nắp và lấy mẫu ra.
Ngay cả sau khi block mẫu đã nguội, các khu vực xung quanh cũng như khay gia
nhiệt có thể vẫn nóng trong một thời gian khá dài. Trong các tình huống không có
đủ thời gian để máy nguội, nên sử dụng thiết bị bảo hộ như găng tay nhiệt hoặc
“găng tay lò nướng”.

Sự an toàn và hiệu suất của bất kỳ hệ thống nào kết hợp Hệ thống CFX Opus Dx
hoàn toàn do người lắp ráp hệ thống chịu trách nhiệm.

Hệ thống CFX Opus Dx trong quá trình hoạt động bình thường có thể nóng đến
mức làm cho chất lỏng trong mẫu sôi hoặc bốc hơi, gây áp lực lên bình chứa mẫu.
Các bình chứa mẫu có thể bị hỏng, dẫn đến rò rỉ, phun chất lỏng hoặc vỡ nổ và làm
thoát hơi hoặc chất lỏng vào trong cũng như xung quanh máy.

Người dùng phải luôn đóng nắp máy hoặc đeo kính bảo hộ, găng tay nhiệt và các
thiết bị bảo vệ cá nhân khác trong khi vận hành máy để tránh bị thương. Việc mở
thiết bị trong khi mẫu vẫn còn nóng, chẳng hạn như sau khi hủy bỏ lượt chạy, có
thể làm cho bình chứa có áp suất bị rò rỉ, làm phun hoặc trào chất lỏng. Luôn để
mẫu nguội trước khi mở nắp.

Người dùng tuyệt đối không nên chạy phản ứng khi nắp hoặc nắp bịt đang mở, bị
lỏng, thủng hoặc hư hỏng vì sẽ làm tăng khả năng vỡ hoặc phát nổ nguy hiểm.

Người dùng không được thực hiện phản ứng với thuốc thử dễ bay hơi có thể làm
tăng khả năng vỡ hoặc phát nổ nguy hiểm.

Bảng 1. Cảnh báo an toàn chung, tiếp
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Tuân thủ an toàn và quy định

Tuân thủ an toàn
Hệ thống CFX Opus Dx thử nghiệm và tuân thủ tất cả các yêu cầu hiện hành của các tiêu chuẩn điện từ
và an toàn sau:

n IEC 61010-1:2010 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm, Phần 1: Yêu cầu chung

n IEC 61010-2-010:2019 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-010: Yêu cầu cụ thể đối với thiết bị trong phòng thí nghiệm để làm
nóng vật liệu

n IEC 61010-2-081:2019 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-081: Yêu cầu cụ thể đối với thiết bị tự động và bán tự động trong
phòng thí nghiệm nhằmmục đích phân tích và các mục đích khác

n IEC 61010-2-101:2018 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-101: Yêu cầu cụ thể đối với thiết bị y tế chẩn đoán trong ống
nghiệm (in vitro diagnostic, IVD)

n CAN/CSA-C22.2 SỐ 61010-1-12:2018 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm
soát và sử dụng trong phòng thí nghiệm, Phần 1: Yêu cầu chung

n CAN/CSA-C22.2 SỐ 61010-2-010:19 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát
và sử dụng trong phòng thí nghiệm, Phần 2-010: Yêu cầu cụ thể đối với thiết bị trong phòng thí
nghiệm để làm nóng vật liệu

n CAN/CSA-C22.2 SỐ 61010-2-081:19 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát
và sử dụng trong phòng thí nghiệm, Phần 2-081: Yêu cầu cụ thể đối với thiết bị tự động và bán tự
động trong phòng thí nghiệm nhằmmục đích phân tích và các mục đích khác

n CSA-C22.2 SỐ 61010-2-101:19 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử
dụng trong phòng thí nghiệm—Phần 2-101: Yêu cầu cụ thể đối với thiết bị y tế chẩn đoán trong ống
nghiệm (in vitro diagnostic, IVD)

n EN 61010-1:2010 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm, Phần 1: Yêu cầu chung
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Tuân thủ an toàn và quy định

n EN 61010-2-010:2014 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-010: Yêu cầu cụ thể đối với thiết bị trong phòng thí nghiệm để làm
nóng vật liệu

n EN 61010-2-081:2015 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-081: Yêu cầu cụ thể đối với thiết bị tự động và bán tự động trong
phòng thí nghiệm nhằmmục đích phân tích và các mục đích khác

n EN 61010-2-101:2017 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-101: Yêu cầu cụ thể đối với thiết bị y tế chẩn đoán trong ống
nghiệm (in vitro diagnostic, IVD)

n UL 61010-1:2012 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Phần 1: Yêu cầu chung

n UL 61010-2-010:2019 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-010: Yêu cầu cụ thể đối với thiết bị trong phòng thí nghiệm để làm
nóng vật liệu

n UL 61010-2-081:2019 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng
trong phòng thí nghiệm—Phần 2-081: Yêu cầu cụ thể đối với thiết bị tự động và bán tự động trong
phòng thí nghiệm nhằmmục đích phân tích và các mục đích khác

n UL 61010-2-101:19 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Phần 2-101: Yêu cầu cụ thể đối với thiết bị y tế chẩn đoán trong ống nghiệm (in
vitro diagnostic, IVD)

Tương thích điện từ (EMC)
Hệ thống CFX Opus Dx được kiểm tra và cho thấy tuân thủ tất cả các yêu cầu hiện hành của các tiêu
chuẩn tương thích điện từ sau:

n IEC 61326-1:2012 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Yêu cầu về EMC—Phần 1: Yêu cầu chung. Đã kiểm tra như một thiết bị Loại A

n IEC 61326-2-6:2012 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Yêu cầu về EMC—Phần 2–6: Yêu cầu cụ thể – Thiết bị y tế chẩn đoán trong
ống nghiệm (in vitro diagnostic, IVD)

n EN 61326-1:2013 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Yêu cầu về EMC—Phần 1: Yêu cầu chung. Đã kiểm tra như một thiết bị Loại A

n EN 61326-2:-6:2013 Yêu cầu về an toàn đối với thiết bị điện để đo lường, kiểm soát và sử dụng trong
phòng thí nghiệm—Yêu cầu về EMC—Phần 2–6: Yêu cầu cụ thể – Thiết bị y tế chẩn đoán trong
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ống nghiệm (in vitro diagnostic, IVD)

n FCC Phần 15, Phần phụ B, Mục 15.107 và 15.109. Đã kiểm tra như một thiết bị kỹ thuật số Loại A

n CAN ICES-003v6:2019 Tiêu chuẩn về thiết bị gây nhiễu, thiết bị công nghệ thông tin (bao gồm cả
thiết bị kỹ thuật số) —Giới hạn và phương pháp đo. Đã kiểm tra giới hạn Loại A

Cảnh báo và lưu ý về EMC
n Cảnh báo: Nếu thực hiện các thay đổi hoặc sửa đổi không được phê duyệt rõ ràng bởi Bio-Rad đối

với máy này, người dùng có thể mất quyền vận hành thiết bị.

n Lưu ý: Thiết bị này đã được thử nghiệm và nhận thấy tuân thủ các giới hạn cho thiết bị kỹ thuật số
Loại A, theo phần 15 của Quy tắc FCC. Những giới hạn này được tạo ra để bảo vệ hợp lý trước hiện
tượng nhiễu có hại khi thiết bị được vận hành trong môi trường thương mại. Thiết bị này tạo ra, sử
dụng và có thể phát ra năng lượng tần số vô tuyến, đồng thời, nếu không được lắp đặt và sử dụng
theo sổ tay hướng dẫn, có thể gây nhiễu có hại cho hoạt động liên lạc vô tuyến. Vận hành thiết bị này
trong khu dân cư có khả năng gây nhiễu có hại, trong trường hợp đó người dùng sẽ phải khắc phục
tình trạng nhiễu bằng chi phí của mình.

n Lưu ý về tuân thủ FCC:Mặc dù máy này đã được thử nghiệm và nhận thấy tuân thủ Phần 15, Phần
phụ B của Quy tắc FCC đối với thiết bị kỹ thuật số Loại A, xin lưu ý rằng sự tuân thủ này là tự nguyện,
đối với máy đủ điều kiện được coi là “thiết bị được miễn trừ” theo 47 CFR 15.103(c), liên quan đến
các quy định FCC được trích dẫn có hiệu lực tại thời điểm sản xuất.

n Lưu ý về cáp:Máy này đã được kiểm tra tuân thủ EMC bằng cáp USB được thiết kế đặc biệt kèm
theo máy. Những loại cáp này, hoặc các bộ phận thay thế được ủy quyền bởi Bio-Rad, phải được sử
dụng với máy này để đảm bảo tiếp tục tuân thủ các giới hạn phát thải EMC.
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Yêu cầu về môi trường
Hệ thống Hệ thống CFX Opus Dxs được thiết kế để vận hành an toàn trong các điều kiện môi trường
được liệt kê trong bảng sau đây.

Tham số Thông số kỹ thuật

Môi trường Chỉ sử dụng trong nhà

Độ cao hoạt động Lên đến 2.000 mét so với mực nước biển

Nhiệt độ phòng 15–31°C*

Nhiệt độ vận chuyển và bảo quản –20° đến 60°C**
–4 đến 140°F

Độ ẩm tương đối 20% đến 80% (không ngưng tụ)***

Công suất hoạt động 100 đến 240 VAC ±10%, 50/60 Hz, tối đa 850
W

Biến động điện áp nguồn cấp ±10%

Mức tiêu thụ điện tối đa <850 watt

Cầu chì 10 A, 250 V, 5 x 20 mm, cháy nhanh (số lượng
2)

Danh mục quá áp II

Mức độ ô nhiễm 2

*Việc vận hành máy bên ngoài phạm vi nhiệt độ này có thể không đáp ứng các thông số kỹ thuật về hiệu
suất. Nhiệt độ phòng từ 5–40°C được coi là an toàn.

**Bảo quản và vận chuyển máy trong thùng chứa máy vận chuyển để đáp ứng các điều kiện nhiệt độ
này.

***Việc vận hành máy ở 4⁰C nên được giới hạn trong 18 giờ ở các điều kiện này. Có thể thực hiện duy
trì ở 4⁰C trong tối đa 72 giờ nếu độ ẩm nhỏ hơn 60% (không ngưng tụ).

Bảng 2. Hệ Thống Real-Time PCR CFX Opus Dx yêu cầu về môi trường
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Mối nguy hại
Hệ thống CFX Opus Dx được thiết kế để hoạt động an toàn khi được sử dụng theo cách do nhà sản xuất
quy định. Nếu hệ thống hoặc bất kỳ bộ phận nào liên quan của hệ thống được sử dụng theo cách không
được nhà sản xuất quy định, khả năng bảo vệ vốn có của máy có thể bị suy giảm. Bio-Rad không chịu
trách nhiệm về bất kỳ thương tích hoặc thiệt hại nào gây ra bởi việc sử dụng máy này theo cách thức
không được quy định, hoặc do các sửa đổi đối với máy không được thực hiện bởi Bio-Rad hoặc đại lý
được ủy quyền. Chỉ nhân viên được đào tạo bởi Bio-Rad mới được phép thực hiện dịch vụ của Hệ thống
CFX Opus Dx

Mối nguy hại sinh học
Hệ thống CFX Opus Dx sản phẩm trong phòng thí nghiệm. Tuy nhiên, nếu có các mẫu sinh học độc hại,
hãy tuân thủ các hướng dẫn sau và làm theo mọi hướng dẫn tại địa phương cụ thể đối với phòng thí
nghiệm và địa điểm của bạn.

Lưu ý: Không có chất sinh học độc hại nào thoát ra ngoài trong quá trình hoạt động bình thường của
máy này.

Biện pháp phòng ngừa chung

n Luôn mặc áo khoác dùng trong phòng thí nghiệm, đeo găng tay phòng thí nghiệm và kính an toàn có
tấm chắn bên hoặc kính bảo hộ.

n Để tay xa khỏi miệng, mũi và mắt.

n Che chắn hoàn toàn mọi vết cắt hoặc vết trầy trước khi làm việc với các vật liệu có khả năng lây
nhiễm.

n Rửa tay kỹ bằng xà phòng và nước sau khi làm việc với bất kỳ vật liệu có khả năng lây nhiễm nào
trước khi rời phòng thí nghiệm.

n Tháo đồng hồ đeo tay và đồ trang sức trước khi làm việc ở bàn thí nghiệm.

n Lưu trữ tất cả các vật liệu lây nhiễm hoặc có khả năng lây nhiễm trong các thùng chứa chống rò rỉ
không thể phá vỡ.

n Trước khi rời phòng thí nghiệm, hãy cởi quần áo bảo hộ.

n Không sử dụng bàn tay đeo găng để viết, trả lời điện thoại, bật công tắc đèn, hay chạm vào bất cứ
thứ gì mà người khác có thể chạm vào khi không đeo găng tay.

n Thường xuyên thay găng tay. Tháo găng tay ngay khi nhìn thấy bị nhiễm bẩn.

n Không để các vật liệu không thể khử nhiễm đúng cách tiếp xúc với vật liệu có khả năng lây nhiễm.
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Tuân thủ an toàn và quy định

n Sau khi hoàn thành một hoạt động có sử dụng vật liệu sinh học độc hại, hãy khử nhiễm khu vực làm
việc bằng chất khử trùng thích hợp (ví dụ: pha loãng thuốc tẩy gia dụng theo tỷ lệ 1:10).
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Mối nguy hại

Khử nhiễm bề mặt

CẢNH BÁO! Để tránh bị điện giật, luôn tắt và rút phích cắm của máy trước khi thực hiện
các quy trình khử nhiễm.

Các khu vực sau đây có thể được làm sạch bằng bất kỳ thuốc diệt khuẩn, thuốc diệt vi trùng, hoặc thuốc
diệt nấm cấp bệnh viện nào:

n Nắp và khung bên ngoài

n Bề mặt bên trong block mẫu và các giếng block mẫu

n Bảng điều khiển và màn hình hiển thị

Để chuẩn bị và sử dụng chất khử trùng, hãy tham khảo hướng dẫn được nhà sản xuất sản phẩm cung
cấp. Luôn rửa sạch block mẫu và các giếng block mẫu vài lần bằng nước sau khi sử dụng chất khử trùng.
Làm khô kỹ block mẫu và các giếng block mẫu sau khi tráng bằng nước.

Quan trọng: Không sử dụng các chất tẩy rửa mài mòn hoặc ăn mòn hoặc các dung dịch kiềm mạnh.
Các chất này có thể làm trầy xước bề mặt và làm hỏng block mẫu, dẫn đến mất khả năng điều khiển
nhiệt chính xác.

Thải Bỏ Vật Liệu Nguy Hại Sinh Học

Thải bỏ các vật liệu có khả năng bị nhiễm bẩn sau đây theo các quy định phòng thí nghiệm của địa
phương, khu vực và quốc gia:

n Mẫu lâm sàng

n Thuốc thử

n Bình phản ứng đã qua sử dụng hoặc vật tư tiêu hao khác có thể bị nhiễm bẩn

Mối nguy hại hóa học
Hệ thống CFX Opus Dx không chứa các vật liệu hóa học nguy hiểm tiềm ẩn.

Mối nguy hại cháy nổ
Hệ thống CFX Opus Dx không gây nguy hiểm bất thường liên quan đến tính dễ cháy hoặc nổ khi được sử
dụng đúng cách theo quy định của Các phòng thí nghiệm Bio-Rad.
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Mối nguy hại về điện
Hệ thống CFX Opus Dx không gây nguy hiểm về điện cho người vận hành nếu được lắp đặt và vận hành
đúng cách mà không cần sửa đổi về mặt vật lý và được kết nối với nguồn điện có thông số kỹ thuật phù
hợp.

Vận chuyển
Trước khi chuyển hoặc vận chuyển Hệ thống CFX Opus Dx, phải thực hiện các quy trình khử nhiễm.
Luôn di chuyển hoặc vận chuyển hệ thống trong một thùng chứa riêng trong vật liệu đóng gói được
Bio-Rad cung cấp, bảo vệ hệ thống khỏi bị hư hại.

Để biết thông tin về việc vận chuyển hệ thống và yêu cầu vật liệu đóng gói thích hợp, hãy liên hệ với văn
phòng Bio-Rad tại địa phương của bạn.

Pin
Hệ thống CFX Opus Dx sử dụng một pin đồng xu kim loại lithium 3 V để duy trì cài đặt thời gian trong
trường hợp mất nguồn AC. Nếu thời gian không được đặt sau khi máy đã tắt, điều này có thể là dấu hiệu
cho thấy pin yếu.

CẢNH BÁO! Không cố gắng thay ắc-quy. Đây không phải là tác vụ người dùng có thể
tự thao tác. Thay vào đó, hãy liên hệ với bộ phận Hỗ trợ kỹ thuật của Bio-Rad để được
trợ giúp.

Chỉ dành cho Tiểu bang California, Hoa Kỳ

n Vật liệu peclorat – Pin lithium có chứa vật liệu peclorat, có thể cần áp dụng cách xử lý đặc biệt. Hãy
xem www.dtsc.ca.gov/hazardouswaste/perchlorate.

Thải bỏ
Hệ thống CFX Opus Dx chứa các vật liệu điện; không thải bỏ các vật liệu này dưới dạng rác thải không
phân loại và phải được thu gom riêng, theo Chỉ thị của Liên minh Châu Âu 2012/19/EU về chất thải thiết bị
điện và điện tử—Chỉ thị WEEE. Trước khi thải bỏ, hãy liên lạc với đại diện Bio-Rad tại địa phương của
bạn để biết hướng dẫn cụ thể cho quốc gia.

Bảo hành
Hệ thống CFX Opus Dx và các phụ kiện liên quan được áp dụng theo bảo hành tiêu chuẩn Bio-Rad. Liên
hệ với văn phòng Bio-Rad tại địa phương của bạn để biết các thông tin chi tiết về bảo hành.
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Chương 1 Giới thiệu
Các hệ thống khuếch đại PCR hiệu suất cao của Bio-Rad có những tiến bộ công nghệ mới nhất, cung cấp
độ chính xác và độ tái lặp cao hơn trong khuếch đại axit nucleic đối với các thử nghiệm trên bộ gen.

Phần mềm CFX Maestro Dx, Phiên bản bảo mật của Bio-Rad tương thích với các máy sau và có các tệp
lượt chạy được tối ưu hóa để thực hiện xét nghiệm đoạn mồi và đoạn dò PrimePCR của Bio-Rad:

n Hệ Thống Real-Time PCR CFX Opus 96 Dx (trong hướng dẫn này được gọi là CFX Opus 96 Dx)

n Hệ Thống Real-time PCR CFX Opus 384 Dx (trong hướng dẫn này được gọi là CFX Opus 384 Dx)

n Hệ thống Real-Time PCR CFX Opus Deepwell Dx (được gọi là CFX Opus Deepwell Dx trong hướng
dẫn này)
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Chương 1 Giới thiệu

Sử dụng Phần mềm CFX Maestro Dx, Phiên bản bảo mật (trong hướng dẫn này gọi là CFX Maestro Dx
SE), bạn có thể giải thích dữ liệu phức tạp và tạo các nghiên cứu có tính ảnh hưởng lớn để phân tích di
truyền. Chỉ với vài lần nhấp chuột, bạn có thể thiết lập các nghiên cứu và giải thích nghiên cứu biểu hiện
gen bằng các công cụ như phương pháp kiểm định t, ANOVAmột yếu tố, phân tích các kiểm tra
PrimePCR và công cụ chọn gen tham chiếu. Sau đó, bạn có thể chuẩn bị các kết quả để xuất bản và đăng
áp-phích với các công cụ chú thích và trực quan hóa dữ liệu có thể tùy chỉnh cao của CFX Maestro Dx
SE.

Lưu ý: Màn hình của một số màn hình trong CFX Maestro có thể xuất hiện khác với màn hình được
trình bày trong hướng dẫn sử dụng này. Màn hình hiển thị trong phần mềm là chính xác và chức
năng giống nhau.

Quan trọng: An ninh mạng là việc bảo vệ tài sản trong không gian mạng khỏi các cuộc tấn công
mạng. An ninh mạng là khả năng Bio-Rad đảm bảo an toàn cho người dùng, thông tin, hệ thống và
danh tiếng của Bio-Rad trong không gian mạng. Không gian mạng là một thế giới luôn hoạt động,
được kết nối với nhau về mặt công nghệ. Không gian mạng bao gồm con người, tổ chức, thông tin và
công nghệ.

Phản ứng nhanh là yếu tố then chốt khi xử lý các vấn đề an ninh mạng! Nếu bạn nghi ngờ rằng có vấn đề
an ninh mạng liên quan đến thiết bị của bạn hoặc an ninh mạng tại cơ sở của bạn đã bị vi phạm, hãy liên
hệ với đại diện của Bio-Rad để được hỗ trợ ngay về kỹ thuật.
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Các Tính Năng Chính Của Phần mềm CFX Maestro Dx, Phiên bản bảo mật

Các Tính Năng Chính Của Phần mềm CFX Maestro Dx, Phiên
bản bảo mật

Với CFX Maestro Dx SE bạn có thể thực hiện các thao tác sau:

n Phân tích dữ liệu bằng biểu đồ thanh, sơ đồ cụm hoặc đồ thị phân tán để nhanh chóng giải thích và
hiểu các kết quả của bạn.

n Tùy chỉnh cách trình bày dữ liệu của bạn và xuất đồ thị có độ phân giải cao để xuất bản và tạo báo
cáo.

n Xác định chất lượng RNA và khắc phục sự cố thử nghiệm với các kiểm tra phân tích PrimePCR.

n Chọn gen tham chiếu thích hợp và phân tích sự ổn định bằng công cụ chọn Reference Gene (Gen
Tham Chiếu).

n Thực hiện phân tích thống kê bao gồm ANOVAmột yếu tố trong phân tích biểu hiện gen.

Hướng dẫn sử dụng này giải thích các tính năng và cách sử dụng các tính năng đó.

Tìm Hiểu Thêm
Sau khi cài đặt CFX Maestro Dx SE và thiết lập máy PCR Bio-Rad liên quan, bạn có thể truy cập hướng
dẫn này cũng như các chủ đề trợ giúp CFX Maestro Dx SE chi tiết từ menu Trợ giúp trong bất kỳ chế độ
xem nào.

Lời khuyên: Nhấp vào logo Bio-Rad ở góc trên bên phải của bất kỳ cửa sổ CFX Maestro Dx SE nào
để khởi chạy trang web của Bio-Rad. Trang web này bao gồm các liên kết dẫn đến các lưu ý kỹ thuật,
hướng dẫn sử dụng, video, thông tin sản phẩm, và hỗ trợ kỹ thuật. Trang web này cũng cung cấp
nhiều tài liệu kỹ thuật về nhiều phương pháp và ứng dụng liên quan đến PCR, real-time PCR, và biểu
hiện gen.
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Chương 2 Cài đặt Phần mềm CFX Maestro Dx,
Phiên bản bảo mật

Chương này giải thích cách cài đặt Phần mềm CFX Maestro Dx, Phiên bản bảo mật. Để biết thêm thông
tin về cách thiết lập các máy real-time PCR được hỗ trợ của Bio-Rad, hãy xem hướng dẫn tương ứng.

Phải có CFX Maestro Dx SE để phân tích dữ liệu real-time PCR từ các hệ thống Real-Time PCR Opus 96
Dx, CFX Opus 384 Dx và CFX Opus Deepwell Dx. Bạn cũng có thể sử dụng phần mềm này để điều khiển
các hệ thống này ở chế độ điều khiển bằng phần mềm.

Cáp USB được vận chuyển kèm theo hệ thống CFX Opus Dx trong túi Phụ kiện. Sử dụng cáp USB để kết
nối máy tính chạy CFX Maestro Dx SE với Hệ thống CFX Opus Dx.

Gỡ vật liệu đóng gói ra và cất giữ để sử dụng trong tương lai. Nếu có mặt hàng nào bị thiếu hoặc hư hỏng,
liên lạc với văn phòng Bio-Rad tại địa phương của bạn.
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Chương 2 Cài đặt Phần mềm CFX Maestro Dx, Phiên bản bảo mật

Yêu Cầu Về Hệ Thống
Bảng 3 liệt kê các yêu cầu hệ thống tối thiểu và được khuyến nghị cho máy tính chạy CFX Maestro Dx SE.

Hệ thống Tối thiểu Được khuyến nghị

Hệ điều hành Microsoft Windows 10 (chỉ 64-bit),
phiên bản 1511 trở lên, với các
bản cập nhật bảo mật mới nhất.

Microsoft Windows 10 (chỉ 64-bit), phiên bản
1511 trở lên, với các bản cập nhật bảo mật mới
nhất.

Lưu ý:Windows 11 cũng hỗ trợ Phần mềm CFX Maestro Dx, Phiên bản bảo mật.

Quan trọng: Phải tắt chức năng Secure Boot (Khởi Động An Toàn) trên máy tính chạy CFX Maestro
Dx SE. Máy tính chạy CFX Maestro Dx SE phải được định cấu hình sao cho không tự động khởi động
lại sau khi cập nhật hệ thống hoặc bảo mật nếu lượt chạy đang diễn ra. Liên hệ với quản trị viên hệ
thống của bạn để được hỗ trợ.

Cổng 2 cổng USB 2.0 tốc độ cao 2 cổng USB 2.0 tốc độ cao

Dung lượng ổ
đĩa cứng

128 GB 128 GB

Tốc độ bộ xử lý 2,4 GHz, Lõi Kép 2,4 GHz, Lõi Tứ

RAM 4 GB RAM 8 GB RAM

Độ phân giải
màn hình

1024 x 768 với chế độ màu thực 1280 x 1024 với chế độ màu thực

PDF reader
(trình đọc PDF)

Adobe PDF Reader (Trình Đọc PDF Adobe)
hoặc Windows PDF Reader (Trình Đọc PDF
Windows) từ một trong những Microsoft Office
Suite được hỗ trợ:

n 2016

n 2019

Bản địa hóa Hệ điều hành Microsoft Windows
64 bit được hỗ trợ bằng Tiếng
Anh, Tiếng Trung Quốc và Tiếng
Nga

Hệ điều hành Microsoft Windows 64 bit được hỗ
trợ bằng Tiếng Anh, Tiếng Trung Quốc và Tiếng
Nga

Bảng 3. Yêu cầu về máy tính đối với CFX Maestro Dx SE

Lưu ý: Nếu bạn định chạy phần mềm CFX Automation Control (Điều Khiển Tự Động CFX) trên cùng
một máy tính như CFX Maestro Dx SE, hãy đặt độ phân giải màn hình thành 1280 x 1024 với chế độ
màu thực.
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Chương 2 Cài đặt Phần mềm CFX Maestro Dx, Phiên bản bảo mật

Cài Đặt CFX Maestro Dx SE Phần Mềm
Quan trọng: Bạn phải ngắt kết nối mọi máy đã kết nối với máy tính chạy CFX Maestro Dx SE trước
khi cài đặt hoặc nâng cấp phần mềm. Bạn không cần tắt máy trong khi cài đặt phần mềm. Hãy đảm
bảo rằng bạn đã lưu tất cả các lượt chạy và không có thử nghiệm nào đang chạy.

Lưu ý: Xác minh rằng chức năng Secure Boot (Khởi Động An Toàn) đã tắt trước khi bắt đầu quy
trình cài đặt. Đảm bảo máy tính được định cấu hình sao cho không tự động khởi động lại sau khi cập
nhật hệ thống hoặc cập nhật bảo mật nếu đang có lượt chạy. Liên hệ với quản trị viên hệ thống của
bạn để được hỗ trợ.

Cách cài đặt phần mềm CFX Maestro Dx SE

1. Nếu cần, ngắt kết nối mọi máy đã kết nối với máy tính.

Định vị và ngắt kết nối cáp USB của máy trên máy tính chạy CFX Maestro Dx SE. Đầu được cắm vào
Hệ thống CFX Opus Dx có thể giữ nguyên vị trí.

2. Đăng nhập vào máy tính chạy CFX Maestro Dx SE bằng đặc quyền quản trị viên.

3. Cắm USB cài đặt phần mềm CFXMaestro Dx SE vào cổng USB của máy tính.

4. TrongWindows Explorer, tìm và mở USB cài đặt phần mềm CFXMaestro Dx SE.

USB chứa Ghi Chú Phát Hành và các thư mục sau:

n CFX

n Drivers (Trình Điều Khiển)

n Firmware (Phần Mềm Điều Khiển)

n Quick Start (Bắt Đầu Nhanh)

Cùng với các tập tin khác, thư mục CFX chứa trình cài đặt phần mềm CFXMaestro Dx SE
(CFXMaestroDxSetup.exe).

5. Mở thư mục CFX và nhấp đúp vào CFXMaestroDxSetup.exe để khởi động trình cài đặt.

6. Làm theo các hướng dẫn cài đặt trên màn hình.

Khi hoàn thành, biểu tượng Bio-Rad Phần mềm CFX Maestro Dx, Phiên bản bảo mật xuất hiện trên
màn hình máy tính.

Lời khuyên: Trình cài đặt CFX Maestro tự động cài đặt hướng dẫn sử dụng Phần mềm
CFX Maestro Dx, Phiên bản bảo mật. Để tìm các hướng dẫn này, hãy điều hướng đến menu Trợ
giúp và chọn Open User Guides (Mở hướng dẫn sử dụng).

7. Sau khi hoàn tất cài đặt, bạn có thể rút USB cài đặt phần mềm ra một cách an toàn.
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Phát Hiện Máy Được Kết Nối
Trong khi cài đặt, trình cài đặt CFX Maestro Dx SE tự động cài đặt các trình điều khiển máy vào máy tính
CFX Maestro Dx SE. CFX Maestro Dx SE phát hiện các máy được kết nối khi bạn khởi động phần mềm.

Cách phát hiện máy được kết nối

1. Nếu bạn chưa làm như vậy, hãy cắm đầu vuông (đực) của cáp USB Type B đi kèm vào cổng USB
Type B nằm ởmặt sau của đế máy.

2. Cắm đầu (cổng) kia vào cổng USB trên máy tính CFX Maestro Dx SE.

3. Nếu máy chưa chạy, hãy nhấn công tắc nguồn ở trên máy để bật máy.

4. Bắt đầu CFX Maestro Dx SE.

Phần mềm tự động phát hiện máy được kết nối và hiển thị tên của máy trong ngăn Detected Instruments
(Máy Đã Phát Hiện) trên cửa sổ Trang Chủ.

Lưu ý: Nếu máy không xuất hiện trong ngăn Detected Instruments (Máy Đã Phát Hiện), hãy xác
minh xem cáp USB đã được cắm đúng cách chưa. Để cài đặt lại các trình điều khiển, trên cửa sổ
Trang Chủ trong CFX Maestro Dx SE chọn Tools > Reinstall Instrument Drivers (Công Cụ > Cài Đặt
Lại Các Trình Điều Khiển Máy).
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Chương 2 Cài đặt Phần mềm CFX Maestro Dx, Phiên bản bảo mật

Tệp phần mềm
Bảng 4 liệt kê các loại tệp CFX Maestro Dx SE.

Loại tệp
Phần mở
rộng Chi tiết

Protocol .prcl Chứa các chi tiết thiết lập protocol để thực hiện một lượt
chạy PCR.

Khay .pltd Chứa chi tiết thiết lập khay để thực hiện một lượt chạy PCR.

Dữ Liệu .pcrd Chứa các kết quả của lượt chạy thử nghiệm và phân tích
PCR.

Lượt chạy PrimePCR .csv Chứa protocol và bố cục khay cho các khay PrimePCR.

Nghiên cứu gen .mgxd Chứa các kết quả của nhiều lượt chạy PCR và phân tích
biểu hiện gen.

Tệp tin tiền dữ liệu độc
lập

.zpcr Chứa các chỉ số chất huỳnh quang từ vận hành độc lập
được chuyển đổi thành một tệp dữ liệu.

LIMS .plrn Chứa thông tin thiết lập khay và thông tin protocol cần thiết
để tiến hành một lượt chạy tương thích với LIMS.

JSON .json Tệp chỉ đọc được tạo bởi hệ thống CFX Opus Dx, tệp này
chứa dữ liệu tệp lượt chạy xuất hiện trong ngăn chi tiết
trong File Browser (Trình duyệt tệp) khi tệp lượt chạy được
chọn. Tệp này được tạo sau khi lượt chạy hoàn tất. Tệp này
được xuất dưới dạng tệp .zpcr và lưu cùng với tệp dữ liệu
khi Vị trí lưu là ổ USB hoặc thư mục mạng dùng chung.

Bảng 4. CFX Maestro Dx SE các loại tệp tin
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Chương 3 Quản lý tài khoản người dùng Phần
mềm CFX Maestro Dx, Phiên bản bảo mật

Trong Phần mềm CFX Maestro Dx, Phiên bản bảo mật, người dùng đăng nhập bằng tên người dùng và
mật khẩuWindows của họ. Người cài đặt CFX Maestro Dx SE được tự động gán vai trò Administrator
(Quản Trị Viên) và có thể tạo cũng như quản lý các tài khoản và vai trò của người dùng. Tất cả những
người dùng khác phải được gán một tài khoản người dùng để đăng nhập và sử dụng phần mềm.

Quan trọng: Mỗi người dùng phải có tài khoản và mật khẩuWindows trên máy tính chạy CFX
Maestro Dx SE trước khi bạn có thể gán tài khoản và vai trò cho người dùng. Người dùng có thể là
thành viên của nhómWindows Users (Người DùngWindows) hoặc nhómWindows Administrators
(Quản Trị Viên Windows). Thành viên của nhómWindows Users (Người DùngWindows) chỉ có thể
truy cập tệp và thư mục CFX Maestro Dx SE của chính họ. Thành viên của nhómWindows
Administrators (Quản Trị Viên Windows) có thể truy cập các tệp và thư mục của tất cả người dùng
trên máy tính.

chương này giải thích cách tạo người dùng Microsoft Windows để thêm vào CFX Maestro Dx SE. Phần
này cũng giải thích cách thêm người dùng CFX Maestro Dx SE và quản lý vai trò cùng quyền của người
dùng.
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Khởi động Phần mềm CFX Maestro Dx, Phiên bản bảo mật
Lưu ý: Mỗi người dùng phải đăng nhập bằng tên người dùng và mật khẩuWindows của mình.

Cách khởi động CFX Maestro Dx SE

1. Trên màn hình máy tính chạy CFX Maestro Dx SE, nhấp đúp vào biểu tượng phím tắt CFX Maestro
Dx SE để khởi động ứng dụng.

2. Trong hộp thoại Login (Đăng Nhập), nhập mật khẩuWindows của bạn và nhấp vào OK.

CFX Maestro Dx SE mở ra cửa sổ Trang Chủ. Thanh tiêu đề hiển thị tên người dùngWindows của
người dùng đã đăng nhập và thanh menu hiển thị nhãn dán màu xanh lam cho biết phần mềm tuân
thủ 21 CFR Phần 11, ví dụ:
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Thêm người dùng Microsoft Windows vào máy tính chạy Phần
mềm CFX Maestro Dx, Phiên bản bảo mật

Tất cả người dùng phải đăng nhập vào máy tính chạy CFX Maestro Dx SE bằng tên người dùng và mật
khẩuWindows của họ. Để theo dõi kiểm soát chính xác, không được thêm tài khoản người dùng
Windows qua hộp thoại Start > Settings > Accounts (Bắt Đầu > Cài Đặt > Tài Khoản). Tài khoản người
dùngWindows phải được thêm qua bảng điều khiển Computer Management (Quản Lý Máy Tính).

Quan trọng: Các thay đổi về thuộc tính của người dùngWindows (trong đó bao gồm Tên người
dùng và Tên đầy đủ) sau khi bạn đã tạo người dùng CFX Maestro Dx SE tương ứng sẽ làmmất hiệu
lực người dùng CFX Maestro Dx SE. Đảm bảo thông tin chính xác trước khi lưu người dùng
Windows và tạo người dùng CFX Maestro Dx SE tương ứng.

Lời khuyên: Xem lại tài liệu Microsoft Windows Administration (Quản Trị Microsoft Windows) và liên
hệ với quản trị viên hệ thốngWindows của bạn để biết thêm thông tin trước khi tạo tài khoản
Windows.

Để thêm tài khoản người dùng Windows vào máy tính chạy CFX Maestro Dx SE

1. Đăng nhập vào máy tính chạy CFX Maestro Dx SE với tư cách là thành viên trong nhóm của
Windows Administrator (Quản Trị Viên Windows).

2. Trên màn hình nền, nhấp chuột phải vào My Computer (Máy Tính Của Tôi) và chọn Manage (Quản
Lý) để mở bảng điều khiển Computer Management (Quản Lý Máy Tính).

3. Trong bảng điều khiển Computer Management (Quản Lý Máy Tính), mở rộng Local Users and
Groups (Người Dùng Và Nhóm Cục Bộ).

4. Nhấp chuột phải vào thư mục Users (Người Dùng) và chọn New User (Người Dùng Mới) để mở hộp
thoại New User (Người Dùng Mới).
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5. Trong hộp thoại New User (Người Dùng Mới), bạn phải điền vào các trường sau:

n User name (Tên người dùng)

n Full name (Họ tên)

n Password (Mật khẩu)

n Confirm password (Xác nhận mật khẩu)

6. Nhấp vào Create (Tạo).
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Thêm và xóa người dùng Phần mềm CFX Maestro Dx, Phiên
bản bảo mật

Lời khuyên: Chỉ những người dùng có vai trò Administrator (Quản Trị Viên) CFX Maestro Dx SE
mới có thể tạo và xóa các tài khoản người dùng CFX Maestro Dx SE. Người cài đặt CFX Maestro Dx
SE được tự động gán vai trò Administrator (Quản Trị Viên). Người đó có thể gán vai trò Administrator
(Quản Trị Viên) cho những người dùng khác.

Lưu ý: Trong CFX Maestro Dx SE, ít nhất một người dùng phải được gán vai trò Administrator
(Quản Trị Viên).

Cách thêm tài khoản người dùng CFX Maestro Dx SE

1. Xác minh rằng mỗi người dùng dự kiến là thành viên của nhómWindows Users (Người Dùng
Windows) hoặc nhómWindows Administrators (Quản Trị Viên Windows) và có mật khẩuWindows
trên máy tính chạy CFX Maestro Dx SE.

2. Khởi động CFX Maestro Dx SE và đăng nhập với tư cách Administrator (Quản Trị Viên).

3. Trong cửa sổ Trang Chủ, chọn User > User Administration (Người Dùng > Quản Trị Người Dùng).

Hộp thoại User Administration (Quản Trị Người Dùng) xuất hiện.
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4. Trong phần Manage Users (Quản Lý Người Dùng), hãy cung cấp thông tin sau cho từng người dùng:

n User name (Tên người dùng) - trong CFX Maestro Dx SE, đây phải là tên đăng nhậpWindows
của người dùng.

n Full name (Họ tên) - tên đầy đủ của người dùng.

Tên này xuất hiện ở phần Full User (Tên người dùng đầy đủ) trong dấu vết kiểm soát. Tên này
phải giống tên được nhập trong trường Full Name (Họ Tên) khi người dùngWindows được tạo.

n Role (Vai trò) - vai trò sẽ gán cho người dùng.

Lưu ý: Bạn chỉ có thể chọn một vai trò trong danh sách thả xuống. Hãy xem Quản lý vai trò
người dùng Phần mềm CFX Maestro Dx, Phiên bản bảo mật để biết thêm thông tin.

n Domain (Miền) - miền Windows để cho người dùng truy cập phần mềm.

Hãy liên hệ với quản trị viên hệ thốngWindows của bạn để biết thêm thông tin.

5. Nhấp vào OK rồi nhấp vào Yes (Có) để lưu các thay đổi và đóng hộp thoại User Administration (Quản
Trị Người Dùng).

Để xóa tài khoản người dùng CFX Maestro Dx SE

1. Khởi động CFX Maestro Dx SE và đăng nhập với tư cách Administrator (Quản Trị Viên).

2. Trong cửa sổ Trang Chủ, chọn User > User Administration (Người Dùng > Quản Trị Người Dùng) để
mở hộp thoại User Administration (Quản Trị Người Dùng).

3. Trong ngăn Manage Users (Quản Lý Người Dùng), hãy chọn Remove (Xóa) cho mỗi người dùng bạn
muốn xóa.

4. Nhấp vào OK rồi nhấp vào Yes (Có) để lưu các thay đổi và đóng hộp thoại User Administration (Quản
Trị Người Dùng).

Quản lý vai trò người dùng Phần mềm CFX Maestro Dx, Phiên
bản bảo mật

Quan trọng: CFXMaestro Dx SE yêu cầu ít nhất một người dùng được gán vai trò Administrator
(Quản Trị Viên). Bạn có thể gán vai trò này cho nhiều người dùng.

CFX Maestro Dx SE có bốn vai trò người dùng. Mỗi người dùng phải được gán một vai trò để truy cập
phần mềm. Mặc dù người dùng chỉ có thể được gán một vai trò, bạn có thể thay đổi vai trò của người
dùng bất kỳ lúc nào.

Ngoại trừ vai trò Administrator (Quản Trị Viên), bạn có thể thay đổi các quyền được gán cho từng vai trò.
Tất cả người dùng được gán một vai trò chỉ được hưởng các quyền của vai trò đó.
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Theo mặc định, các quyền cho mỗi vai trò như sau:

n Administrator (Quản Trị Viên) – vai trò này có tất cả các quyền; bạn không thể thay đổi các quyền
này.

n Principal (Người Dùng Chính) – vai trò này có tất cả các quyền ngoại trừ quyền thiết lập email.

n Operator (Người Vận Hành) – vai trò này có tất cả các quyền ngoại trừ quyền bỏ qua các chu kỳ và
thiết lập email.

n Guest (Khách) – vai trò này chỉ có thể đọc tệp.

Khi gán vai trò trong CFX Maestro Dx SE, hãy cẩn thận xác định các yêu cầu đối với từng người dùng. Ví
dụ: nếu không có quyền lưu, người dùng được gán vai trò Khách sẽ không thể ký tệp. Nếu không có
quyền thiết lập tài khoản email, không vai trò nào sẽ nhận được email khi một lượt chạy hoàn tất.

Để sửa đổi các quyền cho một vai trò

1. Khởi động CFX Maestro Dx SE và đăng nhập với tư cách Administrator (Quản Trị Viên).

2. Trong cửa sổ Trang Chủ, chọn User > User Administration (Người Dùng > Quản Trị Người Dùng) để
mở hộp thoại User Administration (Quản Trị Người Dùng).

3. Trong phần Manage Rights (Quản Lý Quyền), với mỗi vai trò, hãy bỏ chọn hoặc chọn ô kiểm của các
quyền cụ thể, nếu cần.

4. Nhấp vào OK rồi nhấp vào Yes (Có) để lưu các thay đổi và đóng hộp thoại User Administration (Quản
Trị Người Dùng).

Xem Vai Trò Và Quyền Của Bạn
Lời khuyên: Người dùng được gán các vai trò người dùng Principal (Người Dùng Chính), Operator
(Người Vận Hành) hoặc Guest (Khách) chỉ có thể xem phần cài đặt người dùng, quyền và vai trò của
họ. Người dùng được gán vai trò Administrator (Quản Trị Viên) có thể xem tất cả các quyền và vai trò
của người dùng.

Để xem các quyền và vai trò người dùng hiện tại của bạn

u Trong cửa sổ Trang Chủ, chọn User > User Administration (Người Dùng > Quản Lý Người Dùng).

Liên hệ với quản trị viên CFX Maestro Dx SE của bạn để sửa đổi các chi tiết cài đặt, quyền được phép và
vai trò người dùng được liệt kê trong cửa sổ User Administration (Quản Lý Người Dùng).
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Chương 4 Sử dụng Phần mềm CFX Maestro Dx,
Phiên bản bảo mật

Quan trọng: Phần mềm CFX Maestro Dx, Phiên bản bảo mật sử dụng quy trình Xác thực người
dùng Microsoft Windows để xác minh quyền truy cập vào các tập tin dữ liệu CFX bảo mật. Liên hệ với
quản trị viên Windows của bạn để tạo môi trường tuân thủ các yêu cầu của 21 CFR Phần 11.

Sử dụng CFX Maestro Dx SE, người dùng có thể

n Ký tệp dữ liệu và tệp nghiên cứu gen.

n Đặt mật khẩu bảo vệ tệp dữ liệu.

n Xem và in các dấu vết kiểm soát.

Phần này giải thích chi tiết các tính năng này.

Tệp Bảo Mật
Theo mặc định, CFX Maestro Dx SE lưu các tệp bảo mật vào thư mục cá nhân của người dùng đã đăng
nhập, được đặt tại

C:\Users\<tên người dùng>\Documents\Bio-Rad\CFX_MDX\My qPCR

Bạn có thể lưu và chỉnh sửa các tập tin .pcrd trong thư mục đó. Thư mục này chứa các liên kết đến các
thư mục khác (ví dụ: Thư mục tập tin mẫu) chứa các tập tin ở chế độ chỉ đọc. Tuy nhiên, quản trị viên có
thể xóa nội dung của thư mục đó.

Lời khuyên: Ngoài ra, quản trị viên hệ thốngWindows của bạn có thể tạo một thư mục dùng chung
và quản trị viên CFX Maestro Dx SE có thể lập trình phần mềm để lưu tất cả các tệp vào thư mục đó.

Trong CFX Maestro Dx SE, các tệp khay, protocol, dữ liệu và nghiên cứu gen được đánh dấu là bảo mật
khi lưu. Bạn có thể tạo các tệp này trong phần mềm CFXMaestro hoặc trong CFX Maestro Dx SE. Sau
khi tệp được lưu vào CFX Maestro Dx SE, bạn chỉ có thể mở các tệp này trong CFX Maestro Dx SE.

CFX Maestro Dx SE tạo dấu vết kiểm soát cho tất cả tệp dữ liệu và tệp nghiên cứu gen bảo mật (tương
ứng là tệp .pcrd và .mgxd). Phần mềm ghi lại tất cả các hoạt động có thể kiểm soát được trong dấu vết
kiểm soát của tệp. Để biết thêm thông tin, xem Các Dấu Vết Kiểm Soát trên trang 299.
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Ký Tệp Bảo Mật

Sau khi lưu tệp trong CFX Maestro Dx SE, người dùng có thể thêm chữ ký điện tử. Để ký một tệp, vai trò
của người dùng phải có quyền lưu tệp. Ví dụ: theo mặc định, vai trò Khách không có quyền lưu tệp nên
người dùng được gán vai trò này không thể ký tệp.

Trong CFX Maestro Dx SE , các tệp đã ký không được đặt ở trạng thái chỉ đọc. Các tệp này có thể được
xem lại, sửa đổi và ký nhiều lần. Tất cả các thay đổi và chữ ký đều được theo dõi trong dấu vết kiểm soát
của tệp. Bạn có thể ký các loại tệp sau:

n Tệp dữ liệu (.pcrd)

n Tệp nghiên cứu gen (.mgxd)

Lưu ý: Các tệp phải được lưu mới có thể ký được. Nếu gần đây bạn đã thực hiện lượt chạy trong
CFX Maestro Dx SE, trước tiên hãy lưu tệp dữ liệu kết quả.

Cách ký tệp

1. Đăng nhập vào CFX Maestro Dx SE bằng thông tin xác thực đăng nhậpWindows của bạn.

2. Mở tệp dữ liệu hoặc tệp nghiên cứu gen bảo mật cần ký.

3. Chọn File > Sign (Tệp > Ký). Hộp thoại Electronic Signature (Chữ Ký Điện Tử) xuất hiện.
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4. Nhập tên người dùng và mật khẩuWindows của bạn và lý do cho việc ký tệp.

Tên người dùng và lý do cho việc ký tên được bao gồm trong dấu vết kiểm soát (để biết thêm thông
tin, hãy xem Các Dấu Vết Kiểm Soát trên trang 299).

5. Nhấp vào OK để gửi chữ ký và đóng hộp thoại.

Sửa Đổi Tệp Bảo Mật

Trong CFX Maestro Dx SE , người dùng có thể sửa đổi các tệp bảo mật, trong đó bao gồm tệp dữ liệu và
tệp nghiên cứu gen đã ký và chưa ký. Phần mềm sẽ nhắc bạn cho biết lý do thay đổi khi bạn lưu tệp dữ
liệu hoặc tệp nghiên cứu gen bảo mật đã sửa đổi. Các thay đổi được theo dõi trong dấu vết kiểm soát của
tệp.

Lời khuyên: Bởi vì phần mềm không tạo dấu vết kiểm soát cho các tệp khay hoặc protocol, bạn sẽ
không được nhắc cung cấp lý do khi bạn lưu thay đổi cho các tệp này.

Cách lưu tệp dữ liệu hoặc tệp nghiên cứu gen đã sửa đổi.

1. Đăng nhập vào CFX Maestro Dx SE bằng thông tin xác thực đăng nhậpWindows của bạn.

2. Mở và sửa đổi tệp dữ liệu hoặc tệp nghiên cứu gen bảo mật.

Lời khuyên: Để biết danh sách các hoạt động có thể kiểm soát, hãy xem Sự Kiện Có Thể Kiểm
Soát trên trang 301.

3. Chọn File > Save (Tệp > Lưu). Hộp thoại Audit Trail Change Reason (Lý Do Thay Đổi Dấu Vết Kiểm
Soát) xuất hiện.
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Hộp thoại này hiển thị thông tin sau, được ghi lại trong tiêu đề dấu vết kiểm soát của tệp cho mỗi sự
kiện sửa đổi:

n Date (Ngày) – ngày diễn ra sự thay đổi.

n User (Người dùng) – miền Windows và tên người dùng của người dùng đã đăng nhập.

n Comment (Nhận xét) – nhận xét gần nhất được lưu.

n Signature (Chữ ký) – chữ ký điện tử của người gần đây nhất đã ký tệp.

n Signature reason (Lý do ký) – lý do họ để lại chữ ký.

n Application (Ứng dụng) -CFX Maestro Dx SE (xuất hiện ở dạng BioRadCFXManager.exe là
chính xác).

n Application version (Phiên bản ứng dụng) – phiên bản hiện tại của CFX Maestro Dx SE.

n Full user (Người dùng đầy đủ) – họ tên của người dùng đã đăng nhập.

Lưu ý: Tên này xuất hiện trong dấu vết kiểm soát.

n Machine (Máy) – máy tính đã cài đặt ứng dụng.

48 | Phần Mềm CFXMaestro Dx SE



Bảng thay đổi hiển thị những thay đổi có thể kiểm soát đã diễn ra do việc sửa đổi. Có thể có thêm
phần mô tả ngắn gọn về lý do cho sự thay đổi.

Lời khuyên: Bạn có thể thêm hoặc chỉnh sửa phần mô tả trong cột Reason for Change (Lý Do
Thay Đổi).

4. Xem lại danh sách các thay đổi. Cung cấp lý do chi tiết nếu cần.

5. Thực hiện một trong các thao tác sau:

n Nhấp vào Save Changes (Lưu Thay Đổi) để lưu các thay đổi ở tệp cũng như bất kỳ thay đổi nào
bạn đã thực hiện cho bảng và đóng hộp thoại.

Các thay đổi ở tệp và lý do thay đổi sẽ xuất hiện trong dấu vết kiểm soát của tệp.

n Nhấp vào Cancel Changes (Hủy Thay Đổi) để hoàn nguyên tệp về trạng thái trước đó và đóng
hộp thoại.

Các thay đổi không được lưu vào tệp và dấu vết kiểm soát không được cập nhật.
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Đặt Mật Khẩu Bảo Vệ Tệp

Để tăng mức độ bảo mật, CFX Maestro Dx SE cho phép người dùng đặt mật khẩu cho tất cả các tệp bảo
mật. Khi đặt mật khẩu cho tệp bảo mật, bạn hãy cân nhắc các điều kiện sau:

Điều Kiện Thao Tác

Không yêu cầu mật khẩu. Tất cả người dùng có thể mở, sửa đổi và lưu tập tin an
toàn, dựa trên quyền của họ.

Tệp yêu cầu Mật khẩu lưu. Tất cả người dùng có thể mở tệp bảo mật và người dùng
biết Mật khẩu lưu có thể sửa đổi và lưu tệp bảo mật.

Tệp yêu cầu Mật khẩu mở. Chỉ những người dùng biết Mật khẩu mởmới có thể mở,
sửa đổi và lưu tệp bảo mật.

Tệp yêu cầu cả Mật khẩu mở và
Mật khẩu lưu.

Một số người dùng có thể mở tệp bảo mật và một nhóm
người dùng trong số đó có thể sửa đổi và lưu tệp.

Tùy thuộc vào vai trò của người dùng, bất kỳ người dùng nào cũng có thể thực hiện Save As (Lưu Dưới
Dạng) để tạo tệp bảo mật mới với tên khác hoặc lưu tệp cùng tên ở vị trí khác, miễn đáp ứng một trong
các điều sau:

n Tệp bảo mật không được bảo vệ bằng mật khẩu.

n Người dùng có mật khẩu để mở tệp.

Lời khuyên: Tệp mới được lưu mà không có mật khẩu bảo vệ. Tệp gốc vẫn giữ nguyên mật khẩu.

Tùy thuộc vào vai trò, người dùng có thể sửa đổi và lưu tệp gốc, miễn một trong các điều sau là đúng:

n Tệp không được bảo vệ bằng mật khẩu.

n Người dùng có mật khẩu để mở và mật khẩu để lưu tệp.

Lưu ý: Vai trò của người dùng phải bao gồm quyền lưu tệp để đặt mật khẩu. Ví dụ: người dùng có
vai trò Khách không thể lưu tệp và do đó không thể đặt mật khẩu cho tệp.

Quan trọng: Chỉ quản trị viên CFX Maestro Dx SE mới có thể đặt lại hoặc xóa mật khẩu.
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Cách đặt mật khẩu bảo vệ tệp

1. Đăng nhập vào CFX Maestro Dx SE bằng thông tin đăng nhậpWindows của bạn.

2. Mở tệp bảo mật.

3. Chọn File > File Passwords (Tệp > Mật Khẩu Tệp). Hộp thoại File Passwords (Mật Khẩu Tệp) xuất
hiện.

4. Nhập mật khẩu vào các ô Save Password (Mật Khẩu Lưu) và Open Password (Mật Khẩu Mở).

Lời khuyên: Theo mặc định, mật khẩu xuất hiện ở dạng ký tự dấu hoa thị khi nhập. Chọn Show
Password (Hiển Thị Mật Khẩu) để hiển thị mật khẩu khi bạn nhập.

Quan trọng: Mật khẩu phân biệt chữ hoa, chữ thường. CFX Maestro Dx SE không đặt giới hạn
về mật khẩu. Tốt nhất, bạn nên liên hệ với quản trị viên hệ thống để biết các yêu cầu về mật khẩu
tại cơ sở của bạn.

5. Nhấp vào Set Passwords (Đặt Mật Khẩu) để đặt mật khẩu và đóng hộp thoại.

6. Chọn File > Save (Tệp > Lưu) để lưu các thay đổi đối với tệp.
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Cách bỏ mật khẩu

Quan trọng: Bạn phải là quản trị viên CFX Maestro Dx SE thì mới xóa được mật khẩu.

1. Trong hộp thoại Password Required (Yêu Cầu Mật Khẩu), nhấp vào Remove Passwords (Bỏ Mật
Khẩu).

Hộp thoại đăng nhập vào CFX Maestro Dx SE xuất hiện.

2. Cung cấp tên người dùng và mật khẩuWindows cho quản trị viên CFX Maestro Dx SE và nhấp vào
OK.

Tệp dữ liệu gốc xuất hiện.

Quan trọng: Bạn phải lưu tệp thì mới bỏ được mật khẩu.

3. Chọn File > Save (Tệp > Lưu) để lưu các thay đổi đối với tệp.
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Cách thay đổi mật khẩu

Quan trọng: Chỉ quản trị viên CFX Maestro Dx SE mới có thể thay đổi mật khẩu.

1. Mở tệp bảo mật.

2. Chọn File > File Passwords (Tệp > Mật Khẩu Tệp). Hộp thoại File Passwords (Mật Khẩu Tệp) xuất
hiện.

Lời khuyên: Save Password (Mật Khẩu Lưu), Open Password (Mật Khẩu Mở) và Show
Password (Hiển Thị Mật Khẩu) không thể sửa.

3. Nhấp vào Reset Passwords (Đặt Lại Mật Khẩu).

Hộp thoại đăng nhập vào CFX Maestro Dx SE xuất hiện.
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4. Cung cấp tên người dùng và mật khẩuWindows cho quản trị viên CFX Maestro Dx SE và nhấp vào
OK.

Hộp thoại File Passwords (Mật Khẩu Tệp) xuất hiện.

5. Thực hiện một trong các thao tác sau:

n Để đặt lại mật khẩu bảo vệ, hãy nhập mật khẩu mới vào ô mật khẩu thích hợp.

n Để bỏ tính năng bảo vệ bằng mật khẩu, xóa các ô mật khẩu.

6. Nhấp vào Set Passwords (Đặt Mật Khẩu) để lưu các thay đổi mật khẩu và thoát khỏi hộp thoại.
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Chương 5 Vùng Làm Việc
Phần mềm CFX Maestro Dx, Phiên bản bảo mật cung cấp giao diện để thiết lập các khay, phát triển các
chương trình PCR, chạy chúng trên các máy CFX Opus Dx Deepwell Dx và phân tích dữ liệu từ các lượt
chạy PCR.

CFX Maestro Dx SE bao gồm năm vùng làm việc chính:

n Cửa sổ Trang Chủ

n Startup Wizard (Trình Hướng Dẫn Khởi Động)

n Cửa Sổ Plate Editor (Trình Chỉnh Sửa Khay)

n Cửa Sổ Plate Editor (Trình Chỉnh Sửa Khay)

n Cửa Sổ Data Analysis (Phân Tích Dữ Liệu)

Mỗi vùng làm việc được hiển thị và được mô tả ngắn gọn trong chương này.
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Cửa Sổ Trang Chủ
CFXMaestro Dx SE mở cửa sổ Trang Chủ và hiển thị Startup Wizard (Trình Hướng Dẫn Khởi Động), từ
đó bạn có thể thiết lập một thử nghiệm, thực hiện hoặc lặp lại một lượt chạy, hoặc phân tích lượt chạy
hiện tại. Từ cửa sổ Trang Chủ, bạn cũng có thể xem nhật ký ứng dụng và máy, tạo và quản lý người dùng,
cũng như truy cập vào nhiều công cụ hữu ích. Để biết thêm thông tin, xem Chương 6, Cửa Sổ Trang Chủ.
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Startup Wizard (Trình Hướng Dẫn Khởi Động)

Startup Wizard (Trình Hướng Dẫn Khởi Động)
Sử dụng Startup Wizard (Trình Hướng Dẫn Khởi Động) để nhanh chóng thiết lập và chạy các thử nghiệm
do người dùng cài đặt hoặc chọn và chạy thử nghiệm PrimePCR. Bạn cũng có thể sử dụng trình hướng
dẫn này để lặp lại lượt chạy hoặc phân tích dữ liệu lượt chạy.
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Cửa Sổ Protocol Editor (Trình Chỉnh Sửa Protocol)
Trong Protocol Editor (Trình Chỉnh Sửa Protocol) bạn có thể tạo, mở, xem lại, và chỉnh sửa protocol. Bạn
cũng có thể sửa đổi nhiệt độ nắp đối với protocol mở. Chức năng của Protocol Editor (Trình Chỉnh Sửa
Protocol) được mô tả chi tiết trong Chương 7, Tạo Protocol.
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Cửa Sổ Plate Editor (Trình Chỉnh Sửa Khay)

Cửa Sổ Plate Editor (Trình Chỉnh Sửa Khay)
Trong Plate Editor (Trình Chỉnh Sửa Khay), bạn có thể tạo, mở, xem lại và chỉnh sửa khay. Chức năng
của Plate Editor (Trình Chỉnh Sửa Khay) được mô tả chi tiết trong Chương 8, Chuẩn Bị Khay.
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Cửa Sổ Data Analysis (Phân Tích Dữ Liệu)
Trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), bạn có thể xem và so sánh dữ liệu lượt chạy, thực hiện
phân tích thống kê, xuất dữ liệu và tạo các báo cáo sẵn sàng xuất bản. Chức năng Data Analysis (Phân
Tích Dữ Liệu) được trình bày chi tiết trong Chương 10, Tổng Quan Về Phân Tích Dữ Liệu và Chương 11,
Chi Tiết Phân Tích Dữ Liệu.
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Chương 6 Cửa Sổ Trang Chủ
Phần mềm CFX Maestro Dx, Phiên bản bảo mật cung cấp một giao diện để phát triển các chương trình
PCR, chạy chương trình trên các hệ thống Dx CFX và phân tích dữ liệu lượt chạy PCR.

Chương này giới thiệu CFX Maestro Dx SE và mô tả các tính năng có thể truy cập từ cửa sổ Trang Chủ.
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Cửa Sổ Trang Chủ
CFXMaestro Dx SE mở cửa sổ Trang Chủ và hiển thị Startup Wizard (Trình Hướng Dẫn Khởi Động), từ
đó bạn có thể thiết lập một lượt chạy, thực hiện hoặc lặp lại một lượt chạy, hoặc phân tích lượt chạy hiện
tại. Từ cửa sổ Trang Chủ, bạn cũng có thể xem nhật ký ứng dụng và máy, tạo và quản lý người dùng,
cũng như truy cập vào nhiều công cụ hữu ích.

1. Thanh tiêu đề của phần mềm hiển thị tên của phần mềm và người dùng đã đăng nhập.

2. Thanh menu cho phép truy cập nhanh vào các lệnh trong menu File (Tệp), View (Xem), Users
(Người Dùng), Run (Lượt Chạy), Tools (Công Cụ), Window (Cửa Sổ), và Help (Trợ Giúp).

3. Các lệnh trên thanh công cụ cho phép truy cập nhanh vào các tùy chọn menu.

4. Ngăn bên trái hiển thị các máy đã kết nối với CFX Maestro Dx SE máy tính và cung cấp các nút
để bạn có thể vận hành nắp và xem trạng thái của các máy.

5. Ngăn chính hiển thị cửa sổ đang hoạt động. Cửa sổ đang hoạt động mặc định trên màn hình
Trang Chủ là Startup Wizard (Trình Hướng Dẫn Khởi Động).

CHÚ THÍCH
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6. Thanh trạng thái hiển thị tên của các máy đã kết nối và người dùng đã đăng nhập.

Các Lệnh Trong Menu File (Tệp)
New (Mới) – mở hộp thoại để bạn có thể chọn tạo một protocol, khay, hoặc nghiên cứu gen mới.

Open (Mở) – mở hộp thoại để bạn có thể chọn tìm đến và mở protocol, khay, tệp dữ liệu, nghiên cứu gen,
tệp LIMS, lượt chạy từ một máy độc lập (lượt chạy độc lập) hoặc tệp lượt chạy PrimePCR hiện có.

Recent Data Files (Tệp Dữ Liệu Gần Đây) – hiển thị danh sách các tệp PCR đã mở gần đây.

Repeat a Run (Lặp Lại Lượt Chạy) – mởWindows Explorer đến vị trí của các tệp PCR đã lưu, tại đó bạn
có thể định vị một lượt chạy để lặp lại.

Exit (Thoát) – đóng CFX Maestro Dx SE.

Các Lệnh Trong Menu View (Chế Độ Xem)
Application Log (Nhật Ký Ứng Dụng) — hiển thị nhật ký sử dụng phần mềm từ thời điểm cài đặt ban đầu
đến ngày hiện tại.

Run Reports (Báo Cáo về Lượt Chạy) — hiển thị danh sách các báo cáo về lượt chạy.

Startup Wizard (Trình Hướng Dẫn Khởi Động) — hiển thị Startup Wizard (Trình Hướng Dẫn Khởi Động)
trong ngăn chính.

Run Setup (Thiết Lập Lượt Chạy) — hiển thị cửa sổ Run Setup (Thiết Lập Lượt Chạy) trong ngăn chính.

Instrument Summary (Thông Tin Tóm Tắt về Máy) — hiển thị cửa sổ Instrument Summary (Thông Tin
Tóm Tắt về Máy) trong ngăn chính.

Detected Instruments (Máy Đã Phát Hiện) — chuyển đổi giữa hiển thị và không hiển thị các máy đã kết
nối trong ngăn bên trái. Theo mặc định, phần mềm sẽ hiển thị các máy đã kết nối ở ngăn bên trái.

Toolbar (Thanh Công Cụ) — chuyển đổi giữa hiển thị và không hiển thị thanh công cụ trên đầu màn hình.
Theo mặc định, phần mềm sẽ hiển thị thanh công cụ.

Status Bar (Thanh Trạng Thái) — chuyển đổi giữa hiển thị và không hiển thị thanh trạng thái ở cuối màn
hình. Theo mặc định, phần mềm sẽ hiển thị thanh trạng thái.

Show (Hiển Thị) —mởmột hộp thoại mà từ đó bạn có thể

n Xem hoặc chặn nhật ký Trạng Thái.

n Mở và xem thư mục dữ liệu CFX Maestro Dx SE.

n Mở và xem thư mục dữ liệu của người dùng.

n Mở và xem thư mục tệp LIMS.
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n Mở và xem thư mục PrimePCR.

n Xem lịch sử lượt chạy.

n Xem các thuộc tính của tất cả các máy đã kết nối.

Các Lệnh Trong Menu User (Người Dùng)
Select User (Chọn Người Dùng) —mởmàn hình Login (Đăng Nhập) trên đó bạn có thể chọn một người
dùng từ danh sách thả xuống User Name (Tên Người Dùng) và đăng nhập vào ứng dụng.

Change Password (Đổi Mật Khẩu) —mở hộp thoại Change Password (Đổi Mật Khẩu), trong đó người
dùng có thể thay đổi mật khẩu của họ.

Lưu ý: Tùy chọn này bị tắt đối với CFX Maestro Dx SE. Người dùng phải thay đổi mật khẩuWindows
để thay đổi mật khẩu CFX Maestro Dx SE của họ.

User Preferences (Ưu Tiên của Người Dùng) —mở hộp thoại User Preferences (Ưu Tiên của Người
Dùng), trong đó người dùng có thể thay đổi cài đặt mặc định để

n Gửi và nhận email thông báo sau khi hoàn tất lượt chạy

n Lưu các tệp dữ liệu

n Tạo các protocol thông qua Protocol Editor (Trình Chỉnh Sửa Protocol) hoặc Protocol AutoWriter
(Tự Động Cài Đặt Protocol)

n Tạo các khay

n Phân tích dữ Liệu

n Thực hiện phân tích biểu hiện gen

n Xác định chất lượng dữ liệu

n Xuất dữ liệu máy CFX

User Administration (Quản Trị Người Dùng) —mở hộp thoại User Administration (Quản Trị Người
Dùng), trong đó quản trị viên có thể tạo người dùng, sửa đổi quyền vai trò, và gán vai trò cho người dùng.

Bio-Rad Service Login (Đăng Nhập Dịch Vụ Bio-Rad) — chỉ dành cho nhân viên dịch vụ kỹ thuật
Bio-Rad. Không chọn lệnh này.

Các lệnh trong menu Run (Lượt Chạy)
User-defined Run (Lượt Chạy Do Người Dùng Cài Đặt) – mở cửa sổ Run Setup (Thiết Lập Lượt Chạy),
trong đó bạn có thể thiết lập một protocol và khay do người dùng cài đặt, rồi chạy thử nghiệm PCR trên
máy đã chọn.
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PrimePCR Run (Lượt Chạy PrimePCR)—mở tab Start Run (Bắt Đầu Lượt Chạy) trong cửa sổ Run
Setup (Thiết Lập Lượt Chạy) với protocol PrimePCRmặc định và bố cục khay đã tải dựa trên máy đã
chọn.

End-Point Only Run (Lượt Chạy Chỉ Điểm Cuối) —mở tab Start Run (Bắt Đầu Lượt Chạy) trong cửa sổ
Run Setup (Thiết Lập Lượt Chạy) với protocol điểm cuối mặc định và bố cục khay được tải dựa trên máy
đã chọn.

Qualification Run (Lượt Chạy Thẩm Định) —mở tab Start Run (Bắt Đầu Lượt Chạy) trong cửa sổ Run
Setup (Thiết Lập Lượt Chạy) với protocol định tính Bio-Rad mặc định và bố cục khay đã tải trong máy đã
chọn.

Các Lệnh Trong Menu Tools (Công Cụ)
Master Mix Calculator (Máy Tính Hỗn Hợp Gốc) —mởMaster Mix Calculator (Máy Tính Hỗn Hợp Gốc),
ở đó bạn có thể tạo hỗn hợp phản ứng và in các phép tính.

Protocol AutoWriter (Tự Động Cài Đặt Protocol) —mở hộp thoại Protocol AutoWriter (Tự Động Cài Đặt
Protocol), ở đó bạn có thể dễ dàng tạo một protocol mới.

Máy tínhT a—mởMáy tính Ta, ở đó bạn có thể dễ dàng tính toán nhiệt độ gắn mồi.

Dye Calibration Wizard (Trình Hướng Dẫn Hiệu Chuẩn Thuốc Nhuộm)—mở trình hướng dẫn Dye
Calibration (Hiệu Chuẩn Thuốc Nhuộm), ở đó bạn có thể hiệu chuẩn máy cho một chất huỳnh quang mới.

Reinstall Instrument Drivers (Cài Đặt Lại Các Trình Điều Khiển Máy) — cài đặt lại các trình điều khiển
kiểm soát giao tiếp với các hệ thống Real-Time PCR của Bio-Rad.

Zip Data and Log Files (Dữ Liệu Nén và Tệp Nhật Ký) —mởmột hộp thoại trong đó bạn có thể chọn các
tệp để tập hợp lại và lưu trong tệp nén để lưu trữ hoặc gửi email.

Batch Analysis (Phân Tích Theo Lô) —mở hộp thoại Batch Analysis (Phân Tích Theo Lô), trong đó bạn
có thể cài đặt các tham số để phân tích nhiều hơn một tệp dữ liệu cùng một lúc.

Options (Tùy Chọn) —mởmột hộp thoại trong đó bạn có thể

n Định cấu hình cài đặt máy chủ email của bạn

n Định cấu hình cài đặt xuất cho LIMS, Seegene và các tệp dữ liệu khác

Lời khuyên: Bạn cũng có thể chọn tùy chọn này để tự động khởi động Seegene Viewer
(Trình xem Seegene) khi xuất nếu bạn chọn xuất dữ liệu của mình ở định dạng Seegene.

n Thay đổi ngôn ngữ mà giao diện người dùng hiển thị (tiếng Anh, tiếng Trung, tiếng Nga)

Quan trọng: Bạn phải khởi động lại CFX Maestro Dx SE để hiển thị ngôn ngữ đã chọn.
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Quan trọng: Ngôn ngữ hệ điều hành của bạn phải tương ứng với ngôn ngữ bạn muốn hiển
thị trong giao diện CFX Maestro Dx SE.

Các Lệnh Trong Menu Help (Trợ Giúp)
Lời khuyên: Menu Help (Trợ Giúp) có sẵn trên thanh menu ở tất cả cửa sổ của CFX Maestro Dx SE.

Contents (Nội Dung) – hiển thị tab Contents (Nội Dung) trong hệ thống Trợ giúp của CFX Maestro Dx SE.

Index (Chỉ Mục) – hiển thị tab Index (Chỉ mục) trong hệ thống Trợ giúp của CFX Maestro Dx SE.

Search (Tìm Kiếm) – hiển thị tab Contents (Nội dung) trong hệ thống Trợ giúp của CFX Maestro Dx SE.

Open User Guide (Mở Hướng Dẫn Sử Dụng) – mở bản PDF của hướng dẫn này.

Additional Documentation (Tài Liệu Bổ Sung) – cung cấp quyền truy cập vào Hướng dẫn vận hành hệ
thống Real-Time PCR CFX Opus Dx.

Release Notes (Ghi Chú Phát Hành) – mở tài liệu Ghi Chú Phát Hành đối với phiên bản CFX Maestro Dx
SE đã cài đặt.

Video Resources (Nguồn Thông Tin Qua Video) – mởmột trang web có nguồn thông tin qua video hiện
có về Bio-Rad, như video hướng dẫn.

qPCR Applications and Technologies Web Site (Trang Web Về Công Nghệ Và Ứng Dụng QPCR)
– mở trang web về Công nghệ và ứng dụng qPCR của Bio-Rad, từ đây bạn có thể tìm hiểu thêm về Real-
Time PCR (qPCR).

PCR Reagents Web Site (Trang Web Thuốc Thử PCR) – mở trang web thuốc thử qPCR của Bio-Rad, từ
đây bạn có thể đặt mua thuốc thử, supermix, thuốc nhuộm và bộ dụng cụ PCR.

PCR Plastic Consumables Web Site (Trang Web Vật Tư Tiêu Hao Bằng Nhựa PCR) – mở trang web
về Vật tư tiêu hao và vật tư nhựa PCR của Bio-Rad, từ đây bạn có thể đặt mua khay, tấm che khay, ống
và nắp, cùng các phụ kiện khác bằng nhựa PCR.

Software Web Site (Trang Web Phần Mềm) – mở trang web Phần mềm phân tích PCR của Bio-Rad, từ
đây bạn có thể đặt mua các phiên bản cập nhật cho CFX Maestro Dx SE của Bio-Rad.

About (Giới thiệu) – hiển thị thông tin về bản quyền và phiên bản CFX Maestro Dx SE.

Các Lệnh trên Thanh Công Cụ

—mởWindows Explorer, ở đó bạn có thể điều hướng đến và mởmột tệp dữ liệu hoặc tệp nghiên
cứu gen.
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—mởMaster Mix Calculator (Máy Tính Hỗn Hợp Gốc).

—mở cửa sổ Run Setup (Thiết Lập Lượt Chạy).

—mở cửa sổ Run Setup (Thiết Lập Lượt Chạy) với protocol PrimePCRmặc định và bố cục khay
được tải dựa trên máy đã chọn.

—mở Startup Wizard (Trình Hướng Dẫn Khởi Động).
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Startup Wizard (Trình Hướng Dẫn Khởi Động)
Khi CFX Maestro Dx SE khởi động, ngăn làm việc hiển thị Startup Wizard (Trình Hướng Dẫn Khởi Động).
Từ Startup Wizard (Trình Hướng Dẫn Khởi Động) bạn có thể

n Chọn một máy từ các máy đã phát hiện và thiết lập một lượt chạy do người dùng cài đặt hoặc lượt
chạy PrimePCR

n Mở và thực hiện lại lượt chạy

n Mởmột tệp dữ liệu để phân tích kết quả từ một lượt chạy đơn lẻ hoặc một tệp nghiên cứu gen để biết
kết quả từ nhiều lượt chạy biểu hiện gen

Các thao tác này được giải thích chi tiết trong các chương tiếp theo.

Thanh Trạng Thái
Bên trái của thanh trạng thái ở dưới cùng cửa sổ phần mềm chính hiển thị trạng thái hiện tại của các máy
đã phát hiện. Bên phải của thanh trạng thái hiển thị tên của người dùng hiện tại và ngày giờ.
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Ngăn Detected Instruments (Máy Đã Phát Hiện)
ÔDetected Instruments (Máy Đã Phát Hiện) hiển thị từng máy được kết nối với CFX Maestro Dx SE máy tính.
Theo mặc định, mỗi máy xuất hiện dưới dạng biểu tượng, và số sê-ri của máy xuất hiện dưới dạng tên của
máy.

Từ ngăn này, bạn có thể

n Xem các thuộc tính và thuốc nhuộm hiệu chuẩn cho máy đã chọn

Để biết thông tin về các thuộc tính của máy, xem Xem Các Thuộc Tính của Máy trên trang 72.

n Xem trạng thái của máy được kết nối

n Mở nắp điện trên máy đã chọn

n Đóng nắp điện trên máy đã chọn

n Xem trạng thái của tất cả các máy được kết nối

Để xem trạng thái của một máy được kết nối

u Trong ngăn Detected Instruments (Máy Đã Phát Hiện), chọn máy muốn dùng và thực hiện một trong
các thao tác sau:

n Nhấp vào View Status (Xem Trạng Thái) trong mục Selected Instrument (Máy Đã Chọn).

n Nhấp chuột phải và chọn View Status (Xem Trạng Thái) trên menu xuất hiện.

Hộp thoại Run Details (Chi Tiết Lượt Chạy) xuất hiện hiển thị tab Run Status (Trạng Thái Lượt Chạy).
Trạng thái của máy được chọn xuất hiện bên dưới ngăn trạng thái lượt chạy, ví dụ:
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Để mở hoặc đóng nắp một máy

u Trong ngăn Detected Instruments (Máy Đã Phát Hiện), chọn máy muốn dùng và thực hiện một trong
các thao tác sau:

n Nhấp vào Open Lid (Mở Nắp) hoặc Close Lid (Đóng Nắp) trong mục Selected Instrument (Máy
Đã Chọn).

n Nhấp chuột phải và chọn thao tác thích hợp trên menu xuất hiện.

n Mở hộp thoại Run Details (Chi Tiết Lượt Chạy), chọn tab Run Status (Trạng Thái Lượt Chạy), và
nhấp vào Open Lid (Mở Nắp) hoặc Close Lid (Đóng Nắp).

Để xem trạng thái của tất cả các máy đã phát hiện

u Thực hiện một trong các thao tác sau:

n Trong mục All Instruments (Tất Cả Các Máy) ở ngăn Detected Instruments (Máy Đã Phát Hiện),
nhấp vào View Summary (Xem Tóm Tắt).

n Trên thanh menu, chọn View > Instrument Summary (Xem > Thông Tin Tóm Tắt về Máy).

Hộp thoại Instrument Summary (Thông Tin Tóm Tắt Về Máy) xuất hiện.

Lời khuyên: Nếu hệ thống chỉ phát hiện một máy được kết nối, mục All Instruments (Tất Cả
Các Máy) sẽ không xuất hiện trong ngăn Detected Instruments (Máy Đã Phát Hiện). Để xem tóm
tắt máy đối với một máy, chọn View > Instrument Summary (Xem > Thông Tin Tóm Tắt về Máy).
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Các Tính Năng Điều Khiển Trên Thanh Công Cụ Thông Tin Tóm Tắt Về Máy

Bảng 5 liệt kê các điều khiển và chức năng trên thanh công cụ Instrument Summary (Thông Tin Tóm Tắt
Về Máy).

Nút Tên Nút Chức Năng

Tạo Lượt Chạy mới Tạo một lượt chạy trên block được chọn
bằng cách mở cửa sổ Run Setup (Thiết
Lập Lượt Chạy).

Dừng Dừng lượt chạy hiện tại trên các block
được chọn.

Tạm dừng Tạm dừng lượt chạy hiện tại trên các
block được chọn.

Tiếp tục Tiếp tục lượt chạy trên các block được
chọn.

Nháy Đèn Báo Block Nháy sáng chỉ báo LED trên nắp của các
block được chọn.

Mở Nắp Mở nắp điện của block được chọn.

Đóng Nắp Đóng nắp điện của block được chọn.

Ẩn block đã chọn Ẩn các block đã chọn trong danh sách
Instrument Summary (Thông Tin Tóm Tắt
Về Máy)

Hiển thị tất cả các block Hiển thị các block đã chọn trong danh
sách Instrument Summary (Thông Tin
Tóm Tắt Về Máy)

Hiển thị Chọn các block để hiển thị trong danh
sách. Chọn một trong các tùy chọn để
hiển thị tất cả các block được phát hiện,
tất cả các block không hoạt động, tất cả
các block đang chạy với người dùng hiện
tại, hoặc tất cả các block đang chạy

Bảng 5. Các Tính Năng Điều Khiển Trên Thanh Công Cụ Thông Tin Tóm Tắt Về Máy
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Xem Các Thuộc Tính của Máy
Từ ô Detected Instruments (Máy Đã Phát Hiện), bạn có thể xem chi tiết về một máy đã chọn, bao gồm các
thuộc tính, trạng thái vít vận chuyển (chỉ các máy CFX Connect và CFX Touch) và danh sách các thuốc
nhuộm đã hiệu chuẩn (chất huỳnh quang).

Cách xem các thuộc tính của máy

u Trong ngăn Detected Instruments (Máy Đã Phát Hiện), nhấp chuột phải vào máy muốn dùng và chọn
Properties (Thuộc Tính) trên menu xuất hiện.

Tab Properties (Thuộc Tính)

Tab Properties (Thuộc Tính) liệt kê các chi tiết kỹ thuật của máy đã chọn bao gồmmẫu, số sê-ri của các
thành phần, và các phiên bản phần mềm điều khiển. Tên mặc định của máy (số sê-ri) xuất hiện ở nhiều vị
trí, bao gồm ngăn Detected Instruments (Máy Đã Phát Hiện) và trong thanh tiêu đề của hộp thoại
Instrument Properties (Thuộc Tính của Máy). Bạn có thể đổi tên máy để xác định dễ dàng hơn.

Lưu ý: Bạn không thể thay đổi tên của máy CFX Opus bằng CFX Maestro.

Trang Calibrated Dyes (Thuốc Nhuộm Hiệu Chuẩn)

Trang Calibrated Dyes (Thuốc nhuộm hiệu chuẩn) hiển thị các chất huỳnh quang và khay cho máy đã
hiệu chuẩn.

Để xem thông tin chi tiết về hiệu chuẩn, nhấp vào nút Info (Thông Tin) trong cột Detail (Chi Tiết).
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Trước Khi Bạn Bắt Đầu
Phần này giải thích những việc có thể bạn cần thực hiện trước khi sử dụng CFX Maestro Dx SE. Những
việc đó bao gồm

n Tạo hỗn hợp gốc cho phản ứng

n Hiệu chuẩn thuốc nhuộmmới

Tạo Hỗn Hợp Gốc Cho Phản Ứng
Sử dụng Máy Tinh Hỗn Hợp Gốc của CFX Maestro Dx SE, bạn có thể dễ dàng tính toán thể tích được yêu
cầu của từng thành phần trong hỗn hợp gốc của mình. Bạn có thể in bảng tính hỗn hợp gốc vào máy in
mặc định của mình, và lưu các phép tính cho từng mục tiêu để sử dụng sau này.

Để tạo hỗn hợp gốc cho phản ứng bằng cách sử dụng Máy Tinh Hỗn Hợp Gốc

1. Để mởMáy Tính Hỗn Hợp Gốc, hãy thực hiện một trong những thao tác sau:

n Chọn Tools > Master Mix Calculator (Công Cụ > Máy Tính Hỗn Hợp Gốc).

n Nhấp vào Master Mix Calculator (Máy Tính Hỗn Hợp Gốc) trên thanh công cụ.

Máy Tính Hỗn Hợp Gốc xuất hiện.
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2. Trong mục Reaction (Phản Ứng), chọn phương pháp phát hiện:

n SYBR®Green/EvaGreen®

n Probe (Đoạn Dò)

3. Để tạo một mục tiêu mới, trong mục Target (Mục Tiêu) nhấp vào Create New (Tạo Mới). Tên mục
tiêu mới xuất hiện trong danh sách mục tiêu thả xuống.

4. (Không bắt buộc) Để thay đổi tên mục tiêu mặc định:

a. Tô sáng tên của mục tiêu trong danh sách mục tiêu thả xuống.

b. Nhập tên mục tiêu mới trong ô Target (Mục Tiêu).

c. Nhấn phím Enter.

5. Điều chỉnh nồng độ bắt đầu và cuối cùng cho các mồi xuôi và ngược và bất kỳ đoạn dò nào.

6. Trong mục Master Mix Setup (Thiết Lập Hỗn Hợp Gốc), điều chỉnh giá trị cho

n Số lượng phản ứng để chạy
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n Thể tích phản ứng mỗi giếng

n Thể tích mẫu mỗi giếng

n Nồng độ Supermix mỗi giếng

n Thể tích phản ứng dư thừa mỗi giếng

7. (Không bắt buộc) Thực hiện các bước 2–6 đối với càng nhiều mục tiêu cần thiết.

8. Trong mục Choose Target to Calculate (Chọn Mục Tiêu Để Tính), chọn mục tiêu để tính.

Lời khuyên: Bạn chỉ có thể tính một hoặc một vài hoặc tất cả các mục tiêu cùng một lúc.

Thể tích được tính của các thành phần bắt buộc cho mỗi mục tiêu được chọn sẽ xuất hiện trong bảng
hỗn hợp gốc.

9. Nhấp vào Set as Default (Đặt làm Mặc Định) để giữ số lượng đầu vào trong các mục Target and
Master Mix Setup (Mục Tiêu và Thiết Lập Hỗn Hợp Gốc) làm mặc định mới.

10. Nhấp OK để lưu các nội dung trong hộp thoại Master Mix Calculator (Máy Tinh Hỗn Hợp Gốc).

Để in bảng tính hỗn hợp gốc

u Để in bảng tính hỗn hợp gốc, nhấp Print (In).

Bảng tính toán sẽ in ra máy in mặc định của bạn.

Để lưu bảng tính hỗn hợp gốc dưới dạng PDF

u Thay đổi máy in mặc định của bạn thành trình điều khiển PDF và nhấp vào Print (In) trên Máy Tính
Hỗn Hợp Gốc.

Để xóa mục tiêu

u Chọn mục tiêu bằng cách sử dụng danh sách mục tiêu thả xuống và nhấp vào Remove (Xóa).

Quan trọng: Việc loại bỏ một mục tiêu khỏi danh sách mục tiêu cũng loại bỏ mục tiêu đó khỏi
các phép tính toán hỗn hợp gốc có dùng mục tiêu đó. Hãy cẩn thận khi xóa mục tiêu.

Hiệu Chuẩn Thuốc Nhuộm Mới
Hệ thống CFX Opus 96 Dx and CFX Opus Deepwell Dx được hiệu chuẩn từ ban đầu cho các chất huỳnh
quang thường được sử dụng trong các khay giếng trắng và giếng trong. Hệ thống CFX Opus 384 Dx chỉ
được hiệu chuẩn từ ban đầu cho các chất huỳnh quang thường dùng trong khay giếng trắng. Bảng 6 liệt kê
các chất huỳnh quang và kênh mà từng máy được hiệu chuẩn.
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Lưu ý: Hệ thống CFX Opus 96 Dx, CFX Opus 384 Dx và CFX Opus Deepwell Dx cũng bao gồmmột
kênh dành riêng cho hóa chất FRET. Kênh này không yêu cầu hiệu chuẩn cho các thuốc nhuộm cụ
thể.

Quan trọng: Nếu bạn tiến hành hiệu chuẩn theo cài đặt của người dùng cho thuốc nhuộm đã được
hiệu chuẩn từ ban đầu, thiết bị sẽ sử dụng hiệu chuẩn do người dùng cài đặt thay vì hiệu chuẩn từ
ban đầu.

Chất Phát
Huỳnh
Quang Kênh Kích Thích, nm Phát Hiện, nm Máy

FAM, SYBR®
Green I

1 450–490 515–530 Hệ thống CFX
Opus 96 Dx,
CFX Opus
384 Dx và
CFX Opus
Deepwell Dx

VIC, HEX,
CAL Fluor
Gold 540, Cal
Fluor Orange
560

2 515–535 560–580 Hệ thống CFX
Opus 96 Dx
,CFX Opus
384 Dx và
CFX Opus
Deepwell Dx

ROX, Texas
Red,
CAL Fluor
Red 610, TEX
615

3 560–590 610–650 Hệ thống CFX
Opus 96 Dx,
CFX Opus
384 Dx và
CFX Opus
Deepwell Dx

CY5, Quasar
670

4 620–650 675–690 Hệ thống CFX
Opus 96 Dx,
CFX Opus
384 Dx và
CFX Opus
Deepwell Dx

Bảng 6. Chất phát huỳnh quang được hiệu chuẩn từ ban đầu, các kênh, và máy
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Chất Phát
Huỳnh
Quang Kênh Kích Thích, nm Phát Hiện, nm Máy

Quasar 705,
Cy5.5

5 672–684 705–730 Chỉ hệ thống
CFX Opus 96
Dx

Hóa chất FRET (Không được hiệu chuẩn từ ban đầu)

Màu không
được hiệu
chuẩn từ ban
đầu

FRET 450–490 560-580 Hệ thống CFX
Opus 96 Dx,
CFX Opus
384 Dx và
CFX Opus
Deepwell Dx

Cách hiệu chuẩn các thuốc nhuộm mới cho các hệ thống CFX

1. Trong cửa sổ Trang Chủ, chọn một máy muốn dùng ở ngăn Detected Instruments (Máy Đã Phát
Hiện).

2. Chọn Tools > Calibration Wizard (Công Cụ > Trình Hướng Dẫn Hiệu Chuẩn) để mở trình hướng dẫn
Dye Calibration (Hiệu Chuẩn Thuốc Nhuộm).
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Các chất huỳnh quang đã hiệu chuẩn cho máy muốn dùng xuất hiện trong bảng Calibrated
Fluorophores (Các Chất Phát Huỳnh Quang Đã Hiệu Chuẩn).

3. Trong mục Calibrate New or Existing Fluorophores (Hiệu Chuẩn Chất Phát Huỳnh Quang Mới hoặc
Có Sẵn), chọn chất huỳnh quang để hiệu chuẩn từ danh sách thả xuống.

Nếu tên chất huỳnh quang không có trong danh sách, nhập tên vào ô văn bản để thêm vào danh
sách.

Quan trọng: Hãy cẩn thận khi đặt tên cho các chất huỳnh quang đã hiệu chuẩn tùy chỉnh. Nếu
bạn tạo hiệu chuẩn thuốc nhuộm tùy chỉnh cho chất huỳnh quang có cùng tên với chất huỳnh
quang được hiệu chuẩn từ ban đầu, chất huỳnh quang tùy chỉnh (không phải chất huỳnh quang
đã hiệu chuẩn từ ban đầu) sẽ được máy sử dụng trong các lượt chạy.

4. Chọn loại khay cho chất huỳnh quang.

Nếu loại khay không có trong danh sách, nhập tên vào trong ô văn bản để thêm vào danh sách.

5. Chọn một kênh cho chất huỳnh quang.

6. Chọn cột khay cho chất huỳnh quang.

7. (Không bắt buộc) Nhập một màu vào để liên kết với chất huỳnh quang.

8. Nhấp Add to Plate (Thêm Vào Khay) để thêm chất huỳnh quang.

9. (Không bắt buộc) Lặp lại các bước 3–8 để thêm từng chất huỳnh quang bạn định hiệu chuẩn cho
khay.

10. Khi bạn hoàn thành việc thêm chất huỳnh quang, nhấp View Plate (Xem Khay) để mở cửa sổ Pure
Dye Plate Display (Hiển Thị Khay Thuốc Nhuộm Nguyên Chất).

Sử dụng cửa sổ này làm hướng dẫn để nạp thuốc nhuộm vào khay.

11. Chuẩn bị khay 96, 384 giếng hoặc giếng sâu để hiệu chuẩn thuốc nhuộm:

a. Dùng ống pipet hút dung dịch thuốc nhuộm vào từng giếng, làm theo mẫu hình hiển thị trên Pure
Dye Plate Display (Màn Hình Hiển Thị Khay Thuốc Nhuộm Nguyên Chất).

b. Đối với mỗi chất huỳnh quang, làm đầy bốn giếng bằng 50 µl (khay 96 giếng hoặc giếng sâu)
hoặc 30 µl (khay 384 giếng) dung dịch thuốc nhuộm 300 nM. Lưu ý rằng ít nhất nửa khay chứa
các giếng trống.

c. Đóng kín khay bằng phương pháp đóng kín bạn sẽ sử dụng trong thử nghiệm của bạn.

12. Đặt khay hiệu chuẩn vào block và đóng nắp lại.

13. Trong trình hướng dẫn Dye Calibration (Hiệu Chuẩn Thuốc Nhuộm), nhấp vào Calibrate (Hiệu
Chuẩn) và nhấp OK để xác nhận rằng khay đang ở trong block.
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14. Khi Phần mềm CFX Maestro Dx, Phiên bản bảo mật hoàn thành lượt chạy hiệu chuẩn, một hộp thoại
sẽ xuất hiện. Nhấp vào Yes (Có) để hoàn thành hiệu chuẩn và mở Dye Calibration Viewer (Trình
Xem Hiệu Chuẩn Thuốc Nhuộm).

15. Nhấp OK để đóng cửa sổ.

Cài Đặt Ưu Tiên Của Người Dùng
Lời khuyên: Không bắt buộc thực hiện các tác vụ này để sử dụng CFX Maestro Dx SE. Bạn có thể
bỏ qua mục này một cách an toàn hoặc thực hiện các tác vụ này bất cứ lúc nào.

Trong CFX Maestro Dx SE, mỗi người dùng có thể tùy chỉnh môi trường làm việc của họ. Ví dụ, trong
menu Users > User Preferences (Người Dùng > Ưu Tiên của Người Dùng), bạn có thể thực hiện các thao
tác sau:

n Thiết lập email thông báo về việc hoàn thành lượt chạy.

Lưu ý: Tính năng này chỉ dành cho những người dùng có vai trò được trao quyền này. Xem
Quản lý vai trò người dùng Phần mềm CFX Maestro Dx, Phiên bản bảo mật trên trang 43 để biết
thêm thông tin.

n Thay đổi cài đặt mặc định cho

o Vị trí lưu tệp

o Tệp tin thiết lập lượt chạy

o Tiền tố đặt tên tệp

n Đặt các tham số mặc định để sử dụng khi tạo protocol và khay mới.

n Đặt phân tích dữ liệu mặc định và tham số biểu hiện gen.

n Tùy chỉnh các tham số kiểm soát chất lượng mặc định.

n Tùy chỉnh tham số xuất dữ liệu.

Trong menu Tools (Công Cụ), bạn có thể thực hiện các thao tác sau:

n Tạo hỗn hợp gốc.

n Hiệu chuẩn thuốc nhuộm cho một máy cụ thể.

Lưu ý: Thao tác pha trộn hỗn hợp gốc và hiệu chuẩn thuốc nhuộm khả dụng đối với bất kỳ ai đăng
nhập vào phần mềm.

Phần này giải thích cách thực hiện các thao tác này.
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Thiết Lập Email Thông Báo

Bạn có thể kết nối CFX Maestro Dx SE đến máy chủ email gửi đi của bạn để gửi email thông báo về việc
hoàn tất lượt chạy tới danh sách người dùng. Bạn cũng có thể chọn đính kèm tệp dữ liệu và báo cáo phân
tích vào danh sách người dùng. Để thiết lập kết nối giữa CFX Maestro Dx SE và máy chủ SMTP của bạn,
xem Kết Nối Phiên Bản Bảo Mật cho Máy Chủ SMTP trên trang 81.

Lưu ý: Khả năng truy cập các tính năng thiết lập email của người dùng phụ thuộc vào vai trò và
quyền của người dùng do quản trị viên gán. Để biết chi tiết về cách quản lý người dùng và vai trò của
họ, hãy xem Quản lý vai trò người dùng Phần mềm CFX Maestro Dx, Phiên bản bảo mật trên trang
43.

Cách thiết lập email thông báo

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

Hộp thoại User Preferences (Ưu Tiên của Người Dùng) xuất hiện, hiển thị tab Email.

Lưu ý: Bạn được thông báo nếu hệ thống phát hiện rằng bạn chưa thiết lập máy chủ SMTP hợp
lệ cho CFX Maestro Dx SE. Nhấp vào Configure Outgoing Email (Định Cấu Hình Email Gửi Đi)
để mở hộp thoại Options (Tùy Chọn) và định cấu hình máy chủ SMTP email. Để biết thêm thông
tin, xem Kết Nối Phiên Bản Bảo Mật cho Máy Chủ SMTP trên trang 81.

2. Trong ô văn bản To (Đến), nhập địa chỉ email của từng người bạn dự định thông báo về việc hoàn
thành lượt chạy. Tất cả người nhận sẽ nhận được email sau khi lượt chạy hoàn tất.

Lưu ý: Bạn phải nhập từng địa chỉ email trên một dòng riêng biệt. Nhấn Enter (Nhập) hoặc
Return (Trở Lại) sau mỗi địa chỉ.

3. (Không bắt buộc) Trong ô văn bản cc, nhập địa chỉ email của bất kỳ người nhận nào mà bạn định gửi
bản sao của mỗi email thông báo.
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4. (Không bắt buộc) Theo mặc định, tất cả người nhận sẽ nhận được một bản sao của tệp dữ liệu dưới
dạng tệp đính kèm. Bỏ chọn ô kiểm này nếu bạn không muốn đính kèm bản sao của tệp dữ liệu.

5. (Không bắt buộc) Chọn Attach Analysis Report (Đính Kèm Báo Cáo Phân Tích) để đính kèm bản
PDF của báo cáo phân tích vào email.

6. Nhấp OK để lưu các thay đổi và đóng hộp thoại User Preferences (Ưu Tiên của Người Dùng).

Lưu ý: Bạn có thể định cấu hình hệ thống để gửi thông báo qua email đến điện thoại di động của
mình, tùy thuộc vào nhà cung cấp dịch vụ của bạn. Liên hệ với nhà cung cấp dịch vụ điện thoại di
động của bạn để biết thông tin cụ thể về địa chỉ email cho điện thoại di động của bạn. Nhập địa chỉ
email của điện thoại của bạn (ví dụ: 5552221234@your_service_provider_EmailDomain.net) vào ô
văn bản To (Người nhận) của màn hình User Preference (Ưu Tiên Của Người Dùng).

Cách chỉnh sửa địa chỉ email của người nhận

u Sửa đổi địa chỉ email nếu cần và nhấp vào OK.

Cách xóa người nhận email

1. Chọn người nhận email và nhấn phím Delete (Xóa).

2. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.

Kết Nối Phiên Bản Bảo Mật cho Máy Chủ SMTP

Quan trọng: Một số nhà cung cấp dịch vụ thư mạng thương mại đã tăng cường bảo mật email. Nếu
bạn sử dụng những tài khoản này, bạn phải kích hoạt cài đặt Allow less secure apps (Cho phép
các ứng dụng ít bảo mật hơn) trong cài đặt tài khoản để cho phép CFX Maestro Dx SE gửi email.
Xem thông tin bảo mật đối với nhà cung cấp dịch vụ thư mạng của bạn để biết thêm thông tin.

Nếu bạn đang sử dụng máy chủ SMTP của Google Gmail hoặc Microsoft Office 365 để gửi email, bạn
phải bật xác minh 2 yếu tố và tạo "Mật Khẩu Ứng Dụng" trong cài đặt tài khoản Gmail hoặc Office365 của
bạn. Để xác thực trong hộp thoại Maestro Email Setup (Thiết Lập Email Maestro), sao chép và dán "Mật
Khẩu Ứng Dụng" vào trường Password (Mật Khẩu) thay vì mật khẩu email thông thường.

Bạn phải thiết lập kết nối từ CFX Maestro Dx SE đến máy chủ email của bạn trước khi phần mềm có thể
gửi email thông báo.
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Cách kết nối CFX Maestro Dx SE đến máy chủ email

1. Thực hiện một trong các thao tác sau:

n Chọn User > User Preferences (Người Dùng > Ưu Tiên Của Người Dùng) và nhấp vào
Configure Outgoing Email (Định Cấu Hình Email Gửi Đi) trên tab Email.

n Chọn Tools > Options (Công Cụ > Tùy Chọn).

Hộp thoại Options (Tùy Chọn) xuất hiện hiển thị tab Email.

2. Cung cấp các thông tin sau cho công ty của bạn:

n SMTP Server Name (Tên Máy Chủ SMTP) – tên của máy chủ email gửi đi tại công ty của bạn.

n Port (Cổng) – số cổng của máy chủ SMTP của bạn. Số này thường là 25.

n Use SSL (Sử Dụng SSL) – Tùy chọn Lớp Cổng Bảo Mật (SSL). Một số máy chủ SMTP yêu cầu
cài đặt này. Nếu công ty bạn không yêu cầu, hãy xóa ô kiểm này.

n Use Default “From” Address (Sử Dụng Địa Chỉ “Người Gửi” Mặc Định) – tên của máy chủ
email tại công ty của bạn. Một số máy chủ SMTP yêu cầu mọi email gửi đi phải có địa chỉ “người
gửi” từ một miền nhất định, ví dụ, name@YourCompany.com. Nếu rơi vào trường hợp này, hãy
xóa ô kiểm và cung cấp địa chỉ email hợp lệ.

n Authentication Required (Yêu Cầu Xác Thực) – nếu trang của bạn yêu cầu xác thực tài khoản,
hãy xác nhận rằng đã chọn ô kiểm này.

n User Name (Tên Người Dùng) – tên của tài khoản đã xác thực. Điều này chỉ bắt buộc nếu chọn
Authentication Required (Yêu Cầu Xác Thực).
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n Password (Mật Khẩu)– mật khẩu cho tài khoản được xác thực. Điều này chỉ bắt buộc nếu chọn
Authentication Required (Yêu Cầu Xác Thực).

Quan trọng: Nếu bạn đang sử dụng máy chủ SMTP của Google Gmail hoặc Microsoft Office
365 để gửi email, bạn phải bật xác minh 2 yếu tố và sau đó tạo "Mật Khẩu Ứng Dụng" trong cài
đặt tài khoản Gmail hoặc Office365 của bạn. Để xác thực trong hộp thoại Maestro Email Setup
(Thiết Lập Email Maestro), sao chép và dán "Mật Khẩu Ứng Dụng" vào trường Password (Mật
Khẩu) của CFX Maestro Dx SE thay vì mật khẩu email thông thường.

Để xác nhận rằng các cài đặt máy chủ SMTP chính xác, nhập một địa chỉ email hợp lệ trong ô văn
bản Test Email Address (Kiểm Tra Địa Chỉ Email) và nhấp Test Email (Kiểm Tra Email).

Lưu ý: Một số máy chủ SMTP không cho phép tệp đính kèm và các máy chủ khác cho phép tệp
đính kèm chỉ lên đến kích cỡ nhất định. Nếu bạn định gửi email các tệp dữ liệu và/hoặc báo cáo
bằng cách sử dụng CFX Maestro Dx SE, chọn Test Attachment (Kiểm Tra Tệp Đính Kèm) và đặt
Attachment Size in MB (Kích Cỡ Tệp Đính Kèm theo MB) về 5 megabyte (MB) hoặc lớn hơn.

3. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Thay Đổi Cài Đặt Tệp Mặc Định

Trong tab Files (Tệp) trên hộp thoại User Preference (Ưu Tiên Của Người Dùng), bạn có thể thay đổi:

n Vị trí mặc định để lưu tệp CFX Maestro Dx SE

n Các tệp mặc định cho thiết lập chạy

n Các tham số đặt tên tệp mặc định

Cách thay đổi các cài đặt tệp mặc định

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên Của Người Dùng), chọn tab Files (Tệp).
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3. Trong mục Default Folder for File Creation (Thư Mục Mặc Định để Tạo Tập Tin), tạo đường dẫn đến
và chọn thư mục mặc định bạn muốn lưu các tập tin mới. Bạn có thể chọn vị trí khác nhau cho từng
loại tệp:

n Protocol

n Khay

n Tệp Dữ Liệu

n Nghiên Cứu Gen

4. Trong mục File Selection for Run Setup (Chọn Tập Tin để Thiết Lập Chạy), tạo đường dẫn đến và
chọn protocol và tập tin khay muốn dùng để xuất hiện khi bạn mở cửa sổ Experiment Setup (Thiết
Lập Thử Nghiệm).

5. Trong mục Data File (Tệp Dữ Liệu), xác định tiền tố và/hoặc hậu tố cho các tệp dữ liệu. Đối với bất kỳ
phần nào, chọn một giá trị mới từ danh sách thả xuống. Bạn cũng có thể cung cấp các giá trị tiền tố
và hậu tố tùy chỉnh trong các ô văn bản Prefix (Tiền Tố) và Suffix (Hậu Tố).

CFX Maestro Dx SE hiển thị xem trước tên tập tin bên dưới các ô chọn.

6. Nhấp OK để lưu các thay đổi và đóng hộp thoại.
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Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.

Cài Đặt Các Tham Số Protocol Mặc Định

Cách cài đặt các tham số protocol mặc định cho Protocol Editor (Trình Chỉnh Sửa Protocol)
và Protocol AutoWriter (Tự Động Cài Đặt Protocol)

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên của Người Dùng), chọn tab Protocol.

3. Trong mục Protocol Editor (Trình Chỉnh Sửa Protocol), chỉ định giá trị cho các cài đặt sau xuất hiện
trong Protocol Editor (Trình Chỉnh Sửa Protocol):

n Sample volume (Thể tích mẫu) — thể tích của mỗi mẫu trong giếng (tính bằng µl).

n Lid Shutoff temperature (Nhiệt độ Đóng Nắp) — nhiệt độ ºC mà tại đó bộ tạo nhiệt cho nắp sẽ
tắt trong khi chạy.

4. Trong mục Protocol AutoWriter (Tự Động Cài Đặt Protocol), chỉ định giá trị cho các cài đặt sau xuất
hiện trong Protocol AutoWriter (Tự Động Cài Đặt Protocol):

n Annealing temperature (Nhiệt độ gắn mồi) — nhiệt độ đo bằng ºC đối với các thử nghiệm sử
dụng iProof DNA polymerase, iTaq DNA polymerase hoặc các polymerase khác.

n Amplicon length (Chiều dài amplicon) — chiều dài của amplicon tính bằng bp.

5. Nhấp OK để lưu các thay đổi và đóng hộp thoại.
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Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.

Cài Đặt Các Tham Số Khay Mặc Định

Những thay đổi bạn thực hiện đối với tab Plate (Khay) có sẵn đối với tất cả người dùng phần mềm.
Những thay đổi bạn thực hiện trong quá trình thiết lập khay có sẵn cho người dùng sau khi bạn lưu và
đóng tệp tin khay.

Trong hộp thoại User Preferences (Ưu Tiên của Người Dùng) bạn có thể thực hiện các thao tác sau:

n Đặt các tham số khay mặc định.

n Thêm tên mục tiêu, mẫu và nhóm sinh học mới vào các thư viện tương ứng.

n Xóa tên mục tiêu, mẫu và nhóm sinh học khỏi các thư viện tương ứng.

Cách đặt các tham số khay mặc định

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên của Người Dùng), chọn tab Plate (Khay).
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3. Chỉ định các giá trị cài đặt sau đây cho tệp khay mới. Những giá trị này xuất hiện trong cửa sổ Plate
Editor (Trình Chỉnh Sửa Khay):

n Plate type (Loạ i khay)

n Plate size (Kích thước khay)

n Units (Đơn vị) — nồng độ của mẫu khởi đầu cho các giếng có chứa các mẫu tiêu chuẩn.

CFX Maestro Dx SE sử dụng các đơn vị này để tạo đường cong chuẩn trong tab Data Analysis
Quantification (Định Lượng Phân Tích Dữ Liệu).

n Scientific notation (Ký hiệu khoa học) — khi được chọn, CFX Maestro Dx SE hiển thị đơn vị
nồng độ trong ký hiệu khoa học.

n Scan mode (Chế độ quét) — số hoặc loại kênh để quét trong lượt chạy.

n Fluorophores (Chất phát huỳnh quang) — chất huỳnh quang mặc định xuất hiện trong các đối
chứng tải nạp giếng Plate Editor (Trình Chỉnh Sửa Khay).

n Libraries (Thư viện) — tên mục tiêu, mẫu và nhóm sinh học mà bạn thường sử dụng trong thử
nghiệm của mình:

o Target names (Tên mục tiêu) — tên của gen và chuỗi mục tiêu.

o Sample names (Tên mẫu) — tên của các mẫu thử nghiệm hoặc một đặc điểm nhận dạng
cho các mẫu (ví dụ, Mouse1, Mouse2, Mouse3).

o Biological group names (Tên nhóm sinh học) — tên cho các nhóm có các mẫu tương tự
có trạng thái hoặc điều kiện xử lý tương tự (ví dụ, 0Hr, 1Hr, 2Hr).

4. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Cách thêm tên mục tiêu, mẫu hoặc nhóm sinh học mới

u Trong ô thư viện thích hợp, nhập tên cho mục tiêu, mẫu, hoặc nhóm sinh học và nhấp vào OK.

Cách xóa tên mục tiêu, mẫu hoặc nhóm sinh học

u Trong ô thư viện thích hợp, chọn tên và nhấn phím Delete (Xóa) và nhấp vào OK.

Quan trọng: Các tên bạn xóa khỏi thư viện sẽ bị xóa khỏi phần mềm và không còn khả dụng cho
người dùng nữa. Để khôi phục lại tên mặc định CFX Maestro Dx SE, nhấp vào Restore Defaults
(Khôi Phục Mặc Định). Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại
User Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các
tab về cài đặt ban đầu. Thận trọng khi xóa tên mặc định CFX Maestro Dx SE và khi nhấp vào nút này.
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Cài Đặt Các Tham Số Phân Tích Dữ Liệu Mặc Định

Cách cài đặt các tham số Phân Tích Dữ Liệu mặc định

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên Của Người Dùng), chọn tab Data Analysis (Phân Tích
Dữ Liệu).

3. Trong mục Analysis Mode (Chế Độ Phân Tích), chọn chế độ để phân tích dữ liệu (Chất Phát Huỳnh
Quang hoặc Mục Tiêu).

4. Trong mục PCR Quantitation (Định Lượng PCR), cài đặt tham số mặc định cho các tùy chọn sau:

n Baseline Setting (Cài đặt Đường Nền) – phương pháp đường nền cho chế độ phân tích.

n Cq Determination Mode (Chế Độ Xác Định Cq) – chế độ mà giá trị Cq được tính toán cho mỗi
dấu vết chất huỳnh quang regression (hồi quy) hoặc single threshold (ngưỡng đơn).

n Threshold Calc. Mode (Chế Độ Tính Toán Ngưỡng) – số lượng mục tiêu điểm cuối.

Mặc định là Tự Động. Nghĩa là, phần mềm tự động tính toán mục tiêu điểm cuối. Để đặt một
ngưỡng cụ thể, xóa ô kiểm Auto (Tự Động) và nhập lượng điểm cuối của bạn, được tính toán
bằng các đơn vị huỳnh quang tương đối (relative fluorescence unit, RFU). Giá trị tối đa là
65000,00 RFU. Tệp dữ liệu cho các lượt chạy tiếp theo sẽ sử dụng cài đặt ngưỡng này.
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n Baseline Calc. Mode (Chế Độ Tính Toán Đường Nền) – giá trị đường nền cho mọi vạch đồ
họa.

Mặc định là Tự Động. Nghĩa là, phần mềm tự động tính toán đường nền cho mọi vạch đồ họa.
Để cài đặt một giá trị đường nền cụ thể, xóa ô kiểm Auto (Tự Động) và nhập giá trị tối thiểu và tối
đa cho phạm vi chu kỳ (1 đến 9999). Các tệp dữ liệu cho các lượt chạy tiếp theo sẽ sử dụng
phạm vi chu kỳ này.

n Log View (Xem Lôgarit)– xác định cách thức phần mềm hiển thị dữ liệu khuếch đại:

o On (Bật) – dữ liệu khuếch đại được hiển thị trong một đồ thị bán lôgarit.

o Off (Tắt) – (mặc định) dữ liệu khuếch đại được hiển thị trong đồ thị tuyến tính.

5. Trong mục End Point (Điểm Cuối), chọn số của chu kỳ cuối để tính trung bình khi tính toán các phép
tính điểm cuối:

n PCR – số chu kỳ cuối để tính trung bình dữ liệu định lượng (mặc định là 5).

n End Point Only run (Lượt Chạy Chỉ Điểm Cuối) – số chu kỳ cuối để tính trung bình dữ liệu điểm
cuối (mặc định là 2).

6. Trong mục Melt Curve (Đường Cong Chảy), chọn loại đỉnh để phát hiện (dương tính hoặc âm tính).

7. Trong mụcWell Selector (Bộ Chọn Giếng), chọn cách hiển thị nhãn giếng (theo loại mẫu, tên mục
tiêu, hoặc tên mẫu).

8. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.
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Đặt Các Tham Số Tệp Dữ Liệu Biểu Hiện Gen Mặc Định

Cách đặt các tham số mặc định cho tệp dữ liệu biểu hiện gen mới

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên Của Người Dùng), chọn tab Gene Expression (Biểu Hiện
Gen).

3. Chỉ rõ các giá trị cho các cài đặt sau:

n Relative to (Tương đối với) – vẽ đồ thị dữ liệu biểu hiện gen tương đối với đối chứng (bắt nguồn
từ 1) hoặc với 0:

o Zero (0) – phần mềm bỏ qua đối chứng. Điều này là mặc định khi không có mẫu đối chứng
nào được gán trong cửa sổ Experiment Settings (Cài Đặt Thí Nghiệm).

o Control (Đối Chứng) – phần mềm tính toán dữ liệu liên quan đến mẫu đối chứng được gán
trong cửa sổ Experiment Setup (Thiết Lập Thử Nghiệm).

n X-axis (Trục X) – vẽ đồ thị mẫu hoặc mục tiêu trên trục x.

n Y-axis (Trục Y) – vẽ đồ thị tỷ lệ tuyến tính, log2, hoặc log10 trên trục y.

n Scaling (Chia Tỷ Lệ) – tùy chọn chia tỷ lệ cho đồ thị (tùy chọn mặc định không được chia tỷ lệ):

o Highest (Cao Nhất) – phần mềm chia tỷ lệ đồ thị theo điểm dữ liệu cao nhất.

o Lowest (Thấp Nhất) – phần mềm chia tỷ lệ đồ thị theo điểm dữ liệu thấp nhất.

o Unscaled (Không Chia Tỷ Lệ) – phần mềm thể hiện dữ liệu không được chia tỷ lệ trong đồ
thị.

n Mode (Chế Độ) – chế độ phân tích, đại lượng tương đối (∆Cq) hoặc biểu hiện gen chuẩn hóa
(∆∆Cq).

n Error Bar (Thanh Sai Số) – sự biến đổi dữ liệu được hiển thị dưới dạng độ lệch chuẩn (Std.
Dev.) hoặc sai số chuẩn của giá trị trung bình (Std. Error Mean).

n Error Bar Multiplier (Số Nhân Thanh Sai Số) – số nhân độ lệch chuẩn được dùng để vẽ đồ thị
thanh sai số (mặc định là 1).

Bạn có thể tăng số nhân lên 2 hoặc 3.

n Sample Types to Exclude (Các Loại Mẫu để Loại Trừ) – các loại mẫu để loại trừ khỏi phân tích.

Bạn có thể chọn một hoặc nhiều mẫu để loại trừ khỏi phân tích. Để loại trừ tất cả các loại mẫu,
hãy xóa các ô kiểm của bất kỳ loại mẫu được chọn nào.

4. Nhấp OK để lưu các thay đổi và đóng hộp thoại.
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Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.

Tùy Chỉnh Quy Tắc Kiểm Soát Chất Lượng

Trong CFX Maestro Dx SE, bạn có thể đặt quy tắc kiểm soát chất lượng, áp dụng cho dữ liệu trong cửa sổ
Data Analysis (Phân Tích Dữ Liệu). Phần mềm xác thực dữ liệu dựa trên các quy tắc mà bạn đã đặt.

Lưu ý: Theo mặc định, tất cả các quy tắc kiểm soát chất lượng được kích hoạt.

Lời khuyên: Bạn có thể dễ dàng loại trừ các giếng không đạt tham số kiểm soát chất lượng khỏi
phân tích trong mô-đun kiểm soát chất lượng của cửa sổ Data Analysis (Phân Tích Dữ Liệu).

Cách tùy chỉnh quy tắc kiểm soát chất lượng

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên Của Người Dùng), chọn tab kiểm soát chất lượng.

Trong đó:

n NTC – đối chứng không mẫu

Hướng Dẫn Sử Dụng | 91



Chương 6 Cửa Sổ Trang Chủ

n NRT – đối chứng không enzyme phiên mã ngược

n Efficiency (Hiệu Suất) – hiệu suất phản ứng

n Std Curve R^2 (Đường Cong Chuẩn R^2) – giá trị bình phương R cho đường cong chuẩn

n Replicate group Cq Std Dev (Độ lệch chuẩn được tính trong nhóm bản sao) – độ lệch chuẩn
được tính toán cho mỗi nhóm bản sao

3. Đối với mỗi quy tắc kiểm soát chất lượng, hãy thực hiện một trong các thao tác sau:

n Để sử dụng giá trị mặc định, không làm gì cả.

n Để thay đổi giá trị, nhấp vào ô văn bản Value (Giá Trị), nhập giá trị mới, và nhấn phím Enter.

n Để vô hiệu hóa quy tắc, bỏ chọn ô kiểm Use (Sử Dụng).

4. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.

Tùy Chỉnh Tham Số Xuất Dữ Liệu

Bạn có thể xuất dữ liệu của CFX Maestro Dx SE ở các định dạng sau:

n Văn bản (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Quan trọng: Máy tính của bạn phải được cài đặt Microsoft Excel để bạn xuất dữ liệu sang trang
bảng tính Microsoft Excel.

Bạn có thể chỉ định loại dữ liệu để xuất và tùy chỉnh đầu ra của dữ liệu được xuất.

Cách tùy chỉnh tham số xuất dữ liệu

1. Chọn Users > User Preferences (Người dùng > Ưu Tiên Của Người Dùng) để mở hộp thoại User
Preferences (Ưu Tiên Của Người Dùng).

2. Trong hộp thoại User Preferences (Ưu Tiên Của Người Dùng), chọn tab Custom Export (Xuất Tuỳ
Chỉnh).
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3. Trên danh sách thả xuống Export Format (Định Dạng Xuất), chọn định dạng để xuất dữ liệu.

4. Trong mục Data to Export (Dữ Liệu để Xuất), hãy chọn hoặc bỏ chọn ô kiểm cho loại dữ liệu để xuất.
Các mục đã chọn sẽ xuất hiện trong ô danh sách Exported Columns (Cột Đã Xuất).

Lưu ý: Theo mặc định, thông tin về lượt chạy được bao gồm trong tiêu đề. Xóa ô kiểm này nếu
bạn không muốn thông tin về lượt chạy được bao gồm.

5. Bạn có thể thay đổi thứ tự hiển thị đầu ra của các mục đã chọn.

Trong ô danh sách Exported Columns (Cột Đã Xuất), tô sáng mục và sau đó nhấp vào các nút mũi
tên ở bên trái danh sách để di chuyển lên hoặc xuống.

6. Không bắt buộc, bạn có thể thay đổi tên cột đầu ra của các mục đã chọn:

a. Nhấp vào Customize Column Names (Tùy Chỉnh Tên Cột).

Hộp thoại Column Name Customizer (Trình Tùy Chỉnh Tên Cột) xuất hiện.

b. Đối với mỗi tên cột mặc định mà bạn muốn thay đổi, hãy nhập tên mới vào phần Custom Name
(Tên Tùy Chỉnh) của cột đó.

c. Thực hiện một trong các thao tác sau:

n Nhấp OK để lưu các thay đổi và quay lại tab Custom Export (Xuất Tùy Chỉnh). Tên mới xuất
hiện trong dấu ngoặc đơn bên cạnh tên cột mặc định trong ô danh sách Exported Columns
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(Cột Đã Xuất).

n Nhấp Cancel (Hủy) để xóa các thay đổi và quay lại tab Custom Export (Xuất Tùy Chỉnh).

7. Nhấp OK để lưu các thay đổi và đóng hộp thoại.

Quan trọng: Việc bạn nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại User
Preferences (Ưu Tiên Của Người Dùng) sẽ cài đặt lại tất cả các tùy chọn ưu tiên trên tất cả các tab về
cài đặt ban đầu. Thận trọng khi nhấp vào nút này.
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Protocol là một tập hợp các bước được thực hiện trong một chuỗi cụ thể. Trong Phần mềm CFX Maestro
Dx, Phiên bản bảo mật, tất cả các bước được liên kết với các tùy chọn trên máy. Ví dụ: các bước hướng
dẫn máy điều khiển nhiệt độ block và nắp, áp dụng sự chênh lệch nhiệt độ trên toàn block, lấy số đọc khay
hoặc phân tích đường cong chảy. Mỗi tùy chọn được quy định cho các loại khay và lượt chạy khác nhau.

CFX Maestro Dx SE cung cấp hai tùy chọn để tạo protocol: Protocol Editor (Trình Chỉnh Sửa Protocol) và
Protocol AutoWriter (Tự Động Cài Đặt Protocol).

Các tính năng của Protocol Editor (Trình Chỉnh Sửa Protocol) bao gồm:

n Tính năng điều khiển protocol chuẩn để tạo nhanh protocol

n Khả năng tính nhanh thang gradient cho một số lượng hàng đã chọn

n Khả năng tính nhanh thời gian chạy cho loại khay đã chọn

n Khả năng chỉnh sửa các bước trong protocol

n Khả năng lưu các protocol để tái sử dụng

n Khả năng in protocol ra một máy in mặc định

Protocol AutoWriter (Tự Động Cài Đặt Protocol) tạo một protocol PCR tùy chỉnh có các bước khởi động
nóng, biến tính ban đầu, gắn mồi và kéo dài sử dụng các tham số bạn cung cấp. Sau đó, bạn có thể xem
trình bày protocol đề xuất bằng đồ họa và chỉnh sửa, chạy, hoặc lưu protocol.
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Tham số và phạm vi cho các bước trong chương trình
Sử dụng thông tin trong Bảng 7 để sửa đổi thông số cài đặt mặc định cho các bước trong chương trình
của bạn.

Bước nhiệt độ

Nhiệt độ mục tiêu là giá trị trong khoảng từ 4,0 đến 100,0°C, được đặt theo phần mười độ. Hệ thống tăng
đến nhiệt độ này và giữ giá trị đó trong một khoảng thời gian được chỉ định (thời gian lưu giữ).

Bước gradien

Phạm vi gradien là sự khác biệt giữa nhiệt độ dưới và nhiệt độ trên trong bước gradien. Phạm vi khác biệt
cho phép là 24°C. Nhiệt độ dưới là giá trị trong khoảng từ 30,0 đến 99,0°C, được đặt theo phần mười độ.
Nhiệt độ trên tối đa là 100°C. Máy luân nhiệt tăng lên đến gradien nhiệt độ mục tiêu trên toàn block và lưu
giữ nhiệt độ đó trong khoảng thời gian lưu giữ được chỉ định.

Quan trọng: Máy sẽ tính toán giá trị gradien. Khi bạn nhập giá trị vào các hàng trên cùng và dưới
cùng của máy tính gradien, phần mềm sẽ tự động tính toán và chỉ định nhiệt độ cho các hàng còn lại.
Khi bạn nhập nhiệt độ vào bất kỳ hàng nào trong khoảng hàng trên và dưới, máy sẽ tự động tính toán
các hàng còn lại. Bạn không thể nhập thủ công giá trị nhiệt độ trong mỗi hàng.

Tham số Phạm vi Mô tả

Tỷ lệ dốc nhiệt n Đối với hệ thống CFX Opus 96 Dx
:
0,1–5°C mỗi giây

n Đối với hệ thống CFX Opus 384
Dx :
0,1–2,5°C mỗi giây

n Đối với hệ thống CFX Opus
Deepwell Dx:
0,1–2,5°C mỗi giây

Hướng dẫn máy luân nhiệt tăng đến nhiệt
độ mục tiêu ở tỷ lệ được chỉ định trong
bước đó.

Chỉ có sẵn cho các bước nhiệt độ.

Sự gia tăng Một số từ –10,0 đến 10,0°C mỗi chu
kỳ tính bằng phần mười độ

Hướng dẫn máy luân nhiệt thay đổi nhiệt độ
mục tiêu của bước với mỗi chu kỳ, trong đó
số dương sẽ tăng nhiệt độ và số âm sẽ
giảm nhiệt độ.

Chỉ có sẵn cho các bước nhiệt độ.

Bảng 7. Tham số và phạm vi cho các bước trong chương trình

96 | Phần Mềm CFXMaestro Dx SE



Tham số và phạm vi cho các bước trong chương trình

Tham số Phạm vi Mô tả

Kéo dài Khoảng thời gian từ –60 đến 60 giây
mỗi chu kỳ

Hướng dẫn máy luân nhiệt kéo dài thời gian
lưu giữ với mỗi chu kỳ. Số dương sẽ tăng
thời gian lưu giữ và số âm sẽ giảm thời gian
lưu giữ.

Có sẵn cho cả bước nhiệt độ và bước
gradien.

Tiếng bíp (Không có tham số) Hướng dẫn máy luân nhiệt phát ra tiếng bíp
để báo hiệu rằng máy luân nhiệt đã đạt đến
nhiệt độ mục tiêu cho bước đó.

Chỉ có sẵn cho các bước nhiệt độ.

Plate read (Đọc
khay)

(Không có tham số) Hướng dẫn máy luân nhiệt thêm thao tác
đọc khay vào bước đã chọn.

Có sẵn cho cả bước nhiệt độ và bước
gradien.

Bảng 7. Tham số và phạm vi cho các bước trong chương trình, tiếp
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Cửa Sổ Protocol Editor (Trình Chỉnh Sửa Protocol)
Sử dụng Protocol Editor (Trình Chỉnh Sửa Protocol) để tạo, mở, xem lại và chỉnh sửa protocol. Theo mặc
định, Protocol Editor (Trình Chỉnh Sửa Protocol) hiển thị protocol 2 bước real-time tổng quát cho một khay
96 giếng.

1. Thanh menu cho phép truy cập nhanh vào các lệnh trong menu File (Tệp), Settings (Cài Đặt) và
Tools (Công Cụ).

2. Thanh công cụ cung cấp truy cập nhanh để lưu và in protocol, xác định vị trí chèn bước, cài đặt
thể tích mẫu, và xem thời gian ước tính chạy protocol.

3. Ngăn chính hiển thị phần trình bày protocol bằng đồ họa.

4. Ngăn bên dưới hiển thị phần phác thảo protocol.

5. Ngăn bên trái hiển thị các điều khiển protocol mà bạn có thể thêm vào để tùy chỉnh protocol.

CHÚ THÍCH

Các Lệnh Trong Menu File (Tệp)
Save (Lưu) — lưu protocol hiện tại.
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Save As(Lưu Dưới Dạng) — lưu protocol hiện tại bằng tên mới hoặc ở vị trí mới.

File Passwords (Mật Khẩu Tệp) — cho phép người dùng đặt mật khẩu cần nhập khi lưu tệp và mở tệp.

Lời khuyên: Để biết thêm thông tin, hãy xem Đặt Mật Khẩu Bảo Vệ Tệp trên trang 50.

Close (Đóng) — đóng Protocol Editor (Trình Chỉnh Sửa Protocol).

Lệnh trong Menu Cài Đặt
Lid Settings (Cài Đặt Nắp) —mở hộp thoại Lid Setting (Cài Đặt Nắp) mà trong đó bạn có thể thay đổi
hoặc cài đặt nhiệt độ nắp.

Các Lệnh Trong Menu Tools (Công Cụ)
Gradient Calculator (Máy Tính Thang Gradient) —mởmột hộp thoại mà từ đó bạn có thể chọn loại
block cho bước thang gradient. Mặc định là 96 giếng.

Run time Calculator (Máy Tính thời gian Lượt Chạy)—mởmột hộp thoại mà từ đó bạn có thể chọn loại
khay và chế độ quét để tính toán thời gian lượt chạy ước tính trong cửa sổ Run Setup (Thiết Lập Lượt
Chạy). Mặc định là 96 giếng, tất cả các kênh.

Các Lệnh trên Thanh Công Cụ

— lưu tệp protocol hiện tại.

— in cửa sổ đã chọn.

— sử dụng lệnh này để chọn vị trí chèn các bước liên quan với bước đã chọn
hiện tại.

— sử dụng lệnh này để nhập thể tích mẫu theo đơn vị µl. Các thể tích mẫu khác
nhau tùy thuộc vào loại block:

n Đối với block 96 giếng thì phạm vi là 0–50 µl.

n Đối với block 384 giếng thì phạm vi là 0–30 µl.

n Đối với block 96 giếng sâu thì phạm vi là 0–125 µl.
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—hiển thị thời gian chạy ước tính dựa trên các bước protocol, tỷ lệ dốc nhiệt, và
loại block đã chọn.

— hiển thị thông tin Trợ Giúp về protocol.

Điều Khiển Chỉnh Sửa Protocol
Ngăn bên trái của cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol) bao gồm các điều khiển bạn có thể
sử dụng để tạo các protocol.

Mỗi điều khiển gồmmột bộ các tham số đại diện cho một bước trong protocol. Bạn có thể điều chỉnh từng
tham số và thêm hoặc xóa để tùy chỉnh protocol của bạn. Mục này mô tả các tùy chọn trong từng tính
năng điều khiển.

n Insert Step (Chèn Bước) — chèn một bước trước hoặc sau bước đã
chọn. Bạn có thể chỉnh sửa giá trị nhiệt độ và thời gian ủ trong phần hiển
thị đồ họa của protocol hoặc bản phác thảo protocol.

n Insert Gradient (Chèn Thang Gradient) — chèn một bước thang
gradient dựa trên loại block giếng đã chọn trong máy tính thang gradient.
Bạn có thể chỉnh sửa phạm vi thang gradient trong ngăn Gradient xuất
hiện khi một bước thang gradient được chèn.

n Insert GOTO (Chèn GOTO)— chèn một bước chu kỳ (vòng lặp) có
chức năng thông báo cho phần mềm lặp lại các bước cụ thể trong chuỗi
cho một số chu kỳ nhất định. Các lần lặp lại bắt đầu sau khi chu kỳ đầu
tiên hoàn thành. Ví dụ, bạn có thể thông báo cho phần mềm thực hiện 39

lần lặp các bước 2-4. Sau lần lặp cuối, phần mềm thực hiện các bước 2–4 tổng cộng 40 lần. Bạn có
thể chỉnh sửa bước trả về (GOTO) và số chu kỳ trong phần hiển thị đồ họa hoặc phần phác thảo
protocol.

n Insert Melt Curve (Chèn Đường Cong Chảy) — chèn bước đọc đường cong chảy.

n Insert Plate Read to Step (Chèn Lệnh Đọc Khay Vào Bước) — thêmmột lệnh đọc khay vào bước
đã chọn. Lệnh đọc khay đo lượng huỳnh quang ở cuối chu kỳ. Bước đọc khay thường là bước cuối
cùng trong một vòng lặp GOTO.

Lời khuyên: Sau khi bạn thêm lệnh đọc khay vào một bước, nút sẽ thay đổi thành Remove
Plate Read (Xóa Lệnh Đọc Khay) khi bạn chọn bước đó.
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n Remove Plate Read (Xóa Lệnh Đọc Khay) — xóa lệnh đọc khay khỏi bước đã chọn.

Lời khuyên: Sau khi bạn xóa lệnh đọc khay khỏi một bước, nút sẽ thay đổi thành Add Plate
Read to Step (Thêm Lệnh Đọc Khay Vào Bước) khi bạn chọn bước đó.

n Step Options (Tùy Chọn Bước) —mở hộp thoại Step Options (Tùy Chọn Bước) và hiển thị các tùy
chọn có sẵn cho bước đã chọn. Xem Tùy Chọn Bước trên trang 102 để biết thông tin chi tiết về các
tùy chọn bước.

Lời khuyên: Bạn cũng có thể truy cập vào Step Options (Tùy Chọn Bước) bằng cách nhấp
chuột phải vào bước trên phần hiển thị đồ họa.

n Delete Step (Xóa Bước) — xóa bước đã chọn khỏi protocol.
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Tùy Chọn Bước

Mở hộp thoại Step Options (Tùy Chọn Bước) để xem các tùy chọn bạn có thể thêm, thay đổi, hoặc xóa
khỏi một bước.

n Plate Read (Đọc Khay) — khi được chọn, bước sẽ được thêmmột lần đọc khay.

n Temperature (Nhiệt Độ) — cài đặt nhiệt độ mục tiêu cho bước đã chọn.

n Gradient (Thang Gradient) — cài đặt phạm vi thang gradient cho bước; trong khoảng 1–24°C.

Lưu ý: Thang gradient chạy với nhiệt độ thấp nhất ở phía trước block (trong ảnh này là hàng H)
và nhiệt độ cao nhất ở mặt sau của block (trong ảnh này là hàng A).

n Increment (Gia Tăng) — lượng tăng (hoặc giảm) nhiệt độ của bước đã chọn; lượng giá trị này được
thêm vào nhiệt độ mục tiêu với mỗi chu kỳ. Phạm vi là ± 0,1–10°C.

Lưu ý: Để giảm nhiệt độ, nhập dấu trừ (–) trước giá trị số (ví dụ: –5°C).

n Ramp Rate (Tỷ Lệ Dốc Nhiệt) — tỷ lệ dốc nhiệt đối với bước đã chọn; phạm vi phụ thuộc vào kích
thước block.

n Time (Thời Gian) — thời gian ủ đối với bước đã chọn.
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n Extend (Kéo Dài) — lượng thời gian (tính bằng giây) để kéo dài hoặc thu giảm cho bước đã chọn;
tùy chọn này được thêm vào thời gian ủ trong mỗi chu kỳ; phạm vi là ±1–60 giây.

n Bíp (Tiếng Bíp) — khi được chọn, một tiếng bíp sẽ phát ra trong bước.

Lời khuyên: Khi bạn nhập một số nằm ngoài phạm vi tùy chọn, phần mềm sẽ thay đổi số đó
thành mục nhập gần nhất nằm trong phạm vi.
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Tạo Protocol trong Protocol Editor (Trình Chỉnh Sửa Protocol)
Sử dụng Protocol Editor (Trình Chỉnh Sửa Protocol), bạn có thể tạo các tệp protocol tùy ý. Bạn cũng có
thể chỉnh sửa và lưu các tệp tin protocol đã lưu trước đây hoặc các tệp tin protocol mẫu được chuyển với
CFX Maestro Dx SE.

Để tạo một tệp protocol mới, thực hiện các thao tác sau:

n Mởmột tệp protocol trong Protocol Editor (Trình Chỉnh Sửa Protocol).

Lời khuyên: Bạn có thể mởmột protocol mới hoặc hiện có trong Protocol Editor (Trình Chỉnh
Sửa Protocol).

n Thiết lập protocol mới.

n Thêm các bước vào protocol từ ngăn điều khiển protocol.

n Chỉnh sửa thuộc tính của các bước.

n Lưu protocol.

Lời khuyên: Để tạo một protocol mới từ tệp protocol đã lưu trước đây hoặc mẫu, xemMở Protocol
Hiện Có Trong Trình Chỉnh Sửa Protocol trên trang 106.

Mở Tệp Protocol Mới Trong Protocol Editor (Trình Chỉnh Sửa
Protocol)
CFXMaestro Dx SE cung cấp nhiều cách mở tệp protocol mới:

n Từ menu File (Tệp) trong cửa sổ Trang Chủ

n Từ hộp thoại Run Setup (Thiết Lập Lượt Chạy) trong cửa sổ Trang Chủ

n Từ hộp thoại Startup Wizard (Trình Hướng Dẫn Khởi Động) trong cửa sổ Trang Chủ

Cách mở một tệp protocol mới từ cửa sổ File (Tệp)

u Trong cửa sổ Trang Chủ, chọn File > New > Protocol (Tệp > Mới > Protocol).

Cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol) mở ra, hiển thị tệp protocol mặc định.

Lời khuyên: Để biết thông tin về cách cài đặt protocol mặc định của bạn, xem Thay Đổi Cài Đặt
Tệp Mặc Định trên trang 83.
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Cách mở một protocol mới từ hộp thoại Run Setup (Thiết Lập Lượt Chạy)

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau để mở hộp thoại Run Setup (Thiết Lập
Lượt Chạy):

n Chọn Run > User-defined Run (Lượt Chạy > Lượt Chạy Do Người Dùng Cài Đặt).

n Nhấp vào User-defined Run Setup (Thiết Lập Lượt Chạy Do Người Dùng Cài Đặt) trên thanh
công cụ.

Hộp thoại Run Setup (Thiết Lập Lượt Chạy) mở tab Protocol và hiển thị tập tin protocol mặc định của
bạn.

2. Nhấp vào Create New (Tạo Mới).

Cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol) mở ra, hiển thị protocol thời gian thực mặc định.

Cách mở một tệp protocol mới từ Startup Wizard (Trình Hướng Dẫn Khởi Động)

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau để mở Startup Wizard (Trình Hướng
Dẫn Khởi Động) nếu trình này không xuất hiện:

n Chọn View > Startup Wizard (Xem > Trình Hướng Dẫn Khởi Động).

n Nhấp vào Startup Wizard (Trình Hướng Dẫn Khởi Động) trên thanh công cụ.

2. Nếu cần, hãy chọn loại máy từ danh sách thả xuống.

3. Nhấp vào User-defined (Do Người Dùng Cài Đặt) làm loại lượt chạy.

Hộp thoại Run Setup (Thiết Lập Lượt Chạy) mở đến tab Protocol và hiển thị tệp tin protocol mặc định.

4. Nhấp vào Create New (Tạo Mới).

Cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol) mở ra, hiển thị protocol thời gian thực mặc định.

Cách mở protocol mới từ menu Run (Lượt Chạy)

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau để mở hộp thoại Run Setup (Thiết Lập
Lượt Chạy):

n Chọn Run > User-defined Run (Lượt Chạy > Lượt Chạy Do Người Dùng Cài Đặt).

n Nhấp vào User-defined Run Setup (Thiết Lập Lượt Chạy Do Người Dùng Cài Đặt) trên thanh
công cụ.

Hộp thoại Run Setup (Thiết Lập Lượt Chạy) mở tab Protocol và hiển thị tập tin protocol mặc định của
bạn.

2. Nhấp vào Create New (Tạo Mới).

Cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol) mở ra, hiển thị protocol thời gian thực mặc định.
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Mở Protocol Hiện Có Trong Trình Chỉnh Sửa Protocol
CFXMaestro Dx SE cung cấp các tệp tin protocol mẫu mà bạn có thể chỉnh sửa và lưu thành protocol mới
tùy chỉnh. Bạn cũng có thể tạo một protocol mới từ một protocol tùy chỉnh hiện có.

Cách mở tệp protocol mẫu

1. Trong cửa sổ Trang Chủ, chọn File > Open > Protocol (Tệp > Mở > Protocol).

Theo mặc định, Windows Explorer mở đến vị trí thư mục Sample files (Tệp mẫu) của CFX Maestro
Dx SE.

2. Mở thư mục Sample files (Tệp mẫu). Bạn có thể thấy các thư mục sau đây:

n ConventionalProtocols (Protocol Thông Thường) — chứa các tệp protocol mẫu để phân tích
PCR truyền thống.

n DataFiles (Tệp Dữ Liệu) — chứa các tệp dữ liệu mẫu mà bạn có thể sử dụng để khám phá các
tính năng của CFX Maestro Dx SE.

n MeltCalibration (Hiệu Chuẩn Chảy) — chứa các tệp protocol mẫu để sử dụng với phần mềm
Precision Melt Analysis của Bio-Rad.

n Plates (Khay) — chứa các tệp khay mẫu.

n RealTimeProtocols (Protocol Thời Gian Thực) – chứa các tệp protocol mẫu để phân tích PCR
thời gian thực.

3. Mở thư mục protocol cho loại lượt chạy bạn dự định thực hiện, ConventionalProtocols (Protocol
Thông Thường) hoặc RealTimeProtocols (Protocol Thời Gian Thực).

4. Chọn protocol theo lựa chọn và nhấp Open (Mở).

Protocol mẫu mở trong cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol)

5. Chọn File > Save As (Tệp Tin > Lưu Dưới Dạng) và lưu protocol bằng tên mới hoặc trong một thư
mục mới.

Cách mở một protocol hiện có

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau:

n Chọn File > Open > Protocol (Tệp > Mở > Protocol), tìm và chọn một protocol mục tiêu rồi nhấp
vào Open (Mở).

n Mở Startup Wizard (Trình Hướng Dẫn Khởi Động) và thực hiện một trong các thao tác sau:

o Để chỉnh sửa protocol được hiển thị, nhấp vào Edit Selected (Chỉnh Sửa Protocol Đã
Chọn).
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o Để chỉnh sửa một protocol hiện có khác, nhấp vào Select Existing (Chọn Protocol Hiện có)
và tìm tệp mục tiêu.

Protocol mở ra trong cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol)

2. Chọn File > Save As (Tệp Tin > Lưu Dưới Dạng) và lưu protocol bằng tên mới hoặc trong một thư
mục mới.

Thiết Lập Protocol Mới
Lời khuyên: Nếu tệp protocol của bạn bao gồm các tham số bắt buộc (ví dụ: nếu bạn đang chỉnh
sửa tệp khay hiện có), bạn có thể bỏ qua mục này. Tiếp tục đến Thêm Bước vào Protocol trên trang
109.

Các tệp protocol mới yêu cầu các tham số sau:

n Loại block

n Chế độ quét cho loại block được chọn

n Nhiệt độ nắp

n Thể tích mẫu

Hướng Dẫn Sử Dụng | 107



Chương 7 Tạo Protocol

Cài Đặt Loại Block

CFXMaestro Dx SE tự động tính toán sự gia tăng nhiệt độ cho các bước thang gradient dựa trên loại
block.

Lưu ý: Loại khay được cài đặt trong Protocol Editor (Trình Chỉnh Sửa Protocol) phải giống với khay
trong mô-đun phản ứng.

Cách cài đặt loại block

u Trong cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol), chọn Tools > Gradient Calculator (Công Cụ
> Máy Tính Thang Gradient) và chọn loại khay thích hợp trong danh sách thả xuống hiện ra.

Chọn Chế Độ Quét cho Loại Block Đã Chọn

Để xác định thời gian chạy cho protocol, chọn loại block mục tiêu và chế độ quét.

Chọn loại block và chế độ quét

u Trong cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol), chọn Tools > Run time Calculator (Công
Cụ > Máy Tính thời gian Lượt Chạy) và chọn loại khay thích hợp và chế độ quét trong danh sách thả
xuống hiện ra.

Điều Chỉnh Nhiệt Độ Nắp

CFXMaestro Dx SE đặt nhiệt độ nắp mặc định như sau:

n Máy 96 giếng và giếng sâu— 105,0°C

n Máy 384 giếng— 95,0°C

Bạn có thể thay đổi cài đặt mặc định hoặc tắt bộ cấp nhiệt cho nắp khi cần thiết đối với protocol này.

Cách điều chỉnh nhiệt độ nắp

1. Trong cửa sổ Plate Editor (Trình Chỉnh Sửa Khay), chọn Settings > Lid Settings (Cài Đặt > Cài Đặt
Nắp).

Hộp thoại Lid Settings (Cài Đặt Nắp) xuất hiện.

2. Thực hiện một trong các thao tác sau:

n Chọn User Defined (Do Người Dùng Cài Đặt) và nhập giá trị nhiệt độ vào ô văn bản.

n Chọn Turn Off Lid Heater (Tắt Bộ Cấp Nhiệt Cho Nắp).

3. Nhấp OK để chấp nhận các thay đổi và đóng hộp thoại
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Đặt Thể Tích Mẫu

Theo mặc định, CFX Maestro Dx SE đặt thể tích mẫu cho mỗi giếng thành 25 µl. Thể tích mẫu khác nhau
tùy thuộc vào loại block, ví dụ:

n 0–50 µl với block 96 giếng

n 0–30 µl với block 384 giếng

Máy sử dụng một trong hai chế độ điều khiển nhiệt độ để xác định khi nào mẫu đạt đến nhiệt độ mục tiêu
trong một protocol:

n Calculated mode (Chế độ tính toán) — khi thể tích mẫu được đặt thành thể tích có giá trị khác không
thích hợp cho block, máy sẽ tính toán nhiệt độ mẫu dựa trên thể tích mẫu. Đây là chế độ tiêu chuẩn.

n Block mode (Chế độ block) — khi thể tích mẫu được đặt thành không (0) µl, máy sẽ ghi lại nhiệt độ
mẫu giống như nhiệt độ block đo được.

Cách đặt thể tích mẫu cho một block cụ thể

u Trong cửa sổ Plate Editor (Trình Chỉnh Sửa Khay), nhập giá trị chính xác vào ô văn bản Sample
Volume (Thể Tích Mẫu) trên thanh công cụ.

Lời khuyên: Bạn có thể thay đổi thể tích mẫu mặc định trong hộp thoại User Preferences (Ưu Tiên
của Người Dùng). Xem Thay Đổi Cài Đặt Tệp Mặc Định trên trang 83.

Thêm Bước vào Protocol
Để thêm bước vào protocol

1. Mở protocol trong cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol)

2. Xác định xem chèn bước mới vào đâu. Trên thanh công cụ, chọn Before (Trước) hoặc After (Sau)
trong danh sách thả xuống Step (Bước).

3. Trên đồ thị, chọn bước trước hoặc sau mà bạn dự định chèn bước mới.

4. Ở ngăn bên trái, nhấp vào Insert Step (Chèn Bước).

5. Để thay đổi nhiệt độ hoặc thời gian ủ, hãy nhấp vào giá trị mặc định trên đồ thị hoặc phần phác thảo
protocol và nhập một giá trị mới.

6. (Không bắt buộc) Ở ngăn bên trái, nhấp vào Step Options (Tùy Chọn Bước) để hiển thị hộp thoại
Step Options (Tùy Chọn Bước) và sửa đổi các tùy chọn có sẵn cho bước đã chọn.

Lời khuyên: Bạn có thể truy cập vào hộp thoại Step Options (Tùy Chọn Bước) trên menu khi
nhấp chuột phải trong ngăn đồ thị hoặc phần phác thảo protocol.

7. Nhấp vào OK rồi nhấp vào Yes (Có) để lưu các thay đổi vào protocol.
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Hộp thoại Save As (Lưu Dưới Dạng) xuất hiện.

8. Trong hộp thoại Save As (Lưu Dưới Dạng), nhập tên tệp protocol mới và nhấp vào Save (Lưu).

Chèn Bước Thang Gradient
Cách chèn bước thang gradient

1. Xác minh rằng kích thước khay đối với thang gradient cũng giống như loại block của máy, loại 96
giếng, loại 384 giếng hoặc giếng sâu.

2. Chọn kích thước khay đối với thang gradient, nếu bạn chưa chọn:

Chọn Tools > Gradient Calculator (Công Cụ > Máy Tính Thang Gradient) và chọn loại giếng thích
hợp từ danh sách thả xuống.

3. Trên thanh công cụ, chọn Before (Trước) hoặc After (Sau) trong danh sách thả xuống Insert Step
(Chèn Bước).

4. Trong đồ thị hoặc ngăn phác thảo, chọn bước trước hoặc sau mà bạn dự định chèn bước thang
gradient.

5. Trong ngăn bên trái, nhấp vào Insert Gradient (Chèn Thang Gradient). Bước thang gradient mới
được làm nổi bật trong biểu đồ và ngăn phác thảo, ví dụ:
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Nhiệt độ của mỗi hàng trong thang gradient xuất hiện trong bảng Thang Gradient ở ngăn bên phải.

6. Để chỉnh sửa phạm vị nhiệt độ của thang gradient, thực hiện một trong các thao tác sau:

n Nhấp vào nhiệt độ mặc định trong đồ thị hoặc ngăn phác thảo và nhập nhiệt độ mới vào.

n Nhấp vào Step Options (Tùy Chọn Bước) để nhập phạm vi thang gradient trong cửa sổ Step
Options (Tùy Chọn Bước).

n Thay đối giá trị Range (Phạm Vi) trong bảng Gradient (Thang Gradient).

7. Để chỉnh sửa thời gian ủ, hãy nhấp vào thời gian mặc định trong chế độ xem đồ họa hoặc văn bản và
nhập thời gian mới vào.

8. Nhấp OK sau đó nhấp Yes (Có) để lưu các thay đổi.

Chèn Bước GOTO
Lưu ý: Bạn không thể chèn bước GOTO trong tập hợp GOTO; bạn không thể tạo các vòng lặp
GOTO được lồng vào.

Cách chèn bước GOTO

1. Trên thanh công cụ, chọn Before (Trước) hoặc After (Sau) từ danh sách thả xuống Insert Step (Chèn
Bước).

2. Trong đồ thị này, chọn bước trước hoặc sau mà bạn dự định chèn bước GOTO.

3. Trong ngăn bên trái, nhấp vào Insert GOTO (Chèn GOTO).

4. Để chỉnh sửa số bước GOTO và số GOTO lặp lại, chọn số mặc định trong đồ thị hoặc ngăn phác
thảo và nhập giá trị mới.

5. Nhấp OK sau đó nhấp Yes (Có) để lưu các thay đổi.

Chèn Bước Đường Cong Chảy
Lời khuyên: Bạn không thể chèn bước đường cong chảy bên trong vòng lặp GOTO.

Lưu ý: Bước đường cong chảy bao gồmmột lần giữ 30 giây khi bắt đầu bước không được hiển thị
trong protocol.

Cách chèn bước đường cong chảy

1. Trên thanh công cụ, chọn Before (Trước) hoặc After (Sau) từ danh sách thả xuống Insert Step (Chèn
Bước).

2. Trong đồ thị này, chọn bước trước hoặc sau mà bạn dự định chèn bước đường cong chảy.
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3. Trong ngăn bên trái, nhấp Insert Melt Curve (Chèn Đường Cong Chảy). Bước đường cong chảy mới
được làm nổi bật trong đồ thị này và trong ngăn phác thảo, ví dụ:

4. Để chỉnh sửa phạm vi nhiệt độ chảy và thời gian gia tăng, chọn số mặc định trong đồ thị hoặc ngăn
phác thảo và nhập một giá trị mới.

5. Nhấp OK sau đó nhấp Yes (Có) để lưu các thay đổi.
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Thêm Hoặc Xóa Bước Đọc Khay
Lời khuyên: Sau khi bạn thêm lệnh đọc khay vào một bước, nút sẽ thay đổi thành Remove Plate
Read (Xóa Lệnh Đọc Khay) khi bạn chọn bước đó.

Để thêm lệnh đọc khay vào bước

1. Trên thanh công cụ, chọn Before (Trước) hoặc After (Sau) từ danh sách thả xuống Insert Step (Chèn
Bước).

2. Trên đồ thị, chọn bước trước và sau bước bạn dự định chèn bước đọc khay vào.

3. Ở ngăn trái, nhấp vào Add Plate Read to Step (Thêm Lệnh Đọc Khay vào Bước) để thêm lệnh đọc
khay vào bước đã chọn.

4. Nhấp OK sau đó nhấp Yes (Có) để lưu các thay đổi.

Cách loại bỏ lệnh đọc khay ra khỏi bước

u Trên đồ thị, chọn bước có lệnh đọc khay và nhấp vào Remove Plate Read (Xóa Lệnh Đọc Khay) ở
ngăn bên trái.

Changing Step Options (Thay Đổi Các Tùy Chọn Bước)
Cách thay đổi các tùy chọn bước cho một bước đã chọn

1. Chọn bước mục tiêu trong biểu đồ hay ngăn phác thảo.

2. Ở ngăn bên trái, nhấp vào Step Options (Tùy Chọn Bước) để mở hộp thoại Step Options (Tùy Chọn
Bước).

Ngoài ra, nhấp chuột phải vào bước mục tiêu ở một trong hai ngăn và chọn Step Options (Tùy Chọn
Bước) trong menu xuất hiện.

3. Cách thêm, sửa đổi hoặc xóa tùy chọn:

n Nhập giá trị vào ô văn bản phù hợp.

n Chỉnh sửa giá trị trong ô văn bản cụ thể.

n Chọn hoặc bỏ chọn ô kiểm.

4. Nhấp OK để lưu các thay đổi và đóng hộp thoại Step Options (Tùy Chọn Bước).

5. Nhấp OK và sau đó nhấp Yes (Có) để lưu protocol.
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Xóa Bước
Quan trọng: Bạn không thể khôi phục chức năng này. Hãy cẩn thận khi xóa các bước.

Cách xóa một bước trong protocol

1. Chọn bước trong ngăn biểu đồ hoặc phác thảo.

2. Trong ngăn bên trái, nhấp Delete Step (Xóa Bước) để xóa bước đã chọn.

3. Nhấp OK và sau đó nhấp Yes (Có) để lưu protocol.

Sao Chép, Xuất, hoặc In Protocol
Cách sao chép protocol

u Nhấp chuột phải vào phần phác thảo protocol và chọn Copy Protocol (Sao Chép Protocol).

Bạn có thể dán phác thảo vào một tệp tin .txt, .xls, .doc, hoặc .ppt.

Cách xuất protocol

1. Nhấp chuột phải vào phần phác thảo protocol và chọn Export Protocol (Xuất Protocol).

Hộp thoại Save As (Lưu Dưới Dạng) xuất hiện.

2. (Tùy chọn) TrongWindows Explorer, điều hướng đến một thư mục để lưu tệp tin protocol.

3. Trong File name (Tên tệp tin), nhập tên cho tệp tin protocol đã xuất.

4. Nhấp Save (Lưu).

Cách in protocol

u Nhấp chuột phải vào phần phác thảo protocol và chọn Print (In).

Bạn có thể in phần phác thảo protocol ra máy in mặc định của bạn.
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Tạo Protocol Bằng Protocol AutoWriter (Tự Động Cài Đặt
Protocol)

Quan trọng: Bio-Rad không đảm bảo rằng việc chạy protocol tạo bằng Protocol AutoWriter (Tự
Động Cài Đặt Protocol) sẽ luôn tạo ra sản phẩm PCR.

Protocol AutoWriter (Tự Động Cài Đặt Protocol) của CFX Maestro Dx SE tự động tạo các protocol tuần
hoàn dựa trên các tham số đầu vào sau đây:

n Amplicon length (Chiều dài amplicon) — chiều dài dự kiến của sản phẩm PCR

n Annealing temperature (Nhiệt độ gắn mồi) — Ta của phản ứng đối với các mồi đang được sử dụng

Nếu Ta chưa xác định, bạn có thể dùng máy tính Ta để tự động tính dựa trên trình tự mồi của bạn.

Lưu ý: Ta được điều chỉnh từ thông tin nhiệt độ chảy mồi (Tm) dựa trên enzyme đã chọn và tốc
độ protocol.

n Enzyme type (Loại enzyme) — DNA polymerase enzyme (iTaq, iProof DNA polymerase hoặc Other
(Khác))

Nếu bạn sử dụng một enzyme khác ngoài iTaq hoặc iProof DNA polymerase, bạn có thể nhập thông
tin bổ sung, trong đó bao gồm phạm vi thang gradient, thời gian kích hoạt khởi động nóng (tính bằng
giây) và thời gian kéo dài cuối (tính bằng giây).

n Run speed (Tốc độ chạy) — tốc độ phản ứng (tiêu chuẩn, nhanh, hoặc siêu nhanh)

Protocol AutoWriter (Tự Động Cài Đặt Protocol) tối ưu hóa protocol tùy thuộc vào cài đặt tốc độ đã
chọn. Thời gian chạy tổng thể được xác định bằng số bước và chu kỳ, thời gian ủ ở mỗi bước, và thời
gian cần sử dụng để đạt đến tính đồng nhất ở nhiệt độ mục tiêu.

Sử dụng các tham số bạn nhập và các hướng dẫn PCR tiêu chuẩn, Tự Động Cài Đặt Protocol tự động tạo
một protocol PCR tùy chỉnh với các bước khởi động nóng, biến tính ban đầu, gắn mồi và kéo dài. Sau đó,
bạn có thể xem protocol đề xuất được trình bày bằng đồ họa và chỉnh sửa, chạy hoặc lưu protocol.

Hướng Dẫn Sử Dụng | 115



Chương 7 Tạo Protocol

Cách tạo một protocol mới bằng Protocol AutoWriter (Tự Động Cài Đặt Protocol) của CFX
Maestro Dx SE

1. Trong cửa sổ Trang Chủ, chọn Tools > Protocol AutoWriter (Công Cụ > Tự Động Cài Đặt Protocol).

Hộp thoại Protocol AutoWriter (Tự Động Cài Đặt Protocol) xuất hiện.

2. Trong mục Enter Target Values/Enzyme (Nhập Giá Trị Mục Tiêu/Enzyme), thực hiện các thao tác
sau:

n Nhập nhiệt độ gắn mồi (Ta) cho các mồi, nếu biết.

Lời khuyên: Xem Sử Dụng Máy Tính Ta trên trang 117 để biết thêm thông tin.

Lưu ý: Để biết thông tin về các phép tính được sử dụng trong Máy Tính Ta, xem tài liệu của
Breslauer và cộng sự năm 1986.

n Nhập chiều dài amplicon theo cặp bazơ (base pair, bp).

n Chọn một loại enzyme trong danh sách các tùy chọn (iTaq DNA polymerase, iProof DNA
polymerase hoặc Other (Khác)).

Lời khuyên: Nếu bạn chọn Other (Khác) làm loại enzyme, các tham số trong mục
Additional Parameters (Tham Số Bổ Sung) (Tùy Chọn) trở nên có hiệu lực.
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3. Nếu bạn đã chọn Other (Khác) làm loại enzyme, bạn có thể thêm bất kỳ hoặc tất cả các tham số sau
vào protocol:

n Phạm vi thang gradient

n Nhiệt độ kích hoạt khởi động nóng

n Thời gian kéo dài cuối

4. Trong mục Type (Loại), di chuyển thanh trượt để chọn tốc độ protocol (Standard (Tiêu Chuẩn), Fast
(Nhanh), hoặc Ultrafast (Siêu Nhanh)). CFX Maestro Dx SE sẽ điều chỉnh thời gian chạy tổng thể.

5. Chọn loại PCR để thực hiện (Real-time PCR là loại mặc định).

Với real-time PCR, CFX Maestro Dx SE thêmmột bước đọc khay để thu thập dữ liệu huỳnh quang.

6. Trong mục Preview (Xem Trước), xem lại protocol. Bạn có thể thực hiện thay đổi nếu cần.

7. Thực hiện một trong các thao tác sau:

n Nhấp vào OK để lưu protocol mới. Sau khi lưu, protocol mở ra trong Trình Hướng Dẫn Khởi
Động. Nhấp Edit Selected (Chỉnh Sửa Protocol Đã Chọn) để tạo bất kỳ thay đổi nào cho
protocol. Ví dụ: bạn có thể cần thay đổi nhiệt độ nắp và thể tích mẫu.

n Nhấp vào Cancel (Hủy) để đóng cửa sổ mà không lưu protocol.

Sử Dụng Máy Tính Ta
Khi chưa xác định nhiệt độ gắn mồi, bạn có thể sử dụng Máy Tính Ta để tính toán giá trị. Bạn có thể sử
dụng giá trị trong Protocol AutoWriter (Tự Động Cài Đặt Protocol) hoặc trong Protocol Editor (Trình Chỉnh
Sửa Protocol) để tạo protocol của bạn.

Giới Thiệu Máy Tính Ta
Máy Tính Ta tính giá trị Tm cho mỗi mồi cũng như giá trị Ta cho protocol ở tốc độ tiêu chuẩn.

Ta cho protocol dựa trên các giá trị Tmmồi trung bình với các quy tắc sau được áp dụng:

n Chênh lệch giữa các giá trị Tm của mồi là >4°C, Ta = (giá trị dưới trong hai giá trị Tmmồi + 2) – 4°C

n Nếu chênh lệch giữa các giá trị Tm là ≤4°C, Ta = (giá trị Tmmồi trung bình) – 4°C
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Phương Pháp Đếm Cặp Bazơ

Đối với mỗi mồi, Máy Tính Ta sử dụng phương pháp đếm cặp bazơ cho các trình tự có 14 cặp bazơ (bp)
trở xuống.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

trong đó w, x, y, và z lần lượt là số bazơ A, T, G, và C trong trình tự.

Phương Pháp Lân Cận Gần Nhất

Đối với các chuỗi dài hơn 14 bp, sử dụng phương pháp lân cận gần nhất. Trong phương pháp lân cận
gần nhất, các phép tính toán nhiệt độ chảy được dựa trên mối quan hệ nhiệt động giữa entropy (thứ tự
hoặc phép đo sự ngẫu nhiên của oligonucleotide), enthalpy (nhiệt lượng giải phóng hoặc hấp thụ bởi
oligonucleotide), năng lượng tự do và nhiệt độ.

∆H = ∆G + T* ∆S

trong đó:

n ∆H = giá trị enthalpy, Cal/Mole*K

n T = nhiệt độ, Kelvin

n ∆S = Giá trị entropy, Cal/Mole*K

n ∆G = Năng lượng tự do Gibbs tính bằng Cal/Mole*K

Sự thay đổi ở entropy và enthalpy được tính trực tiếp bằng cách cộng các giá trị đối với các cặp
nucleotide có trong Bảng 8 (Breslauer và cộng sự 1986).

Mối quan hệ giữa năng lượng tự do và nồng độ chất phản ứng và sản phẩm ở trạng thái cân bằng được
xác định bởi:

∆G = R*T*ln ((DNA * Mồi)/(DNA + Mồi))

trong đó R là hằng số khí (1,986 Cal/Mole*K).

Thay thế G trong hai phương trình và giải tìm T cho kết quả

T = ∆H/(∆S + R*Ln((DNA * Mồi)/(DNA + Mồi)))

giả định rằng nồng độ của phức hợp DNA và DNAmồi bằng nhau.

Được xác định theo kinh nghiệm rằng có 5 kcal năng lượng tự do (3,4 kcal) (Sugimoto và cộng sự 1996)
thay đổi trong quá trình chuyển đổi từ DNA đơn sợi dạng B. Trường hợp này có lẽ là năng lượng bắt đầu
xoắn. Cuối cùng, việc thêmmột điều chỉnh cho muối tạo ra phương trình cho máy tính Ta sử dụng:

T = (∆H – 5(KCal/K*Mole))/(∆S + (R * ln(1/(mồi)))) + 16,6 log10 (Nồng Độ Mole Muối)
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Không cần hằng số điều chỉnh cho nồng độ muối, vì các tham số khác nhau được xác định tại 1 M NaCl
và log10 của 1 bằng 0.

Phép tính toán nhiệt động giả định rằng quá trình gắn mồi xảy ra ở độ pH 7,0. Các phép tính Tm giả định
rằng các trình tự không đối xứng và chứa ít nhất một G hoặc C.

Trình tự oligonucleotide cần dài ít nhất 14 bazơ để cung cấp giá trị Tm hợp lý. Có dưới 14 bazơ sử dụng
phương pháp đếm cặp bazơ (xem Bảng 8 sau đây).

Tương tác ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3.1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3.1

GG CC 11 26,6 3.1

Bảng 8. Hằng số tương tác Breslauer
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Sử Dụng Máy Tính Ta

Cách sử dụng Máy Tính Ta

1. Để mởMáy Tính Ta, thực hiện một trong các thao tác sau:

n Nếu bạn đang trong Protocol AutoWriter (Tự Động Cài Đặt Protocol), nhấp vào Ta Calculator
(Máy Tính Ta).

n Trong cửa sổ Trang Chủ, chọn Tools > Ta Calculator (Công Cụ > Máy Tính Ta).

Hộp thoại Ta Calculator (Máy Tính Ta) xuất hiện.

2. Trong ô văn bản Forward Primer (Mồi Xuôi), gõ hoặc dán trình tự mồi xuôi.

Lời khuyên: Bạn cũng có thể sử dụng các nút A, T, G, C ở bên trái của hộp thoại để nhập chuỗi.

3. Gõ hoặc dán trình tự mồi ngược trong ô văn bản Reverse Primer (Mồi Ngược).

4. Nhấp vào Calculate (Tính).
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Máy Tính Ta tính toán và hiển thị Tm của mỗi mồi và các giá trị Tm và Ta trung bình, ví dụ:

Nếu các giá trị Tmmồi cách nhau hơn 4°C, Protocol AutoWriter (Tự Động Cài Đặt Protocol) sẽ sử
dụng giá trị Tmmồi thấp hơn + 2°C làm cơ sở để tính toán giá trị Ta, mà sau đó bạn có thể sửa đổi
thêm bằng cách thay đổi enzyme và tốc độ phản ứng.

Máy Tính Ta tạo ra nhiệt độ gắn mồi cho tốc độ tiêu chuẩn với iTaq DNA polymerase. Khi sử dụng
một enzyme khác, cài đặt tốc độ sẽ tự động điều chỉnh Ta.

5. Thực hiện một trong các thao tác sau:

n Nếu bạn đã mởMáy Tính Ta từ Protocol AutoWriter (Tự Động Cài Đặt Protocol), nhấp vào OK.
Bạn trở lại Protocol AutoWriter (Tự Động Cài Đặt Protocol). Nhiệt độ gắn mồi được sửa đổi tự
động.

n Nếu bạn đã mởMáy Tính Ta từ menu Tools (Công Cụ), ghi lại các phép tính và nhấp vào Cancel
(Hủy) để đóng máy tính.
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Chương 8 Chuẩn Bị Khay
Một tệp khay chứa thông tin về các tham số lượt chạy như chế độ quét, chất huỳnh quang, và thành phần
giếng. Sau khi chạy, Phần mềm CFX Maestro Dx, Phiên bản bảo mật liên kết thành phần của giếng với
dữ liệu huỳnh quang thu thập được trong lượt chạy và áp dụng phân tích thích hợp trong cửa sổ Data
Analysis (Phân Tích Dữ Liệu). Ví dụ, các giếng được tải loại mẫu chuẩn sẽ được sử dụng để tạo đường
cong chuẩn.

CFX Maestro Dx SE cung cấp hai tùy chọn để tạo khay: Plate Editor (Trình Chỉnh Sửa Khay) để chạy real-
time PCR và Setup Wizard (Trình Hướng Dẫn Thiết Lập) để phân tích biểu hiện gen chuẩn hóa.

Plate Editor (Trình Chỉnh Sửa Khay) bao gồm các tính năng sau:

n Chất phát huỳnh quang tiêu chuẩn và các loại mẫu để gán cho các giếng khay

n Khả năng đặt mục tiêu tham chiếu và mẫu đối chứng để phân tích biểu hiện gen

n Khả năng chỉnh sửa thiết lập khay trước, trong, hoặc sau một lượt chạy

n Khả năng lưu tệp khay để tái sử dụng

n Khả năng in tệp khay vào máy in mặc định

Setup Wizard (Trình Hướng Dẫn Cài Đặt) sẽ hướng dẫn bạn cách tạo bố cục khay để phân tích biểu hiện
gen chuẩn hóa. Bạn có thể sử dụng Setup Wizard (Trình Hướng Dẫn Cài Đặt) trước, trong, hoặc sau một
lượt chạy.
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Cửa Sổ Plate Editor (Trình Chỉnh Sửa Khay)
Bạn sử dụng Plate Editor (Trình Chỉnh Sửa Khay) để tạo các khay tùy chỉnh hoặc sửa đổi các khay hiện
có.

1. Thanh menu cho phép truy cập nhanh vào các lệnh trong menu File and Settings (Tệp và Cài
Đặt) cũng như các tùy chọn trong công cụ chỉnh sửa khay.

2. Thanh công cụ cho phép truy cập nhanh vào các chức năng tải khay quan trọng.

3. Ngăn chính hiển thị phác thảo khay và các tùy chọn khay khi bạn áp dụng chúng.

4. Ngăn bên phải hiển thị các tùy chọn mà bạn sử dụng để tùy chỉnh khay của mình.

5. Ngăn dưới cùng hiển thị loại khay và cung cấp quyền truy cập nhanh vào các tùy chọn xem.

CHÚ THÍCH

Các Lệnh Trong Menu File (Tệp)
Save (Lưu) — lưu tệp dữ liệu khay vào vị trí quy định trong tab File (Tệp) trong hộp thoại User
Preferences (Ưu Tiên của Người Dùng). Xem Thay Đổi Cài Đặt Tệp Mặc Định trên trang 83 để biết thêm
thông tin. Mục này trong menu chỉ có sẵn khi tạo một tệp khay mới.

Save As (Lưu Dưới Dạng) — lưu tệp dữ liệu khay đang mở bằng tên mới mà bạn cung cấp. Mục này
trong menu chỉ có sẵn khi tạo một tệp khay mới.
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File Passwords (Mật Khẩu Tệp) — cho phép người dùng đặt mật khẩu cần nhập khi lưu tệp và mở tệp.

Extract Plate (Trích Xuất Khay) —mở hộp thoại trong đó bạn có thể trích xuất/lưu tệp khay (.pltd). Mục
trong menu này chỉ có sẵn khi xem hoặc chỉnh sửa một tệp khay hiện có.

Print (In) — in tệp dữ liệu khay mở.

Close (Đóng) — đóng Plate Editor (Trình Chỉnh Sửa Khay).

Các Lệnh Trong Menu Edit (Chỉnh Sửa)
Undo (Không Thực Hiện) — không thực hiện một thay đổi vào tệp khay cho đến khi tệp khay được lưu.

Redo (Thực Hiện Lại) — trở lại thao tác Undo (Không Thực Hiện) gần nhất trừ khi tệp khay đã được lưu.

Các Lệnh Trong Menu Settings (Cài Đặt)
Plate Size (Kích Thước Khay)—mởmột hộp thoại từ đó bạn có thể chọn kích thước khay cho lượt chạy.

Lưu ý: Kích thước khay phải tương đồng với kích thước block trên máy thực hiện lượt chạy.

Chọn 96 giếng cho:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Chọn 384 giếng cho:

n CFX Opus 384 Dx

Plate Type (Loại Khay) — cho phép bạn chọn loại giếng trong khay để giữ mẫu của bạn, hoặc là BR
White (BR Trắng) hoặc là BR Clear (BR Trong Suốt). Để phân tích dữ liệu chính xác, loại khay được chọn
phải tương đồng với loại khay được sử dụng trong lượt chạy.

Lưu ý: Bạn phải hiệu chuẩn các loại khay mới. Xem Hiệu Chuẩn Thuốc NhuộmMới trên trang
75 để biết thêm thông tin.

Number Convention (Quy Ước Số) — Cho phép bạn chọn hoặc bỏ chọn hiển thị các đơn vị theo ký hiệu
khoa học. Mặc định là hiển thị các đơn vị theo ký hiệu khoa học.

Unit (Đơn Vị) — cho phép bạn chọn các đơn vị để hiển thị trong các trang bảng tính khi thực hiện định
lượng các ẩn số so với đường cong chuẩn.

Các Lệnh Trong Menu Editing Tools (Công Cụ Chỉnh Sửa)
Setup Wizard (Trình Hướng Dẫn Thiết Lập) —mở Setup Wizard (Trình Hướng Dẫn Thiết Lập), trong đó
bạn có thể xác định bố cục và các tham số phân tích cho khay hiện tại. Bạn có thể sử dụng Setup Wizard
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(Trình Hướng Dẫn Thiết Lập) trước, trong, hoặc sau khi một lượt chạy đã hoàn tất.

Spreadsheet View/Importer (Chế Độ Xem/Trình Nhập Trang Bảng Tính) —mở hộp thoại View (Chế Độ
Xem), hiển thị bố cục khay làmmẫu trong định dạng trang bảng tính. Bạn có thể sử dụng hộp thoại này để
xuất hoặc nhập dữ liệu mẫu khay ở định dạng .csv.

Flip Plate (Lật Khay) — lật nội dung khay 180o.

Các Lệnh trên Thanh Công Cụ

Hoàn nguyên thay đổi đối với một khay. CFX Maestro Dx SE hỗ trợ tối đa
mười lần hoàn tác

Đảo ngược thao tác Hoàn nguyên gần đây nhất. CFX Maestro Dx SE hỗ
trợ tối đa mười lần thực hiện lại.

Lưu tệp khay hiện tại.

Hiển thị danh sách thả xuống từ đó bạn có thể tăng hay giảm khuếch đại
chế độ xem khay.

Hiển thị danh sách thả xuống từ đó bạn có thể chọn chế độ quét, hướng
dẫn máy thu thập dữ liệu huỳnh quang từ các kênh nào trong một lượt
chạy.

MởWell Groups Manager (Trình Quản Lý Các Nhóm Giếng), có thể được
sử dụng để tạo các nhóm giếng cho khay hiện tại.

Hiển thị một hộp thoại trong đó bạn có thể chọn màu và biểu tượng cho
các vạch đồ họa khuếch đại.

Mở hộp thoại View (Chế Độ Xem), hiển thị bố cục khay dưới dạng mẫu
trong định dạng trang tính. Bạn có thể sử dụng hộp thoại này để xuất
hoặc nhập dữ liệu mẫu khay ở định dạng .csv.

Mở Setup Wizard (Trình Hướng Dẫn Cài Đặt), trong đó bạn có thể xác
định bố cục và các tham số phân tích đối với khay hiện tại. Bạn có thể sử
dụng Setup Wizard (Trình Hướng Dẫn Cài Đặt) trước, trong, hoặc sau
một lượt chạy.

Mở tab Plate (Khay) trong hộp thoại User Preferences (Ưu Tiên của
Người Dùng), trong đó bạn có thể xác định các tham số về bố cục khay và
tạo hoặc xóa tên mục tiêu, mẫu, và nhóm sinh học. Các thay đổi mà bạn
thực hiện trong tab Plate (Khay) sẽ có sẵn vào lần tiếp theo khi bạn mở
Plate Editor (Trình Chỉnh Sửa Khay).

Hiển thị các bước cần thiết để thiết lập khay và tải giếng.
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Tạo Tệp Tin Khay Bằng Cách Sử Dụng Plate Editor (Trình
Chỉnh Sửa Khay)

Bằng cách sử dụng Plate Editor (Trình Chỉnh Sửa Khay), bạn có thể tạo các tệp khay tùy chỉnh. Bạn cũng
có thể chỉnh sửa và lưu các tệp khay đã lưu từ trước hoặc tệp khay mẫu được vận chuyển cùng với Hệ
thống CFX Opus Dx.

Để tạo một tệp khay mới, hãy thực hiện các thao tác sau:

n Mở tệp khay trong Plate Editor (Trình Chỉnh Sửa Khay).

n Chọn loại khay.

Lưu ý: Loại khay cho tệp khay phải giống như khay trong mô-đun phản ứng.

n Chọn chế độ quét để sử dụng trong protocol.

n Chọn chất huỳnh quang để sử dụng trong khay.

n Chọn loại mẫu, mục tiêu, và mẫu.

n Chọn bản sao kỹ thuật, nếu thích hợp.

n Lưu bố cục khay.

Lời khuyên: Để tạo một khay mới từ các tệp khay mẫu hoặc đã lưu trước đó, xemMở Tệp Khay
Hiện Có trong Chỉnh Sửa Khay trên trang 129.

Mở Tệp Khay Mới trong Chỉnh Sửa Khay
CFXMaestro Dx SE cung cấp nhiều tùy chọn để mởmột tệp khay mới:

n Từ cửa sổ Trang Chủ

n Từ hộp thoại Startup Wizard (Trình Hướng Dẫn Khởi Động)

n Từ hộp thoại Run Setup (Thiết Lập Lượt Chạy)

Mở tệp khay mới từ cửa sổ Trang Chủ

u Chọn File > New > Plate (Tệp > Mới > Khay).

Cửa sổ Plate Editor (Trình Chỉnh Sửa Khay) mở ra hiển thị tệp khay mặc định đối với máy đã chọn.

Lời khuyên: Để có thêm thông tin về cài đặt tệp khay mặc định của bạn, hãy xem Thay Đổi Cài
Đặt Tệp Mặc Định trên trang 83.
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Mở tệp khay mới từ Startup Wizard (Trình Hướng Dẫn Khởi Động)

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau để mở Startup Wizard (Trình Hướng
Dẫn Khởi Động) nếu trình này không xuất hiện:

n Chọn View > Startup Wizard (Xem > Trình Hướng Dẫn Khởi Động).

n Nhấp vào Startup Wizard (Trình Hướng Dẫn Khởi Động) trên thanh công cụ.

2. Nếu cần, hãy chọn loại máy từ danh sách thả xuống.

3. Để tạo một khay mới, nhấp vào User-defined (Do người dùng cài đặt) làm loại lượt chạy.

Hộp thoại Run Setup (Thiết Lập Lượt Chạy) mở ra hiển thị tab Protocol.

4. Nhấp vào tab Plate (Khay) và nhấp vào Create New (Tạo Mới).

Cửa sổ Plate Editor (Trình Chỉnh Sửa Khay) mở ra hiển thị bố cục khay mặc định đối với máy đã
chọn.

Mở một tệp khay mới từ hộp thoại Run Setup (Thiết Lập Lượt Chạy)

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau để mở hộp thoại Run Setup (Thiết Lập
Lượt Chạy):

n Chọn Run > User-defined Run (Lượt Chạy > Lượt Chạy Do Người Dùng Cài Đặt).

n Nhấp vào User-defined Run Setup (Thiết Lập Lượt Chạy Do Người Dùng Cài Đặt) trên thanh
công cụ.

Hộp thoại Run Setup (Thiết Lập Lượt Chạy) mở ra tab Protocol.

2. Để tạo một khay mới, nhấp vào tab Plate (Khay) và nhấp Create New (Tạo Mới).

Cửa sổ Plate Editor (Trình Chỉnh Sửa Khay) mở ra hiển thị bố cục khay mặc định đối với máy đã
chọn.
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Mở Tệp Khay Hiện Có trong Chỉnh Sửa Khay
CFXMaestro Dx SE cung cấp tệp tin khay mẫu mà bạn có thể chỉnh sửa và lưu thành một khay mới. Bạn
cũng có thể tạo tệp khay mới từ một tệp khay đã lưu trước đó.

Cách mở một tệp khay mẫu

1. Trong cửa sổ Trang Chủ, chọn File > Open > Plate (Tệp > Mở > Khay).

Windows Explorer (Trình Tìm Kiếm) mở đến vị trí thư mục tệp Sample (Mẫu) của Hệ thống CFX
Opus Dx.

2. Mở thư mục tệp Sample (Mẫu), sau đó mở thư mục Plates (Khay).

3. Chọn một tệp khay và nhấp vào Open (Mở).

Tệp tin khay mẫu mở trong cửa sổ Plate Editor (Trình Chỉnh Sửa Khay).

4. Chọn File > Save As (Tệp Tin > Lưu Dưới Dạng) và lưu tệp tin khay bằng tên mới hoặc trong một thư
mục mới.

Cách mở một tệp khay đã lưu trước đó

1. Trong cửa sổ Trang Chủ, thực hiện một trong các thao tác sau:

n Chọn File > Open > Plate (Tệp > Mở > Khay), tạo đường dẫn và chọn khay mục tiêu và nhấp vào
Open (Mở).

n Mở Startup Wizard (Trình Hướng Dẫn Khởi Động) và thực hiện một trong các thao tác sau:

o Để chỉnh sửa tệp khay hiện có, nhấp vào Select Existing (Chọn Khay Hiện Có) và tìm đến
tệp mục tiêu.

o Để chỉnh sửa tệp khay được hiển thị, chọn Edit Selected (Chỉnh Sửa Tệp Khay Đã Chọn).

Khay mục tiêu mở trong cửa sổ Plate Editor (Trình Chỉnh Sửa Khay).

2. Chọn File > Save As (Tệp Tin > Lưu Dưới Dạng) và lưu tệp tin khay bằng tên mới hoặc trong một thư
mục mới.
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Thiết Lập Tệp Khay Mới
Lời khuyên: Nếu tệp khay của bạn bao gồm các tham số bắt buộc (ví dụ như nếu bạn đang chỉnh
sửa khay mẫu hoặc tệp khay hiện có), bạn có thể bỏ qua mục này. Tiếp tục đến Gán Thông Số Tùy
Chọn cho Tập Tin Khay trên trang 137.

Các tệp khay mới yêu cầu các tham số sau:

n Plate size (Kích thước khay)

n Plate type (Loại khay)

n Chế độ quét

n Một chất huỳnh quang (thuốc nhuộm)

n Một loại mẫu

Chọn Kích Thước và Loại Khay

Quan trọng: Bạn phải chọn kích thước khay trong khi thiết lập khay. Bạn không thể thay đổi kích
thước khay trong hoặc sau khi chạy.

Phần mềm này áp dụng kích thước và loại khay cho tất cả các giếng trong khi chạy. Đảm bảo rằng kích
thước khay được chọn giống như khay bạn sẽ sử dụng trong khi chạy.

Các hệ thống CFX Opus Dx của Bio-Rad được hiệu chuẩn từ ban đầu cho nhiều kết hợp khay và thuốc
nhuộm huỳnh quang. Hiệu chuẩn dành riêng cho máy, thuốc nhuộm, và loại khay. Đảm bảo rằng thuốc
nhuộm huỳnh quang bạn dự định sử dụng được hiệu chuẩn cho loại khay bạn chọn.

Lời khuyên: Để hiệu chuẩn một kết hợp mới của thuốc nhuộm và loại khay trên một máy, chọn
Tools > Calibration Wizard (Công Cụ > Trình Hướng Dẫn Hiệu Chuẩn). Để biết thông tin về việc hiệu
chuẩn thuốc nhuộm và các loại khay, xem Hiệu Chuẩn Thuốc NhuộmMới trên trang 75.

Chọn Chế Độ Quét

Hệ thống CFX Opus 96 Dx và CFX Opus Deepwell Dx kích thích và phát hiện các chất huỳnh quang trong
năm kênh (ngoài FRET). Hệ thống CFX Opus 384 Dx kích thích và phát hiện các chất huỳnh quang trong
bốn kênh (ngoài FRET). Tất cả các hệ thống sử dụng nhiều chế độ quét thu thập dữ liệu để thu thập dữ
liệu về chất huỳnh quang trong lượt chạy.

CFX Maestro Dx SE cung cấp ba chế độ quét:

n Tất Cả Các Kênh

o Quét các kênh từ 1 đến 5 trên hệ thống CFX Opus 96 Dx và CFX Opus Deepwell Dx

o Quét các kênh 1 đến 4 trên hệ thống CFX Opus 384 Dx
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n SYBR®/FAM

o Chỉ quét kênh 1

o Cho phép quét nhanh

n FRET

o Chỉ quét kênh FRET

o Cho phép quét nhanh

Chọn Chất Phát Huỳnh Quang

Quan trọng: Trước khi bắt đầu lượt chạy, hệ thống CFX xác minh rằng chất huỳnh quang bạn chỉ
định trong khay được hiệu chuẩn trên máy đó. Bạn không thể chạy một khay nếu có chất huỳnh
quang chưa được hiệu chuẩn trên máy đó.

Bạn phải tải ít nhất một chất huỳnh quang lên bố cục khay trước khi chạy. Bạn có thể thêm nhiều chất
huỳnh quang nếu cần thiết vào thời điểm này nhưng khay phải chứa ít nhất một chất huỳnh quang. Các
chất huỳnh quang đã chọn xuất hiện dưới dạng các tùy chọn cho mục tiêu trong Target Names (Tên Mục
Tiêu).

Bạn sử dụng hộp thoại Select Fluorophores (Chọn Chất Huỳnh Quang) để nạp chất huỳnh quang (hoặc
thuốc nhuộm khay) vào các điều khiển nạp giếng của Plate Editor (Trình Chỉnh Sửa Khay). Các chất
huỳnh quang xuất hiện trong hộp thoại Select Fluorophores (Chọn Chất Huỳnh Quang) tùy thuộc vào chế
độ quét bạn chọn:

n Tất Cả Các Kênh

Tất cả các chất huỳnh quang có sẵn xuất hiện.

Lời khuyên: Bạn có thể thêm nhiều chất huỳnh quang nếu cần thiết, nhưng bạn chỉ có thể tải
một chất huỳnh quang cho mỗi kênh ở mỗi giếng.

n SYBR®/FAM

Chỉ chất huỳnh quang ở kênh 1 xuất hiện.

n FRET

Chỉ chất huỳnh quang ở kênh 6 xuất hiện.

Lời khuyên: Chất huỳnh quang FRET kênh 6 chỉ xuất hiện khi FRET là chế độ quét được chọn.
Tính năng này không khả dụng cho chế độ quét All Channels (Toàn Bộ Kênh).

Lưu ý: Bạn không thể trực tiếp thêm chất huỳnh quang vào hoặc xóa chúng khỏi hộp thoại Select
Fluorophore (Chọn Chất Phát Huỳnh Quang). Bạn phải hiệu chuẩn các chất huỳnh quang mới trên
máy bằng Calibration Wizard (Trình Hướng Dẫn Hiệu Chuẩn). Sau khi hiệu chuẩn, chất huỳnh quang
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mới được tự động thêm vào danh sách này. Để biết thêm thông tin, xem Hiệu Chuẩn Thuốc Nhuộm
Mới trên trang 75.

Chọn Các Loại Mẫu

Quan trọng: Bạn phải chọn ít nhất một loại mẫu để gán cho giếng khay trước khi chạy.

CFX Maestro Dx SE cung cấp năm loại mẫu:

n Ẩn số

n Tiêu chuẩn

n NTC (đối chứng không mẫu)

n Đối Chứng Dương

n Đối Chứng Âm

n NRT (đối chứng không enzyme phiên mã ngược)

Bạn gán các loại mẫu cho các giếng khay.

Thiết Lập Khay Mới

Cách thiết lập khay mới

1. Mở khay mới trong cửa sổ Plate Editor (Trình Chỉnh Sửa Khay).

2. Để đặt kích thước khay, chọn Settings > Plate Size (Cài Đặt > Kích Thước Khay) và chọn kích thước
khay thích hợp từ menu thả xuống.

3. Để đặt loại khay, chọn Settings > Plate Type (Cài Đặt > Loại Khay) và chọn BRWhite (BR Trắng)
hoặc BR Clear (BR Trong Suốt) từ menu thả xuống.

4. Không bắt buộc, từ menu Settings (Cài Đặt), bạn có thể thay đổi quy ước số và các đơn vị hiển thị:

n Để thay đổi quy ước số, chọn Settings > Number Convention (Cài Đặt > Quy Ước Số) và chọn
Scientific Notation (Ký Hiệu Khoa Học).

Lời khuyên: Scientific Notation (Ký Hiệu Khoa Học) được chọn mặc định. Trong trường
hợp này, việc chọn Scientific Notation (Ký Hiệu Khoa Học) sẽ xóa mặc định và đặt quy ước
số thành biểu mẫu chuẩn.

n Để thay đổi đơn vị hiển thị, chọn Settings > Units (Cài Đặt > Đơn Vị) và chọn giá trị đơn vị mới.

5. Để đặt chế độ quét, chọn chế độ quét thích hợp từ danh sách thả xuống Scan Mode (Chế Độ Quét)
trong thanh công cụ cửa sổ Plate Editor (Trình Chỉnh Sửa Khay).
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6. Chọn chất huỳnh quang cần thiết cho khay:

a. Trong ngăn bên phải, nhấp vào Select Fluorophores (Chọn Chất Phát Huỳnh Quang).

Hộp thoại Select Fluorophores (Chọn Chất Phát Huỳnh Quang) xuất hiện. Bạn sẽ thấy chất
huỳnh quang sẵn có dành cho kiểu chế độ quét mà bạn đã chọn trong Bước 5, ví dụ:

b. Để chọn một chất huỳnh quang, nhấp vào ô kiểm Selected (Được Chọn).

Lời khuyên: Để xóa một chất huỳnh quang ra khỏi danh sách, bỏ đánh dấu ô kiểm
Selected (Được Chọn).

c. Để thay đổi màu hiển thị của chất huỳnh quang, nhấp vào ô Color (Màu Sắc).

Lưu ý: Màu bạn chọn thể hiện cho chất huỳnh quang trong cả cửa sổ Plate Editor (Trình
Chỉnh Sửa Khay) và biểu đồ Data Analysis (Phân Tích Dữ Liệu).

d. Trong hộp thoại Color (Màu Sắc), chọn màu mà bạn muốn hoặc nhấp vào Define Custom Colors
(Xác Định Màu Tùy Chỉnh) và tạo màu mới để biểu thị chất huỳnh quang.

e. Nhấp vào OK để lưu các thay đổi và đóng hộp thoại Select Fluorophores (Chọn Chất Phát
Huỳnh Quang).
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7. Bạn phải chọn ít nhất một giếng để tải loại mẫu. Theo mặc định, giếng A1 được chọn.

Trong ngăn khay, thực hiện một trong các thao tác sau:

n Để tải nhiều giếng liền kề, nhấp vào giếng và kéo đến giếng mục tiêu.

n Để tải nhiều giếng không liền kề, giữ phím Control và nhấp vào từng giếng.

n Để tải toàn bộ cột có cùng loại mẫu, nhấp vào số cột.

n Để tải toàn bộ hàng, nhấp vào số hàng.

n Để tải toàn bộ khay, hãy nhấp vào góc trên bên trái của khay.

Ví dụ:

8. Gán một loại mẫu cho giếng hoặc các giếng được chọn từ menu thả xuống Sample Type (Loại Mẫu).
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9. Gán ít nhất một chất huỳnh quang cho tất cả các giếng có chứa một loại mẫu. Bạn có thể gán nhiều
hơn một chất huỳnh quang cho một giếng hoặc một nhóm giếng.

Lưu ý: Bạn chỉ có thể gán một chất huỳnh quang mỗi kênh. Bạn không thể gán nhiều hơn một
chất huỳnh quang từ cùng một kênh cho cùng một giếng.

Lời khuyên: Bạn có thể liên kết một mục tiêu với chất huỳnh quang hoặc bạn có thể chỉ cần gán
chất huỳnh quang cho giếng tại thời điểm này và liên kết một mục tiêu với chất huỳnh quang sau
khi bạn chạy thử nghiệm.

n Để chỉ gán một chất huỳnh quang cho các giếng được chọn, trong mục Target Names (Tên Mục
Tiêu) ở ngăn bên phải, chọn ngăn kiểm Load (Tải) cho chất huỳnh quang cụ thể.

n Để liên kết một mục tiêu với một chất huỳnh quang, trong mục Target Names (Tên Mục Tiêu)
chọn một tên mục tiêu từ danh sách thả xuống cho chất huỳnh quang cụ thể. Phần mềm tự động
chọn ô kiểm Load (Nạp).

10. Đối với các giếng có chứa một loại mẫu Standard (Tiêu Chuẩn), bạn phải nạp một nồng độ. Mỗi
giếng có thể có giá trị nồng độ khác nhau. Theo mặc định, CFX Maestro Dx SE nạp một nồng độ
1,00E+06 cho tất cả các giếng với loại mẫu Standard (Tiêu Chuẩn). Bạn có thể thay đổi giá trị nếu
cần thiết.

a. Trong ngăn khay, chọn một giếng Standard (Tiêu Chuẩn) hoặc một nhóm giếng.

b. Trong mục Concentration (Nồng Độ) nhấp vào Load (Tải) để tải giá trị cho giếng hoặc các giếng
đã chọn.

c. (Không bắt buộc) Để nạp nồng độ khác, nhập giá trị mới vào ô văn bản Concentration (Nồng Độ)
và nhấn enter.

d. Thực hiện bước này cho tất cả các giếng có loại mẫu Standard (Tiêu Chuẩn).

Lời khuyên: Để nạp cùng một nồng độ cho tất cả các giếng Standard (Tiêu Chuẩn), đảm
bảo rằng <All> (Tất Cả) xuất hiện trong danh sách thả xuống bên dưới giá trị Concentration
(Nồng Độ). Để nạp cùng một giá trị nồng độ cho tất cả các giếng với một chất huỳnh quang
cụ thể, hãy nhấp vào danh sách thả xuống và chọn chất huỳnh quang.

11. Nhấp OK để lưu khay mới.
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Nhấp chuột phải vào các mục trong menu cho Công cụ chỉnh sửa khay

Bảng 9 liệt kê các mục trong menu có sẵn trong công cụ Chỉnh sửa khay khi bạn nhấp chuột phải vào bất
kỳ giếng nào trong công cụ. Menu này cũng xuất hiện trong Chế độ xem/Nhập trang bảng tính.

Mục Chức Năng

Copy (Sao Chép) Sao chép toàn bộ trang bảng tính.

Copy as Image (Sao
Chép dưới dạng Hình
Ảnh)

Sao chép trang bảng tính dưới dạng tệp tin hình ảnh.

Print (In) In trang bảng tính.

Print Selection (Lựa
Chọn In)

Chỉ in các ô đã chọn.

Export to Excel (Xuất
sang Excel)

Xuất tệp tin sang trang bảng tính Excel.

Export to CSV (Xuất
sang CSV)

Xuất tệp tin dưới dạng tệp tin .csv.

Export to Xml (Xuất
sang Xml)

Xuất tệp tin dưới dạng tệp tin .xml.

Export to Html (Xuất
sang Html)

Xuất tệp tin dưới dạng tệp tin .html.

Find (Tìm) Tìm kiếm văn bản cụ thể.

Sort (Sắp Xếp) Sắp xếp trang bảng tính bằng cách chọn lên đến ba cột dữ liệu
trong cửa sổ Sort (Sắp Xếp).

Bảng 9. Các mục trong menu nhấp chuột phải trong công cụ Plate Spreadsheet
View/Importer (Xem/Nhập Trang Bảng Tính Khay)
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Gán Thông Số Tùy Chọn cho Tập Tin Khay
Một tệp khay có chứa thông tin về thành phần của mỗi giếng được tải với mẫu cho một lượt chạy. Sau khi
chạy, CFX Maestro Dx SE liên kết thành phần của giếng đến dữ liệu huỳnh quang được thu thập trong
protocol này và áp dụng phân tích thích hợp trong cửa sổ Data Analysis (Phân Tích Dữ Liệu).

Trong CFX Maestro Dx SE, bạn có thể gán các tham số cho mỗi giếng trong khay trước khi, trong khi
hoặc thậm chí sau khi bạn chạy các thử nghiệm. Bạn có thể gán các tham số cho một tệp khay hiện có
hoặc cho một tệp khay mới. Các tham số này bao gồm:

n Target names (Tên mục tiêu) —mục tiêu hoặc các mục tiêu quan tâm (gen hoặc trình tự) trong mỗi
giếng được tải.

n Sample names (Tên mẫu) —mã định danh hoặc điều kiện tương ứng với mẫu tải trong giếng,
chẳng hạn như mouse1, mouse2 hoặc mouse3.

n Biological groups (Nhóm sinh học) —mã định danh hoặc điều kiện tương ứng với nhóm giếng,
chẳng hạn như 0Hr, 1Hr, hoặc 2Hr.

Lời khuyên: Tên mục tiêu, tên mẫu, và nhóm sinh học phải giống nhau giữa các giếng để so
sánh dữ liệu trong tab Gene Expression (Biển Hiện Gen) của cửa sổ Data Analysis (Phân Tích
Dữ Liệu). Mỗi tên phải có kiểu viết hoa, chấm câu, và dấu cách giống nhau. Ví dụ: “Actin” không
giống với “actin”, “2Hr” không giống với “2 hr” và “Mouse 1” không giống với “mouse1”. Để đảm
bảo tính nhất quán của việc đặt tên, hãy nhập tên vào phần Libraries (Thư Viện) trong User >
User Preferences > Plate (Người Dùng> Ưu Tiên của Người Dùng> Khay) trên cửa sổ Trang
Chủ.

n Technical replicates (Bản sao kỹ thuật) —mỗi giếng được sử dụng để phân tích cùng một cách kết
hợp mẫu và mục tiêu; đó là các phản ứng qPCR trùng lặp.

n Dilution series (Dãy pha loãng dần) — số lượng để thay đổi nồng độ của loại mẫu Tiêu Chuẩn trong
một nhóm trùng lặp để tạo ra dữ liệu đường cong tiêu chuẩn để phân tích.

Chỉ Định Mục Tiêu cho Giếng
Lời khuyên: Bạn có thể gán cùng tên mục tiêu cho một hoặc nhiều giếng. Bạn cũng có thể gán
nhiều mục tiêu cho cùng một giếng.

Quan trọng: Nhấp OK sau khi gán một mục tiêu để lưu các thay đổi và tắt năng Undo (Khôi Phục)
trên thanh công cụ Plate Editor (Trình Chỉnh Sửa Khay). Hãy cẩn thận khi nhấp OK.
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Để gán một mục tiêu vào giếng hoặc nhóm giếng

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), đảm bảo rằng giếng hoặc nhóm giếng đã được gán loại
mẫu.

Xem Chọn Các Loại Mẫu trên trang 132 để biết thông tin về gán các loại mẫu cho giếng.

2. Trong ngăn khay, chọn giếng hoặc nhóm giếng:

n Để chọn một giếng, nhấp vào giếng.

n Để chọn nhiều giếng liền kề, nhấp vào giếng và kéo đến giếng mục tiêu.

n Để chọn nhiều giếng không liền kề, giữ phím Control và nhấp vào từng giếng.

n Để chọn toàn bộ cột có cùng loại mẫu, nhấp vào số cột.

n Để chọn toàn bộ hàng, nhấp vào số hàng.

3. Ở ngăn bên phải, hãy chọn tên từ danh sách thả xuống Target Name (Tên Mục Tiêu) cho mỗi chất
huỳnh quang đã chọn.

4. Lặp lại Bước 3 cho mỗi giếng hoặc nhóm giếng mà bạn phải gán mục tiêu.

Lời khuyên: Bạn có thể gán tên mục tiêu giống hoặc khác nhau cho mỗi chất huỳnh quang đã
chọn.

5. Nhấp OK để chấp nhận các thay đổi và lưu khay.

Lưu ý: Nếu bạn thay đổi khay bị lỗi, nhấp Undo (Khôi Phục) trên thanh công cụ Plate Editor
(Trình Chỉnh Sửa Khay) trước khi nhấp OK để chấp nhận các thay đổi.

Cách xóa một tên mục tiêu

u Để xóa một tên mục tiêu khỏi giếng hoặc nhóm giếng đã chọn, hãy xóa ô kiểm Load (Tải).

Quan trọng: Việc xóa tên mục tiêu khỏi giếng cũng xóa chất huỳnh quang liên kết với giếng đó.
Hãy cẩn thận khi xóa tên mục tiêu khỏi giếng.

Cách thêm tên mục tiêu vào danh sách

u Để thêm tên mục tiêu vào danh sách thả xuống, thực hiện một trong các thao tác sau:

n Nhập tên vào danh sách thả xuống Target Name (Tên Mục Tiêu) và nhấn Enter.
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Lời khuyên: Tên mục tiêu mà bạn thêm vào một danh sách xuất hiện trong tất cả các danh
sách mục tiêu khác.

n Nhấp vào biểu tượng dấu + màu xanh lá cây ở bên phải danh sách thả xuống, nhập một tên cho
mục tiêu và nhấn Enter.

n Nhấp User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ và thêm tên đó vào thư
viện Target Names (Tên Mục Tiêu) trong tab Plate (Khay).

Quan trọng: Tên mục tiêu mà bạn thêm vào danh sách thả xuống chỉ khả dụng cho khay hiện
tại, và chỉ khi bạn gán tên cho giếng và lưu bố cục khay. Nếu bạn không gán tên cho giếng và lưu
bố cục khay, tên sẽ không được lưu và không khả dụng để sử dụng trong tương lai. Để thêm
vĩnh viễn một tên mục tiêu, hãy thêm vào thư viện Target Names (Tên Mục Tiêu) bằng cách sử
dụng hộp thoại User Preferences (Ưu Tiên của Người Dùng). Các tên mà bạn thêm vào thư viện
sẽ khả dụng sau khi bạn mở lại Plate Editor (Trình Chỉnh Sửa Khay). Xem Cài Đặt Các Tham Số
Khay Mặc Định trên trang 86 để biết thêm thông tin.

Cách xóa tên mục tiêu khỏi danh sách

1. Nhấp User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ.

Hộp thoại User Preferences (Ưu Tiên của Người Dùng) xuất hiện, hiển thị tab Plate (Khay).

2. Trong thư viện Target Names (Tên Mục Tiêu) trong tab Plate (Khay), chọn tên để xóa và nhấn phím
Delete (Xóa).

3. Nhấp OK để lưu các thay đổi và thoát hộp thoại User Preferences (Ưu Tiên của Người Dùng).

Quan trọng: Bạn không thể xóa tên mục tiêu mà bạn đã lưu với tệp khay. Tên tùy chỉnh mà bạn
thêm vào danh sách thả xuống Target Names (Tên Mục Tiêu) và không sử dụng và lưu với khay
được tự động xóa khỏi danh sách. Tên mà bạn xóa khỏi Target Names Library (Thư Viện Tên
Mục Tiêu) được xóa vĩnh viễn khỏi phần mềm và không còn khả dụng cho người dùng. Hãy cẩn
thận khi xóa tên mục tiêu.

Chỉ Định Tên Mẫu Cho Giếng
Lưu ý: Để gán một tên mẫu, bạn phải gán cho các giếng đã chọn ít nhất một chất huỳnh quang. Nếu
giếng đã chọn không được gán một chất huỳnh quang, danh sách thả xuống Sample Names (Tên
Mẫu) sẽ bị tắt. Xem Chỉ Định Mục Tiêu cho Giếng trên trang 137 để biết thông tin về việc gán chất
huỳnh quang.

Lời khuyên: Bạn chỉ có thể gán một tên mẫu cho mỗi giếng hoặc nhóm giếng.
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Cách gán tên mẫu cho một giếng hoặc nhóm giếng

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), đảm bảo rằng giếng hoặc nhóm giếng đã được gán chất
huỳnh quang.

2. Trong ngăn khay, chọn giếng hoặc nhóm giếng.

3. Trong ngăn bên phải, chọn tên trong danh sách thả xuống Sample Names (Tên Mẫu).

Phần mềm tự động chọn ô kiểm Load (Tải).

4. Lặp lại Bước 3 cho mỗi giếng hoặc nhóm giếng mà bạn phải gán một tên mẫu.

5. Nhấp OK để chấp nhận các thay đổi và lưu khay.

Lưu ý: Nếu bạn thay đổi khay bị lỗi, nhấp Undo (Khôi Phục) trên thanh công cụ Plate Editor
(Trình Chỉnh Sửa Khay) trước khi nhấp OK để chấp nhận các thay đổi.

Cách xóa một tên mẫu

u Để xóa một tên mẫu khỏi giếng hoặc nhóm giếng đã chọn, xóa ô kiểm Load (Tải) của giếng đó.

Cách thêm một tên mẫu vào danh sách này

u Để thêmmột tên mẫu vào danh sách thả xuống này, thực hiện một trong các thao tác sau:

n Nhập tên vào danh sách thả xuống Sample Names (Tên Mẫu) và nhấn Enter.

n Nhấp vào biểu tượng dấu + màu xanh lá cây ở bên phải của danh sách thả xuống và nhập tên
cho mẫu này.

n Nhấp User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ và thêm tên vào thư viện
Sample Names (Tên Mẫu) trong tab Plate (Khay).

Quan trọng: Tên mẫu mà bạn thêm trong danh sách thả xuống chỉ khả dụng đối với khay hiện
tại, và chỉ khi bạn gán tên cho giếng và lưu bố cục khay. Nếu bạn không gán tên cho giếng và lưu
bố cục khay, tên sẽ không được lưu và không khả dụng để sử dụng trong tương lai. Để thêm
vĩnh viễn một tên mẫu, hãy thêm tên này vào thư viện Sample Names (Tên Mẫu) bằng cách sử
dụng hộp thoại User Preferences (Ưu Tiên của Người Dùng). Các tên mà bạn thêm vào thư viện
sẽ khả dụng sau khi bạn mở lại Plate Editor (Trình Chỉnh Sửa Khay). Xem Cài Đặt Các Tham Số
Khay Mặc Định trên trang 86 để biết thêm thông tin.
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Cách xóa một tên mẫu khỏi danh sách này

1. Nhấp User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ.

Hộp thoại User Preferences (Ưu Tiên của Người Dùng) xuất hiện, hiển thị tab Plate (Khay).

2. Trong thư viện Sample Names (Tên Mẫu) trong tab Plate (Khay), chọn tên cần xóa và nhấn phím
Delete (Xóa).

3. Nhấp OK để lưu các thay đổi và thoát hộp thoại User Preferences (Ưu Tiên của Người Dùng).

Quan trọng: Bạn không thể xóa tên mẫu mà bạn đã lưu với tệp khay. Tên tùy chỉnh mà bạn
thêm vào danh sách Sample Names (Tên Mẫu) và không sử dụng và lưu với khay được tự động
xóa khỏi danh sách thả xuống. Tên mà bạn xóa khỏi Sample Names Library (Thư Viện Tên Mẫu)
được xóa khỏi phần mềm và không còn khả dụng cho người dùng nữa. Cẩn thận khi xóa tên
mẫu.

Gán Nhóm Sinh Học Cho Giếng
Lưu ý: Để gán một nhóm sinh học, bạn phải gán cho các giếng đã chọn ít nhất một chất huỳnh
quang. Việc gán chất huỳnh quang kích hoạt danh sách thả xuống Biological Groups (Nhóm Sinh
Học). Xem Chỉ Định Mục Tiêu cho Giếng trên trang 137 để biết thông tin về việc gán chất huỳnh
quang.

Lời khuyên: Bạn có thể gán một nhóm sinh học cho mỗi giếng hoặc nhóm giếng.

Cách gán một nhóm sinh học cho mỗi giếng hoặc nhóm giếng.

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), đảm bảo rằng giếng hoặc nhóm giếng đã được gán chất
huỳnh quang.

2. Trong ngăn khay, chọn giếng hoặc nhóm giếng.

3. Trong ngăn bên phải, hãy chọn từ danh sách thả xuống Biological Group (Nhóm Sinh Học) .

CFX Maestro Dx SE tự động chọn ô kiểm Load (Tải).

4. Lặp lại Bước 3 cho mỗi giếng hoặc nhóm giếng mà bạn phải gán một nhóm sinh học.

5. Nhấp OK để chấp nhận các thay đổi và lưu khay.
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Lưu ý: Nếu bạn thay đổi khay bị lỗi, nhấp Undo (Khôi Phục) trên thanh công cụ Plate Editor
(Trình Chỉnh Sửa Khay) trước khi nhấp OK để chấp nhận các thay đổi.

Cách xóa nhóm sinh học

u Để xóa một nhóm sinh học khỏi giếng hoặc nhóm giếng đã chọn, hãy bỏ chọn ô kiểm Load (Tải).

Cách thêm một nhóm sinh học vào danh sách

u Để thêm nhóm sinh học vào danh sách thả xuống, hãy thực hiện một trong các thao tác sau:

n Nhập tên vào ô thả xuống Biological Group (Nhóm Sinh Học) và nhấn Enter.

n Nhấp vào màu xanh lá cây + biểu tượng ở bên phải của danh sách thả xuống và nhập tên cho
nhóm sinh học.

n Nhấp vào User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ và thêm tên đó vào
thư viện Biological Names (Tên Nhóm Sinh Học) trong tab Plate (Khay).

Quan trọng: Tên nhóm sinh học mà bạn thêm vào danh sách thả xuống chỉ dùng được cho
khay hiện tại và chỉ khi bạn gán tên này cho giếng và lưu bố cục khay. Nếu bạn không gán tên
cho giếng và lưu bố cục khay, tên sẽ không được lưu và không khả dụng để sử dụng trong
tương lai. Để thêm vĩnh viễn tên nhóm sinh học, hãy thêm tên đó vào cả thư viện Biological
Group Names (Tên Nhóm Sinh Học) bằng hộp thoại User Preferences (Ưu Tiên của Người
Dùng). Các tên mà bạn thêm vào thư viện sẽ khả dụng sau khi bạn mở lại Plate Editor (Trình
Chỉnh Sửa Khay). Xem Cài Đặt Các Tham Số Khay Mặc Định trên trang 86 để biết thêm thông
tin.

Cách xóa tên nhóm sinh học khỏi danh sách

1. Nhấp User Preferences (Ưu Tiên của Người Dùng) trên thanh công cụ.

Hộp thoại User Preferences (Ưu Tiên của Người Dùng) xuất hiện, hiển thị tab Plate (Khay).

2. Trong thư viện Biological Group Names (Tên Nhóm Sinh Học) trong tab Plate (Khay), chọn tên cần
xóa và nhấn phím Delete (Xóa).

3. Nhấp OK để lưu các thay đổi và thoát hộp thoại User Preferences (Ưu Tiên của Người Dùng).

Quan trọng: Bạn không thể xóa tên nhóm sinh học mà bạn đã lưu với một tệp khay. Tên tùy
chỉnh mà bạn thêm vào danh sách thả xuống Biological Group Names (Tên Nhóm Sinh Học) và
không sử dụng và lưu với khay được tự động xóa khỏi danh sách này. Tên bạn xóa khỏi thư viện
Biological Group Names (Tên Nhóm Sinh Học) được xóa vĩnh viễn khỏi phần mềm và người
dùng không sử dụng được nữa. Hãy cẩn thận khi xóa tên sinh học.
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Cách xem tất cả các nhóm sinh học trên khay

u Nhấp vào Show Biological Groups (Hiển Thị Nhóm Sinh Học) để xem tất cả nhóm sinh học trên khay
này.

Mỗi nhóm được xác định bằng một màu cụ thể và nút Show Biological Groups (Hiển Thị Nhóm Sinh
Học) thay đổi thành Hide Biological Groups (Ẩn Nhóm Sinh Học).

Nhấp vào Hide Biological Groups (Ẩn Nhóm Sinh Học) để xóa màu trong các giếng. Ngoài ra, bạn có
thể nhấp vào bất kỳ giếng nào trong khay này để ẩn nhóm sinh học.

Chỉ Định Số Bản Sao Kỹ Thuật Cho Giếng
Quan trọng: Để gán số bản sao kỹ thuật, các giếng đã chọn phải có thành phần giếng đồng nhất.
Nghĩa là, các giếng đã chọn phải có cùng loại mẫu và chất huỳnh quang. Nếu thích hợp, các giếng
cũng phải được gán cùng tên mục tiêu và tên mẫu và nhóm sinh học. Nếu không giống nhau, CFX
Maestro Dx SE không bật tùy chọn này.

Cách gán số bản sao kỹ thuật cho nhóm giếng

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), đảm bảo rằng nội dung của các nhóm giếng đã đồng
nhất.

2. Trong ngăn khay, chọn nhóm giếng mục tiêu.

3. Để gán cùng một số bản sao cho tất cả các giếng đã chọn, trong mục Replicate # (Số Bản Sao) trong
ngăn bên phải, nhập số tái tạo vào ô và chọn Load (Tải).

4. (Không bắt buộc) Cách áp dụng chuỗi bản sao vào tập hợp các giếng đã chọn:
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a. Nhấp vào Technical Replicates (Bản Sao Kỹ Thuật). Mục Replicate # (Số Bản Sao) thay đổi để
hiển thị các tùy chọn sau đây:

n Replicate size (Kích cỡ bản sao) — số cho biết số lượng giếng trong mỗi nhóm bản sao

n Starting replicate # (Số bản sao bắt đầu) — số đầu tiên trong dãy bản sao cho nhóm bản
sao đã chọn

Lưu ý: Theo mặc định, CFX Maestro Dx SE hiển thị số bản sao bắt đầu là một số lớn hơn
số bản sao kỹ thuật gần nhất được gán trong khay này. Ví dụ: nếu số bản sao kỹ thuật gần
nhất trong khay là năm, số bắt đầu tiếp theo là sáu. Bạn có thể thay đổi số bắt đầu thành bất
kỳ số nào chưa được gán.

n Hướng tải (Ngang hoặc Dọc)

b. Nhấp vào Apply (Áp Dụng) để áp dụng các tham số cho các chuỗi và trở về màn hình hiển thị
Replicate # (Số Bản Sao).

5. Nhấp OK để chấp nhận các thay đổi và lưu khay.

Lưu ý: Nếu bạn thay đổi khay bị lỗi, nhấp Undo (Khôi Phục) trên thanh công cụ Plate Editor
(Trình Chỉnh Sửa Khay) trước khi nhấp OK để chấp nhận các thay đổi.

Cách xóa một giếng khỏi chuỗi bản sao

u Chọn giếng hoặc nhóm giếng cần xóa và bỏ chọn ô kiểm Replicate # Load (Tải Số Bản Sao).

Ngoài ra, bạn có thể nhấp vào Clear Replicate # (Xóa Số Bản Sao) để xóa số bản sao khỏi giếng
hoặc nhóm giếng đã chọn.

Cách xem tất cả các bản sao kỹ thuật trên khay này

u Nhấp vào Show Technical Replicates (Hiển Thị Bản Sao Kỹ Thuật) để xem tất cả bản sao kỹ thuật
trên khay này.

Mỗi nhóm được xác định bằng một màu cụ thể và nút Show Technical Replicates (Hiển Thị Bản Sao
Kỹ Thuật) thay đổi thành Hide Technical Replicates (Ẩn Bản Sao Kỹ Thuật).

Nhấp vào Hide Technical Replicates (Ẩn Bản Sao Kỹ Thuật) để xóa màu sắc trong giếng. Ngoài ra,
bạn có thể nhấp vào bất kỳ giếng nào trong khay để ẩn các bản sao kỹ thuật.
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Gán Dãy Pha Loãng Dần Cho Mẫu Tiêu Chuẩn
Như đã đề cập trước đó, tất cả các giếng có loại mẫu Tiêu Chuẩn phải được gán một giá trị nồng độ. Bạn
có thể gán dãy pha loãng dần cho nhiều giếng với loại mẫu Tiêu Chuẩn.

Lưu ý: Để gán dãy pha loãng dần cho một nhóm giếng, các giếng này phải được bao gồm trong
chuỗi bản sao kỹ thuật. Xem Chỉ Định Số Bản Sao Kỹ Thuật Cho Giếng trên trang 143 để biết thông
tin về việc thêm giếng vào chuỗi bản sao.

Cách gán dãy pha loãng dần cho một nhóm giếng mẫu Tiêu Chuẩn

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), đảm bảo đáp ứng những yêu cầu sau đây:

n Loại mẫu cho nhóm giếng là Tiêu Chuẩn.

n Tất cả các giếng trong nhóm được gán ít nhất một chất huỳnh quang và tất cả có cùng một chất
huỳnh quang.

n Tất cả các giếng trong nhóm có cùng chuỗi bản sao kỹ thuật.

Lưu ý: CFXMaestro Dx SE kích hoạt tùy chọn Dilution Series (Dãy Pha Loãng Dần) chỉ khi
tất cả các giếng đã chọn đáp ứng các tiêu chí này.

2. Trong ngăn khay, chọn nhóm giếng mục tiêu.

3. Trong mục Concentration (Nồng Độ) ở ngăn bên phải, nhấp vào Dilution Series (Dãy Pha Loãng
Dần). Mục Concentration (Nồng Độ) thay đổi để hiển thị các tùy chọn sau đây:

n Nồng độ khi bắt đầu—giá trị nồng độ từ đó bắt đầu chuỗi

n Sao chép từ và đến—bản sao trong chuỗi mà những hệ số pha loãng dần sẽ được sử dụng

n Hệ số pha loãng—số lượng thay đổi nồng độ trong mỗi nhóm bản sao

4. Đặt giá trị cho các tùy chọn hoặc chấp nhận giá trị mặc định.

5. Theo mặc định, dãy pha loãng giảm theo hệ số pha loãng. Chọn Increasing (Tăng) để tăng dãy pha
loãng.
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6. (Tùy chọn) Theo mặc định, hệ số pha loãng áp dụng cho tất cả các chất huỳnh quang trong chuỗi bản
sao. Nếu chuỗi của bạn chứa nhiều hơn một chất huỳnh quang và bạn muốn dùng chất pha loãng
cho một chất huỳnh quang, chọn từ danh sách thả xuống.

7. Nhấp vào Apply (Áp Dụng) để sử dụng dãy pha loãng dần cho nhóm giếng và trả về chế độ xem
Concentration (Nồng Độ).

8. Nhấp OK để chấp nhận các thay đổi và lưu khay.

Sao Chép Nội Dung Giếng vào Một Giếng Khác
Bạn có thể sao chép các nội dung của một giếng và dán vào một hoặc nhiều giếng. Tuy nhiên, bạn chỉ có
thể sao chép nội dung của một giếng đơn lẻ. Bạn không thể chọn nhiều giếng và sao chép nội dung của
chúng.

Cách sao chép nội dung giếng vào một giếng khác

1. Trong ngăn khay, chọn giếng sẽ được sao chép.

2. Nhấp chuột phải vào giếng và chọn Copy Well (Sao Chép Giếng).

3. Chọn giếng hoặc các giếng mà sẽ dán nội dung vào đó:

n Để chọn một giếng, nhấp vào giếng.

n Để chọn nhiều giếng liền kề, nhấp vào giếng và kéo đến giếng mục tiêu.

n Để chọn nhiều giếng không liền kề, giữ phím Control và nhấp vào từng giếng.

4. Với các giếng mục tiêu đã chọn, nhấp chuột phải và chọn Paste Well (Dán Giếng).

CFX Maestro Dx SE dán các nội dung của giếng đầu tiên vào các giếng được chọn.

Thêm Ghi Chú cho Giếng
Bạn có thể thêm ghi chú mô tả cho giếng. Bạn có thể xem các ghi chú cho giếng trong tab Quantification
(Định Lượng) trong cửa sổ Data Analysis (Phân Tích Dữ Liệu).

Để thêm ghi chú cho giếng

1. Trong ngăn khay, chọn giếng hoặc các giếng mà bạn dự định thêm ghi chú.

2. Trong mục View (Chế Độ Xem) ở ngăn dưới cùng, chọnWell Note (Ghi Chú cho Giếng).

Vùng Ghi Chú cho Giếng xuất hiện ở ngăn bên phải.

146 | Phần Mềm CFXMaestro Dx SE



Gán Thông Số Tùy Chọn cho Tập Tin Khay

3. Nhập nội dung ghi chú trong ô văn bản và nhấn Enter (Nhập).

Phần văn bản sẽ xuất hiện ở phía dưới cùng của giếng đã chọn.

Lời khuyên: Nếu bạn đã tạo một lưu ý về giếng trước đó, bạn có thể chọn từ danh sách thả
xuống và áp dụng vào các giếng được chọn.

Xóa Tất Cả Nội Dung Của Giếng
Bạn có thể xóa nội dung của một giếng lẻ, một nhóm giếng, hoặc toàn bộ khay. Việc xóa giếng không xóa
bỏ các dữ liệu huỳnh quang thu thập được trong khi đọc khay.

Quan trọng: Xóa giếng đồng nghĩa với xóa vĩnh viễn thành phần khỏi giếng. Nếu bạn nhấp OK và
lưu khay sau khi xóa một giếng, bạn không thể khôi phục thao tác xóa đó. Hãy thận trọng khi xóa
giếng.

Để xóa giếng của tất cả các cài đặt

1. Trong Plate Editor (Trình Chỉnh Sửa Khay), chọn giếng hoặc nhóm giếng trong ngăn khay:

n Để chọn một giếng, nhấp vào giếng.

n Để chọn nhiều giếng liền kề, nhấp vào giếng và kéo đến giếng mục tiêu.

n Để chọn nhiều giếng không liền kề, giữ phím Control và nhấp vào từng giếng.

n Để chọn toàn bộ cột có cùng loại mẫu, nhấp vào số cột.

n Để chọn toàn bộ hàng, nhấp vào số hàng.

2. Trong ngăn bên phải, nhấp vào Clear Wells (Xóa Giếng).

CFX Maestro Dx SE xóa tất cả các cài đặt cho giếng đã chọn.

3. Thực hiện một trong các thao tác sau:

n Nếu bạn xóa giếng bị lỗi, nhấp Undo (Khôi Phục) trên thanh công cụ Plate Editor ( Trình Chỉnh
Sửa Khay) trước khi nhấp OK để chấp nhận các thay đổi.

Quan trọng: Nhấp vào OK trước khi bạn nhấp vào Undo (Khôi Phục) sẽ lưu các thay đổi và
tắt chức năng Undo (Khôi Phục) trên thanh công cụ Plate Editor (Trình Chỉnh Sửa Khay).

n Nhấp OK để chấp nhận các thay đổi và lưu khay.
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Thay Đổi Cài Đặt Thí Nghiệm
Sử dụng hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm) để xem hoặc thay đổi danh sách các mục
tiêu, mẫu, hay nhóm sinh học, hoặc để cài đặt nhómmẫu phân tích biểu hiện gen để phân tích nếu bạn đã
gán nhóm sinh học cho các giếng trong khay.

Trong hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm), tab Targets (Các Mục Tiêu) hiển thị danh
sách tên các mục tiêu cho từng phản ứng PCR, như gen mục tiêu hay các chuỗi gen quan tâm.

Trang Samples and Biological Groups (Các Mẫu Và Nhóm Sinh Học) hiển thị danh sách tên các mẫu và
nhóm sinh học biểu thị nguồn của mục tiêu, ví dụ như mẫu lấy ở thời điểm 1 giờ (1Hr) hoặc từ một cá thể
cụ thể (mouse1).

Để thay đổi cài đặt khay sử dụng hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm)

1. Để mở hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm), thực hiện một trong các thao tác sau:

n Trong ngăn bên phải của Plate Editor (Trình Chỉnh Sửa Khay), nhấp vào Experiment Settings
(Cài Đặt Thí Nghiệm).

n Trong tab Gene Expression (Biểu Hiện Gen) trong cửa sổ Data Analysis (Phân Tích Dữ Liệu),
nhấp vào Experiment Settings (Cài Đặt Thí Nghiệm).

Hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm) xuất hiện hiển thị nội dung của tab Targets (Các
Mục Tiêu).

2. Để thêmmột tên mục tiêu, mẫu hoặc nhóm sinh học mới, trong tab thích hợp, hãy nhập một tên vào ô
văn bản New (Tạo Mới) và nhấp vào Add (Thêm).
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3. Để gỡ một hoặc nhiều tên mục tiêu, mẫu hoặc nhóm sinh học khỏi danh sách, trong tab thích hợp,
hãy chọn ô kiểm tương ứng của mục trong cột Select to Remove (Chọn để Xóa) và nhấp vào
Remove checked item(s) (Xóa (các) mục được đánh dấu).

4. CFX Maestro Dx SE loại trừ loại mẫu NTC (đối chứng không mẫu) khỏi phân tích biểu hiện gen.

Để bao gồm các loại mẫu NTC, xóa ô kiểm trong mục Exclude the following sample types (Loại trừ
các loại mẫu sau). Bạn có thể chọn loại trừ các loại mẫu sau bằng cách chọn ô kiểm phù hợp:

n NRT (đối chứng không enzyme phiên mã ngược)

n Đối Chứng Âm

n Đối Chứng Dương

n Tiêu chuẩn

5. Trong tab Targets (Các Mục Tiêu):

a. Để chọn một mục tiêu làm tham chiếu cho phân tích dữ liệu biểu hiện gen, hãy chọn trong cột
Reference (Tham Chiếu).

b. Để ẩn cài đặt phân tích sẽ được áp dụng trong tab Gene Expression (Biểu Hiện Gen) ở cửa sổ
Analysis Settings (Cài Đặt Phân Tích), xóa Show Analysis Settings (Hiển Thị Cài Đặt Phân
Tích).

Phần mềm sẽ ẩn các cột sau:

n Color (Màu)

n Show Chart (Hiển Thị Biểu Đồ)

n Auto Efficiency (Hiệu Suất Tự Động)

n Efficiency (Hiệu Suất) (%)

c. Để đổi màu của mục tiêu khi được vẽ đồ thị trong biểu đồ Gene Expression (Biểu Hiện Gen),
nhấp vào ô trong cột Color (Màu), chọn một màu mới trong hộp thoại Color (Màu) sẽ xuất hiện,
và nhấp OK.

d. Để hiển thị mục tiêu trong màu được chọn ở biểu đồ Gene Expression (Biểu Hiện Gen), chọn ô
kiểm trong cột Show Chart (Hiển Thị Biểu Đồ).

e. Theo mặc định, CFX Maestro Dx SE tự động tính hiệu suất tương đối cho một mục tiêu nếu dữ
liệu có bao gồmmột đường cong tiêu chuẩn.

Để dùng một giá trị hiệu suất đã xác định từ trước, nhập giá trị vào ô trong cột Efficiency (Hiệu
Suất) (%) và nhấn phím Enter. CFX Maestro Dx SE bỏ chọn ô kiểm Auto Efficiency (Hiệu Suất
Tự Động).
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6. Trong tab Samples and Biological Groups (Mẫu và Nhóm Sinh Học):

a. Để chọn một mẫu hay nhóm sinh học làm mẫu đối chứng để phân tích dữ liệu biểu hiện gen,
chọn ô kiểm tương ứng trong cột Control (Đối Chứng).

b. Để gán điều kiện đối chứng cho một mẫu hay nhóm sinh học cho một lượt chạy, chọn ô kiểm
tương ứng trong cột Control (Đối Chứng).

c. Nếu chưa được chọn, nhấp vào Show Analysis Settings (Hiển Thị Cài Đặt Phân Tích) để xem
hoặc thay đổi các tham số phân tích sẽ được áp dụng trong tab Gene Expression (Biểu Hiện
Gen). Phần mềm sẽ ẩn các cột Color (Màu) và Show Chart (Hiển Thị Biểu Đồ).

7. Nhấp OK để lưu các tham số trong hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm) và quay lại
cửa sổ Plate Editor (Trình Chỉnh Sửa Khay).
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Tạo Các Nhóm Giếng
Các nhóm giếng chia khay đơn lẻ thành các tập hợp con giếng có thể được phân tích độc lập trong cửa
sổ Data Analysis (Phân Tích Dữ Liệu). Sau khi các nhóm giếng được thiết lập, chọn một nhóm giếng
trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) để phân tích dữ liệu dưới dạng một nhóm độc lập. Ví dụ,
thiết lập các nhóm giếng để phân tích lượt chạy nhiều thử nghiệm trong một khay hoặc để phân tích từng
nhóm giếng với một đường cong chuẩn khác.

Lưu ý: Nhóm giếng mặc định là All Wells (Toàn Bộ Giếng).

Cách tạo các nhóm giếng

1. Để mởWell Groups Manager (Trình Quản Lý Nhóm Giếng), thực hiện một trong các thao tác sau:

n Trong thanh công cụ Plate Editor (Trình Chỉnh Sửa Khay), nhấpWell Groups (Nhóm Giếng).

n Trong cửa Sổ Data Analysis (Phân Tích Dữ Liệu), nhấp ManageWell Groups (Quản Lý Các
Nhóm Giếng).

Hộp thoại Well Groups Manager (Trình Quản Lý Nhóm Giếng) xuất hiện.

2. Nhấp Add (Thêm) để tạo một nhómmới. Menu thả xuống hiển thị tên nhóm là Group 1 (Nhóm 1) cho
nhóm đầu tiên.

3. Chọn các giếng cho nhóm giếng trong chế độ xem khay bằng cách nhấp và kéo ngang qua nhóm
giếng. Các giếng đã chọn xuất hiện có màu xanh dương trong Manager (Trình Quản Lý).
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4. (Tùy chọn) Để thay đổi tên của nhóm, chọn tên nhóm trong menu thả xuống và nhập tên mới.

5. (Tùy chọn) Để xóa một nhóm giếng, chọn tên nhóm trong danh sách thả xuống và nhấp Delete (Xóa).

6. Nhấp OK để kết thúc và đóng cửa sổ, hoặc nhấp Cancel (Hủy) để đóng cửa sổ mà không thực hiện
các thay đổi.

Các Mục Trong Menu Nhấp Chuột Phải đối với Hộp Thoại Well Groups Manager
(Trình Quản Lý Nhóm Giếng)

Bảng 10 liệt kê các mục trong menu có sẵn trong hộp thoại Well Groups Manager (Trình Quản Lý Nhóm
Giếng) khi bạn nhấp chuột phải vào giếng bất kỳ.

Mục Chức Năng

Copy (Sao Chép) Sao chép các nội dung giếng để sau đó có thể dán vào một
hoặc nhiều giếng khác.

Copy as Image (Sao Chép dưới
dạng Hình Ảnh)

Sao chép chế độ xem bộ chọn giếng dưới dạng hình ảnh.

Print (In) In chế độ xem bộ chọn giếng.

Print Selection (Lựa Chọn In) Chỉ in các ô đã chọn.

Export to Excel (Xuất sang
Excel)

Xuất dữ liệu sang trang tính Excel.

Export to CSV (Xuất sang CSV) Xuất dữ liệu dưới dạng tài liệu phân cách bằng dấu phẩy.

Export to Xml (Xuất sang Xml) Xuất dữ liệu dưới dạng tài liệu .xml.

Export to Html (Xuất sang Html) Xuất dữ liệu dưới dạng tài liệu .html.

Bảng 10. Các mục trong menu nhấp chuột phải trong hộp thoại Plate Editor Well
Selector (Trình Quản Lý Nhóm Giếng Khi Chỉnh Sửa Khay)
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Thay Đổi Kiểu Vạch Đồ Họa
Trong thời gian thiết lập khay và trong khi một lượt chạy đang diễn ra, bạn có thể sửa đổi màu và kiểu của
vạch đồ họa khuếch đại. Sau đó bạn có thể dễ dàng xem các vạch đồ họa trong cửa sổ trạng thái thời
gian thực khi dữ liệu được thu thập.

Để thay đổi các kiểu vạch đồ họa

1. Nhấp vào Trace Styles (Kiểu Vạch Đồ Họa) trong thanh công cụ Plate Editor (Trình Chỉnh Sửa
Khay).

Hộp thoại Trace Styles (Kiểu Vạch Đồ Họa) xuất hiện cho khay đang mở, ví dụ:

2. Để hiển thị kiểu vạch đồ họa theo một chất huỳnh quang cụ thể, chọn từ mục thả xuống Fluorophores
(Chất Phát Huỳnh Quang).

3. Cách thay đổi hiển thị vạch đồ họa:

a. Chọn loại vạch đồ họa từ danh sách thả xuốngWells (Giếng).

b. Nhấp vào màu của dấu vết trong cột Color (Màu).

c. Trong hộp thoại Color (Màu) xuất hiện, chọn một màu khác cho vạch đồ họa đó và nhấp OK.

CFX Maestro Dx SEhiển thị sự thay đổi màu sắc cho loại giếng dưới dạng ô lưới.

d. (Không bắt buộc) Chọn một biểu tượng cho vạch đồ họa từ danh sách thả xuống Symbols (Biểu
Tượng).
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4. Để thay đổi nhanh bộ màu, nhấp vào lựa chọn phù hợp trong mục Color Quick Set (Cài Đặt Màu
Nhanh).

5. Để xem các nhãn giếng trong lưới, chọn loại nhãn trong mụcWell Labels (Nhãn Giếng).

6. Nhấp OK để lưu thay đổi hoặc Cancel (Hủy) để hủy thay đổi.
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Xem, xuất và nhập khay ở định dạng bảng tính
Công cụ Spreadsheet View/Importer (Xem/Nhập Trang Bảng Tính) hiển thị thành phần của một khay ở
định dạng trang bảng tính. Trình xem cung cấp tùy chọn để xem, nhập và xuất dữ liệu giếng như được mô
tả bên dưới.

Sử dụng trình xem bảng tính để xuất và nhập dữ liệu khay

Từ trình xem bảng tính, bạn có thể xuất Tên mục tiêu, Tên mẫu, Tên nhóm sinh học và Ghi chú giếng
dưới dạng mẫu ở định dạng được phân tách bằng tab sang một ứng dụng như Microsoft Excel. Bạn cũng
có thể nhập dữ liệu đó từ một ứng dụng được phân tách bằng tab vào một đĩa được xác định trước từ tập
tin thông tin thử nghiệm.

Sử dụng công cụ Spreadsheet View/Importer (Xem/Nhập Trang Bảng Tính)

1. Tạo và lưu khay (xem Tạo Tệp Tin Khay Bằng Cách Sử Dụng Plate Editor (Trình Chỉnh Sửa Khay) ).

2. Trên thanh công cụ Plate Editor (Trình Chỉnh sửa khay), nhấp vào Spreadsheet View/Importer
(Xem/Nhập trang bảng tính) để mở hộp thoại Plate Spreadsheet View (Xem trang bảng tính khay).

3. (Tùy chọn) Nhấp vào hộp Show Biological Set Name and ShowWell Note (Hiển thị tên nhóm sinh
học và Hiển thị ghi chú giếng để hiển thị các cột đó trong Chế độ xem trang bảng tính và trong tập tin
đã xuất).

4. Bấm vào nút Export Template (Xuất mẫu) để tạo mẫu trống trong tập tin Excel (định dạng .csv). Tập
tin được xuất sẽ hiển thị cùng một bố cục với khay của bạn.

Lời khuyên: Sử dụng tên tập tin khay khi lưu tập tin khay của bạn để dễ dàng xác định tập tin.

Hướng Dẫn Sử Dụng | 155



Chương 8 Chuẩn Bị Khay

5. Điền thành phần giếng vào các ô tập tin Excel.

Lưu ý: Bạn chỉ có thể chỉnh sửa nội dung của bất kỳ ô nào trong cột có dấu hoa thị (*) bên cạnh
tên cột (*Tên mục tiêu, *Tên mẫu, *Tên nhóm sinh học, *Ghi chú về giếng).

Lưu ý: Bạn không thể thêm giá trị vào Đường cong chuẩn và Cột số lượng trong tập tin Excel đã
xuất. Để sửa đổi dữ liệu đó, hãy quay lại Chỉnh sửa khay và chọn Settings > Units (Cài đặt > Đơn
vị) trong thanh menu. Sau khi hoàn tất lượt chạy khay, dữ liệu từ những tiêu chuẩn này xuất hiện
trong biểu đồ Standard Curve (Đường Cong Chuẩn) ở tab Quantification (Định Lượng) thuộc
cửa sổ Data Analysis (Phân Tích Dữ Liệu) với các đơn vị bạn chọn.

6. Nhập tập tin Excel đã điền vào Chỉnh sửa khay bằng cách nhấp nút Import (Nhập). Dữ liệu khay đã
nhập sẽ xuất hiện trong cửa sổ Plate Spreadsheet View (Chế độ xem trang bảng tính khay).

Quan trọng: Nếu bạn có nhiều chất huỳnh quang, bạn sẽ cần thực hiện các bước 3-5 cho mỗi
chất huỳnh quang bằng cách sử dụng menu thả xuống Danh sách chất huỳnh quang ở Chế độ
xem trang bảng tính khay.

7. Nhấp vào nút OK. Dữ liệu khay mới hiện xuất hiện trong cửa sổ Plate Editor (Trình Chỉnh sửa khay).

Lời khuyên: Bạn có thể xem các mục menu có sẵn trong công cụ Xem/Nhập trang bảng tính khi bạn
nhấp chuột phải vào bất kỳ giếng nào trong công cụ hoặc trên bất kỳ tiêu đề bảng nào của chế độ
xem Trang bảng tính khay.
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Tạo Bố Cục Khay Bằng Trình Hướng Dẫn Thiết Lập Khay
Bạn có thể sử dụng Setup Wizard (Trình Hướng Dẫn Thiết Lập) để nhập thông tin bố cục khay cần cho
phân tích biểu hiện gen chuẩn hóa, bao gồm:

n Tên mục tiêu

n Tên mẫu

n Vị trí các mục tiêu và mẫu trên khay

n (Các) gen tham chiếu

n Mẫu đối chứng

Bạn có thể sử dụng Setup Wizard (Trình Hướng Dẫn Cài Đặt) trước, trong, hoặc sau một lượt chạy.

Sử Dụng Trình Hướng Dẫn Thiết Lập Khay
Mục này giải thích cách tạo một bố cục khay bằng cách sử dụng Setup Wizard (Trình Hướng Dẫn Thiết
Lập) cho khay. Để xem nội dung của từng giếng trong khay dễ dàng hơn, nhấp Zoom plate (Thu phóng
khay) ở trên đầu Setup Wizard (Trình Hướng Dẫn Thiết Lập).

Quan trọng: Trở về tab Auto layout (Bố cục tự động) khi ở bất kỳ tab nào khác trong Setup Wizard
(Trình Hướng Dẫn Thiết Lập) sẽ đặt lại bố cục khay. Thận trọng khi chọn tab này.

Lời khuyên: Bạn có thể đặt lại bố cục bằng cách chọn Tools > Clear Plate (Công Cụ > Xóa Khay)
trong Setup Wizard (Trình Hướng Dẫn Thiết Lập).

Cách sử dụng Setup Wizard (Trình Hướng Dẫn Thiết Lập) cho khay

1. Mở Plate Editor (Trình Chỉnh Sửa Khay).

2. Để mở Setup Wizard (Trình Hướng Dẫn Thiết Lập), hãy thực hiện một trong các thao tác sau:

n Chọn Editing Tools > Setup Wizard (Công Cụ Chỉnh Sửa > Trình Hướng Dẫn Thiết Lập).

n Nhấp Setup Wizard (Trình Hướng Dẫn Thiết Lập) trên thanh công cụ Plate Editor (Trình Chỉnh
Sửa Khay).

Setup Wizard (Trình Hướng Dẫn Thiết Lập) xuất hiện hiển thị tab Auto layout (Bố cục tự động).
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3. Trong tab Auto layout (Bố cục tự động), thực hiện các thao tác sau:

a. Nhấp vào một giếng trong lưới và kéo qua và xuống để xác định khu vực trên khay mà bạn định
tải mẫu.

b. Nhập số mục tiêu và mẫu để tải.

Lời khuyên: Số mục tiêu và mẫu phải bằng số ô đã chọn. Nếu số được nhập không khớp
trong khu vực được chọn, điều chỉnh số hoặc khu vực chọn khay. Hướng của các mục trên
khay và phân nhóm của chúng có thể được chỉ định.

c. (Không bắt buộc) Thay đổi hướng khay. Ví dụ, bạn có thể đặt các mục tiêu thành cột và mẫu
thành hàng, hoặc nhóm theo mẫu.

d. Nhấp Next (Tiếp Theo) để tiếp tục đến tab Target names (Tên mục tiêu).

Lưu ý: Nếu bố cục khay của bạn không có mẫu hình thông thường, sử dụng tab Target names
(Tên mục tiêu) để xác định thủ công vị trí của mục tiêu của bạn hoặc tab Sample names (Tên
mẫu) để xác định thủ công vị trí mẫu của bạn trên khay. Nhấp và kéo để chọn nhiều giếng.

4. Trong tab Target names (Tên mục tiêu), xác định tên mục tiêu cho các nhómmục tiêu:

a. Thực hiện một trong các thao tác sau:

n Để đổi tên mục tiêu theo nhóm, đặt Select by (Chọn theo) về Target (Mục Tiêu).

n Để đổi tên các mục tiêu theo giếng, đặt Select by (Chọn theo) về Well (Giếng).
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b. Chọn một nhómmục tiêu hoặc giếng trong lưới và nhập tên vào danh sách thả xuống Target
name (Tên mục tiêu).

Lời khuyên: Nhấp Trang để chọn nhóm hoặc giếng tiếp theo ở bên phải hoặc Enter (Nhập)
để chọn nhóm hoặc giếng tiếp theo bên dưới. Cách khác, trong các tab Target name (Tên
mục tiêu) và Sample name (Tên mẫu), nhấn giữ phím Control và nhấp vào một giếng để
chọn nhiều giếng không liền kề.

c. Nhấp vào Next (Tiếp Theo) để tiếp tục đến tab Sample names (Tên mẫu).

5. Trong tab Sample names (Tên mẫu), xác định tên mẫu cho các nhómmẫu:

6. Nhấp vào Next (Tiếp Theo) để tiếp tục đến tab Reference targets (Mục tiêu tham chiếu).

7. Trong tab Reference targets (Mục tiêu tham chiếu), chọn một hoặc nhiều mục tiêu để dùng làm tham
chiếu cho biểu hiện gen chuẩn hóa và nhấp Next (Tiếp Theo) để tiếp tục đến tab Control sample
(Mẫu đối chứng).

8. Trong tab Control sample (Mẫu đối chứng), chọn một mẫu để dùng làm đối chứng cho các tính toán
biểu hiện gen tương đối.

9. Nhấp OK để lưu bố cục khay và trở về Plate Editor (Trình Chỉnh Sửa Khay), trong đó bạn có thể xác
định thêm các tham số khay. Xem Gán Thông Số Tùy Chọn cho Tập Tin Khay trên trang 137 để biết
thêm thông tin.

Cách khác, nhấp Previous (Trước) để trở về một tab trước để thực hiện bất kỳ thay đổi nào.

Lưu ý: Trở về tab Auto layout (Bố cục tự động) sẽ tự động cài đặt lại khay. Thận trọng khi nhấp
vào Previous (Trước).
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Chương này giải thích cách chạy các thử nghiệm xét nghiệm tùy chỉnh (do người dùng cài đặt) hoặc
PrimePCR bằng Phần mềm CFX Maestro Dx, Phiên bản bảo mật.

Tệp dữ liệu lượt chạy có chứa thông tin khay và protocol cho lượt chạy này. Tệp này cũng chứa dữ liệu từ
các phân tích mà CFX Maestro Dx SE thực hiện sau khi lượt chạy hoàn tất.

CFX Maestro Dx SE giúp dễ dàng thiết lập và chạy thử nghiệm do người dùng cài đặt hoặc thử nghiệm
PrimePCR. Cửa sổ Run Setup (Thiết Lập Lượt Chạy) sẽ hướng dẫn bạn qua các bước thường gặp để
thiết lập một thử nghiệm, dẫn bạn đến hộp thoại Start Run (Bắt Đầu Lượt Chạy), từ đó bạn sẽ bắt đầu
lượt chạy.
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Cửa Sổ Run Setup (Thiết Lập Lượt Chạy)
Cửa sổ Run Setup (Thiết Lập Lượt Chạy) cho phép truy cập nhanh vào các tệp tin và cài đặt cần thiết để
thiết lập và chạy thử nghiệm. Khi bạn chọn chạy thử nghiệm do người dùng cài đặt, cửa sổ Run Setup
(Thiết Lập Lượt Chạy) sẽ mở ra hiển thị tab Protocol. Khi bạn chọn chạy thử nghiệm PrimePCR, cửa sổ
Run Setup (Thiết Lập Lượt Chạy) sẽ mở ra hiển thị tab Start run (Bắt đầu lượt chạy).

Lời khuyên: Xem Thực Hiện Thí Nghiệm PrimePCR trên trang 179 để biết thông tin về PrimePCR;
xem Tab Start Run (Bắt Đầu Lượt Chạy) trên trang 169 để biết thông tin về tab Start Run (Bắt Đầu
Lượt Chạy).
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1. Các tab sẽ hướng dẫn bạn thiết lập và chạy thử nghiệm:

n Trang Protocol — chọn một protocol hiện có để chạy hoặc chỉnh sửa, hoặc tạo
một protocol mới trong Protocol Editor (Trình Chỉnh Sửa Protocol).

n Trang Plate (Khay) — chọn một khay hiện có để chạy hoặc chỉnh sửa, hoặc để
tạo một khay mới trong Plate Editor (Trình Chỉnh Sửa Khay).

n Trang Start Run (Bắt Đầu Lượt Chạy) — xem các thiết lập thử nghiệm, chọn một
hoặc nhiều block máy, và bắt đầu lượt chạy.

2. Cửa sổ chính hiển thị các tùy chọn cho mỗi tab khi bạn áp dụng chúng.

3. Các nút điều hướng sẽ dẫn bạn đến tab Start Run (Bắt Đầu Lượt Chạy).

CHÚ THÍCH

Truy cập Cửa Sổ Run Setup (Thiết Lập Lượt Chạy)
Cách truy cập cửa sổ Run Setup (Thiết Lập Lượt Chạy)

u Thực hiện một trong các thao tác sau:

n Trong tab Run setup (Thiết Lập Lượt Chạy) ở Startup Wizard (Trình Hướng Dẫn Khởi Động),
nhấp vào User-defined (Do Người Dùng Cài Đặt) hoặc PrimePCR.

n Trong cửa sổ Trang Chủ, nhấp vào User-defined Run Setup (Thiết Lập Lượt Chạy Do Người
Dùng Cài Đặt) hoặc PrimePCR Run Setup (Thiết Lập Lượt Chạy PrimePCR) trên thanh công cụ.

n Trong cửa sổ Trang Chủ, chọn Run > User-defined Run (Lượt Chạy > Lượt Chạy Do Người
Dùng Cài Đặt) hoặc Run > PrimePCR Run (Lượt Chạy > Lượt Chạy PrimePCR).
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Tab Protocol
Tab Protocol hiển thị bản xem trước tập tin protocol mà bạn dự định chạy. Tệp protocol chứa hướng dẫn
về các bước nhiệt độ của máy cũng như các tùy chọn máy điều khiển tỷ lệ dốc nhiệt, khối lượng mẫu, và
nhiệt độ nắp.

Theo mặc định, phần mềm sẽ hiển thị protocol được xác định trong mục File Selection for Run Setup
(Chọn Tệp Tin để Thiết Lập Lượt Chạy) trong hộp thoại User > User Preferences (Người Dùng > Ưu Tiên
của Người Dùng). Bạn có thể thay đổi protocol mặc định trong hộp thoại User Preferences (Ưu Tiên của
Người Dùng). Xem Thay Đổi Cài Đặt Tệp Mặc Định trên trang 83 để biết thêm thông tin.

Trong tab Protocol, bạn có thể

n Tạo protocol mới để chạy

n Chọn protocol hiện có để chạy hoặc chỉnh sửa

Để biết thêm thông tin về việc tạo và sửa đổi các protocol, xem Chương 7, Tạo Protocol.

Cách tạo protocol mới

1. Trên tab Protocol, nhấp vào Create New (Tạo Mới).

Protocol Editor (Trình Chỉnh Sửa Protocol) xuất hiện.

2. Sử dụng Protocol Editor (Trình Chỉnh Sửa Protocol) để tạo protocol mới.
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3. Nhấp OK để lưu protocol và quay lại tab Protocol trong Run Setup (Thiết Lập Lượt Chạy).

4. Xem chi tiết protocol và thực hiện một trong các thao tác sau:

n Nếu các chi tiết chính xác, nhấp vào Next (Tiếp Theo) để tiếp tục đến tab Plate (Khay).

n Nếu các chi tiết không chính xác, nhấp vào Edit Selected (Chỉnh Sửa Protocol Đã Chọn) để quay
lại cửa sổ Protocol Editor (Trình Chỉnh Sửa Protocol). Sửa đổi protocol, lưu thay đổi, sau đó
nhấp Next (Tiếp Theo) trên tab Protocol để tiếp tục đến tab Plate (Khay).

Chọn một protocol hiện có

1. Trên tab Protocol, thực hiện một trong các thao tác sau:

n Nhấp Select Existing (Chọn Protocol Hiện Có) và điều hướng đến protocol hiện có.

n Nhấp Express Load (Tải Nhanh) và chọn một protocol từ danh sách các protocol thả xuống.

Lời khuyên: Bạn có thể thêm protocol hoặc xóa khỏi danh sách thả xuống Express Load
(Tải Nhanh). Xem Thêm và Xóa Các Protocol Tải Nhanh sau đó để biết thêm thông tin.

2. Xem chi tiết protocol và thực hiện một trong các thao tác sau:

n Nếu các chi tiết chính xác, nhấp vào Next (Tiếp Theo) để tiếp tục đến tab Plate (Khay).

n Nếu các chi tiết không chính xác, nhấp Edit Selected (Chỉnh Sửa Protocol Đã Chọn) để mở
Protocol Editor (Trình Chỉnh Sửa Protocol). Sửa đổi protocol, lưu thay đổi, sau đó nhấp Next
(Tiếp Theo) trên tab Protocol để tiếp tục đến tab Plate (Khay).

Thêm và Xóa Các Protocol Tải Nhanh

Bạn có thể điều chỉnh nội dung của danh sách thả xuống Express Load (Tải Nhanh) khi xuất hiện trong
Protocol Editor (Trình Chỉnh Sửa Protocol) Các protocol trong danh sách này được lưu trong thư mục sau
đây:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<tên_người_dùng>\ExpressLoad\

Cách điều chỉnh danh sách Express Load (Tải Nhanh) của các protocol

1. Điều hướng đến và mở thư mục ExpressLoad (Tải Nhanh).

2. Xem xét các tệp tin protocol (.pcrl) trong thư mục này.

3. Thực hiện một trong các thao tác sau:

n Xóa các protocol khỏi thư mục này để xóa khỏi danh sách thả xuống.

n Sao chép các protocol vào thư mục này để thêm vào danh sách thả xuống.
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Trang Plate (Khay)
Lưu ý: Nếu protocol được chọn trong tab Protocol không bao gồm bước đọc khay đối với phân tích
real-time PCR, tab Plate (Khay) được ẩn đi. Để xem tab Plate (Khay), thêm ít nhất một lượt đọc khay
vào protocol.

Trang Plate (Khay) hiển thị bản xem trước của tệp khay mà bạn dự định tải. Trong một lượt chạy real-time
PCR, tệp khay chứa mô tả thành phần của mỗi giếng bao gồm chất huỳnh quang, chế độ quét và loại
khay. CFX Maestro Dx SE sử dụng các mô tả này để thu thập và phân tích dữ liệu.

Theo mặc định, phần mềm sẽ hiển thị khay được cài đặt trong mục File Selection for Run Setup (Chọn
Tệp để Thiết Lập Lượt Chạy) ở tab Files (Tệp) trong hộp thoại User > User Preferences (Người Dùng >
Ưu Tiên của Người Dùng). Bạn có thể thay đổi khay mặc định trong hộp thoại User Preferences (Ưu Tiên
của Người Dùng). Xem Thay Đổi Cài Đặt Tệp Mặc Định trên trang 83 để biết thêm thông tin.

Trong tab Plate (Khay), bạn có thể

n Tạo một khay mới để nạp

n Chọn một khay hiện có để nạp hoặc chỉnh sửa

Để biết thêm thông tin về việc tạo và sửa đổi các khay, xem Chương 8, Chuẩn Bị Khay.
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Tạo khay mới

1. Trên tab Plate (Khay), nhấp vào Create New (Tạo Mới).

Plate Editor (Trình Chỉnh Sửa Khay) xuất hiện.

2. Sử dụng Plate Editor (Trình Chỉnh Sửa Khay) để tạo một khay mới.

3. Nhấp OK để lưu khay và quay lại tab Plate (Khay) trong Run Setup (Thiết Lập Lượt Chạy).

4. Xem chi tiết khay và thực hiện một trong các thao tác sau:

n Nếu các chi tiết chính xác, nhấp Next (Tiếp Theo) để tiếp tục đến tab Start Run (Bắt Đầu Lượt
Chạy).

n Nếu các chi tiết không chính xác, nhấp vào Edit Selected (Trình Chỉnh Sửa Khay Đã Chọn) để
quay lại Plate Editor (Trình Chỉnh Sửa Khay). Sửa lại tệp tin khay, lưu thay đổi, sau đó nhấp Next
(Tiếp Theo) trên tab Plate (Khay) để tiếp tục đến tab Start Run (Bắt Đầu Lượt Chạy).

Chọn tệp tin khay hiện có

1. Trên tab Plate (Khay), thực hiện một trong các thao tác sau:

n Nhấp vào Select Existing (Chọn Khay Hiện Có) và điều hướng đến tệp khay hiện có.

n Nhấp vào Express Load (Tải Nhanh) và chọn tệp khay từ danh sách thả xuống.

Lời khuyên: Bạn có thể thêm khay hoặc xóa khay khỏi danh sách thả xuống Express Load
(Tải Nhanh). Xem Thêm và Xóa Các Tệp Tin Khay Tải Nhanh sau đó để biết thêm thông tin.

2. Xem chi tiết khay và thực hiện một trong các thao tác sau:

n Nếu các chi tiết chính xác, nhấp Next (Tiếp Theo) để tiếp tục đến tab Start Run (Bắt Đầu Lượt
Chạy).

n Nếu các chi tiết không chính xác, nhấp vào Edit Selected (Trình Chỉnh Sửa Khay Đã Chọn) để mở
cửa sổ Plate Editor (Trình Chỉnh Sửa Khay). Sửa lại tệp tin khay, lưu thay đổi, sau đó nhấp Next
(Tiếp Theo) để tiếp tục đến tab Start Run (Bắt Đầu Lượt Chạy).

Thêm và Xóa Các Tệp Tin Khay Tải Nhanh

Bạn có thể điều chỉnh nội dung của danh sách thả xuống Express Load (Tải Nhanh) khi xuất hiện trong
Plate Editor (Trình Chỉnh Sửa Khay). Những khay xuất hiện trong danh sách này được lưu trong thư mục
sau đây:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<tên_người_dùng>\ExpressLoad\

Cách điều chỉnh danh sách Express Load (Tải Nhanh) của tệp khay

1. Điều hướng đến và mở thư mục ExpressLoad (Tải Nhanh).

2. Xem lại tệp tin khay (.pltd) trong thư mục này.
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3. Thực hiện một trong các thao tác sau:

n Xóa các tệp khay khỏi thư mục để xóa khỏi danh sách thả xuống.

n Sao chép tệp khay vào thư mục để thêm vào danh sách thả xuống.
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Tab Start Run (Bắt Đầu Lượt Chạy)
Tab Start Run (Bắt Đầu Lượt Chạy) hiển thị thông tin về thử nghiệm sẽ chạy. Đồng thời hiển thị block
hoặc các block máy đã kết nối mà bạn có thể chạy thử nghiệm trên đó.

Trong tab Start Run (Bắt Đầu Lượt Chạy) bạn có thể thực hiện các thao tác sau:

n Xem thông tin lượt chạy chi tiết, bao gồm tệp protocol đã chọn, tệp khay, và chế độ quét.

n Thêm lưu ý về lượt chạy.

n Xem thông tin chi tiết về tất cả các máy đã kết nối, bao gồm trạng thái lượt chạy (chạy hoặc không
chạy) của máy, thể tích mẫu theo µl, nhiệt độ nắp, chế độ mô phỏng, và ID hoặc mã vạch nếu có.

Lưu ý: Bạn có thể sửa đổi các cột xuất hiện trong Start Run (Bắt Đầu Lượt Chạy) trên bảng
Selected Blocks (Block Đã Chọn). Xem Sửa Đổi Chi Tiết trong Bảng Các Block Đã Chọn trên
trang 170 để biết thông tin.

n Chọn block hoặc các block để thực hiện lượt chạy.

n Mở hoặc đóng nắp từ xa của từng máy đã chọn.

n Bắt đầu lượt chạy.
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Sửa Đổi Chi Tiết trong Bảng Các Block Đã Chọn

Bạn có thể sửa đổi các cột xuất hiện trong bảng Start Run on Selected Block(s) (Bắt Đầu Lượt Chạy trên
(Các) Block Đã Chọn). Bạn cũng có thể sửa đổi giá trị thể tích mẫu và nhiệt độ nắp mặc định trong bảng.
Các thay đổi cài đặt được áp dụng cho lượt chạy sẽ được thực hiện.

Cách thêm các cột trong bảng Start Run on Selected Blocks (Bắt Đầu Lượt Chạy trên Các
Block Đã Chọn).

u Nhấp chuột phải vào bảng và chọn một tùy chọn trong menu xuất hiện.

Xóa các cột trong bảng Start Run on Selected Blocks (Bắ t Đầu Lượt Chạy trên Các Block
Đã Chọn)

u Nhấp chuột phải vào bảng và xóa tùy chọn trong menu xuất hiện.

Cách chỉnh sửa giá trị thể tích mẫu hoặc nhiệt độ nắp đối với một block

u Chọn ô thể tích mẫu hoặc ô nhiệt độ nắp đối với block mục tiêu và nhập giá trị mới vào ô.

Cách thêm ID lượt chạy hoặc mã vạch đối với một block

u Chọn ô ID/Mã Vạch đối với block mục tiêu và nhập ID hoặc quét block bằng trình đọc mã vạch.

Chạy Thí Nghiệm
Quan trọng: Trước khi chạy thử nghiệm, hãy đảm bảo phần mềm chống vi-rút trong máy tính của
bạn sẽ không bắt đầu quét trong khi chạy. Xem Cài Đặt CFX Maestro Dx SE Phần Mềm trên trang 34
và liên hệ với quản trị viên hệ thống của bạn để biết thêm thông tin.

Cách chạy thử nghiệm

1. Trong tab Start Run (Bắt Đầu Lượt Chạy), hãy xác minh chi tiết khay và protocol trong mục Run
Information (Thông Tin Lượt Chạy).

2. (Không bắt buộc) Thêm ghi chú về lượt chạy hoặc thử nghiệm trong ô văn bản Notes (Ghi Chú).

3. Chọn ô kiểm của một hoặc nhiều block để thực hiện lượt chạy.

Lời khuyên: Để chạy thử nghiệm trên tất cả các block, chọn Select All Blocks (Chọn Tất Cả Các
Block) nằm bên dưới bảng Selected Blocks (Block Được Chọn).

4. (Không bắt buộc) Nhấp vào Flash Block Indicator (Nháy Đèn Báo Block) để bật đèn LED chỉ báo trên các
block máy đã chọn.

5. Đặt các khay thử nghiệm vào block:

a. Nhấp vào Open Lid (Mở Nắp). Nắp điện của mỗi block được chọn sẽ mở ra.

b. Đặt một khay thử nghiệm vào từng block đã chọn.
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c. Nhấp vào Close Lid (Đóng Nắp).

Lời khuyên: Trên Hệ thống CFX Opus Dx, chạm vào Open Lid (Mở Nắp) hoặc Close Lid (Đóng
Nắp) trên màn hình Trang Chủ.

6. Nhấp vào Open Lid (Mở Nắp) và Close Lid (Đóng Nắp) để mở và đóng nắp điện của từng block máy
đã chọn.

7. Xem chi tiết lượt chạy và thực hiện một trong các thao tác sau:

n Nếu các chi tiết là chính xác, nhấp vào Start Run (Bắt Đầu Lượt Chạy).

n Nếu các chi tiết là không chính xác:

o Sửa đổi các chi tiết trong bảng Selected Blocks (Block Được Chọn) và nhấp vào Start Run
(Bắt Đầu Lượt Chạy).

o Quay lại đúng tab và thực hiện các thay đổi thích hợp, lưu các thay đổi và sau đó nhấp vào
Next (Tiếp Theo) để quay lại tab Start Run (Bắt Đầu Lượt Chạy) và bắt đầu lượt chạy.

Cách bắt đầu lượt chạy mới từ lượt chạy trước

u Thực hiện một trong các thao tác sau:

n Chọn File > Repeat a Run (Tệp > Lặp Lại Lượt Chạy) trong thanh menu phần mềm chính; điều
hướng đến và nhấp đúp vào tệp dữ liệu chạy mà bạn muốn lặp lại.

n Chọn tab Repeat Run (Lặp Lại Lượt Chạy) trong Startup Wizard (Trình Hướng Dẫn Khởi Động)
và nhấp đúp vào tệp dữ liệu lượt chạy của lượt chạy bạn muốn lặp lại.

Tùy chọn, trên tab Repeat Run (Lặp Lại Lượt Chạy), bạn có thể nhấp vào Browse (Tìm Đường
Dẫn) và điều hướng đến và nhấp đúp vào tệp dữ liệu lượt chạy mà bạn muốn lặp lại.
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Hộp Thoại Chi Tiết Lượt Chạy
Khi bạn nhấp vào Start Run (Bắt Đầu Lượt Chạy), CFX Maestro Dx SE sẽ nhắc bạn lưu tệp dữ liệu
(.pcrd), bắt đầu lượt chạy và mở hộp thoại Run Details (Chi Tiết Lượt Chạy). Hộp thoại Run Details (Chi
Tiết Lượt Chạy) bao gồm ba tab trạng thái:

n Run Status (Trạng Thái Lượt Chạy) — sử dụng tab này để xem trạng thái hiện tại của protocol, mở
hoặc đóng nắp, dừng lượt chạy, thêm số lượt lặp lại, bỏ qua các bước, hoặc ngừng lượt chạy.

n Real-time Status (Trạng Thái Thời Gian Thực) — sử dụng tab này để xem dữ liệu huỳnh quang real-
time PCR khi chúng được thu thập.

n Time Status (Trạng Thái Thời Gian) — sử dụng tab này để xem đồng hồ đếm ngược toàn màn hình
cho protocol.

Các tab này được giải thích chi tiết trong các mục tiếp theo.

Tab Run Status (Trạng Thái Lượt Chạy)
Tab Run Status (Trạng Thái Lượt Chạy) hiển thị trạng thái hiện tại lượt chạy đang diễn ra. Trong chế độ
xem này bạn cũng có thể điều khiển nắp và thay đổi lượt chạy đang diễn ra.
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1. Ngăn Run Status (Trạng Thái Lượt Chạy) — hiển thị tiến độ hiện tại của protocol.

2. Điều khiển Run Status (Trạng Thái Lượt Chạy) — cho phép bạn vận hành máy hoặc
làm gián đoạn protocol hiện tại.

3. Ngăn Run Information (Thông Tin Lượt Chạy) — hiển thị thông tin chi tiết lượt chạy.

CHÚ THÍCH

Các Lệnh về Trạng Thái Lượt Chạy

Sử dụng các lệnh trong tab Run Status (Trạng Thái Lượt Chạy) để vận hành máy từ phần mềm hoặc thay
đổi lượt chạy đang diễn ra.

Lưu ý: Thay đổi protocol trong lượt chạy, chẳng hạn như thêm lượt lặp lại, sẽ không thay đổi tệp
protocol liên quan đến lượt chạy. Những thao tác này được ghi lại trong Run Log (Nhật Ký Lượt
Chạy).

—mở nắp điện trên các máy đã chọn.

Quan trọng: Mở nắp trong quá trình chạy sẽ làm tạm dừng lượt chạy trong bước hiện tại và có
thể thay đổi dữ liệu. Các Lệnh về Trạng Thái Lượt Chạy trên trang 173.

— đóng nắp điện trên các máy đã chọn.

— thêm lượt lặp lại vào bước GOTO hiện tại trong protocol. Tùy chọn này chỉ khả dụng khi một
bước GOTO đang chạy.

Lưu ý: Bạn có thể thêm các lượt lặp lại khác trong một chu kỳ GOTO khi chương trình đang
chạy. Tuy nhiên, CFX Maestro Dx SE nhận biết được sự thay đổi gần nhất về số lượt lặp lại. Ví
dụ: nếu bạn thêm 10 lượt lặp lại bổ sung trong một chu kỳ GOTO, phần mềm sẽ thay đổi tổng số
thành n + 10. Sau đó, nếu bạn thêm năm (5) lượt lặp nữa lại trong cùng chu kỳ đó, CFX Maestro
sẽ thay đổi tổng số lượt lặp lại thành n + 5. Thay đổi đầu tiên (10 lượt lặp lại) bị bỏ qua. Để đảm
bảo phần mềm thực hiện đúng số lượt lặp lại mục tiêu, hãy nhập tổng số (trong trường hợp này
là 15 lượt lặp lại).

— bỏ qua bước hiện tại trong protocol.

Lưu ý: Nếu bạn bắt đầu bỏ qua trong một bước GOTO, hệ thống sẽ bỏ qua đến chu kỳ tiếp theo
trong vòng lặp GOTO. Nếu chu kỳ cuối của bước GOTO đang diễn ra tại thời điểm bỏ qua, hệ
thống sẽ bỏ qua đến bước tiếp theo.

Hướng Dẫn Sử Dụng | 173



Chương 9 Chạy Thí Nghiệm

—nháy đèn LED trên máy đã chọn để xác định các block đã chọn.

— tạm dừng protocol.

Lưu ý: Thao tác này được ghi lại trong Run Log (Nhật Ký Lượt Chạy).

— tiếp tục protocol bị tạm dừng.

— dừng lượt chạy trước khi protocol kết thúc.

Lưu ý: Việc dừng lượt chạy trước khi protocol kết thúc có thể thay đổi dữ liệu của bạn.

Mở nắp máy trong quá trình chạy PCR

Nếu nắp của bất kỳ máy nào được mở ra trong quá trình chạy PCR,CFX Maestro Dx SE sẽ hiển thị hộp
thoại xác nhận sau:

Trong khi hộp thoại xuất hiện, các máy tiếp tục chạy chương trình. Nút OK tạm dừng quá trình chạy và nắp máy
nới lỏng và mở ra. Nút Cancel (Hủy) bỏ hộp thoại và tiếp tục lượt chạy.
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Tab Real-time Status (Trạng Thái Thời Gian Thực)
Trang Real-time Status (Trạng Thái Thời Gian Thực) hiển thị dữ liệu real-time PCR thu thập được tại từng
chu kỳ trong lần chạy sau hai lần đọc khay đầu tiên.

1. Amplification trace pane (Ngăn vạch đồ họa khuếch đại) – hiển thị dữ liệu khuếch
đại thời gian thực trong khi chạy.

2. Well group identifier (Định danh nhóm giếng) – nếu các nhóm giếng được xác định
trong thiết lập khay, người dùng có thể chọn một nhóm giếng cụ thể để xem các
vạch đồ họa, giếng, và thông tin bảng của nhóm.

Step number identifier (Định danh số bước) — nếu protocol thu thập dữ liệu ở nhiều
hơn một bước (ví dụ như trong quá trình khuếch đại và đường cong chảy), người
dùng có thể chọn một bước cụ thể và xem các vạch đồ họa thu được tại bước đấy.

3. Well selector pane (Ngăn bộ chọn giếng) — hiển thị các giếng hoạt động, không
hoạt động, và trống trong khay.

4. Plate setup table pane (Ngăn bảng thiết lập khay) — hiển thị thiết lập khay ở định
dạng bảng.

CHÚ THÍCH
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5. Run details pane (Ngăn chi tiết lượt chạy) — hiển thị trạng thái thời gian thực của
lượt chạy bao gồm:

n Bước hiện tại

n Lần lặp hiện tại

n Nhiệt độ hiện tại

n Thời gian còn lại

n Nhiệt độ mẫu

n Nhiệt độ nắp

6. Plate Setup (Thiết Lập Khay) —mở hộp thoại Plate Setup (Thiết Lập Khay), trong
đó người dùng có thể điều chỉnh thiết lập khay hiện tại trong khi chạy.

Trong tab Real-time Status (Trạng Thái Thời Gian Thực) bạn có thể

n Hiển thị hoặc ẩn các vạch đồ họa thời gian thực bằng cách chọn trong ngăn bộ chọn giếng hoặc bảng
thiết lập khay

n Xemmột hoặc các nhóm vạch đồ họa bằng cách chọn trong menu thả xuống của nhóm giếng

n Chỉnh sửa khay hoặc thay thế tệp khay

n Áp dụng tệp PrimePCR vào lần chạy.

Hiển Thị hoặc Ẩn Các Vạch Đồ Họa Thời Gian Thực

Theo mặc định, các giếng đã nạp thì mang tính hoạt động và xuất hiện trong bảng thiết lập khay. Các
giếng hoạt động có màu xanh dương trong ngăn bộ chọn giếng. Các giếng ẩn có màu xám nhạt, và các
giếng không được sử dụng có màu xám đậm trong ngăn bộ chọn giếng.

Bạn có thể ẩn vạch đồ họa từ các giếng hoạt động trong lượt chạy. CFX Maestro Dx SE tiếp tục thu thập
dữ liệu đối với tất cả các giếng; khi bạn ẩn các giếng, dữ liệu của chúng sẽ không xuất hiện trong bảng
thiết lập khay.

Cách ẩn các vạch đồ họa thời gian thực

u Trong ngăn bộ chọn giếng, nhấp vào các giếng hoạt động (màu xanh dương) mà bạn muốn ẩn.

Cách hiển thị các vạch đồ họa thời gian thực

u Trong ngăn bộ chọn giếng, nhấp vào các giếng bị ẩn (màu xám nhạt) mà bạn muốn hiển thị.

Để biết thêm thông tin về bộ chọn giếng, xem Bộ Chọn Giếng trên trang 195.
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Chỉnh Sửa Thiết Lập Khay

Cách chỉnh sửa thiết lập khay

u Nhấp vào Plate Setup (Thiết Lập Khay) sau đó chọn View/Edit Plate (Xem/Chỉnh Sửa Khay).

Cửa sổ Plate Editor (Trình Chỉnh Sửa Khay) xuất hiện, trong đó bạn có thể chỉnh sửa khay khi lượt
chạy đang diễn ra. Để biết thêm thông tin về chỉnh sửa khay, xem Chương 8, Chuẩn Bị Khay.

Lưu ý: Bạn cũng có thể chỉnh sửa kiểu vạch đồ họa từ cửa sổ Plate Editor (Trình Chỉnh Sửa
Khay). Các thay đổi xuất hiện trên đồ thị vạch đồ họa khuếch đại trong tab Real-time Status
(Trạng Thái Thời Gian Thực).

Thay Thế Tệp Khay

Lời khuyên: Việc thay thế một tệp khay đặc biệt hữu ích nếu bạn bắt đầu một lượt chạy với một tệp
Quick Plate (Khay Nhanh) trong thư mục ExpressLoad (Tải Nhanh).

Cách thay thế một tệp khay

u Nhấp vào Plate Setup (Thiết Lập khay) và chọn một trong các tùy chọn sau:

n Replace Plate file (Thay thế tệp Khay) — chọn tệp khay mới từ danh sách trong cửa sổ tìm
đường dẫn

n Apply PrimePCR file (Áp dụng tệp PrimePCR)— tìm kiếmmột tệp về lượt chạy mà từ đó sẽ thu
được bố cục khay bằng cách sử dụng Smart search (Tìm kiếm thông minh) hoặc nhấp vào
Browse (Tìm Đường Dẫn) để tìm ra tệp bạn đã tải xuống từ trang web Bio-Rad và không nằm
trong thư mục PrimePCR

Lưu ý: CFXMaestro Dx SE kiểm tra chế độ quét và kích thước khay cho tệp khay. Phải giống
như cài đặt lượt chạy theo đó lượt chạy đã được bắt đầu.
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Tab Time Status (Trạng Thái Thời Gian)
Tab Time Status (Trạng Thái Thời Gian) hiển thị thời gian còn lại để hoàn thành lượt chạy hiện tại.
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Thực Hiện Thí Nghiệm PrimePCR
Các thí nghiệm PrimePCR sử dụng các xét nghiệm đặc trưng cho lộ trình sinh học hoặc đặc trưng cho
bệnh mà đã qua xác nhận với hóa chất và tối ưu hóa tại phòng thí nghiệm tại Bio-Rad. Các xét nghiệm có
sẵn ở các dạng sau:

n Các khay mạ sẵn— các khay chứa các xét nghiệm đặc trưng cho lộ trình sinh học hoặc đặc trưng
cho bệnh; trong đó bao gồm các đối chứng PrimePCR và các gen tham chiếu.

n Khay được định cấu hình tùy chỉnh— các khay có thể được thiết lập theo bố cục do người dùng cài
đặt, có thể lựa chọn xét nghiệm cho các mục tiêu quan tâm, đối chứng, và tham chiếu.

n Xét nghiệm đơn lẻ – các ống chứa bộ mồi đơn lẻ để sử dụng trong phản ứng thời gian thực.

Để giảm thời gian chạy tổng thể, bạn có thể xóa bỏ bước chảy trong protocol. Bio-Rad khuyến nghị không
nên thực hiện bất kỳ sửa đổi nào khác đối với một protocol lượt chạy PrimePCR. Protocol mặc định là
protocol đã được sử dụng để xác nhận xét nghiệm. Bất kỳ thay đổi nào khỏi protocol này đều có thể ảnh
hưởng đến kết quả. Các thay đổi protocol được ghi lại trong tab Run Information (Thông Tin về Lượt
Chạy) của tệp dữ liệu kết quả và trong bất kỳ báo cáo nào được tạo.

Cách bắt đầu lượt chạy PrimePCR

u Để bắt đầu một lượt chạy PrimePCR, thực hiện bất kỳ thao tác nào sau đây:

n Trong Startup Wizard (Trình Hướng Dẫn Khởi Động), chọn PrimePCR trên tab Run setup (Thiết
lập lượt chạy), sau đó chọn hóa chất phù hợp (SYBR® hoặc Probe (Đoạn Dò)).

n Chọn một lượt chạy PrimePCR từ danh sách Recent Runs (Các Lượt Chạy Gần Đây) trên tab
Repeat run (Thực Hiện Lại Lượt Chạy) trong Startup Wizard (Trình Hướng Dẫn Khởi Động).

n Chọn File > Open > PrimePCR Run File (Tệp > Mở > Tệp Lượt Chạy PrimePCR) trên cửa sổ
Trang Chủ.

n Kéo và thả một tệp lượt chạy PrimePCR vào cửa sổ Trang Chủ.

Sau khi bạn chọn một lượt chạy PrimePCR, cửa sổ Run Setup (Thiết Lập Lượt Chạy) sẽ mở trên tab Start
Run (Bắt Đầu Lượt Chạy) với bố cục khay PrimePCRmặc định được tải dựa trên máy đã chọn.

Cách xóa bỏ bước chảy trong protocol

u Trong tab Protocol, xóa ô bên cạnh Include Melt Step (Bao Gồm Bước Chảy).
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Nhập thông tin mục tiêu cho các khay PrimePCR vào bố cục khay

1. Thực hiện một trong các thao tác sau:

n Trong tab Real-time Status (Trạng Thái Thời Gian Thực) ở hộp thoại Run Details (Chi Tiết Lượt
Chạy), chọn Plate Setup > Apply PrimePCR File (Thiết Lập Khay > Áp Dụng Tệp Prime PCR).

n Trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), chọn Plate Setup > Apply PrimePCR File
(Thiết Lập Khay > Áp Dụng Tệp Prime PCR).

2. Trong hộp thoại tệp lượt chạy PrimePCR, nhấp vào Browse (Tìm Đường Dẫn) để điều hướng đến
tệp PrimePCR phù hợp (.csv).

3. Chọn tệp PrimePCRmục tiêu và nhấp vào Open (Mở).

Hệ thống CFX Opus Dx nhập thông tin mục tiêu vào bố cục khay của bạn.
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Chuyển Dữ Liệu Độc Lập để Phân Tích
Quan trọng: Khi bạn chuyển các tệp dữ liệu từ Hệ thống CFX Opus Dx đến CFX Maestro Dx SE, tất
cả các tệp lưu trên hệ thống đều được chuyển. Đảm bảo rằng bạn có đủ dung lượng đĩa để chuyển
dữ liệu an toàn.

Khi lượt chạy hoàn tất, CFX Maestro Dx SE sẽ phân tích dữ liệu về chất huỳnh quang. Nếu lượt chạy
được thực hiện ở chế độ độc lập và được lưu trên Hệ thống CFX Opus Dx, dữ liệu cần được chuyển sang
CFX Maestro Dx SE để phân tích.

Hệ thống CFX Opus Dx có thể lưu trữ tới 100 lượt chạy real-time PCR. Sau khi lượt chạy hoàn tất, bạn có
thể chuyển các tệp dữ liệu độc lập sang máy tínhCFX Maestro Dx SE qua email, ổ đĩa USB, hoặc qua
chính phần mềm.

Mục này giải thích cách chuyển các tệp dữ liệu độc lập sang máy tính CFX Maestro Dx SE.

Chuyển Dữ Liệu Qua Email
Gửi một tệp dữ liệu qua email khi kết thúc lượt chạy

1. Thiết lập email thông báo cho máy.

Xem Thiết Lập Email Thông Báo trên trang 80 hoặc Hướng Dẫn Vận Hành Hệ Thống Real-Time
PCR CFX Opus Dx.

2. Khi bạn thiết lập email thông báo, hãy đảm bảo chọn Attach Data File (Đính Kèm Tệp Dữ Liệu).

Dữ liệu lượt chạy được gửi qua email dưới dạng tệp tin .pcrd.

Chuyển dữ liệu từ Hệ Thống Real-Time PCR CFX Opus Dx
Với tính năng File Browser (Trình Duyệt Tệp) trên Hệ thống CFX Opus Dx, bạn có thể chuyển các tệp dữ
liệu sang USB gắn kèm hoặc vào thư mục mạng dùng chung. Bạn cũng có thể chuyển các tệp protocol
của CFX Maestro Dx SE từ USB hoặc ổ đĩa mạng dùng chung vào thư mục của bạn hoặc thư mục Public
(Công Khai) trên Hệ thống CFX Opus Dx và chạy các tệp này trên Hệ thống CFX Opus Dx .

Lời khuyên: Phần này giải thích cách chuyển dữ liệu. Để biết thông tin về cách thiết lập kết nối
Ethernet hãy xem Hướng Dẫn Vận Hành Hệ Thống Real-Time PCR CFX Opus Dx có trên CFX
Maestro Dx SE menu Help (Trợ Giúp).

1. Trên màn hình Trang Chủ của Hệ thống CFX Opus Dx, chạm vào Files (Tệp) để xemmàn hình File
Browser (Trình Duyệt Tệp).

2. Trên màn hình File Browser (Trình Duyệt Tệp), điều hướng đến tệp bạn muốn sao chép, sau đó
chạm vào tệp để xem ngăn chi tiết tệp.

3. Trong ngăn chi tiết tệp, chạm vào Options (Tùy chọn) rồi chạm vào Copy (Sao chép).
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Hộp thoại Select Location (Chọn vị trí) xuất hiện.

4. Trong hộp thoại Select Location (Chọn vị trí), thực hiện một trong các thao tác sau:

n Điều hướng đến một thư mục hiện có.

n Điều hướng đến vị trí để tạo thư mục lưu tập tin, sau đó chạm vào Create Folder (Tạo thư mục)

( ) để tạo thư mục mới ở vị trí đó.

5. Chạm vào Select (Chọn) để sao chép tập tin vào vị trí đã chọn hoặc Cancel (Hủy) để quay lại màn
hình File Browser (Trình Duyệt Tập Tin).

Lưu ý: Nếu có tệp cùng tên ở vị trí bạn chọn, một hộp thông báo sẽ xuất hiện. Chạm vào Yes
(Có) để ghi đè tệp hiện có hoặc No (Không) để quay lại màn hình File Browser (Trình Duyệt
Tệp).

Hệ thống CFX Opus Dx sẽ hiển thị thông báo xác nhận khi tệp được sao chép thành công.
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Chuyển Dữ Liệu Qua Phần mềm CFX Maestro Dx, Phiên bản bảo
mật
Cách chuyển dữ liệu qua CFX Maestro Dx SE

1. Trong ngăn Detected Instruments (Máy Đã Phát Hiện) trên cửa sổ Trang Chủ, nhấp chuột phải vào
máy muốn dùng và chọn Retrieve Data Files (Truy Xuất Tệp Dữ Liệu).

CFX Maestro Dx SE hiển thị hộp thoại Browse For Folder (Duyệt Tìm Thư Mục).

2. Trong hộp thoại Browse For Folder (Duyệt Tìm Thư Mục), duyệt đến vị trí mà bạn dự định lưu tệp dữ
liệu và nhấp OK.

Quá trình chuyển sẽ tạo một thư mục gắn nhãn Real-Time Data (Dữ Liệu Thời Gian Thực) ở vị trí đã
chọn. Dữ liệu lượt chạy được lưu vào thư mục Real-Time Data (Dữ Liệu Thời Gian Thực) dưới dạng
các tệp tin .zpcr riêng biệt.

Chuyển Dữ Liệu Bằng Ổ Đĩa USB
Nếu bạn cắm ổ đĩa USB vào cổng USB trên máy, tệp dữ liệu sẽ tự động được lưu vào thư mục gốc của ổ
đĩa USB khi lượt chạy hoàn thành. Bạn cũng có thể định vị các tệp dữ liệu đã lưu trước đó và lưu chúng
vào ổ đĩa USB đã cắm.

Cách chuyển các tệp dữ liệu vào ổ USB trên Hệ thống CFX Opus Dx

u Trong hộp thoại Select Location (Chọn Vị Trí), chạm vào USB và tìm đến thư mục mục tiêu để sao
chép tệp hoặc Cancel (Hủy) để quay lại màn hình File Browser (Trình Duyệt Tệp).

Lưu ý: Nếu một tệp có cùng tên tồn tại ở vị trí đã chọn, một hộp thoại sẽ xuất hiện. Chạm vào
Yes (Có) để ghi đè tệp hiện có hoặc No (Không) để quay lại màn hình File Browser (Trình Duyệt
Tệp).

Hệ thống CFX Opus Dx sẽ hiển thị thông báo xác nhận khi tệp được sao chép thành công.
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Chuyển Dữ Liệu Thông Qua Ổ Đĩa Mạng Dùng Chung Bằng Hệ
Thống Real-Time PCR CFX Opus Dx
Lời khuyên: Bạn chỉ có thể chuyển dữ liệu đến và đi từ một ổ đĩa mạng dùng chung thông qua Hệ
thống CFX Opus Dx.

Hệ thống CFX Opus Dx cho phép bạn kết nối với ổ đĩa mạng dùng chung bằng Ethernet. Với kết nối thành
công, bạn có thể chuyển các tệp dữ liệu đến và đi từ một thư mục trên ổ đĩa mạng dùng chung.

Cách chuyển dữ liệu đến và đi từ một ổ đĩa mạng dùng chung

u Trong hộp thoại Select Location (Chọn Vị Trí), chạm vào Network (Mạng) và tìm thư mục mục tiêu để
sao chép tệp hoặc Cancel (Hủy) để quay lại màn hình File Browser (Trình Duyệt Tệp).

Lưu ý: Nếu một tệp có cùng tên tồn tại ở vị trí đã chọn, một hộp thoại sẽ xuất hiện. Chạm vào
Yes (Có) để ghi đè tệp hiện có hoặc No (Không) để quay lại màn hình File Browser (Trình Duyệt
Tệp).

Hệ thống CFX Opus Dx sẽ hiển thị thông báo xác nhận khi tệp được sao chép thành công.

Tạo Tệp Dữ Liệu
Để phân tích dữ liệu được chuyển từ máy sang máy tính chạy CFX Maestro Dx SE, tệp dữ liệu nén (tệp
.zpcr) phải được chuyển đổi thành tệp dữ liệu (tệp .pcrd). CFX Maestro Dx SE chuyển đổi tệp .zpcr thành
tệp .pcrd, sau đó chọn một tệp khay có cùng chế độ quét và kích thước khay và áp dụng vào tệp .pcrd.

Cách tạo tệp dữ liệu từ một tệp dữ liệu độc lập

1. Trong CFX Maestro Dx SE thực hiện một trong các thao tác sau:

n Định vị tệp .zpcr mục tiêu và kéo vào cửa sổ Trang Chủ của CFX Maestro Dx SE.

n Chọn File > Open > Stand-alone Run (Tệp > Mở > Lượt Chạy Độc Lập) và điều hướng đến và
chọn tệp mục tiêu.

CFX Maestro Dx SE hiển thị hộp thoại Save As (Lưu Dưới Dạng).

2. Điều hướng đến thư mục bạn định lưu tệp .pcrd và nhấp Save (Lưu).

Sau khi bạn lưu tệp tin .pcrd, CFX Maestro Dx SE mở cửa sổ Data Analysis (Phân Tích Dữ Liệu) và
hiển thị dữ liệu kết quả.
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Phần mềm CFX Maestro Dx, Phiên bản bảo mật xử lý dữ liệu Real-Time PCR tự động vào cuối mỗi lượt
chạy và mở cửa sổ Data Analysis (Phân Tích Dữ Liệu) để hiển thị các dữ liệu này (tệp .pcrd).

n Kéo một tệp dữ liệu (phần mở rộng .pcrd) vào cửa sổ Trang Chủ và thả ra

n Chọn File > Open > Data File (Tệp > Mở > Tệp Dữ Liệu) trong cửa sổ Trang Chủ và tìm đến tệp .pcrd
mục tiêu

n Chọn File > Recent Data Files (Tệp > Tệp Dữ Liệu Gần Đây) trong cửa sổ Trang Chủ để chọn trong
danh sách mười tệp dữ liệu được mở gần đây nhất

n Chọn tab Analyze (Phân Tích) trong Startup Wizard (Trình Hướng Dẫn Khởi Động) và chọn từ
Recent Files (Tệp Gần Đây) hoặc nhấp vào Browse (Tìm Đường Dẫn) để tìm tệp dữ liệu

Cửa Sổ Data Analysis (Phân Tích Dữ Liệu)
Cửa sổ Data Analysis (Phân Tích Dữ Liệu) hiển thị nhiều tab, mỗi tab hiển thị dữ liệu được phân tích cho
một phương pháp phân tích cụ thể hoặc thông tin cụ thể về lượt chạy. Trang chỉ xuất hiện nếu có sẵn dữ
liệu được thu thập trong lượt chạy cho loại phân tích đó.

Lời khuyên: Để chọn các tab cần hiển thị, chọn từ View (Xem) trong menu thả xuống ở cửa sổ Data
Analysis (Phân Tích Dữ Liệu). Để trở về bố cục tab ban đầu, chọn Settings > Restore Default
Window Layout (Cài Đặt > Khôi Phục Bố Cục Cửa Sổ Mặc Định).

Hướng Dẫn Sử Dụng | 185



Chương 10 Tổng Quan Về Phân Tích Dữ Liệu

Thanh Công Cụ Phân Tích Dữ Liệu
Thanh công cụ trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) cho phép truy cập nhanh các chức năng
phân tích dữ liệu quan trọng.

Bảng 11 liệt kê chức năng của các nút trong thanh công cụ.

Nút Tên Chức Năng

Plate Setup
(Thiết Lập Khay)

View/Edit plate (Xem/Chỉnh sửa khay) —Mở
Plate Editor (Trình Chỉnh Sửa Khay) để xem và
chỉnh sửa nội dung của các giếng.

Replace Plate (Thay Thế Khay) – Chọn tệp khay
để thay thế bố cục khay.

Apply PrimePCR file (Áp dụng tệp PrimePCR) –
Chọn một tệp lượt chạy để thay thế bố cục khay
cho một lượt chạy PrimePCR.

Quản Lý Các
Nhóm Giếng

Mở cửa sổWell Groups Manager (Trình Quản Lý
Các Nhóm Giếng) để tạo, chỉnh sửa, và xóa các
nhóm giếng.

Nhóm Giếng Chọn tên nhóm giếng hiện có từ menu thả xuống.
Lựa chọn mặc định là All Wells (Tất Cả Các
Giếng). Nút này chỉ xuất hiện khi các nhóm giếng
được tạo.

Chế Độ Phân
Tích

Phân tích dữ liệu trong chế độ Fluorophore (Chất
Phát Huỳnh Quang) hoặc Target (Mục Tiêu).

Trợ Giúp Mở phần Help (Trợ Giúp) của phần mềm, giúp
bạn tìm sự trợ giúp trực tuyến và bản sao kỹ thuật
số của hướng dẫn này ở định dạng Acrobat PDF.

Bảng 11. Thanh công cụ trong cửa sổ Data Analysis (Phân Tích Dữ Liệu)
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Thanh Menu Phân Tích Dữ Liệu
Bảng 12 liệt kê các mục trên thanh menu trong cửa sổ Data Analysis (Phân Tích Dữ Liệu).

Mục Menu Lệnh Chức Năng

File (Tệp) Save (Lưu) Saves the file (Lưu tệp).

Save As (Lưu Dưới Dạng) Lưu tệp bằng tên mới.

File Passwords (Mật Khẩu Tệp) Cho phép người dùng đặt mật khẩu cần nhập
khi lưu và mở tệp.

Sign (Ký Tên) Cho phép người dùng ký tên vào tệp dữ liệu.

Repeat Run (Lặp Lại Lượt Chạy) Trích xuất protocol và tệp khay từ lượt chạy
hiện tại để chạy lại.

Close (Đóng) Đóng cửa sổ Data Analysis (Phân Tích Dữ
Liệu).

View (Chế Độ
Xem)

Run Log (Nhật Ký Lượt Chạy) Mở một cửa sổ Run Log (Nhật Ký Lượt Chạy)
để xem nhật ký lượt chạy của tệp dữ liệu hiện
tại.

Dấu Vết Kiểm Soát Mở dấu vết kiểm soát cho tệp.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information
(Định Lượng, Đường Cong Chảy,
Biểu Hiện Gen, Điểm Cuối, Chế Độ
Xem Dữ Liệu Tùy Chỉnh, QC,
Thông Tin Lượt Chạy)

Hiển thị dữ liệu được phân tích trong các tab
đã chọn trong cửa sổ Data Analysis (Phân
Tích Dữ Liệu). Phải chọn ít nhất một tab.

Bảng 12. Các mục trên thanh menu trong cửa sổ Data Analysis (Phân Tích Dữ Liệu)
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Mục Menu Lệnh Chức Năng

Settings (Cài
Đặt)

Cq Determination Mode (Chế Độ
Xác Định Cq)

Cho phép bạn chọn chế độ Regression (Hồi
Quy) hoặc Single Threshold (Ngưỡng Đơn) để
xác định cách các giá trị Cq được tính cho mỗi
vạch đồ họa.

Baseline Setting (Cài Đặt Đường
Nền)

Cho phép bạn chọn phương pháp Baseline
Subtraction (Trừ Đường Nền) cho các nhóm
giếng đã chọn.

Chế Độ Phân Tích Cho phép bạn phân tích dữ liệu theo Chất Phát
Huỳnh Quang hoặc theo Mục Tiêu.

Chu Kỳ để Phân Tích Cho phép bạn chọn các chu kỳ để phân tích.

Baseline Thresholds (Ngưỡng
Đường Nền)

Mở cửa sổ Baseline Threshold (Ngưỡng
Đường Nền) để điều chỉnh đường nền hoặc
ngưỡng.

Trace Styles (Các Kiểu Vạch Đồ
Họa)

Mở cửa sổ Trace Styles (Các Kiểu Vạch Đồ
Họa).

Plate Setup (Thiết Lập Khay) Mở Plate Editor (Trình Chỉnh Sửa Khay) để
xem và chỉnh sửa khay; thay thế khay hiện tại
bằng một khay từ tập tin khay do người dùng
xác định hoặc tập tin lượt chạy PrimePCR.

Include All Excluded Wells (Bao
Gồm Tất Cả Các Giếng Bị Loại
Trừ)

Bao gồm tất cả các giếng bị loại trừ trong phân
tích.

Mouse Highlighting (Tô Sáng Bằng
Chuột)

Bật hoặc tắt chế độ tô nổi dữ liệu đồng thời
bằng con trỏ chuột.

Lời khuyên: Nếu tắt Mouse Highlighting
(Tô Nổi Bằng Chuột), hãy nhấn phím
Control (Điều Khiển) để tạm thời bật chức
năng tô nổi.

Restore Default Window Layout
(Khôi Phục Bố Cục Cửa Sổ Mặc
Định)

Khôi phục sắp xếp cửa sổ về cài đặt mặc định.

Bảng 12. Các mục trên thanh menu trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), tiếp
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Mục Menu Lệnh Chức Năng

Export (Xuất) Export All Data Sheets (Xuất Tất
Cả Các Trang Dữ Liệu)

Cho phép bạn chọn xuất tất cả các chế độ xem
bảng tính từ mọi tab sang tệp .csv, .txt, Excel
hoặc .xml.

Export RDML File (Xuất Tệp
RDML)

Cho phép bạn chọn phiên bản 1.1 hoặc 1.0
của RDML để xuất tệp.

Custom Export (Xuất Tùy Chỉnh) Mở cửa sổ Custom Export (Xuất Tùy Chỉnh),
trong đó có thể chỉ định chọc lọc các trường sẽ
được xuất và định dạng tập tin.

Export to LIMS Folder (Xuất sang
Thư Mục LIMS)

Mởmột cửa sổ để lưu dữ liệu theo định dạng
được xác định trước vào thư mục LIMS.

Xuất Thủ Công Mởmột cửa sổ để xác định vị trí lưu dữ liệu từ
tất cả các chế độ xem trang bảng tính vào các
tệp Excel có cấu trúc đặc biệt được sử dụng
bởi Seegene, Inc. và Bio-Rad Laboratories.

Lời khuyên: Bạn cũng có thể tự động
khởi động Trình Xem Seegene khi xuất.
Xem Các Lệnh Trong Menu Tools (Công
Cụ) trên trang 65 để biết thêm thông tin.

Tools (Công Cụ) Reports (Báo Cáo) Mở Báo Cáo cho tệp dữ liệu này.

Well Group Reports (Báo Cáo
Nhóm Giếng)

Mở cửa sổWell Group Report (Báo Cáo Nhóm
Giếng) để tạo báo cáo cho các nhóm giếng chỉ
định.

Import Fluorophore Calibration
(Nhập Hiệu Chuẩn Chất Phát
Huỳnh Quang)

Chọn một tập tin hiệu chuẩn để áp dụng cho
tệp dữ liệu hiện tại.

qbase + Chạy qbase+ v2.5 trực tiếp từ tệp .pcrd hiện tại
nếu được cài đặt.

Generate LIMS PLRN file (Tạo tệp
PLRN LIMS)

Lưu tệp dữ liệu dưới dạng tệp .plrn có định
dạng LIMS.

Bảng 12. Các mục trên thanh menu trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), tiếp
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Chi Tiết Tab
Mỗi tab trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) hiển thị dữ liệu trong các biểu đồ và trang bảng
tính cho một phương pháp phân tích cụ thể và bao gồm bộ chọn giếng để chọn dữ liệu bạn muốn hiển thị.
Khi mở ra, cửa sổ Data Analysis (Phân Tích Dữ Liệu) sẽ hiển thị tab Quantification (Định Lượng) theo
mặc định. Bạn có thể sử dụng dữ liệu biểu đồ Amplification (Khuếch Đại) trong tab Quantification (Định
Lượng) để xác định cài đặt phân tích thích hợp cho lượt chạy.

Lưu ý: Phần mềm liên kết dữ liệu trong các ngăn của mỗi tab Data Analysis (Phân Tích Dữ Liệu). Ví
dụ, tô sáng một giếng bằng cách đặt con trỏ chuột lên giếng trong ngăn bộ chọn giếng sẽ tô sáng dữ
liệu trong tất cả các ngăn khác.

Chọn Bước Số
Hệ thống CFX Opus Dx có thể thu được dữ liệu về chất huỳnh quang ở nhiều bước chương trình; phần
mềm duy trì dữ liệu thu được ở mỗi bước một cách độc lập. CFX Maestro Dx SE hiển thị bộ chọn Step
Number (Số bước) bên dưới biểu đồ Standard Curve (Đường cong chuẩn) trên tab Quantification (Định
lượng). Khi một protocol chứa ít nhất một bước thu thập dữ liệu, CFX Maestro Dx SE hiển thị dữ liệu từ
bước thu thập đầu tiên.

Nếu protocol chứa nhiều bước thu thập, bạn có thể chọn một bước khác từ danh sách thả xuống. Ví dụ:

Khi bạn chọn một bước, phần mềm sẽ áp dụng lựa chọn đó cho tất cả dữ liệu được hiển thị trong cửa sổ
Data Analysis (Phân Tích Dữ Liệu).
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Xem Các Nhóm Giếng trong Phân Tích Dữ Liệu
Các giếng trong khay có thể được nhóm lại thành các tập con để phân tích độc lập bằng cách sử dụng
các nhóm giếng. Khi bạn tạo các nhóm giếng, tên nhóm của chúng sẽ xuất hiện trong danh sách thả
xuốngWell Group (Nhóm Giếng) ở cửa sổ Data Analysis (Phân Tích Dữ Liệu) trên thanh công cụ.

Nếu bạn tạo các nhóm giếng, phần mềm sẽ hiển thị nhóm giếng mặc định All Wells (Tất Cả Các Giếng)
khi bạn mở cửa sổ Data Analysis (Phân Tích Dữ Liệu), hiển thị dữ liệu trong tất cả các giếng có nội dung
trong biểu đồ và trang bảng tính. Chỉ các giếng trong nhóm giếng đã nạp nội dung đó mới xuất hiện trong
bộ chọn giếng, và chỉ dữ liệu cho các giếng đó mới được bao gồm trong các tính toán phân tích dữ liệu.

Lời khuyên: Để tạo, chỉnh sửa, và xóa các nhóm giếng, nhấp vào ManageWell Groups (Quản Lý
Các NhómGiếng) trên thanh công cụ.

Lưu ý: Nếu bạn không tạo các nhóm giếng, danh sách thả xuốngWell Groups (Các Nhóm Giếng) sẽ
không xuất hiện trên thanh công cụ.

Thay Đổi Nội Dung Giếng sau một Lượt Chạy
Trong quá trình phân tích dữ liệu, thay đổi cách dữ liệu được hiển thị bằng cách thay đổi nội dung của các
giếng trong Plate Editor (Trình Chỉnh Sửa Khay) không bao giờ làm thay đổi dữ liệu chất huỳnh quang
được thu thập từ mỗi giếng trong suốt lượt chạy. Sau khi mô-đun thu thập dữ liệu về chất huỳnh quang,
bạn không thể xóa dữ liệu đó nhưng bạn có thể chọn xóa dữ liệu khỏi chế độ xem và phân tích.

Cách thay đổi nội dung của giếng sau một lượt chạy

u Trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), nhấp vào Plate Setup (Thiết Lập Khay) và chọn
một trong các tùy chọn sau:

n Edit/View Plate (Chỉnh Sửa/Xem Khay) —mở Plate Editor (Trình Chỉnh Sửa Khay), ở đó bạn
có thể thay đổi bố cục theo cách thủ công.

n Replace Plate File (Thay Thế Tệp Khay) —mở trình duyệt Select Plate (Chọn Khay), trong đó
bạn có thể tìm đến tệp khay đã lưu trước đó để thay thế bố cục khay hiện tại.

n Apply PrimePCR file (Áp dụng tệp PrimePCR)—mở hộp thoại Select PrimePCR file (Chọn tệp
PrimePCR), ở đó bạn có thể tìm đến tệp lượt chạy PrimePCR và áp dụng cho bố cục khay.

Lời khuyên: Bạn có thể thêm hoặc chỉnh sửa thông tin về nội dung của giếng trước một lượt chạy,
trong một lượt chạy, hoặc sau khi một lượt chạy PCR hoàn tất. Bạn phải gán chế độ quét và kích
thước khay trước khi chạy. Các tham số này không thể thay đổi sau lượt chạy.
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Cài Đặt Phân Tích Dữ Liệu
Dữ liệu biểu đồ Amplification (Khuếch Đại) trong tab Quantification (Định Lượng) hiển thị dữ liệu huỳnh
quang tương đối (RFU) cho từng giếng ở mọi chu kỳ. Mỗi vạch đồ họa trong biểu đồ đại diện cho dữ liệu
từ một chất huỳnh quang riêng lẻ trong một giếng. Những dữ liệu này được sử dụng để xác định các giá
trị Cq cho mỗi giếng trên cơ sở mỗi chất huỳnh quang. Phần mềm sử dụng một trong hai chế độ để xác
định các giá trị Cq:

n Regression (Hồi Quy) — sử dụng mô hình đa biến, phi tuyến tính cho các vạch đồ họa giếng riêng lẻ
và sau đó sử dụng mô hình này để tính giá trị Cq tối ưu.

n Single Threshold (Ngưỡng Đơn) — sử dụng một giá trị ngưỡng đơn để tính giá trị Cq dựa trên điểm
giao nhau giữa vạch ngưỡng và các vạch dấu vết huỳnh quang đơn lẻ.

Chọn Settings > Cq Determination Mode (Cài Đặt > Chế Độ Xác Định Cq) để chọn chế độ xác định Cq.

Điều Chỉnh Ngưỡng
Ở chế độ Single Threshold (Ngưỡng Đơn), bạn có thể điều chỉnh ngưỡng cho một chất huỳnh quang
bằng cách nhấp vào đường ngưỡng trong biểu đồ Amplification (Khuếch Đại) và di chuyển con trỏ chuột
theo chiều dọc. Ngoài ra, bạn có thể chỉ định một ngưỡng giao chính xác cho chất huỳnh quang đã chọn.

Cài Đặt Đường Nền
Phần mềm tự động thiết lập đường nền riêng cho từng giếng. Cài đặt đường nền xác định phương pháp
trừ đường nền cho tất cả các dấu vết huỳnh quang. Phần mềm cung cấp ba tùy chọn trừ đường nền:

n No Baseline Subtraction (Không Trừ Đường Nền) — hiển thị dữ liệu theo các dấu vết huỳnh quang
tương đối. Một số phân tích không thể thực hiện được trong chế độ phân tích này và do đó phần
mềm không hiển thị các tab Gene Expression (Biểu Hiện Gen), End Point (Điểm Cuối), và Allelic
Discrimination (Phân Định Alen).

n Baseline Subtracted (Đã Trừ Đường Nền) — hiển thị dữ liệu dưới dạng các vạch đồ họa đã trừ
đường nền cho mỗi chất huỳnh quang trong giếng. Phần mềm phải trừ đường nền dữ liệu để xác
định các chu kỳ định lượng, xây dựng đường cong tiêu chuẩn, và xác định nồng độ của các mẫu ẩn
số. Để tạo ra một dấu vết đã trừ đường nền, phần mềm đưa đường thẳng phù hợp nhất qua dữ liệu
huỳnh quang được ghi lại của mỗi giếng trong các chu kỳ đường nền và sau đó trừ đi dữ liệu phù hợp
nhất từ ​​dữ liệu đã trừ nền tại mỗi chu kỳ.

n Baseline Subtracted Curve Fit (Vẽ Đường Cong Đã Trừ Đường Nền) — hiển thị dữ liệu dưới dạng
các vạch đồ họa đã trừ đường nền và phần mềm dàn xếp đường cong đã trừ đường nền bằng cách
sử dụng bộ lọc trung bình căn giữa. Quá trình này được thực hiện để mỗi Cq duy trì bất biến.
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Ngoài các tùy chọn này, bạn cũng có thể chọn Apply Fluorescent Drift Correction (Áp Dụng Hiệu Chỉnh Dấu
Vết Huỳnh Quang). Đối với các giếng có giá trị RFU tạo vết bất thường trong một vài chu kỳ ban đầu của một
lượt chạy, phần mềm suy ra một đường nền ước tính từ các giếng lân cận có đường nền ngang được tạo
thành công.

Cách thay đổi cài đặt trừ đường nền

u Chọn Settings > Baseline Setting (Cài Đặt > Cài Đặt Đường Nền).

Chế Độ Phân Tích
Dữ liệu có thể được nhóm lại và phân tích theo chất huỳnh quang hoặc tên mục tiêu. Khi được nhóm theo
chất fluorophore, các vạch đồ họa dữ liệu được hiển thị theo chất huỳnh quang như được chỉ ra trong thiết
lập khay cho lượt chạy đó. Dữ liệu huỳnh quang riêng lẻ xuất hiện trong biểu đồ khuếch đại và biểu đồ
đường cong chuẩn (nếu có) khi các ô kiểm để chọn chất huỳnh quang, nằm bên dưới biểu đồ khuếch đại,
được đánh dấu thích hợp.

Khi được nhóm theo mục tiêu, các vạch đồ họa dữ liệu được hiển thị theo tên mục tiêu như được nhập
trong thiết lập khay cho lượt chạy đó.

Cách chọn chế độ phân tích dữ liệu

u Thực hiện một trong các thao tác sau:

n Chọn Settings > Analysis Mode (Cài Đặt > Chế Độ Phân Tích).

n Chọn một chế độ từ menu thả xuống Analysis Mode (Chế Độ Phân Tích) trên thanh công cụ.
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Chu Kỳ để Phân Tích
Bạn có thể hạn chế số chu kỳ để phân tích. Bạn cũng có thể phân tích dữ liệu từ một tập hợp các chu kỳ
cụ thể. Số chu kỳ tối đa bạn có thể phân tích là 50.

Lưu ý: Loại bỏ chu kỳ từ đầu lượt chạy có thể có tác động đáng kể đến việc tạo đường nền.

Cách hạn chế phân tích dữ liệu cho một phạm vi chu kỳ cụ thể

1. Chọn Settings > Cycles to Analyze (Cài Đặt > Chu Kỳ để Phân Tích).

Hộp thoại Cycles to Analyze (Chu Kỳ để Phân Tích) xuất hiện.

2. Nhập giá trị chu kỳ bắt đầu và kết thúc và nhấp vào OK.

Nhấp vào Restore Defaults (Khôi Phục Mặc Định) trong hộp thoại Cycles to Analyze (Chu Kỳ để Phân
Tích) để trở về chu kỳ ban đầu được sử dụng để phân tích.
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Bộ Chọn Giếng
Sử dụng Bộ Chọn Giếng để hiển thị hoặc ẩn dữ liệu giếng trong các biểu đồ hoặc trang bảng tính trong
cửa sổ Data Analysis (Phân Tích Dữ Liệu). Chỉ có thể chọn các giếng đã tải kèmmẫu trong bộ chọn giếng
này. Phần mềm tô màu các giếng trong Bộ Chọn Giếng:

n Xanh dương—biểu thị các giếng đã chọn. Dữ liệu từ các giếng đã chọn xuất hiện trong cửa sổ
Data Analysis (Phân Tích Dữ Liệu).

n Xám nhạt—biểu thị các giếng không chọn. Dữ liệu từ các giếng không chọn không xuất hiện trong
cửa sổ Data Analysis (Phân Tích Dữ Liệu).

n Xám đậm—biểu thị các giếng trống.

Cách hiển thị hoặc ẩn dữ liệu giếng

u Trong bộ chọn giếng, thực hiện bất kỳ thao tác nào sau đây:

n Để ẩn một giếng, nhấp vào giếng đơn lẻ đó. Để hiển thị giếng đó, nhấp vào giếng lần nữa.

n Để ẩn nhiều giếng, kéo qua các giếng bạn muốn chọn. Để hiển thị các giếng đó, kéo qua các
giếng lần nữa.

n Nhấp vào góc trên bên trái của khay để ẩn tất cả các giếng. Nhấp lại vào góc trên bên trái để
hiển thị tất cả các giếng.

n Nhấp vào điểm đầu cột hoặc hàng để ẩn các giếng đó. Nhấp lại vào cột hoặc hàng để hiển thị
các giếng.
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Các Mục Trong Menu Nhấp Chuột Phải của Bộ Chọn Giếng
Bảng 13 liệt kê các tùy chọn nhấp chuột phải có sẵn trong chế độ xem bộ chọn giếng.

Mục Chức Năng

Well XX (Giếng XX) Chỉ hiển thị giếng này, loại bỏ giếng này khỏi màn hình xem, cài đặt
màu cho giếng này, hoặc loại trừ giếng này khỏi phân tích.

Các Giếng Đã Chọn (nhấp chuột
phải và kéo)

Chỉ hiển thị các giếng này, loại bỏ các giếng này khỏi màn hình xem,
cài đặt màu cho các giếng này, hoặc loại trừ các giếng này khỏi phân
tích.

Copy (Sao Chép) Sao chép nội dung của giếng vào bảng tạm, bao gồm Loại Mẫu và Số
Bản Sao tùy chọn.

Copy as Image (Sao Chép dưới
dạng Hình Ảnh)

Sao chép chế độ xem bộ chọn giếng dưới dạng hình ảnh.

Print (In) In chế độ xem bộ chọn giếng.

Print Selection (Lựa Chọn In) In lựa chọn hiện tại.

Export to Excel (Xuất sang
Excel)

Xuất dữ liệu sang trang tính Excel.

Export to CSV (Xuất sang CSV) Xuất dữ liệu thành tài liệu .csv.

Export to Xml (Xuất sang Xml) Xuất dữ liệu dưới dạng tài liệu .xml.

Well Labels (Nhãn Giếng) Thay đổi nhãn giếng thành Loại mẫu, Tên Mục Tiêu, hoặc Tên Mẫu.

Bảng 13. Các mục ở menu nhấp chuột phải trong chế độ xem bộ chọn giếng
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Tạm Thời Loại Trừ Các Giếng khỏi Phân Tích
Cách tạm thời loại trừ các giếng khỏi phân tích dữ liệu

1. Nhấp chuột phải vào giếng trong bộ chọn giếng, trên dấu vết chất huỳnh quang hoặc trên một điểm
chấm trên đường cong chuẩn. Để loại nhiều giếng, nhấp chuột phải và kéo để đánh dấu nhiều giếng,
vạch đồ họa, hoặc điểm.

2. Từ menu nhấp chuột phải, chọn tùy chọn thích hợp:

n Well > Exclude Well (Giếng > Loại Trừ Giếng)

n Selected Wells > Exclude from Analysis (Các Giếng Đã Chọn > Loại khỏi Phân Tích)

n Selected Traces > Exclude these wells from Analysis (Các Vạch Đồ Họa Đã Chọn > Loại trừ các
giếng này khỏi Phân Tích)

Ngoài ra, để xóa vĩnh viễn các giếng khỏi phân tích, hãy xóa nội dung khỏi các giếng trong Plate
Editor (Trình Chỉnh Sửa Khay) bằng cách nhấp vào nút Clear Wells (Xóa Giếng).

Quan trọng: Bạn phải nhập lại bất kỳ nội dung giếng nào đã bị xóa.

Cách bao gồm giếng đã loại trừ

u Nhấp chuột phải vào giếng thích hợp trong bộ chọn giếng và chọnWell > Include Well in Analysis
(Giếng > Bao GồmGiếng vào Phân Tích)
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Biểu Đồ
Mỗi biểu đồ trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) hiển thị dữ liệu trong một biểu đồ khác và
bao gồm các tùy chọn để điều chỉnh và xuất dữ liệu hoặc hình ảnh trong biểu đồ.

Công Cụ Biểu Đồ
Bảng 14 liệt kê các tùy chọn nhấp chuột phải khả dụng trong hầu hết các biểu đồ.

Mục Chức Năng

Copy (Sao Chép) Sao chép biểu đồ vào bảng tạm.

Save Image As... (Lưu Ảnh
Dưới Dạng...)

Lưu biểu đồ dưới dạng tệp tin hình ảnh. Đặt độ phân giải và kích thước
của ảnh và sau đó chọn loại tệp tin (PNG, GIF, JPG, TIF, hoặc BMP).

Page Setup... (Thiết Lập
Trang...)

Chọn thiết lập trang để in.

Print... (In...) In biểu đồ.

Set Scale to Default (Đặt Tỷ Lệ
Về Mặc Định)

Hiển thị toàn bộ dữ liệu trong biểu đồ thanh. Màn hình hiển thị các
thanh cuộn nếu có quá nhiều điểm/mẫu dữ liệu cần hiển thị trong
khung biểu đồ.

Chart Settings (Cài Đặt Biểu Đồ) Mở hộp thoại Chart Settings (Cài Đặt Biểu Đồ), ở đó bạn có thể sửa đổi
các tùy chọn hiển thị của biểu đồ, trong đó bao gồm:

n Tiêu đề biểu đồ và trục

n Phông chữ và kích cỡ biểu đồ và trục

n Tỷ lệ trục

n Vị trí chú thích

Bảng 14. Các mục trong menu nhấp chuột phải thường gặp ở hầu hết các biểu đồ

Công cụ biểu đồ cũng xuất hiện ở từng biểu đồ trong cửa sổ Data Analysis (Phân Tích Dữ Liệu). Tất cả
các biểu đồ hiển thị các công cụ này:

Copy to Clipboard (Sao Chép vào Bảng Tạm)— sao chép nội dung của chế độ xem biểu đồ vào bảng
tạm.

Chart Settings (Cài Đặt Biểu Đồ) —mở hộp thoại Chart Settings (Cài Đặt Biểu Đồ), ở đó bạn có thể sửa
đổi các tùy chọn hiển thị của biểu đồ.

Export (Xuất) —mở hộp thoại Export Options (Tùy Chọn Xuất), từ đó bạn có thể sửa đổi độ phân giải và
kích cỡ của đồ thị và lưu đến vị trí chỉ định dưới dạng một trong các loại tệp sau:
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n .bmp

n .jpg

n .png

Công Cụ Biểu Đồ Thanh

Ngoài các công cụ biểu đồ, biểu đồ thanh cũng hiển thị các công cụ sau:

Sort (Sắp Xếp) — sắp xếp các mục tiêu và mẫu theo thứ tự bảng chữ cái hoặc thứ tự bảng chữ cái ngược
lại.

Color Settings (Cài Đặt Màu) —mở hộp thoại Color Settings (Cài Đặt Màu), trong đó bạn có thể thay đổi
màu của mục tiêu và mẫu.

Để biết thêm thông tin về các công cụ này, xem Thay Đổi Và Lập Chú Thích Chế Độ Xem Biểu Đồ trên
trang 258.

Công Cụ Biểu Đồ Khuếch Đại

Ngoài những công cụ liệt kê trên, biểu đồ khuếch đại cũng hiển thị các công cụ sau:

Trace Styles (Các Kiểu Vạch Đồ Họa) —mở hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa), trong đó
bạn có thể chỉnh sửa diện mạo của các vạch đồ họa trong biểu đồ khuếch đại.

Baseline Threshold (Ngưỡng Đường Nền) —mở hộp thoại Baseline Threshold (Ngưỡng Đường Nền),
trong đó bạn có thể chỉnh sửa đường nền mặc định cho các giếng đã chọn hoặc thay đổi ngưỡng cho
từng đường cong huỳnh quang trong biểu đồ khuếch đại.

Sao Chép Dữ Liệu Biểu Đồ Vào Bảng Tạm

Bạn có thể sao chép nội dung của chế độ xem biểu đồ và dán vào bất kỳ ứng dụng nào chấp nhận tập tin
ảnh bitmap.

Cách sao chép dữ liệu biểu đồ vào bảng tạm

1. Từ các công cụ biểu đồ, hãy chọn biểu tượng Copy to Clipboard (Sao Chép vào Bảng tạm).

2. Mở một ứng dụng chấp nhận ảnh bitmap, ví dụ như Microsoft Word.

3. Nhấp chuột phải và chọn Paste (Dán) để dán ảnh bitmap từ bảng tạm vào ứng dụng.

Thay Đổi Cài Đặt Hiển Thị Biểu Đồ

Sử dụng hộp thoại Chart Settings (Cài Đặt Biểu Đồ) để thay đổi tiêu đề, phông chữ và kích cỡ, tỷ lệ trục,
và vị trí chú thích cho biểu đồ được hiển thị. Các thay đổi bạn tạo ra chỉ áp dụng cho biểu đồ được hiển thị
và được lưu với biểu đồ.
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Cách thay đổi các cài đặt hiển thị biểu đồ

1. Từ các công cụ biểu đồ, nhấp vào Chart Settings (Cài Đặt Biểu Đồ).

Hộp thoại Chart Settings (Cài Đặt Biểu Đồ) xuất hiện.

2. Chọn tab Chart And Axes (Biểu Đồ Và Trục) để:

n Nhập tiêu đề cho biểu đồ.

n Nhập tiêu đề mới cho trục x và đo góc các nhãn dán.

n Nhập tiêu đề mới cho trục y.

3. Chọn tab Fonts (Phông Chữ) để thay đổi phông chữ và kích cỡ phông chữ của biểu đồ.

Lời khuyên: Theo mặc định, kích cỡ phông chữ tự căn tỷ lệ khi kích cỡ biểu đồ thay đổi. Chọn
Change Font Size (Thay Đổi Kích Cỡ Phông Chữ) để đặt kích cỡ phông tĩnh cho từng loại nhãn
dán.

4. Chọn tab Axes Scale (Tỷ Lệ Trục) để:

n Xóa tự động căn tỷ lệ trục x và y và chỉ định các giá trị đặt tỷ lệ tối thiểu và tối đa.

n Chọn để hiển thị đường lưới hoặc dấu tích trên đồ thị.

5. Chọn tab Legend (Chú Thích) để:

n Chọn để ẩn chú thích biểu đồ.

n Thay đổi vị trí mặc định của chú thích biểu đồ.
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Lưu ý: Khi chú thích được đặt ở bên trái hay bên phải của biểu đồ, biểu đồ chỉ hiển thị mười
chất huỳnh quang đầu tiên.

6. Nhấp Apply (Áp Dụng) tại bất kỳ thời điểm nào để xem các thay đổi cài đặt biểu đồ mà không lưu các
thay đổi.

7. Nhấp OK để lưu các thay đổi và quay lại biểu đồ.

Xuất Biểu Đồ

Sử dụng hộp thoại này để sửa đổi chiều rộng, chiều cao, và độ phân giải của đồ thị để xuất ra bằng một
trong các định dạng tệp sau:

n .bmp

n .jpg

n .png

Sau đó bạn có thể dùng đồ thị đã xuất để hiển thị các kết quả của bạn trong các bài trình bày báo cáo
bằng áp phích, bản thuyết trình Microsoft PowerPoint, và tạp chí khoa học chuyên môn.

Lưu ý: Xem xét những điều sau khi sửa đổi các cài đặt:

n Giới hạn chiều rộng và chiều cao tối đa và tối thiểu

o Tại 72 dpi: 0,1–83 in

o Tại 96 dpi: 0,1–62 in

o Tại 150 dpi: 0,1–40 in

o Tại 300 dpi: 0,1–20 in

o Tại 600 dpi: 0,1–10 in

o Ở tất cả các độ phân giải: 2–6.000 pixel

n Tỷ lệ khung hình dựa trên chiều rộng.

Cách xuất biểu đồ

1. Từ các công cụ biểu đồ, nhấp Export (Xuất).

Hộp thoại Export Preview (Xem Trước Xuất) xuất hiện.
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2. Sửa đổi các cài đặt cho màn hình hiển thị theo yêu cầu.

3. Nhấp Export (Xuất).

4. Trong hộp thoại Export (Xuất), thực hiện các thao tác sau:

a. (Không bắt buộc) Điều hướng đến một thư mục để lưu tệp biểu đồ.

b. Nhập tên cho tệp và chọn loại tệp từ danh sách thả xuống.

5. Nhấp Save (Lưu) để lưu tệp tin biểu đồ.

Sửa Đổi Cài Đặt Ngưỡng Đường Nền

Ở chế độ Single Threshold (Ngưỡng Đơn), bạn có thể điều chỉnh ngưỡng cho một chất huỳnh quang
bằng cách nhấp vào đường ngưỡng trong biểu đồ Amplification (Khuếch Đại) và di chuyển con trỏ chuột
theo chiều dọc. Ngoài ra, bạn có thể chỉ định một ngưỡng giao chính xác cho chất huỳnh quang đã chọn.

Lời khuyên: Bạn có thể chỉ định một phạm vi chu kỳ để xác định đường nền cho tất cả các tệp dữ
liệu trong tab Data Analysis (Phân Tích Dữ Liệu) trong User > User Preferences (Người Dùng > Ưu
Tiên của Người Dùng).

Để điều chỉnh chu kỳ đường nền bắt đầu và kết thúc cho từng giếng

1. Trong tab Quantification (Định Lượng), chọn một chất huỳnh quang dưới biểu đồ Amplification
(Khuếch Đại).

2. Từ các công cụ biểu đồ, hãy chọn Baseline Threshold (Ngưỡng Đường Nền).
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Hộp thoại Baseline Threshold (Ngưỡng Đường Nền) xuất hiện.

3. Trong mục Baseline Cycles (Chu Kỳ Đường Nền), thực hiện một trong các thao tác sau:

n Để chọn một giếng, nhấp vào số hàng của giếng.

n Để chọn nhiều giếng liền kề, nhấp vào số hàng của giếng đầu tiên và kéo cột xuống giếng cuối
cùng.

n Để chọn nhiều giếng không liền kề, hãy nhấn phím Control và nhấp vào số hàng của từng giếng
mục tiêu.

n Để chọn tất cả các giếng, nhấp vào góc trên cùng bên trái của bảng.

4. Điều chỉnh chu kỳ Baseline Begin (Bắt Đầu Đường Nền) và chu kỳ Baseline End (Kết Thúc Đường
Nền) cho tất cả các giếng đã chọn, hoặc thay đổi số chu kỳ Begin (Bắt Đầu) và End (Kết Thúc) ở cuối
trang bảng tính.

Lời khuyên: Để cài đặt quay trở về giá trị được lưu lần cuối, hãy nhấp vào Reset All User
Defined Values (Đặt Lại Tất Cả Giá Trị Do Người Dùng Cài Đặt).

5. Nhấp OK để lưu các thay đổi và quay lại biểu đồ.

Để chỉ định một phạm vi chu kỳ cho tất cả các tệp dữ liệu

u Trong cửa sổ Trang Chủ hoặc Plate Editor (Trình Chỉnh Sửa Khay), chọn User > User Preferences
(Người Dùng > Ưu Tiên của Người Dùng) và chọn tab Data Analysis (Phân Tích Dữ Liệu).

Sắp Xếp Dữ Liệu Mục Tiêu, Mẫu, và Nhóm Sinh Học

Lưu ý: Tùy chọn này chỉ có sẵn trên các biểu đồ biểu hiện gen.

Theo mặc định, danh sách Mục Tiêu, Mẫu, và Nhóm Sinh Học hiển thị theo thứ tự bảng chữ cái. Sử dụng
hộp thoại Sort (Sắp Xếp) để sắp xếp hiển thị theo thứ tự bảng chữ cái ngược lại hoặc để di chuyển thủ
công một thuật ngữ đến một vị trí khác trong danh sách.

Cách sắp xếp dữ liệu mục tiêu, mẫu và nhóm sinh học

1. Từ các công cụ biểu đồ, nhấp vào Sort (Sắp Xếp).

Hộp thoại Gene Expression Chart Sorting (Sắp Xếp Biểu Đồ Biểu Hiện Gen) xuất hiện.
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2. Trong hộp thoại, nhấp vào Z-A để sắp xếp danh sách theo thứ tự bảng chữ cái ngược.

3. Để di chuyển thủ công một thuật ngữ, hãy chọn thuật ngữ đó và nhấp vào nút thích hợp giữa các biểu
đồ:

n Nhấp vào mũi tên Lên hoặc Xuống để di chuyển thuật ngữ đã chọn vào một vị trí.

n Nhấp vào mũi tên Lên hoặc Xuống có vạch để di chuyển thuật ngữ đã chọn lên đầu hoặc cuối
danh sách.

4. Nhấp OK để lưu các thay đổi và quay lại tab Gene Expression (Biểu Hiện Gen).
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Biểu Đồ

Thay Đổi Cài Đặt Màu Mục Tiêu Và Màu Mẫu

Lưu ý: Tùy chọn này chỉ có sẵn trên các biểu đồ biểu hiện gen.

Sử dụng hộp thoại Color Settings (Cài Đặt Màu) để thay đổi màu của mục tiêu hay mẫu, hoặc để xóa mục
đó khỏi đồ thị.

Cách thay đổi cài đặt màu

1. Từ các công cụ biểu đồ, chọn Color Settings (Cài Đặt Màu).

Hộp thoại Color Settings (Cài Đặt Màu) xuất hiện.

2. Để thay đổi màu hiển thị đối với mục tiêu hay mẫu, nhấp vào màu đó trong cột Color (Màu).

3. Trong hộp thoại Color (Màu) xuất hiện, chọn một màu mới và nhấp OK.

4. Để xóa mục đó khỏi đồ thị biểu hiện gen, bỏ chọn ô kiểm trong cột Show Chart (Hiển Thị Biểu Đồ).

Lời khuyên: Để xóa tất cả các mục khỏi đồ thị biểu hiện gen, bỏ chọn ô kiểm Show Chart (Hiển
Thị Biểu Đồ) trong đầu cột.

5. (Tùy chọn) Theo mặc định, màu biểu đồ thanh xuất hiện ở dạng thang gradient. Để hiển thị màu ở
dạng đồng nhất, chọn Use Solid Colors (Sử Dụng Màu Đồng Nhất).

6. Nhấp OK để lưu các thay đổi và quay lại tab Gene Expression (Biểu Hiện Gen).
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Khuếch Đại một Khu Vực trong Biểu Đồ
Cách khuếch đại một khu vực của biểu đồ

u Nhấp và kéo dọc biểu đồ rồi nhấp vào Zoom* (Thu Phóng). Phần mềm sẽ chỉnh lại kích cỡ biểu đồ và
chỉnh tâm vào khu vực được chọn.

Lưu ý: * Bar Chart (Biểu Đồ Thanh) không yêu cầu bạn phải nhấp vào lệnh Zoom (Thu Phóng)
vừa bật lên.

Cách đặt lại biểu đồ về chế độ xem đầy đủ

u Nhấp chuột phải vào biểu đồ và chọn Set Scale to Default (Đặt Tỷ Lệ Về Mặc Định).

Sao Chép Biểu Đồ vào Tệp Tin Microsoft
Bạn có thể sao chép biểu đồ dữ liệu vào các tài liệu Microsoft Word, Excel, hoặc Powerpoint. Độ phân giải
hình ảnh tương ứng với độ phân giải của màn hình gốc hiển thị hình ảnh.

Cách sao chép biểu đồ vào một tệp Microsoft

1. Trong cửa sổ Data Analysis (Phân Tích Dữ Liệu), nhấp vào Copy To Clipboard (Sao Chéo Vào Bảng
Tạm) ở góc trên bên phải trong ngăn của biểu đồ.

2. Mở một tệp Microsoft trống và dán các nội dung từ bảng tạm.

Các Mục Thường Thấy Trong Menu Khi Nhấp Chuột Phải Cho Các
Biểu Đồ
Bảng 15 liệt kê các mục menu nhấp chuột phải có sẵn trên biểu đồ. Một số mục có sẵn cho tất cả các biểu
đồ, bao gồm các mục để thay đổi cách dữ liệu được hiển thị hoặc để dễ dàng xuất dữ liệu từ biểu đồ.

Mục Chức Năng

Copy (Sao Chép) Sao chép biểu đồ vào bảng tạm.

Save Image As
(Lưu Ảnh Dưới
Dạng)

Lưu hình ảnh ở kích thước, độ phân giải và loại tệp được chỉ định bao gồm PNG
(mặc định), JPG và BMP.

Page Setup (Thiết
Lập Trang)

Hiển thị các tùy chọn thiết lập in.

Bảng 15. Các mục menu nhấp chuột phải cho biểu đồ
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Biểu Đồ

Mục Chức Năng

Print (In) In biểu đồ.

Set Scale to Default
(Đặt Tỷ Lệ Về Mặc
Định)

Đưa biểu đồ trở về chế độ xemmặc định sau khi khuếch đại biểu đồ.

Chart Options (Tùy
Chọn Biểu Đồ)

Mở cửa sổ Chart Options (Tùy chọn biểu đồ) để thay đổi biểu đồ, bao gồm thay đổi
tiêu đề, chọn các giới hạn cho trục x và y, hiển thị đường trong lưới, và hiển thị các
đánh dấu nhỏ trên các trục.

Lưu ý: Các mục trong menu dành cho các biểu đồ cụ thể được mô tả trong Chương 11, Chi Tiết
Phân Tích Dữ Liệu.
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Trang Bảng Tính
Trang bảng tính được hiển thị trong Data Analysis (Phân Tích Dữ Liệu) bao gồm các tùy chọn để sắp xếp
và chuyển dữ liệu. Sắp xếp các cột bằng một trong các phương pháp sau:

n Nhấp và kéo cột đến vị trí mới trong bảng đã chọn.

n Nhấp vào tiêu đề cột để sắp xếp dữ liệu theo thứ tự tăng dần hoặc giảm dần.

Sắp xếp lên đến ba cột dữ liệu trong cửa sổ Sort (Sắp Xếp)

1. Nhấp chuột phải vào trang tính và chọn Sort (Sắp Xếp).

2. Trong hộp thoại Sort (Sắp Xếp), chọn tiêu đề cột đầu tiên để sắp xếp. Sắp xếp dữ liệu theo thứ tự
tăng dần hoặc giảm dần.

3. Chọn cột thứ hai hoặc thứ ba để sắp xếp và chọn Ascending (Tăng Dần) hoặc Descending (Giảm
Dần).

4. Nhấp OK để sắp xếp dữ liệu hoặc nhấp vào Cancel (Hủy Bỏ) để dừng sắp xếp.

Lời khuyên: Đánh dấu dữ liệu trên biểu đồ liên quan và bộ chọn giếng bằng cách giữ con trỏ chuột
trên một ô. Nhấp vào một ô để sao chép và dán nội dung của nó vào chương trình phần mềm khác.

Các Mục trong Menu Nhấp Chuột Phải Chung cho Các Trang Bảng
Tính
Bảng 16 liệt kê các mục trong menu nhấp chuột phải có sẵn trong mọi chế độ xem trang bảng tính.

Mục Chức Năng

Copy (Sao Chép) Sao chép nội dung của các giếng đã chọn vào bảng tạm, sau đó dán
nội dung vào trang bảng tính như Excel.

Copy as Image (Sao Chép dưới
dạng Hình Ảnh)

Sao chép chế độ xem trang bảng tính dưới dạng tệp hình ảnh và dán
vào tệp tin mà chấp nhận tệp hình ảnh, chẳng hạn như tệp văn bản,
hình ảnh, hoặc trang bảng tính.

Print (In) In màn hình xem hiện tại.

Print Selection (Lựa Chọn In) In lựa chọn hiện tại.

Export to Excel (Xuất sang
Excel)

Xuất dữ liệu sang trang tính Excel.

Bảng 16. Các mục trong menu nhấp chuột phải cho các trang bảng tính
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Trang Bảng Tính

Mục Chức Năng

Export to Text (Xuất sang Văn
Bản)

Xuất dữ liệu sang chỉnh sửa văn bản.

Export to CSV (Xuất sang CSV) Xuất dữ liệu sang tệp .csv.

Export to Xml (Xuất sang Xml) Xuất dữ liệu sang tệp Xml.

Export to Html (Xuất sang Html) Xuất dữ liệu sang tệp Html.

Find (Tìm) Tìm kiếm văn bản.

Sort (Sắp Xếp) Sắp xếp dữ liệu trong lên đến ba cột.

Select Columns (Chọn Cột) Chọn các cột mà sẽ được hiển thị trong trang tính.

Bảng 16. Các mục trong menu nhấp chuột phải cho các trang bảng tính, tiếp
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Export (Xuất)
CFXMaestro Dx SE cung cấp một số tùy chọn xuất từ ​​menu thả xuống Export (Xuất):

n Export All Data Sheets (Xuất Tất Cả Các Trang Dữ Liệu)

n Export RDML File (Xuất Tệp RDML)

n Custom Export (Xuất Tùy Chỉnh)

n Export to LIMS Folder (Xuất sang Thư Mục LIMS)

n Xuất Thủ Công

Xuất Tất Cả Các Trang Dữ Liệu
Bạn có thể xuất tất cả các màn hình xem trang tính từ mọi tab của CFX Maestro Dx SE thành các tập tin
riêng lẻ.

Cách xuất tất cả các trang dữ liệu

u Chọn Export > Export All Data Sheets (Xuất > Xuất Tất Cả Các Trang Dữ Liệu) và chọn loại tệp bạn
muốn:

n CSV (*.csv)

n Văn bản (*.txt)

n Sổ Tính Excel (* .xlsx)

Các phân tích đã xuất được lưu trong nhiều tệp Sổ Tính Excel, bao gồmmột tab trang tính dữ
liệu phân tích cho mỗi tệp. Khi một phân tích bao gồm nhiều chất huỳnh quang, dữ liệu từ mỗi
chất huỳnh quang được xuất sang một tab trang tính riêng.

n Sổ Tính Excel - kết hợp (* .xlsx)

Các phân tích đã xuất được lưu vào một tệp Sổ Tính Excel bao gồm nhiều tab trang tính, mỗi tab
dành cho một tập dữ liệu phân tích.

n Excel 97 - 2003 ( *.xls)

Quan trọng: Máy tính của bạn phải được cài đặt Microsoft Excel để bạn xuất dữ liệu sang
trang bảng tính Microsoft Excel.

n Xml (*.xml)
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Xuất Các Tệp Tin RDML
RDML là một tiêu chuẩn dữ liệu có cấu trúc và phổ quát để trao đổi dữ liệu PCR (qPCR) định lượng. Tiêu
chuẩn dữ liệu là một tệp tin văn bản ở định dạng Ngôn ngữ Đánh Dấu Mở Rộng (.xml). Tham khảo trang
web của Hiệp Hội RDML Quốc Tế (www.rdml.org) để biết thêm thông tin về định dạng trao đổi dữ liệu
RDML.

Quan trọng: Tập tin RDML đã xuất bao gồm dữ liệu phân tích với cài đặt đường cơ sở mà bạn áp
dụng trong cửa sổ Data Analysis (Phân tích dữ liệu). Để biết thêm thông tin về cài đặt đường cơ sở,
hãy xem Cài Đặt Đường Nền trên trang 192.

Lưu ý: Lưu tệp RDML dưới dạng phiên bản 1.1 nếu bạn đang sử dụng phiên bản 2.3 hoặc phiên bản
cao hơn của phần mềm qbase+.

Cách xuất tệp RDML

1. Chọn Export > Export RDML Files (Xuất > Xuất Các Tệp Tin RDML) và chọn RDML v1.1 hoặc RDML
v1.0 từ danh sách hiển thị.

Hộp thoại Save As (Lưu Dưới Dạng) xuất hiện.

2. Trong hộp thoại Save As (Lưu Dưới Dạng), chỉ rõ tên tệp tin và vị trí để lưu tệp tin RDML.

3. Nhấp OK để lưu tệp tin xuất.

Hướng Dẫn Sử Dụng | 211



Chương 10 Tổng Quan Về Phân Tích Dữ Liệu

Tạo Tệp Tin Xuất Tùy Chỉnh
Cách tạo tệp xuất tùy chỉnh

1. Chọn Export > Custom Export (Xuất > Xuất Tùy Chỉnh). Hộp thoại Custom Export (Xuất Tùy Chỉnh)
xuất hiện.

2. Chọn định dạng xuất từ danh sách thả xuống xuất hiện.

3. Chọn các ô kiểm cho các mục để xuất.

4. (Tùy chọn) Nhấp Customize Column Names (Tùy Chỉnh Tên Cột) để thay đổi tên các cột.

5. Nhấp Export (Xuất). Hộp thoại Save As (Lưu Dưới Dạng) xuất hiện.

6. Trong hộp thoại Save As (Lưu Dưới Dạng), chỉ rõ tên tệp tin và vị trí để lưu tệp tin đã xuất.

7. Nhấp OK để lưu tệp tin xuất.
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Xuất sang Thư Mục LIMS
Bạn có thể xuất dữ liệu sang định dạng tệp tương thích LIMS. Để biết thêm thông tin về cách tạo, quản lý
và sử dụng các tệp LIMS, xem Phụ lục C, Tích Hợp LIMS.

Cách xuất dữ liệu theo định dạng LIMS

1. Chọn Export > Export to LIMS Folder (Xuất > Xuất sang Thư Mục LIMS).

Hộp thoại Save As (Lưu Dưới Dạng) xuất hiện.

2. Trong hộp thoại Save As (Lưu Dưới Dạng), chỉ rõ tên tệp tin và vị trí để lưu tệp tin đã xuất.

3. Nhấp OK để lưu tệp tin xuất.

Xuất Dữ Liệu Được Định Dạng Seegene
Bạn có thể xuất dữ liệu từ tất cả các chế độ xem trang bảng tính sang các tệp Excel có cấu trúc đặc biệt
được sử dụng bởi Seegene, Inc.

Lời khuyên: Bạn cũng có thể tự động khởi động Trình Xem Seegene khi việc xuất hoàn tất. Xem
Các Lệnh Trong Menu Tools (Công Cụ) trên trang 65 để biết thêm thông tin.

Cách xuất dữ liệu theo định dạng cụ thể của riêng Seegene

1. Chọn Export > Manual Export (Xuất > Xuất Thủ Công).

Hộp thoại Browse For Folder (Duyệt Tìm Thư Mục) xuất hiện.

2. Trong hộp thoại Browse For Folder (Duyệt Tìm Thư Mục), chỉ định vị trí thư mục để lưu các tệp Excel
có định dạng Seegene (.xlsx) đã xuất.

Các phân tích được xuất thành nhiều tệp Sổ Tính Excel, baao gồmmột tab trang tính dữ liệu phân
tích cho mỗi tệp.

3. Nhấp OK để lưu các tệp xuất.
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Chương 11 Chi Tiết Phân Tích Dữ Liệu
Các cửa sổ Data Analysis (Phân Tích Dữ Liệu) của Phần mềm CFX Maestro Dx, Phiên bản bảo mật bao
gồm nhiều tab để xem dữ liệu. Chương này giải thích chi tiết các tab này.

Lời khuyên: Bạn có thể chọn tab để xem trong cửa số Data Analysis (Phân Tích Dữ Liệu) bằng cách
sử dụng menu View (Chế Độ Xem). Bố cục tùy chỉnh được lưu với tệp dữ liệu.
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Trang Quantification (Định Lượng)
Sử dụng dữ liệu trong tab Quantification (Định Lượng) để cài đặt các điều kiện phân tích dữ liệu, bao gồm
các cài đặt đường nền đối với các giếng riêng lẻ và các cài đặt ngưỡng. Trang Quantification (Định
Lượng) hiển thị dữ liệu trong bốn chế độ xem sau đây:

n Biểu đồ khuếch đại — hiển thị đơn vị huỳnh quang tương đối (relative fluorescence unit, RFU) cho
mỗi giếng ở mỗi chu kỳ. Mỗi vạch đồ họa trong biểu đồ đại diện cho dữ liệu từ một chất huỳnh quang
riêng lẻ trong một giếng.

n Đường cong chuẩn— chỉ xuất hiện nếu lượt chạy bao gồm các giếng được gán loại mẫu tiêu chuẩn.
Đường cong chuẩn hiển thị chu kỳ ngưỡng được dựa theo lôgarit của số lượng khởi đầu. Chú thích
hiển thị Reaction Efficiency (Hiệu Suất Phản Ứng) (E) cho mỗi chất huỳnh quang trong các giếng có
loại mẫu Tiêu Chuẩn.

n Bộ chọn giếng— chọn các giếng có dữ liệu huỳnh quang bạn muốn hiển thị.

n Trang bảng tính— hiển thị một trang bảng tính dữ liệu được thu thập trong các giếng đã chọn.

Các Tùy Chọn Chất Phát Huỳnh Quang
Để hiển thị dữ liệu huỳnh quang trong biểu đồ và trang bảng tính thuộc tab Quantification (Định Lượng),
chọn (các) chất huỳnh quang mục tiêu dưới biểu đồ Amplification (Khuếch Đại). Để ẩn dữ liệu huỳnh
quang trong cửa sổ phân tích dữ liệu, bỏ chọn ô kiểm.
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Hộp Thoại Trace Styles (Các Kiểu Vạch Đồ Họa)
Bằng cách sử dụng hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa), bạn có thể điều chỉnh sự xuất hiện
các vạch đồ họa trong các biểu đồ khuếch đại và đường cong chảy trong các tab Quantification (Định
Lượng) và Melt Curve (Đường Cong Chảy). Sau đó bạn có thể xem trước các thay đổi trong bộ chọn
giếng xuất hiện trong hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa).

Cách điều chỉnh các kiểu vạch đồ họa

1. Chỉ chọn một chất huỳnh quang dưới biểu đồ Amplification (Khuếch Đại).

2. Để mở hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa), thực hiện một trong các thao tác sau:

n Nhấp Trace Styles (Các Kiểu Vạch Đồ Họa) trong biểu đồ Amplification (Khuếch Đại).

n Chọn Settings > Trace Styles (Cài Đặt > Các Kiểu Vạch Đồ Họa) thanh menu Data Analysis
(Phân Tích Dữ Liệu).

n Nhấp chuột phải vào vạch đồ họa và chọn Trace Styles (Các Kiểu Vạch Đồ Họa).

Hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa) xuất hiện.

3. Trong hộp thoại Trace Styles (Các Kiểu Vạch Đồ Họa), chọn một bộ giếng cụ thể trong bộ chọn giếng
ở dưới cùng. Cách khác, chọn các giếng chứa một loại mẫu trong menu thả xuống trong cột Wells
(Giếng).

4. Thực hiện bất kỳ thao tác nào sau đây:
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n Để chọn màu cho các giếng được chọn, nhấp vào ô trong cột Color (Màu).

n Để gán một biểu tượng cho các giếng đã chọn, chọn một biểu tượng từ danh sách thả xuống
Symbol (Biểu Tượng).

n Để nhanh chóng tô màu các giếng theo nhãn nút, nhấp vào cài đặt nhanh thích hợp:

o Random byWell (Ngẫu Nhiên theo Giếng)

o Random by Replicate (Ngẫu Nhiên Theo Bản Sao)

o Use Fluor Colors (Sử Dụng Màu Chất Phát Huỳnh Quang)

o Use Target Colors (Sử Dụng Màu Mục Tiêu)

o Use Sample Colors (Sử Dụng Màu Mẫu)

n Để gán nhãn giếng, chọn Sample Type (Loại Mẫu), Target Name (Tên Mục Tiêu), Sample Name
(Tên Mẫu), hoặc Symbol (Biểu Tượng).

Tùy Chọn Tỷ Lệ Logarit
Chọn Log Scale (Tỷ Lệ Loga) bên dưới biểu đồ Amplification (Khuếch Đại) để xem các dấu vết chất
huỳnh quang trong tỷ lệ bán loga:

Lời khuyên: Để khuếch đại bất cứ vùng nào trong biểu đồ, kéo ngang qua vùng mục tiêu. Để quay
lại chế độ xem đầy đủ, nhấp chuột phải vào biểu đồ và chọn Set Scale to Default (Đặt Tỷ Lệ Về Mặc
Định).
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Biểu Đồ Cong Chuẩn
Phần mềm tạo ra biểu đồ Cong Chuẩn trong tab Quantification (Định Lượng) nếu dữ liệu bao gồm loại
mẫu được xác định là Tiêu Chuẩn đối với ít nhất một chất huỳnh quang trong lượt chạy.

Biểu đồ Standard Curve (Đường Cong Chuẩn) hiển thị thông tin sau đây:

n Tên cho mỗi đường cong (chất huỳnh quang hoặc mục tiêu).

n Màu sắc của mỗi chất huỳnh quang hoặc mục tiêu.

n Hiệu suất phản ứng (E). Sử dụng số liệu thống kê này để tối ưu hóa phản ứng đa mồi và để cân bằng
dữ liệu đối với một đường cong chuẩn.

Lưu ý: Hiệu suất phản ứng mô tả mức tạo ra mục tiêu với mỗi chu kỳ trong protocol. Hiệu suất
100% cho biết mục tiêu được tạo ra gấp đôi trong mỗi chu kỳ.

n Hệ số xác định, R2 (được viết là R^2). Sử dụng số liệu thống kê này để xác định mức độ mô tả chính
xác dữ liệu bởi đường tuyến tính (tính phù hợp).

n Độ Dốc

n Giao điểm trục Y
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Các Tùy Chọn trong Menu Biểu Đồ Khuếch Đại
Ngoài các tùy chọn menu nhấp chuột phải chung cho các biểu đồ (xem Các Mục Thường Thấy Trong
Menu Khi Nhấp Chuột Phải Cho Các Biểu Đồ trên trang 206), Bảng 17 liệt kê các tùy chọn trong menu chỉ
có sẵn trên biểu đồ Amplification (Khuếch Đại).

Tùy Chọn trong Menu Chức Năng

Well XX, Fluor Target
(Giếng XX, Mục Tiêu Chất
Phát Huỳnh Quang)

Chỉ hiển thị giếng này, gỡ bỏ giếng này khỏi chế độ xem, đặt màu cho
vạch đồ họa này, hoặc loại trừ giếng này khỏi phân tích.

Selected Traces (Các Vạch
Đồ Họa Đã Chọn)

Chỉ hiển thị các giếng này, gỡ bỏ các giếng này khỏi chế độ xem, đặt màu
cho các vạch đồ họa này, hoặc loại trừ các giếng này khỏi phân tích.

Show Threshold Values
(Hiển Thị Giá Trị Ngưỡng)

Hiển thị giá trị ngưỡng cho từng đường cong khuếch đại trên biểu đồ.

Trace Styles (Các Kiểu
Vạch Đồ Họa)

Mở cửa sổ Trace Styles (Kiểu Vạch Đồ Họa) để thay đổi kiểu vạch đồ họa
xuất hiện trên các tab Quantification (Định Lượng) và Melt Curve (Đường
Cong Chảy).

Baseline Thresholds
(Ngưỡng Đường Nền)

Mở cửa sổ Baseline Thresholds (Ngưỡng Đường Nền) để thay đổi
đường nền hay ngưỡng của từng chất huỳnh quang (các thay đổi xuất
hiện trong biểu đồ Amplification (Khuếch Đại) trong tab Quantification
(Định Lượng)).

Bảng 17. Các mục trong menu nhấp chuột phải và trái của biểu đồ Amplification (Khuếch Đại)

Trang Bảng Tính Trang Quantification (Định Lượng)
Bảng 18 chỉ rõ dữ liệu được hiển thị trên trang bảng tính trong tab Quantification (Định Lượng).

Thông Tin Mô Tả

Giếng Vị trí giếng trong khay

Chất phát huỳnh quang Chất phát huỳnh quang đã phát hiện

Mục Tiêu Tên Mục Tiêu được tải trong các giếng Plate Editor (Trình Chỉnh Sửa
Khay)

Bảng 18. Nội dung trang bảng tính trên tab Quantification (Định Lượng)
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Thông Tin Mô Tả

Nội Dung Kết hợp Loại Mẫu (bắt buộc) và Số Bản Sao (tùy chon) được tải trong
Chỉnh Sửa Khay

Mẫu Tên Mẫu được nạp trong các giếng Chỉnh Sửa Khay

Cq Chu kỳ định lượng cho mỗi vạch đồ họa

Thay Đổi Mục Tiêu, Nội Dung, hoặc Dữ Liệu Mẫu

Bạn có thể thay đổi dữ liệu trong các cột Target (Mục Tiêu), Content (Nội Dung), và Sample (Mẫu) bằng
cách chỉnh sửa tệp tin khay bằng Plate Editor (Trình Chỉnh Sửa Khay) ngay cả sau khi bạn chạy thử
nghiệm.

Cách thay đổi dữ liệu trong các cột Content (Nội Dung), Target (Mục Tiêu), và Sample (Mẫu)

u Nhấp vào Plate Setup (Thiết Lập Khay) và chọn View/Edit Plate (Xem/Chỉnh Sửa Khay) để mở Plate
Editor (Trình Chỉnh Sửa Khay).
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Trang Quantification Data (Dữ Liệu Định Lượng)
Trang Quantification Data (Dữ Liệu Định Lượng) hiển thị dữ liệu định lượng thu được trong mỗi giếng.
CFX Maestro Dx SE hiển thị dữ liệu trong bốn chế độ xem bảng tính khác nhau:

n Results (Kết Quả) – hiển thị trang bảng tính dữ liệu. Đây là chế độ xemmặc định.

n Standard Curve Results (Kết Quả Đường Cong Chuẩn) — hiển thị trang bảng tính của dữ liệu đường
cong chuẩn.

n Plate (Khay) – hiển thị dữ liệu trong từng giếng dưới dạng bản đồ khay.

n RFU – hiển thị số lượng RFU trong từng giếng cho từng chu kỳ.

Chọn từng trang bảng tính từ danh sách thả xuống xuất hiện dưới trang Quantification Data (Dữ Liệu
Định Lượng).

Trang Bảng Tính Cho Kết Quả
Trang bảng tính Results (Kết Quả) hiển thị dữ liệu cho từng giếng trong khay.

Lưu ý: Tất cả tính toán Std. Dev (độ lệch chuẩn) áp dụng cho các nhóm bản sao được gán trong các
giếng ở cửa sổ Plate Editor (Trình Chỉnh Sửa Khay). Các tính toán tính trung bình giá trị Cq cho từng
giếng trong nhóm bản sao.

Bảng 19 chỉ rõ dữ liệu xuất hiện trong trang bảng tính Results (Kết Quả).
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Thông Tin Mô Tả

Giếng Vị trí giếng trong khay

Chất phát huỳnh quang Chất phát huỳnh quang đã phát hiện

Mục Tiêu Tên mục tiêu khuếch đại (gen)

Nội Dung Loại mẫu và số Bản Sao

Mẫu Mô tả mẫu

Tên Nhóm Sinh Học Tên của nhóm sinh học

Cq Chu kỳ định lượng

Cq Trung Bình Giá trị trung bình của chu kỳ định lượng cho nhóm bản sao

Cq Độ Lệch Chuẩn Độ lệch chuẩn của chu kỳ định lượng cho nhóm tái tạo

Số Lượng Khởi Đầu (SQ) Ước lượng số lượng khởi đầu của mục tiêu

Logarith Số Lượng Khởi Đầu Logarith của số lượng khởi đầu

Số Lượng Khởi Đầu Trung Bình Giá trị trung bình của số lượng khởi đầu

Độ Lệch Chuẩn Số Lượng Khởi
Đầu

Độ lệch chuẩn của số lượng khởi đầu qua các bản sao

Bảng 19. Nội dung trang bảng tính Results (Kết Quả)
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Trang Bảng Tính Cho Kết Quả Đường Cong Chuẩn
Trang bảng tính Kết Quả Đường Cong Chuẩn hiển thị tham số đường cong chuẩn đã được tính.

Bảng 20 chỉ rõ dữ liệu xuất hiện trong trang bảng tính Kết Quả Đường Cong Chuẩn.

Thông Tin Mô Tả

Chất Phát Huỳnh Quang (hoặc
Mục Tiêu)

Chất Phát Huỳnh Quang (hoặc Mục Tiêu) đã phát hiện

Hiệu suất % Hiệu suất phản ứng

Độ Dốc Độ dốc của đường cong chuẩn

Giao điểm trục Y Điểm đường cong giao với trục y

R^2 Hệ số xác định

Bảng 20. Nội dung trang bảng tính Kết Quả Đường Cong Chuẩn
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Trang Bảng Tính Dạng Khay
Trang bảng tính Khay hiển thị bản đồ khay của dữ liệu cho từng chất phát huỳnh quang tại một thời điểm.

Cách xem dữ liệu cho một chất huỳnh quang cụ thể

u Nhấp vào tab ở cuối trang bảng tính.
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Trang Bảng Tính Cho RFU
Trang bảng tính RFU hiển thị dữ liệu đơn vị huỳnh quang tương đối (relative fluorescence unit, RFU) đối
với mỗi giếng thu thập được ở mỗi chu kỳ chạy. Số giếng xuất hiện ở đầu mỗi cột và số chu kỳ xuất hiện ở
bên trái của mỗi hàng.
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Trang Melt Curve (Đường Cong Chảy)
Đối với các thuốc nhuộm liên kết DNA và đầu dò bắt cặp không thể tách rời, chất huỳnh quang sáng nhất
khi hai sợi DNA bắt cặp với nhau. Do đó, khi nhiệt độ tăng đến nhiệt độ chảy (Tm), lượng huỳnh quang
giảm theo tốc độ không đổi (độ dốc không đổi). Tại Tm có tình trạng giảm chất huỳnh quang đáng kể với
sự thay đổi độ dốc đáng chú ý. Tốc độ của thay đổi này được xác định bằng cách vẽ đồ thị hồi quy âm tính
đầu tiên của lượng huỳnh quang so với nhiệt độ (-(RFU)/dT). Tốc độ thay đổi lớn nhất trong lượng huỳnh
quang tạo ra các đỉnh rõ rệt và thể hiện Tm của các phức hợp DNA hai sợi.

CFX Maestro Dx SE vẽ đồ thị dữ liệu RFU thu được trong một đường cong chảy dưới dạng hàm số nhiệt
độ. Để phân tích dữ liệu đỉnh chảy, phần mềm sẽ gán nhiệt độ mở đầu và kết thúc cho từng đỉnh bằng
cách di chuyển thanh ngưỡng. Đáy khu vực đỉnh được quy định bởi vị trí của thanh ngưỡng chảy. Đỉnh
hợp lệ phải có chiều cao tối thiểu tương quan với khoảng cách giữa thanh ngưỡng và chiều cao của đỉnh
cao nhất.

Trang Melt Curve (Đường Cong Chảy) hiển thị Tm (nhiệt độ chảy) của các sản phẩm PCR sau khi khuếch
đại trong bốn chế độ xem:

n Melt Curve (Đường Cong Chảy) – hiển thị dữ liệu thời gian thực cho từng lượng huỳnh quang dưới
dạng RFU trên mỗi nhiệt độ cho mỗi giếng.

n Melt Peak (Đỉnh Chảy) – hiển thị hồi quy âm tính của dữ liệu RFU trên mỗi nhiệt độ cho mỗi giếng.

n Well selector (Bộ chọn giếng) – hiển thị các giếng để hiển thị hoặc ẩn dữ liệu.

n Peak spreadsheet (Trang bảng tính đỉnh) – hiển thị dữ liệu thu thập được trong giếng đã chọn.

Lưu ý: Trang bảng tính này hiển thị lên đến hai đỉnh cho từng vạch đồ họa. Để xem nhiều đỉnh
hơn, nhấp vào tab Melt Curve Data (Dữ Liệu Đường Cong Chảy).

Bảng 21 xác định dữ liệu xuất hiện trong trang bảng tính Melt Curve (Đường Cong Chảy).
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Thông
Tin Mô Tả

Giếng Vị trí giếng trong khay

Chất phát
huỳnh
quang

Chất phát huỳnh quang đã phát hiện

Nội Dung Kết hợp loại Mẫu và số Bản Sao

Mẫu Tên của mẫu được nạp trong Plate Editor (Trình Chỉnh Sửa Khay)

Nhiệt Độ
Chảy

Nhiệt độ của đỉnh chảy cho từng giếng

Lưu ý: Chỉ có hai đỉnh cao nhất xuất hiện trong trang bảng tính này.

Bảng 21. Nội dung trang bảng tính Melt Curve (Đường Cong Chảy)
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Trang Melt Curve (Đường Cong Chảy)

Điều Chỉnh Dữ Liệu Đường Cong Chảy
Cách điều chỉnh dữ liệu Đường Cong Chảy

u Thực hiện bất kỳ thao tác nào sau đây:

n Nhấp và kéo các thanh ngưỡng trong biểu đồ Melt Peak (Đỉnh Chảy) để bao gồm hoặc loại trừ
các đỉnh trong phân tích dữ liệu.

n Chọn menu thả xuống Positive in the Peaks (Dương Tính trong Các Đỉnh) để hiển thị dữ liệu
trang bảng tính đối với các đỉnh ở trên dòng Melt Threshold (Ngưỡng Chảy) hoặc chọn Negative
(Âm Tính) để xem dữ liệu trang bảng tính đối với các đỉnh dưới dòng Melt Threshold (Ngưỡng
Chảy).

n Mở cửa sổ Trace Styles (Kiểu Vạch Đồ Họa) để thay đổi màu sắc của các vạch đồ họa trong
biểu đồ Melt Curve (Đường Cong Chảy) và Melt Peak (Đỉnh Chảy).

n Chọn một số trong bộ chọn Step Number (Số Bước) để xem dữ liệu Melt Curve (Đường Cong
Chảy) ở bước khác trong protocol. Danh sách này hiển thị nhiều hơn một bước nếu protocol bao
gồm các lượt đọc khay trong hơn một bước đường cong chảy.

n Chọn các giếng trong bộ chọn giếng để tập trung vào các tập con của dữ liệu.

n Chọn một nhóm giếng để xem và phân tích một tập con các giếng trong khay. Chọn từng nhóm
giếng theo tên trong menu thả xuốngWell Group (Nhóm Giếng) trên thanh công cụ.
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Trang Melt Curve Data (Dữ Liệu Đường Cong Chảy)
Trang Melt Curve Data (Dữ Liệu Đường Cong Chảy) hiển thị dữ liệu từ tab Melt Curve (Đường Cong
Chảy) trong nhiều bảng tính bao gồm tất cả các đỉnh chảy cho mỗi vạch đồ họa. CFX Maestro Dx SE cung
cấp bốn sự lựa chọn về bảng tính để xem dữ liệu đường cong chảy:

n Melt Peaks (Đỉnh Chảy) — hiển thị tất cả các dữ liệu, bao gồm tất cả các đỉnh chảy, đối với mỗi vạch
đồ họa. Đây là chế độ xemmặc định.

n Plate (Khay) — hiển thị chế độ xem dữ liệu và thành phần của mỗi giếng trong khay này.

n RFU— hiển thị số lượng RFU ởmỗi nhiệt độ đối với mỗi giếng.

n -d(RFU)/dT— hiển thị tốc độ thay đổi âm tính trong RFU khi nhiệt độ (T) thay đổi. Đây là đồ thị hồi
quy đầu tiên đối với mỗi giếng trong khay.

Chọn từng trang bảng tính từ danh sách thả xuống xuất hiện bên dưới tab Melt Curve Data (Dữ Liệu
Đường Cong Chảy).

Trang Bảng Tính Cho Đỉnh Chảy
Trang bảng tính cho Đỉnh Chảy hiển thị tất cả dữ liệu đường cong chảy.

Bảng 22 trên trang 231 chỉ rõ dữ liệu xuất hiện trong trang bảng tính cho Đỉnh Chảy.
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Thông Tin Mô Tả

Giếng Vị trí giếng trong khay

Chất phát huỳnh quang Chất phát huỳnh quang đã phát hiện

Nội Dung Loại Mẫu được liệt kê trong cửa sổ Plate Editor (Trình Chỉnh Sửa
Khay)

Mục Tiêu Mục tiêu khuếch đại (gen)

Mẫu Tên Mẫu được liệt kê trong cửa sổ Plate Editor (Trình Chỉnh Sửa
Khay)

Nhiệt Độ Chảy Nhiệt độ chảy của mỗi sản phẩm, được liệt kê thành một đỉnh (cao
nhất) trên mỗi dòng trong trang bảng tính

Chiều Cao Đỉnh Chiều cao của đỉnh

Nhiệt Độ Ban Đầu Nhiệt độ khi bắt đầu đỉnh

Nhiệt Độ Kết Thúc Nhiệt độ khi kết thúc đỉnh

Bảng 22. Nội dung trang bảng tính cho Đỉnh Chảy

Trang Bảng Tính Khay
Trang bảng tính dạng Khay hiển thị dữ liệu đường cong chảy ở định dạng khay.

Lưu ý: Để điều chỉnh đỉnh mà phần mềm đã quy ra, hãy điều chỉnh đường ngưỡng trong biểu đồ
Đỉnh Chảy trên tab Melt Curve (Đường Cong Chảy).

Bảng 23 trên trang 232 chỉ rõ dữ liệu xuất hiện trong trang bảng tính Plate (Khay).
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Thông Tin Mô Tả

Nội Dung Kết hợp Loại Mẫu (bắt buộc) và Số Bản Sao (không bắt buộc)

Mẫu Mô tả mẫu

Đỉnh 1 Đỉnh chảy đầu tiên (cao nhất)

Đỉnh 2 Đỉnh chảy thứ hai (thấp hơn)

Bảng 23. Nội dung trang bảng tính Khay

Trang Bảng Tính Cho RFU
Trang bảng tính RFU hiển thị lượng huỳnh quang cho mỗi giếng thu được ở mỗi chu kỳ thu được trong
đường cong chảy.

Bảng 24 chỉ rõ dữ liệu được hiển thị trong trang bảng tính RFU.

Thông Tin Mô Tả

Số giếng (A1, A2, A3, A4, A5) Vị trí giếng trong khay đối với các giếng đã tải

Nhiệt Độ Nhiệt độ chảy của mục tiêu khuếch đại, được vẽ
thành một giếng trên mỗi hàng và nhiều giếng
cho nhiều sản phẩm trong cùng một giếng

Bảng 24. Nội dung trang bảng tính RFU
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Trang Bảng Tính -d(RFU)/dT
Trang bảng tính -d(RFU)/dT hiển thị tốc độ thay đổi âm tính trong RFU khi nhiệt độ (T) thay đổi.

Bảng 25 chỉ rõ dữ liệu xuất hiện trong trang bảng tính -d(RFU)/dT.

Thông Tin Mô Tả

Số giếng (A1, A2, A3, A4, A5) Vị trí giếng trong khay đối với các giếng đã tải

Nhiệt độ -d(RFU)/dT Tốc độ thay đổi mang tính điều hướng trong RFU khi nhiệt độ
(T) thay đổi

Bảng 25. Nội dung trang bảng tính -d(RFU)/dT
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Trang End Point (Điểm Cuối)
Mở tab End Point (Điểm Cuối) để phân tích các đơn vị huỳnh quang tương đối (relative fluorescence unit,
RFU) cuối cùng cho các giếng chứa mẫu. Phần mềm so sánh các mức RFU cho các giếng chứa mẫu
chưa xác định với các mức RFU cho các giếng chứa đối chứng âm tính và “kết luận” mẫu không xác định
là dương tính hoặc âm tính. Các mẫu dương tính có giá trị RFU lớn hơn giá trị RFU trung bình của các đối
chứng âm tính cộng với giá trị ngưỡng.

Để phân tích dữ liệu điểm cuối, khay phải chứa các đối chứng âm tính nếu không phần mềm không thể
quy ra kết quả.

n Chạy protocol Quantification (Định Lượng) — thiết lập protocol tiêu chuẩn. Sau khi hoàn tất lượt
chạy, mở cửa sổ Data Analysis (Phân Tích Dữ Liệu), điều chỉnh cài đặt phân tích dữ liệu trong tab
Quantification (Định Lượng), sau đó nhấp vào tab End Point (Điểm Cuối) để chọn chu kỳ điểm cuối.

n Chạy protocol End Point Only (Chỉ Điểm Cuối) — tải protocol End Point Only (Chỉ Điểm Cuối) trong
tab Plate (Khay) của cửa sổ Run Setup (Thiết Lập Lượt Chạy), chọn hoặc tạo một khay, và bắt đầu
lượt chạy

Trang End Point (Điểm Cuối) hiển thị các giá trị RFU trung bình để xác định liệu mục tiêu đã được khuếch
đại bởi chu kỳ cuối cùng (cuối) hay chưa. Sử dụng dữ liệu này để xác định xem liệu chuỗi mục tiêu cụ thể
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có hiện diện (dương tính) trong một mẫu hay không. Các mục tiêu dương tính có giá trị RFU cao hơn mức
ngưỡng mà bạn xác định.

Lời khuyên: Để tạo protocol điểm cuối, mở tab Protocol (cửa sổ Run Setup (Thiết Lập Lượt Chạy))
và chọn Run > End Point Only Run (Lượt Chạy > Lượt Chạy Chỉ Điểm Cuối).

Khi lượt chạy hoàn tất, tệp dữ liệu sẽ mở tới tab End Point (Điểm Cuối), trong đó bao gồm các mục sau:

n Settings (Cài Đặt) — điều chỉnh cài đặt phân tích dữ liệu.

n Results (Kết Quả) — hiển thị kết quả ngay sau khi bạn điều chỉnh cài đặt.

n Well Selector (Bộ Chọn Giếng) — chọn các giếng có dữ liệu điểm cuối mà bạn muốn hiển thị.

n RFU spreadsheet (Trang bảng tính RFU)— hiển thị RFU cuối thu thập được trong các giếng đã
chọn.

Dữ Liệu Kết Quả
Phần Results (Kết Quả) hiển thị các dữ liệu sau:

n Giá trị RFU thấp nhất — giá trị RFU thấp nhất trong dữ liệu

n Giá trị RFU cao nhất — giá trị RFU cao nhất trong dữ liệu

n Trung Bình Đối Chứng Âm tính— RFU trung bình cho các giếng chứa các đối chứng âm tính

n Giá Trị Ngưỡng— được tính bằng cách thêm dung sai (RFU hoặc Phần Trăm Trong Khoảng được
liệt kê trong Cài Đặt) vào giá trị trung bình của các đối chứng âm tính. Các mẫu có RFU lớn hơn giá trị
ngưỡng sẽ được gọi là “Dương tính”. Để điều chỉnh giá trị ngưỡng, hãy thay đổi RFU hoặc Phần
Trăm Trong Khoảng

Giá Trị Ngưỡng được tính bằng công thức sau:

Giá Trị Ngưỡng = Trung Bình Đối Chứng Âm tính + Dung Sai

Chọn dung sai theo một trong các phương pháp sau:

n RFU (mặc định) — chọn phương pháp này để sử dụng giá trị RFU tuyệt đối cho dung sai. Giá trị dung
sai RFU tối thiểu là 2. Giá trị tối đa là giá trị tuyệt đối của giá trị RFU cao nhất trừ đi giá trị tuyệt đối của
giá trị RFU thấp nhất. Giá trị dung sai RFUmặc định là 10% tổng khoảng RFU.

n Phần Trăm Trong Khoảng— chọn phương pháp này để sử dụng phần trăm trong khoảng RFU cho
dung sai. Phần trăm tối thiểu trong khoảng là 1%. Phần trăm tối đa trong khoảng là 99%. Phần trăm
mặc định trong khoảng là 10%.
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Điều Chỉnh Phân Tích Dữ Liệu Điểm Cuối
Cách điều chỉnh dữ liệu trong tab End Point (Điểm Cuối)

u Thực hiện bất kỳ thao tác nào sau đây:

n Chọn chất huỳnh quang từ danh sách thả xuống.

n Chọn giá trị End Cycle to Average (Chu Kỳ Cuối để Tính Trung Bình) để thiết lập số chu kỳ để
tính toán RFU điểm cuối trung bình.

n Chọn các RFU để xem dữ liệu trong các đơn vị huỳnh quang tương đối.

n Chọn Percentage of Range (Phần Trăm Trong Khoảng) để xem dữ liệu dưới dạng phần trăm
của khoảng RFU.

n Chọn các giếng trong bộ chọn giếng để tập trung vào các tập con của dữ liệu.

n Chọn một nhóm giếng để xem và phân tích một tập con các giếng trong khay. Chọn từng nhóm
giếng theo tên trong menu thả xuốngWell Group (Nhóm Giếng) trên thanh công cụ.

Trang Bảng Tính RFU cho Phân Tích Điểm Cuối
Bảng 26 xác định dữ liệu xuất hiện trong trang bảng tính RFU trong tab End Point (Điểm Cuối).

Thông Tin Mô Tả

Giếng Vị trí giếng trong khay

Chất phát huỳnh quang Chất phát huỳnh quang đã phát hiện

Nội Dung Kết hợp Loại Mẫu và Số Bản Sao

RFU Cuối RFU tại chu kỳ điểm cuối

Kết Luận Dương Tính hoặc Âm Tính, trong đó các mẫu dương tính có giá trị RFU lớn
hơn RFU trung bình của các đối chứng âm tính cộng với Giá Trị Ngưỡng

Mẫu Tên Mẫu được tải trong Plate Editor (Trình Chỉnh Sửa Khay)

Bảng 26. Nội dung của trang bảng tính RFU End Point (RFU Điểm Cuối)
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Trang Allelic Discrimination (Phân Định Alen)
Trang Allelic Discrimination (Phân Định Alen) gán các kiểu gen cho giếng chứa các mẫu không xác định.
Sử dụng dữ liệu này để xác định các mẫu có các kiểu gen khác nhau, bao gồm Alen 1, Alen 2, Dị Hợp Tử,
Không Kết Luận Được (không khuếch đại), hoặc Không Xác Định.

Lưu ý: Dữ liệu để phân định alen phải đến từ các lượt chạy đa mục tiêu với ít nhất hai chất huỳnh
quang. Mỗi chất huỳnh quang xác định một alen trong tất cả các mẫu.

Phân tích phân định alen yêu cầu có các thành phần giếng tối thiểu sau đây:

n Hai chất huỳnh quang trong mỗi giếng

n Mẫu NTC (đối chứng không mẫu) để phân tích dữ liệu tối ưu

CFX Maestro Dx SE cung cấp bốn tùy chọn để xem dữ liệu phân định alen:

n Biểu đồ Phân Định Alen— hiển thị dữ liệu trong đồ thị của RFU đối với Alen 1/Alen 2. Mỗi điểm trong
biểu đồ đại diện cho dữ liệu từ cả hai chất huỳnh quang trong một giếng. Bạn có thể chuyển đổi giữa
hệ tọa độ Cartesian và hệ tọa độ Cực bằng cách chọn và bỏ chọn ô kiểm Polar Coordinates (Hệ Tọa
Độ Cực). Hệ Tọa Độ Cartesian thể hiện RFU cho Alen 1 trên trục x và RFU cho Alen 2 trên trục y. Hệ
tọa độ cực thể hiện góc trên trục x và khoảng cách giữa gốc và RFU trên trục y (trung vị của tất cả
NTC).
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n Well spreadsheet (Trang bảng tính giếng) — hiển thị dữ liệu phân định alen được thu thập trong mỗi
giếng của khay.

n Well selector (Bộ chọn giếng) — chọn nhóm giếng có dữ liệu alen bạn muốn hiển thị.

n Ngăn Selected Fluorophores (Chất Phát Huỳnh Quang Đã Chọn) — thay đổi các nhãn trục x và trục y
trong biểu đồ Allelic Discrimination (Phân Định Alen), chu kỳ phân tích, và liệu có hiển thị bản đồ kết
quả không.

Điều Chỉnh Dữ Liệu cho Phân Định Alen
Phần mềm tự động gán kiểu gen cho giếng có các mẫu chưa xác định dựa trên vị trí của NTC và góc cũng
như khoảng cách của các điểm dữ liệu không xác định từ NTC.

Cách điều chỉnh dữ liệu cho phân định alen

u Thực hiện bất kỳ thao tác nào sau đây:

n Để hiển thị tọa độ cực, chọn ô kiểm trong biểu đồ Allelic Discrimination (Phân Định Alen).

n Để xemmột chất huỳnh quang khác, chọn chất huỳnh quang từ danh sách thả xuống trong ngăn
Selected Fluorophores (Chất Phát Huỳnh Quang Đã Chọn).

n Để thay đổi kết quả đã quy ra, kéo qua (các) điểm dữ liệu trong biểu đồ Allelic Discrimination
(Phân Định Alen) và chọn một tùy chọn trong danh sách Selected Wells (Các Giếng Đã Chọn):

o Alen 1

o Alen 2

o Dị hợp tử

o Ẩn số

o Không Quy Ra Được

o Quy Ra Tự Động

Lời khuyên: Chọn Auto Call (Quy Ra Tự Động) để trở về quy ra mặc định.
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Tùy Chọn Menu Biểu Đồ
Ngoài các tùy chọn menu nhấp chuột phải chung cho biểu đồ (hãy xem Các Mục Thường Thấy Trong
Menu Khi Nhấp Chuột Phải Cho Các Biểu Đồ trên trang 206), Bảng 27 liệt kê các tùy chọn menu sẵn có
trên biểu đồ Allelic Discrimination (Phân Định Alen).

Tùy Chọn trong Menu Chức Năng

Thu Phóng Tập trung chế độ xem biểu đồ vào khu vực đã chọn (bằng cách nhấp
và kéo con trỏ vào biểu đồ).

Lời khuyên: Để khôi phục lại chức năng thu phóng nhằm hiển
thị tất cả các điểm dữ liệu, nhấp chuột phải và chọn Set Scale to
Default (Đặt Tỷ Lệ Về Mặc Định).

Giếng Đối với giếng được chọn, có các tùy chọn: display only this well (chỉ
hiển thị giếng này), remove this well from view (xóa giếng này khỏi
chế độ xem), set color for this trace (đặt màu sắc cho vạch đồ họa
này), hay exclude this well from analysis (loại trừ giếng này khỏi
phân tích).

Giếng Được Chọn Đối với các giếng được chọn (chọn bằng cách nhấp và kéo con trỏ
vào biểu đồ), có các tùy chọn là: display only these wells (chỉ hiển thị
các giếng này), remove these wells from view (xóa các giếng này
khỏi chế độ xem), set color for these traces (đặt màu cho các vạch
đồ họa này), hoặc exclude these wells from analysis (loại trừ các
giếng này khỏi phân tích).

Bảng 27. Các tùy chọn menu nhấp chuột phải và chuột trái cho biểu đồ Allelic Discrimination
(Phân Định Alen)

Trang Bảng Tính Phân Định Alen
Bảng 28 chỉ rõ dữ liệu xuất hiện trong trang bảng tính Phân Định Alen.

Thông Tin Mô Tả

Giếng Vị trí giếng trong khay

Mẫu Mô tả tên mẫu

Kết Quả Quy Ra Nhận dạng alen, bao gồm Alen 1, Alen 2, Heterozygote, Không Quy
Ra Được, hoặc Chưa Xác Định

Bảng 28. Nội dung trang bảng tính Phân Định Alen
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Thông Tin Mô Tả

Loại Auto (Tự Động) hoặc Manual (Thủ Công) mô tả cách kết quả được quy
ra. Automatic (Tự Động) cho biết phần mềm quy ra kết quả. Manual
(Thủ Công) cho biết người dùng quy ra kết quả

RFU1 RFU cho Alen1

RFU2 RFU cho Alen2

Bảng 28. Nội dung trang bảng tính Phân Định Alen, tiếp
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Trang Custom Data View (Xem Dữ Liệu Tùy Chỉnh)
Trang Custom Data View (Chế Độ Xem Dữ Liệu Tùy Chỉnh) hiển thị đồng thời nhiều ngăn trong định dạng
tùy chỉnh.

Danh sách thả xuống Load a Preset View (Tải Chế Độ Xem Được Cài Đặt Trước) cung cấp một lựa chọn
các mẫu định dạng hiển thị. Chế độ xemmặc định được hiển thị độc lập trên tập tin đang được phân tích.
Ví dụ, nếu có dữ liệu Đường Cong Chảy, chế độ xemmặc định Khuếch Đại+Chảy sẽ xuất hiện.
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Tạo Chế Độ Xem Dữ Liệu Tùy Chỉnh
Cách tạo chế độ xem dữ liệu tùy chỉnh

u Thực hiện bất kỳ thao tác nào sau đây:

n Chọn một chế độ xem được đặt trước thay thế từ danh sách thả xuống.

n Chọn một chế độ xem biểu đồ khác từ danh sách thả xuống nằm ở trên cùng của mỗi ngăn đơn
lẻ.

n Thay đổi số hàng và cột trong tab.

n Thay đổi kích thước ngăn đơn lẻ. Kéo các thanh ở ngoại vi mỗi ngăn.

Nhấp vào Save as Preset (Lưu dưới dạng Cài Đặt Trước) để lưu tùy chỉnh dưới dạng mẫu đặt trước.
Nhấp vào Manage Presets (Quản Lý Cài Đặt Trước) để xóa, đổi tên, hoặc khôi phục các chế độ xem
được đặt trước hiện có.
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Trang QC (Kiểm Soát Chất Lượng)
Sử dụng tab QC để đánh giá nhanh chất lượng của dữ liệu về lượt chạy dựa trên các quy tắc được quy
định trong tab QC trong cửa sổ User Preferences (Ưu Tiên của Người Dùng).

CFX Maestro Dx SE cung cấp bốn tùy chọn để xem dữ liệu QC:

n Biểu đồ khuếch đại—hiển thị RFU cho từng giếng ở mọi chu kỳ. Mỗi vạch đồ họa trong biểu đồ đại
diện cho dữ liệu từ một chất huỳnh quang riêng lẻ trong một giếng.

n Bảng quy tắc QC—hiển thị các quy tắc QC có sẵn và thiết lập xác định từng quy tắc. Các quy tắc
QC đã áp dụng được biểu thị bằng dấu kiểm.

n Bộ chọn giếng—chọn các giếng có dữ liệu huỳnh quang bạn muốn hiển thị.

n Ngăn thông tin tóm tắt về quy tắc QC—hiển thị quy tắc QC đã chọn và nêu bật các giếng không
tuân theo quy tắc.

Thay Đổi Các Tiêu Chí QC (Kiểm Soát Chất Lượng)
Cách thay đổi các tiêu chí QC (Kiểm Soát Chất Lượng)

u Chọn hoặc bỏ chọn ô kiểm Use (Sử Dụng) đối với quy tắc bao gồm hoặc loại trừ khỏi QC.
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Loại Trừ Các Giếng Không Đạt Tiêu Chí QC (Kiểm Soát Chất
Lượng)
CFXMaestro Dx SE hiển thị các giếng không đạt tiêu chí QC trong cột Results (Kết Quả) trong bảng quy
tắc kiểm soát chất lượng và trong ngăn tóm tắt.

Cách loại trừ các giếng không đạt tiêu chí QC

u Chọn Exclude Wells (Loại Trừ Các Giếng) cho từng giếng để loại trừ.

244 | Phần Mềm CFXMaestro Dx SE



Trang Run Information (Thông Tin Lượt Chạy)

Trang Run Information (Thông Tin Lượt Chạy)
Trang Run Information (Thông Tin Lượt Chạy) hiển thị protocol và thông tin khác về từng lượt chạy. Sử
dụng tab này để thực hiện các thao tác sau:

n Xem protocol.

n Nhập hoặc chỉnh sửa các lưu ý về lượt chạy.

n Nhập hoặc chỉnh sửa ID hay mã vạch cho lượt chạy.

n Xem các sự kiện mà có thể đã xảy ra trong lượt chạy. Sử dụng các thông báo này để giúp khắc phục
sự cố cho một lần chạy.

Lời khuyên: Nhấp chuột phải vào Protocol để sao chép, xuất, hoặc in. Nhấp chuột phải vào các
ngăn Notes (Lưu Ý), ID/Bar Code (ID/Mã vạch) hoặc Other (Khác) để hoàn tác, cắt, sao chép, dán,
xóa hoặc chọn văn bản.
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Báo Cáo Phân Tích Dữ Liệu
Hộp thoại Report (Báo Cáo) hiển thị thông tin về tệp dữ liệu hiện tại trong cửa sổ Data Analysis (Phân
Tích Dữ Liệu). Để mởmột báo cáo, chọn Tools > Reports (Công Cụ > Báo Cáo) hoặc nhấp vào Reports
(Báo Cáo) trên thanh công cụ.

Hộp thoại Report (Báo Cáo) bao gồm các phần sau:

n Menu và thanh công cụ— cung cấp các tùy chọn để định dạng, lưu, và in báo cáo hoặc mẫu.

n Danh sách tùy chọn (phía trên cùng bên trái của hộp thoại) — cung cấp các tùy chọn để hiển thị trong
báo cáo.

n Ngăn tùy chọn (phía dưới cùng bên trái của hộp thoại) — hiển thị các ngăn văn bản mà bạn có thể
nhập thông tin về một tùy chọn đã chọn.

n Ngăn xem trước (bên phải của hộp thoại) — hiển thị bản xem trước của báo cáo hiện tại.

246 | Phần Mềm CFXMaestro Dx SE



Báo Cáo Phân Tích Dữ Liệu

Các Danh Mục Báo Cáo Phân Tích Dữ Liệu
Bảng 29 liệt kê tất cả các tùy chọn có sẵn cho báo cáo phân tích dữ liệu, tùy thuộc vào loại dữ liệu trong
cửa sổ Data Analysis (Phân Tích Dữ Liệu).

Danh Mục Tùy Chọn Mô Tả

Header (Tiêu Đề)

Tiêu đề, phụ đề, và logo cho báo cáo

Report Information (Thông Tin
Báo Cáo)

Ngày chạy, tên người dùng, tên tệp dữ
liệu, đường dẫn tệp dữ liệu, và nhóm
giếng được chọn

Audit Information (Thông Tin
Kiểm Soát)

Thông tin bổ sung cần thiết để kiểm soát,
bao gồm chữ ký

Notes (Lưu Ý) Lưu ý về báo cáo dữ liệu

Run Setup (Thiết Lập Lượt Chạy)

Run Information (Thông Tin Lượt
Chạy)

Ngày chạy, tên người dùng, tên tệp dữ
liệu, đường dẫn tệp dữ liệu, và nhóm
giếng được chọn

Protocol Chế độ xem văn bản của các bước và tùy
chọn protocol

Plate Display (Hiển Thị Khay) Chế độ xem thông tin khay ở từng giếng
của khay

Quantification (Định Lượng)

Analysis Settings (Cài Đặt Phân
Tích)

Số bước thu thập dữ liệu, chế độ phân
tích, và phương pháp trừ đường nền

Biểu Đồ Amplification (Khuếch
Đại)

Biểu đồ Amplification (Khuếch Đại) cho
các lượt chạy bao gồm dữ liệu định
lượng

Standard Curve Chart (Biểu Đồ
Cong Chuẩn)

Biểu đồ cong chuẩn

Bảng 29. Danh mục báo cáo phân tích dữ liệu trong danh sách tùy chọn
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Danh Mục Tùy Chọn Mô Tả

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong mỗi
giếng

Gene Expression — Bar Chart (Biểu Hiện Gen — Biểu Đồ Thanh)

Analysis Settings (Cài Đặt Phân
Tích)

Chế độ phân tích, dữ liệu biểu đồ, tùy
chọn chia tỷ lệ, và biểu đồ sai số

Chart (Biểu Đồ) Sao chép biểu đồ thanh

Target Names (Tên Mục Tiêu) Biểu đồ tên mục tiêu

Sample Names (Tên Mẫu) Biểu đồ tên mẫu

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong mỗi
giếng

Target Stability (Độ Ổn Định Mục
Tiêu)

Biểu đồ của các giá trị ổn định mục tiêu

Box-and-Whisker Chart (Biểu Đồ
Hộp và Dải Dữ Liệu Trung Bình)

Biểu đồ hộp và dải dữ liệu trung bình

Dot Plot Chart (Biểu Đồ Đồ Thị
Điểm)

Biểu đồ đồ thị điểm

Gene Expression (Biểu Hiện Gen) — Clustergram, and Scatter Plot (Biểu Hiện Gen — Sơ Đồ
Cụm và Biểu Đồ Phân Tán)

Analysis Settings (Cài Đặt Phân
Tích)

Cài đặt cho từng loại biểu đồ

Chart (Biểu Đồ) Sao chép biểu đồ

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong từng
mục tiêu

Gene Expression — ANOVA Data (Biểu Hiện Gen — Dữ Liệu ANOVA)

ANOVA Settings (Cài Đặt
ANOVA)

Ngưỡng giá trị P được sử dụng trong
phân tích

Bảng 29. Danh mục báo cáo phân tích dữ liệu trong danh sách tùy chọn, tiếp
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Danh Mục Tùy Chọn Mô Tả

ANOVA Results (Kết Quả
ANOVA)

Bảng kết quả từ phân tích hậu kiểm HSD
của ANOVA và Tukey

Melt Curve (Đường Cong Chảy)

Analysis Settings (Cài Đặt Phân
Tích)

Cài đặt số bước chảy và thanh ngưỡng

Melt Curve Chart (Biểu Đồ
Đường Cong Chảy)

Biểu đồ đường cong chảy

Melt Peak Chart (Biểu Đồ Đỉnh
Chảy)

Biểu đồ đỉnh chảy

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong mỗi
giếng

Allelic Discrimination (Phân Định Alen)

Analysis Settings (Cài Đặt Phân
Tích)

Chất phát huỳnh quang, chu kỳ và xem
bản đồ kết quả

Biểu Đồ Allelic Discrimination
(Phân Định Alen)

Sao chép biểu đồ allelic discrimination
(phân định alen)

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong mỗi
giếng

End Point (Điểm Cuối)

Analysis Settings (Cài Đặt Phân
Tích)

Chất phát huỳnh quang, chu kỳ cuối đến
trung bình, chế độ, giá trị RFU thấp nhất,
giá trị RFU cao nhất, và giá trị ngưỡng

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong mỗi
giếng

QC Parameters
(Tham số QC)

Data (Dữ Liệu) Trang bảng tính liệt kê các tham số cho
từng quy tắc kiểm soát chất lượng

Bảng 29. Danh mục báo cáo phân tích dữ liệu trong danh sách tùy chọn, tiếp
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Tạo Báo Cáo Phân Tích Dữ Liệu
Bạn có thể lưu bố cục báo cáo dưới dạng bảng mẫu, để bạn có thể sử dụng lại cho các báo cáo tương tự.

Cách tạo một báo cáo phân tích dữ liệu

1. Thực hiện điều chỉnh cuối cùng cho thành phần giếng, giếng đã chọn, biểu đồ, và trang bảng tính
trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) trước khi tạo báo cáo.

2. Chọn Tools > Reports (Công Cụ > Báo Cáo) trong thanh menu Data Analysis (Phân Tích Dữ Liệu) để
mở hộp thoại Report (Báo Cáo).

3. Chọn các tùy chọn mà bạn muốn đưa vào báo cáo. Báo cáo mở ra với các tùy chọn mặc định được
chọn. Chọn hoặc bỏ chọn các ô kiểm để thay đổi toàn bộ danh mục hoặc các tùy chọn đơn lẻ trong
một danh mục.

Bảng 29 trên trang 247 liệt kê các tùy chọn có sẵn để hiển thị.

Lưu ý: Dữ liệu xuất hiện trong báo cáo phụ thuộc vào sự lựa chọn hiện tại trong các tab của cửa
sổ Data Analysis (Phân Tích Dữ Liệu). Ví dụ: lượt chạy định lượng có thể không chứa đường
cong chuẩn, do đó những dữ liệu đó không xuất hiện trong cửa sổ Data Analysis (Phân Tích Dữ
Liệu) hoặc trong báo cáo dữ liệu.

4. Thay đổi thứ tự các danh mục và các mục trong báo cáo. Kéo các tùy chọn đến vị trí liên quan. Các
mục chỉ có thể được sắp xếp lại trong các danh mục mà các mục thuộc về.

5. (Không bắt buộc) Trong ngăn Report Options (Tùy Chọn Báo Cáo), nhập thông tin liên quan đến tùy
chọn đã chọn:

n Chọn một tập con thông tin để hiển thị trong báo cáo.

n Chọn các cài đặt cụ thể cho tùy chọn đã chọn.

n Thay đổi văn bản để hiển thị cho tùy chọn đã chọn.

6. Nhấp vào Update Report (Cập Nhật Báo Cáo) để cập nhật Report Preview (Xem Trước Báo Cáo) với
bất kỳ thay đổi nào.

7. In hoặc lưu báo cáo:

a. Nhấp vào nút Print Report (In Báo Cáo) trên thanh công cụ để in báo cáo hiện tại.

b. Chọn File > Save (Tệp > Lưu) để lưu báo cáo ở định dạng tệp PDF (tệp Adobe Acrobat Reader) ,
MHT (tài liệu Microsoft) hoặc MHTML (tài liệu Microsoft).

c. Chọn một vị trí để lưu tệp.

d. Chọn File > Save As (Tệp > Lưu Dưới Dạng) để lưu báo cáo bằng tên mới hoặc ở vị trí mới.
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8. (Không bắt buộc) Tạo bảng mẫu báo cáo với thông tin mà bạn muốn. Để lưu cài đặt báo cáo hiện tại
thành một bảng mẫu, chọn Template > Save or Save As (Bảng Mẫu > Lưu hoặc Lưu Dưới Dạng).
Sau đó có thể tải bảng mẫu báo cáo vào lần tiếp theo mà bạn muốn tạo báo cáo mới.
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Creating Well Group Reports (Tạo Báo Cáo Nhóm Giếng)
Cách tạo báo cáo nhóm giếng

1. Chọn Tools > Well Group Reports (Công Cụ > Báo Cáo Nhóm Giếng) trong cửa sổ Data Analysis
(Phân Tích Dữ Liệu).

2. Trong hộp thoại Well Groups Reports (Báo Cáo Nhóm Giếng), chọn các nhóm giếng, các bước
khuếch đại, và các bước chảy để đưa vào báo cáo.

3. Nhập đường dẫn hoặc điều hướng đến thư mục đích để lưu báo cáo.

4. (Không bắt buộc) Chọn Choose a Report Template (Chọn Mẫu Báo Cáo) và điều hướng đến thư
mục tệp tin mẫu.

5. (Không bắt buộc) Chọn Open Destination Folder (Mở Thư Mục Đích) để mở thư mục và xem báo cáo
sau khi được tạo.

6. Nhấp vào Create Reports (Tạo Báo Cáo).
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Chương 12 Phân Tích Biểu Hiện Gen
Bằng việc sử dụng các đối chứng đủ tiêu chuẩn nghiêm ngặt trong các phản ứng, bạn có thể sử dụng
Phần mềm CFX Maestro Dx, Phiên bản bảo mật để thực hiện một lượt chạy biểu hiện gen nhằm chuẩn
hóa những chênh lệch tương đối trong nồng độ mục tiêu giữa các mẫu. Thông thường, các mức biểu hiện
gen cho một hoặc nhiều gen tham chiếu được sử dụng để chuẩn hóa các mức biểu hiện của một gen
quan tâm. Các gen tham chiếu có tính đến các chênh lệch về lượng nạp hoặc các biến đổi khác có trong
mỗi mẫu và các mức biểu hiện gen của chúng không được bị ảnh hưởng trong hệ thống sinh học đang
được nghiên cứu.

Chọn tab Gene Expression (Biểu Hiện Gen) trong cửa sổ Data Analysis (Phân Tích Dữ Liệu) để đánh giá
các khác biệt tương đối giữa các phản ứng PCR trong hai hoặc nhiều giếng. Ví dụ, bạn có thể đánh giá số
lượng tương đối của bộ gen vi-rút hoặc số lượng tương đối của các trình tự đã được chuyển nạp trong
một phản ứng PCR. Ứng dụng phổ biến nhất cho nghiên cứu biểu hiện gen là so sánh nồng độ cDNA
trong nhiều hơn một phản ứng để ước tính các mức RNA thông tin ở trạng thái ổn định.

Phần mềm tính toán mức biểu hiện gen tương đối của một mục tiêu với một trong các trường hợp sau:

n Mức biểu hiện gen tương đối của một trình tự mục tiêu (Mục Tiêu 1) tương quan với một mục tiêu
khác (Mục Tiêu 2); ví dụ, số lượng một gen tương quan với một gen khác trong cùng một phương
pháp xử lý mẫu.

n Mức độ biểu hiện tương đối của một trình tự mục tiêu trong một mẫu so với cùng mục tiêu đó trong
phương pháp xử lý mẫu khác; ví dụ như số lượng tương đối của một gen so với chính gen đó trong
các điều kiện thời gian, địa lý hoặc phát triển khác nhau.

Thiết Lập Khay cho Phân Tích Biểu Hiện Gen
Để thực hiện phân tích biểu hiện gen, thành phần của các giếng phải bao gồm:

n Hai hoặc nhiều mục tiêu— hai mục tiêu đại diện cho các gen hoặc các chuỗi khuếch đại khác nhau
trong các mẫu của bạn.

n Một hoặc nhiều mục tiêu tham chiếu— ít nhất một mục tiêu phải là mục tiêu tham chiếu cho biểu hiện
gen chuẩn hóa. Gán tất cả các mục tiêu tham chiếu trong cửa sổ Experiment Settings (Cài Đặt Thí
Nghiệm) để phân tích dữ liệu trong chế độ Normalized Expression (Biểu Hiện Gen Chuẩn Hóa)
(ΔΔCq). Các lượt chạy không chứa tham chiếu phải được phân tích bằng chế độ Relative Expression
(Biểu Hiện Tương Đối) (ΔCq).
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n Các mẫu phổ biến— phản ứng của bạn phải bao gồm các mẫu phổ biến (yêu cầu tối thiểu hai mẫu)
để xem dữ liệu của bạn được vẽ đồ thị trong tab Gene Expression (Biểu Hiện Gen). Các mẫu này
phải đại diện cho các phương pháp xử lý hoặc điều kiện khác nhau cho mỗi trình tự mục tiêu của
bạn. Gán một mẫu đối chứng (không bắt buộc) trong cửa sổ Experiment Settings (Cài Đặt Thí
Nghiệm). Nếu không có đối chứng nào được chọn, phần mềm sẽ sử dụng Cq thấp nhất làm đối
chứng.

Các yêu cầu cho việc thiết lập Gene Expression (Biểu Hiện Gen) trong Plate Editor (Trình Chỉnh Sửa
Khay) tùy thuộc vào việc thành phần phản ứng là singleplex PCR (PCR phản ứng đơn), có một chất
huỳnh quang trong các phản ứng, hay multiplex PCR (PCR đa mục tiêu), có nhiều hơn một chất huỳnh
quang trong các phản ứng.

Thiết Lập Khay Theo Hướng Dẫn
Nếu thiết lập khay của một tệp dữ liệu không chứa thông tin cần thiết để phân tích và tab Gene
Expression (Biểu Hiện Gen) được chọn thì khoảng trống thường dành cho biểu đồ thanh sẽ chứa hướng
dẫn nhập thông tin này. Đối với biểu hiện gen chuẩn hóa, hoàn thành các bước sau:

1. Xác định tên Target (Mục Tiêu) và tên Sample (Mẫu) bằng cách sử dụng bất kỳ mục nào sau đây:

n Plate Setup (Thiết Lập Khay) – mở cửa sổ Plate Editor (Trình Chỉnh Sửa Khay)

n Replace Plate File (Thay Thế Tệp Khay) —mở trình duyệt Select Plate (Chọn Khay), trong đó
bạn có thể tìm đến tệp khay đã lưu trước đó để thay thế bố cục khay hiện tại.

n Replace PrimePCR File (Thay Thế Tệp PrimePCR)—mở hộp thoại Select PrimePCR file (Chọn
tệp PrimePCR), ở đó bạn có thể tìm đến tệp lượt chạy PrimePCR và áp dụng vào bố cục khay.

2. Chọn một hoặc nhiều mục tiêu tham chiếu và mẫu đối chứng bằng cách sử dụng hộp thoại
Experiment Settings (Cài Đặt Thí Nghiệm).

Nếu bố cục khay đã có sẵn thông tin mục tiêu và mẫu thì chỉ yêu cầu bước thứ hai và bước này được
đánh dấu bằng màu cam. Bước này phải được hoàn thành trước khi phân tích biểu hiện gen chuẩn
hóa có thể diễn ra.

Lưu ý: Dữ liệu cho biểu đồ phân tán và sơ đồ cụm chỉ được hiển thị nếu tất cả các yêu cầu đối
với biểu hiện gen chuẩn hóa nêu trong Plate Setup for Gene Expression Analysis (Thiết Lập
Khay cho Phân Tích Biểu Hiện Gen) được đáp ứng.
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Biểu Đồ Biểu Hiện Gen
CFXMaestro Dx SE hiển thị dữ liệu biểu hiện gen trong nhiều chế độ xem. Bảng 30 liệt kê các tùy chọn
biểu đồ có sẵn trong phần mềm.

Nút Tên Chức Năng

Vẽ Đồ Thị Hiển thị dữ liệu biểu hiện gen chuẩn hóa ở một
trong các chế độ xem sau:

n Biểu đồ thanh (mặc định)

n Biểu đồ hộp và dải dữ liệu trung bình

n Biểu đồ đồ thị điểm

Sơ Đồ Cụm Hiển thị dữ liệu biểu hiện gen chuẩn hóa trong
một cấu trúc phân cấp dựa trên mức độ tương
tự của biểu hiện gen đối với các mục tiêu và
mẫu khác nhau.

Biểu Đồ Phân Tán Hiển thị biểu hiện gen chuẩn hóa của các mục
tiêu cho một mẫu đối chứng so với mẫu thử
nghiệm.

ANOVA Hiển thị kết quả ANOVAmột yếu tố trên dữ liệu
biểu hiện gen bằng cách sử dụng các gói R sau
đây để thực hiện ANOVA và xác định các kết
quả Tukey:

n Đồng hành với Hồi Quy Áp Dụng (car)

n Các giá trị trung bình của bình phương nhỏ
nhất (lsmeans)

Công Cụ Chọn Gen Tham Chiếu (Có sẵn trên tab Study Analysis (Phân Tích
Nghiên Cứu) trong cửa sổ Gene Study (Nghiên
Cứu Gen)) Xác định các gen tham chiếu đã thử
nghiệm và phân loại chúng thành Ideal (Lý
Tưởng), Acceptable (Chấp Nhận Được), hoặc
Unstable (Không Ổn Định) dựa trên độ ổn định
của chúng.

Phân Tích Đối Chứng PrimePCR (Có sẵn trên tab Study Analysis (Phân Tích
Nghiên Cứu) trong cửa sổ Gene Study (Nghiên
Cứu Gen)) Hiển thị kết quả của các mẫu đã thử
nghiệm.

Bảng 30. Các tùy chọn biểu đồ biểu hiện gen
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Vẽ Đồ Thị

Biểu hiện gen tương đối của các mục tiêu được trình bày trong hai chế độ xem này:

n Biểu đồ Gene Expression (Biểu Hiện Gen) — hiển thị dữ liệu Real-Time PCR dưới dạng một trong
những ký hiệu sau:

o ΔΔCq—biểu hiện gen chuẩn hóa tương đối được tính toán bằng các mẫu đối chứng và các mục tiêu
tham chiếu.

o ΔCq—số lượng tương đối của gen mục tiêu trong một mẫu so với mẫu đối chứng.

Xem Thay Đổi Và Lập Chú Thích Chế Độ Xem Biểu Đồ trên trang 258 để biết thêm thông tin về xem
dữ liệu.

n Spreadsheet (Trang Bảng Tính) — hiển thị trang bảng tính dữ liệu biểu hiện gen.

Lời khuyên: Nhấp chuột phải vào bất kỳ biểu đồ hoặc trang bảng tính nào để biết các tùy chọn.
Chọn View/Edit Plate (Xem/Chỉnh Sửa Khay) từ menu thả xuống Plate Setup (Thiết Lập Khay)
để mở Plate Editor (Trình Chỉnh Sửa Khay) và thay đổi nội dung giếng trong khay.

Lời khuyên: Chọn Sort (Sắp Xếp) từ menu nhấp chuột phải để sắp xếp lại thứ tự của tên Mục
Tiêu và Mẫu trong biểu đồ này.
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Biểu Hiện Gen Chuẩn Hóa

Để chuẩn hóa dữ liệu, sử dụng mức biểu hiện đã đo lường của một hoặc nhiều gen tham chiếu làm yếu tố
chuẩn hóa. Gen tham chiếu là các mục tiêu không bị điều tiết trong hệ thống sinh học đang được nghiên
cứu, ví dụ như actin,GAPDH, hoặc tubulin.

Cách thiết lập phân tích biểu hiện gen chuẩn hóa (ΔΔCq)

1. Mở một tệp dữ liệu (phần mở rộng .pcrd).

2. Xem lại dữ liệu trong tab Quantification (Định Lượng) của cửa sổ Data Analysis (Phân Tích Dữ Liệu).
Tạo điều chỉnh dữ liệu, ví dụ như thay đổi ngưỡng và chế độ phân tích.

3. Chọn tab Gene Expression (Biểu Hiện Gen).

4. Trong tab Gene Expression (Biểu Hiện Gen), nhấp vào Experiment Settings (Cài Đặt Thí Nghiệm).

5. Trong hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm), thực hiện các thao tác sau:

a. Chọn tab Samples (Mẫu) và chọn một đối chứng. Khi một đối chứng được gán, CFX Maestro Dx SE
chuẩn hóa các số lượng tương đối cho tất cả các gen theo số lượng đối chứng mà được đặt thành 1.

b. Chọn tab Target (Mục Tiêu) và chọn các gen tham chiếu. Phân tích biểu hiện gen yêu cầu một
tham chiếu trong các mục tiêu ở trong mẫu.

6. Chọn Normalized Expression (Biểu Hiện Gen Chuẩn Hóa) (ΔΔCq) nếu chưa được chọn, và sau đó
xem các mức biểu hiện trong tab Gene Expression (Biểu Hiện Gen).

Lưu ý: Bạn cũng có thể sử dụng Setup Wizard (Trình Hướng Dẫn Thiết Lập) để thiết lập bố cục
khay cho phân tích biểu hiện gen chuẩn hóa.

Số Lượng Tương Đối

Theo định nghĩa, dữ liệu số lượng tương đối (ΔCq) không được chuẩn hóa. Phương pháp này được sử
dụng để định lượng mẫu mà không bao gồm bất kỳ gen tham chiếu nào (mục tiêu). Thông thường, các
nghiên cứu viên tin tưởng vào một trong những cân nhắc sau khi họ thiết lập lượt chạy của mình:

n Mỗi mẫu chứa cùng một lượng RNA hoặc cDNA trong mỗi giếng.

n Bất kỳ phương sai nào về lượng mẫu sinh học đã nạp sẽ được chuẩn hóa sau lượt chạy theo một
phương pháp nào đó trong phân tích dữ liệu bên ngoài phần mềm. Ví dụ: nghiên cứu viên có thể chọn
để chia giá trị số lượng tương đối cho hệ số chuẩn hóa, có thể là khối lượng của axit nucleic đã nạp cho
mỗi mẫu, hoặc số lượng tế bào mà từ đó axit nucleic được chiết tách ra.

Cách thực hiện phân tích Relative Quantity (Số Lượng Tương Đối) (ΔCq)

u Trong tab Gene Expression (Biểu Hiện Gen), chọn Relative Quantity (Số Lượng Tương Đối) (ΔCq) từ
danh sách thả xuống Mode (Chế Độ) trong ngăn bên phải.
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Lời khuyên: Để so sánh kết quả với dữ liệu từ các lượt chạy biểu hiện gen khác, mở một
nghiên cứu gen mới hoặc thêmmột tệp dữ liệu vào một nghiên cứu gen hiện có.

Thay Đổi Và Lập Chú Thích Chế Độ Xem Biểu Đồ
Bằng các lệnh trong menu thanh công cụ biểu đồ và các công cụ biểu đồ phân tích dữ liệu, bạn có thể
thay đổi chế độ xem biểu đồ, chú thích vào từng biểu đồ, cũng như thay đổi cách hiển thị biểu đồ. Thanh
công cụ trong biểu đồ xuất hiện giữa biểu đồ và trang bảng tính phân tích dữ liệu ở cuối màn hình.

Công Cụ trên Thanh Công Cụ Biểu Đồ

Lời khuyên: Xem Biểu Đồ trên trang 198 để biết thông tin về công cụ biểu đồ xuất hiện ở phía bên
phải của biểu đồ phân tích dữ liệu.

Thanh công cụ bên dưới biểu đồ này cung cấp quyền truy cập nhanh vào các công cụ chú thích.

Bảng 31 liệt kê chức năng của các nút trong thanh công cụ của biểu đồ.

Nút Tên Chức Năng

Biểu đồ thanh Hiển thị biểu hiện gen tương đối của mục tiêu.

Biểu đồ Hộp và Dải Dữ
Liệu Trung Bình

Hiển thị dữ liệu dưới dạng khoảng tứ phân vị (xem Phép
Tính Biểu Đồ Hộp và Dải Dữ Liệu Trung Bình trên trang
297 để biết chi tiết về các phép tính).

Lưu ý: Chỉ có sẵn nếu Analyze Using (Phân Tích Sử
Dụng) được đặt thành Biological Groups Only (Chỉ Nhóm
Sinh Học).

Biểu đồ Đồ Thị Điểm Hiển thị các điểm dữ liệu mẫu riêng lẻ cho mỗi mục tiêu.
Lưu ý: Chỉ có sẵn nếu Analyze Using (Phân Tích Sử
Dụng) được đặt thành Biological Groups Only (Chỉ Nhóm
Sinh Học).

ThêmMũi Tên Vẽ một mũi tên trên biểu đồ hoạt động.

Thêm Hình Tròn Vẽ một hình tròn trên biểu đồ hoạt động

Bảng 31. Thanh công cụ của biểu đồ
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Nút Tên Chức Năng

Thêm Văn Bản Chèn một ô văn bản trên biểu đồ hoạt động, trong đó bạn
có thể thêm văn bản để ghi chú các mục quan tâm trong
biểu đồ.

Hoàn tác Xóa hoặc trở lại chú thích cuối cùng đã thực hiện trên biểu
đồ hoạt động.

Thực hiện lại Trở về thao tác Hoàn Tác cuối cùng được thực hiện trên
biểu đồ hoạt động.

Xóa Tất Cả Xóa tất cả các chú thích trên biểu đồ hoạt động.

Bảng 31. Thanh công cụ của biểu đồ, tiếp

Sắp Xếp Dữ Liệu Mục Tiêu, Mẫu, và Nhóm Sinh Học

Lưu ý: Tùy chọn này chỉ có sẵn trên các biểu đồ biểu hiện gen.

Theo mặc định, danh sách Mục Tiêu, Mẫu, và Nhóm Sinh Học hiển thị theo thứ tự bảng chữ cái. Sử dụng
hộp thoại Sort (Sắp Xếp) để sắp xếp hiển thị theo thứ tự bảng chữ cái ngược lại hoặc để di chuyển thủ
công một thuật ngữ đến một vị trí khác trong danh sách.

Cách sắp xếp dữ liệu mục tiêu, mẫu và nhóm sinh học

1. Từ các công cụ biểu đồ, nhấp vào Sort (Sắp Xếp).

Hộp thoại Gene Expression Chart Sorting (Sắp Xếp Biểu Đồ Biểu Hiện Gen) xuất hiện.

2. Trong hộp thoại, nhấp vào Z-A để sắp xếp danh sách theo thứ tự bảng chữ cái ngược.
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3. Để di chuyển thủ công một thuật ngữ, hãy chọn thuật ngữ đó và nhấp vào nút thích hợp giữa các biểu
đồ:

n Nhấp vào mũi tên Lên hoặc Xuống để di chuyển thuật ngữ đã chọn vào một vị trí.

n Nhấp vào mũi tên Lên hoặc Xuống có vạch để di chuyển thuật ngữ đã chọn lên đầu hoặc cuối
danh sách.

4. Nhấp OK để lưu các thay đổi và quay lại tab Gene Expression (Biểu Hiện Gen).
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Thay Đổi Cài Đặt Màu Mục Tiêu, Mẫu, và Nhóm Sinh Học

Sử dụng hộp thoại Color Settings (Cài Đặt Màu) để thay đổi màu của mục tiêu, mẫu, hoặc nhóm sinh học,
hoặc để xóa mục đó khỏi đồ thị.

Để thay đổi cài đặt màu mục tiêu

1. Trong ngăn bên phải ở hộp thoại Gene Expression (Biểu Hiện Gen), xác nhận rằng Sample (Mẫu)
xuất hiện trong danh sách thả xuống Trục X.

2. Trong Chart Tools (Công Cụ Biểu Đồ), chọn Color Settings (Cài Đặt Màu).

Hộp thoại Color Settings (Cài Đặt Màu) xuất hiện.

3. Để thay đổi màu hiển thị cho một mục tiêu, nhấp vào màu của mục tiêu trong cột Color (Màu).

4. Trong hộp thoại Color (Màu) xuất hiện, chọn một màu mới và nhấp OK.

5. Để xóa một mục tiêu khỏi đồ thị biểu hiện gen, bỏ chọn ô kiểm của mục tiêu đó trong cột Show Chart
(Hiển Thị Biểu Đồ).

Lời khuyên: Để xóa mọi mục tiêu, bỏ chọn Show Chart (Hiển Thị Biểu Đồ) ở đầu cột.

6. (Tùy chọn) Theo mặc định, các thanh xuất hiện đồng màu. Để hiển thị các thanh bằng thang chuyển
màu, bỏ chọn Use Solid Colors (Sử Dụng Đồng Màu)

7. Nhấp OK để lưu các thay đổi và quay lại tab Gene Expression (Biểu Hiện Gen).

Để thay đổi cài đặt màu mẫu hoặc nhóm sinh học

1. Trong ngăn bên phải ở hộp thoại Gene Expression (Biểu Hiện Gen), xác nhận rằng Target (Mục
Tiêu) xuất hiện trong danh sách thả xuống Trục X.

2. Thực hiện các bước trong Để thay đổi cài đặt màu mục tiêu trên trang 261.

Thay Đổi Chế Độ Xem Biểu Đồ

Cách thay đổi chế độ xem biểu đồ hiện tại

u Chọn lệnh trong menu trên thanh công cụ để chọn chế độ xemmục tiêu.

Lưu ý: Tab Gene Expression (Biểu Hiện Gen) luôn mở để hiển thị dữ liệu trong chế độ xem Bar
Chart (Biểu Đồ Cột) mặc định.
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Loại Trừ Các Điểm Dữ Liệu của Giá Trị Ngoại Lai

Trong biểu đồ Đồ Thị Điểm, bạn có thể dễ dàng xem và loại trừ các giá trị ngoại lai khỏi phân tích của bạn.

Cách loại trừ các điểm dữ liệu của giá trị ngoại lai

u Trong biểu đồ Dot Plot (Đồ Thị Điểm), nhấp chuột phải vào giá trị ngoại lai mục tiêu và chọn Exclude
Well from Analysis (Loại Trừ Giếng khỏi Phân Tích).

Điểm dữ liệu được xóa khỏi biểu đồ Đồ Thị Điểm và giếng thay đổi thành màu xám trong Well Selector
(Bộ Chọn Giếng) trong tab Quantification (Định Lượng).

Cách bao gồm điểm dữ liệu của giá trị ngoại lai đã loại trừ

u Trong tab Quantification (Định Lượng), nhấp chuột phải vào giếng trong Well Selector (Bộ Chọn
Giếng) và chọnWell > Include in Analysis (Giếng > Bao Gồm trong Phân Tích).

Xem Chi Tiết Điểm Dữ Liệu

Cách xem chi tiết điểm dữ liệu

u Trong đồ thị Hộp và Dải hoặc Đồ Thị Điểm, tạm dừng con trỏ trên một điểm dữ liệu riêng lẻ.

Lời chú giải về công cụ hiển thị, cho biết tên mẫu và biểu hiện gen của mẫu đó (số lượng tương đối hoặc
biểu hiện gen chuẩn hóa, tùy thuộc vào chế độ đã chọn).

Chú Thích Biểu Đồ

Bạn có thể thêmmũi tên, vòng tròn, và văn bản vào mỗi chế độ xem biểu đồ thanh để truyền đạt dữ liệu
một cách rõ ràng. Các chú thích được lưu với biểu đồ thanh và xuất hiện trong tập tin được xuất và in ra.
Tuy nhiên, các chú thích được thực hiện cho một chế độ xem của biểu đồ không được thêm vào các chế
độ xem của biểu đồ khác.

Để vẽ mũi tên hoặc hình tròn trên biểu đồ

1. Trong thanh công cụ của biểu đồ thanh, hãy nhấp vào công cụ cụ thể.

2. Nhấp vào biểu đồ thanh và kéo con trỏ của bạn qua biểu đồ nếu cần.
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Để thêm văn bản vào biểu đồ

1. Trong thanh công cụ của biểu đồ thanh, nhấp vào Add Text (Thêm Văn Bản).

2. Nhấp vào biểu đồ thanh. Ô văn bản xuất hiện ở vị trí đó.

3. Thêm văn bản vào ô văn bản.

4. Nhấp vào vị trí bất kỳ trên biểu đồ để thoát khỏi ô văn bản.

Lời khuyên: Nhấn Enter để thêm nhiều dòng vào ô văn bản.

Để di chuyển chú thích

1. Di chuyển con trỏ chuột vào chú thích. Biểu tượng thay đổi thành ngón trỏ và đường viền chú thích
được tô sáng.

2. Nhấp vào chú thích và kéo chú thích đó đến vị trí khác.

3. Nhả chú thích để đảm bảo chú thích vào vị trí đó.

Cách hoàn tác chú thích

u Nhấp Undo (Khôi Phục).

Chú thích được thêm gần đây nhất sẽ bị xóa.

Lời khuyên: Bạn có thể hoàn tác mười chú thích gần nhất, mỗi lần một chú thích.

Cách thực hiện lại một chú thích

u Nhấp Redo (Thực Hiện Lại).

Chú thích được xóa gần đây nhất sẽ xuất hiện lại.

Lời khuyên: Bạn có thể thực hiện lại mười chú thích gần đây nhất, mỗi lần một chú thích.

Cách xóa một chú thích

u Nhấp chuột phải vào chú thích đó và chọn Delete (Xóa).
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Điều Chỉnh Dữ Liệu Biểu Hiện Gen
Sau khi chọn chế độ phân tích là biểu hiện gen chuẩn hóa (∆∆Cq) hoặc số lượng tương đối (∆Cq), điều
chỉnh dữ liệu bạn xem trong tab Gene Expression (Biểu Hiện Gen) bằng cách thay đổi các tùy chọn cài
đặt ở bên phải của biểu đồ.

Lời khuyên: Bạn đặt các tùy chọn dữ liệu Gene Expression (Biểu Hiện Gen) mặc định trong hộp thoại
User Preferences (Ưu Tiên của Người dùng) (xem Đặt Các Tham Số Tệp Dữ Liệu Biểu Hiện Gen Mặc
Định trên trang 90).

Dữ Liệu Đồ Thị

Đặt giá trị trục y thành tỷ lệ Tuyến Tính để bật các tùy chọn dữ liệu đồ thị. Tùy chọn dữ liệu đồ thị cho phép
bạn trình bày dữ liệu bằng đồ thị với một trong các tùy chọn sau:

n Relative to control (Đối chiếu với đối chứng) — vẽ đồ thị dữ liệu với trục được chia tỷ lệ từ 0 đến 1.
Nếu bạn gán đối chứng trong lượt chạy của mình, chọn tùy chọn này để nhanh chóng xem hiển thị
việc điều tiết tăng lên và điều tiết giảm xuống của mục tiêu.

n Relative to zero (Đối chiếu với 0) — vẽ đồ thị dữ liệu với gốc nằm tại 0.

Phân Tích Sử Dụng

Sử dụng menu thả xuống để chọn cách phân tích và vẽ đồ thị dữ liệu. Các tùy chọn là:

n Samples Only (Chỉ Mẫu) — dữ liệu được phân tích và vẽ đồ thị trên cơ sở mỗi mẫu.

n Biological Groups Only (Chỉ Nhóm Sinh Học) — dữ liệu được phân tích và vẽ đồ thị cho nhóm sinh
học. Biểu hiện gen được hiển thị cho nhóm sinh học là trung bình nhân của các mẫu trong nhóm đó.

n Sample Biological Group (Nhóm Sinh Học Mẫu) — dữ liệu được phân tích và vẽ đồ thị trên cơ sở mỗi
mẫu với nhóm sinh học được nối vào sau tên mẫu. Các giá trị P hiển thị được tính toán dựa trên
nhóm sinh học.

n Biological Group Sample (Mẫu Nhóm Sinh Học) — dữ liệu được phân tích và vẽ đồ thị trên cơ sở mỗi
mẫu với nhóm sinh học được nối vào trước tên mẫu. Các giá trị P hiển thị được tính toán dựa trên
nhóm sinh học.

Sử dụng menu thả xuống để chọn một mẫu sẽ được sử dụng để chuẩn hóa Số lượng tương đối:

Chú Thích Giá Trị P và Ngưỡng Giá Trị P

Khi chọn Annotate P-Values (Chú Thích Giá Trị P), phần mềm sẽ hiển thị dấu hoa thị (*) trên biểu đồ
thanh trên mục tiêu nếu giá trị P thấp hơn ngưỡng được chọn. Phần mềm tự động tính toán giá trị P bằng
cách so sánh mức biểu hiện gen của mẫu với mức biểu hiện gen của mẫu đối chứng được chọn bằng
cách sử dụng phương pháp kiểm định t. Phạm vi ngưỡng giá trị P là từ 0,000—1,000.
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Tùy Chọn Trục X

Tùy chọn trục x cho phép bạn chọn dữ liệu trục x của biểu đồ Gene Expression (Biểu Hiện Gen):

n Mục Tiêu – vẽ đồ thị tên các mục tiêu trên trục x.

n Mẫu – vẽ đồ thị tên các mẫu trên trục x.

Tùy Chọn Trục Y

Tùy chọn trục y cho phép bạn hiển thị biểu đồ Gene Expression (Biểu Hiện Gen) theo một trong ba tỷ lệ
sau đây:

n Linear (Tuyến Tính) — chọn tùy chọn này để hiển thị tỷ lệ tuyến tính.

Lời khuyên: Việc đặt trục y thành Linear (Tuyến Tính) sẽ kích hoạt danh sách thả xuống Graph
Data (Dữ Liệu Đồ Thị), từ đó bạn có thể chọn để vẽ đồ thị dữ liệu so với đối chứng hoặc so với 0.

n Log 2— chọn tùy chọn này để đánh giá các mẫu trong một dải động lớn.

n Log 10— chọn tùy chọn này để đánh giá các mẫu trong một dải động rất lớn.

Tùy Chọn Chia Tỷ Lệ

Chọn Normalized Gene Expression (Biểu hiện gen chuẩn hóa) (ΔΔCq) và đặt về None (Không) để bật các
tùy chọn chia tỷ lệ trong biểu đồ Gene Expression (Biểu hiện gen). Chọn một trong các tùy chọn chia tỷ lệ
này để tính toán và trình bày dữ liệu của bạn theo cách phù hợp nhất với thiết kế lượt chạy của bạn:

n Unscaled (Không chia tỷ lệ) — biểu diễn biểu hiện gen chuẩn hóa không chia tỷ lệ.

n Highest (Cao nhất) — chia tỷ lệ biểu hiện gen chuẩn hóa cho mỗi mục tiêu bằng cách chia mức biểu
hiện gen của mỗi mẫu cho mức biểu hiện gen cao nhất trong tất cả các mẫu.

Tùy chọn chia tỷ lệ này sử dụng công thức chia tỷ lệ theo mức cao nhất.

n Lowest (Thấp nhất) — chia tỷ lệ biểu hiện gen chuẩn hóa cho mỗi mục tiêu bằng cách chia mức biểu
hiện gen của mỗi mẫu cho mức biểu hiện gen thấp nhất trong tất cả các mẫu.

Tùy chọn chia tỷ lệ này sử dụng công thức chia tỷ lệ theo mức thấp nhất.

n Average (Trung bình) — chia tỷ lệ biểu hiện gen chuẩn hóa cho mỗi mục tiêu bằng cách chia mức
biểu hiện gen của mỗi mẫu cho trung bình nhân của mức biểu hiện gen cho tất cả các mẫu.

Tùy chọn chia tỷ lệ này sử dụng công thức được chia tỷ lệ trên mức trung bình.

Chọn một tùy chọn cho loại tính toán sai số (thanh sai số) trong biểu đồ Gene Expression (Biểu Hiện
Gen):
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Số Nhân Thanh Sai Số Biểu Đồ

Chọn một số nhân cho các thanh lỗi trong biểu đồ Gene Expression (Biểu Hiện Gen). Chọn một trong các
số nguyên sau:

n +/- 1 (mặc địnht)

n 2

n 3

Loại số nhân thay đổi khi bạn chọn thanh sai số:

n SEM viết tắt cho standard error of the mean (sai số chuẩn của giá trị trung bình)

n Std Devs viết tắt cho độ lệch chuẩn

Cài Đặt Thí Nghiệm
Lời khuyên: Hộp thoại này cũng khả dụng trong Plate Editor (Trình Chỉnh Sửa Khay). Để biết thêm
thông tin, xem Thay Đổi Cài Đặt Thí Nghiệm trên trang 148.

Trong hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm), bạn có thể xem hoặc thay đổi danh sách mục
tiêu, mẫu hoặc nhóm sinh học, chọn các gen tham chiếu, chọn đối chứng hoặc cài đặt nhóm Gene
Expression Analysis (Phân Tích Biểu Hiện Gen) sẽ được phân tích nếu nhóm sinh học được thêm vào
các giếng.

Cách mở hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm)

u Trong tab Graphing (Vẽ Đồ Thị), nhấp vào Experiment Settings (Cài Đặt Thí Nghiệm) ở cuối ngăn
bên phải.

Hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm) xuất hiện, hiển thị tab Targets (Mục Tiêu).

Cách điều chỉnh cài đặt Targets (Mục Tiêu)

u Trong tab Targets (Mục Tiêu), thực hiện bất kỳ thao tác nào sau đây:

n Để chọn mục tiêu làm tham chiếu cho phân tích dữ liệu biểu hiện gen, chọn tên của mục tiêu
trong cột Reference (Tham Chiếu).

n Để thay đổi màu của mục tiêu, hãy nhấp vào ô của mục tiêu đó trong cột Color (Màu Sắc) và thay
đổi màu trong hộp thoại Color (Màu Sắc) khi xuất hiện.

Xuất hiện sự thay đổi màu sắc trong biểu đồ Gene Expression (Biểu Hiện Gen).

n Để sử dụng giá trị hiệu suất đã xác định trước đó, bỏ chọn ô kiểm của mục tiêu trong cột Auto
Efficiency (Hiệu Suất Tự Động) và nhập số cho tỷ lệ hiệu suất của mục tiêu.

266 | Phần Mềm CFXMaestro Dx SE



Vẽ Đồ Thị

Phần mềm tính toán hiệu suất liên quan cho một mục tiêu bằng cách sử dụng Auto Efficiency
(Hiệu Suất Tự Động) nếu dữ liệu cho mục tiêu bao gồm đường cong chuẩn.

Cách điều chỉnh cài đặt Sample (Mẫu)

u Trong tab Samples (Mẫu và Nhóm Sinh Học), thực hiện bất kỳ thao tác nào sau đây:

n Để chọn mẫu làm đối chứng cho phân tích dữ liệu biểu hiện gen, chọn tên mẫu trong cột Control
(Đối Chứng).

n Để thay đổi màu sắc của mẫu, nhấp vào ô trong cột Color (Màu Sắc) và thay đổi màu trong hộp
thoại Color (Màu Sắc) khi xuất hiện.

Xuất hiện sự thay đổi màu sắc trong biểu đồ Gene Expression (Biểu Hiện Gen).

n Để hiển thị mẫu trong biểu đồ Gene Expression (Biểu Hiện Gen), chọn mẫu hoặc nhóm sinh học
trong cột Show Chart (Hiển Thị Biểu Đồ).

n Để xóa mẫu khỏi biểu đồ Gene Expression (Biểu Hiện Gen), bỏ chọn mẫu hoặc nhóm sinh học
này trong cột Show Chart (Hiển Thị Biểu Đồ).

Lời khuyên: Dữ liệu của mẫu vẫn còn trong bảng Results (Kết Quả).

Cách loại trừ loại mẫu ra khỏi các tính toán phân tích

u Chọn ô kiểm loại mẫu ở cuối hộp thoại Experiment Settings (Cài Đặt Thí Nghiệm).

Lưu ý: Thao tác này loại trừ các đối chứng và/hoặc tiêu chuẩn khỏi phân tích biểu hiện gen.

Các Tùy Chọn Trong Menu Nhấp Chuột Phải
Nhấp chuột phải vào biểu đồ biểu hiện gen để chọn các mục hiển thị trong Bảng 32.

Mục Chức Năng

Copy (Sao Chép) Sao chép biểu đồ vào bảng tạm.

Save Image As (Lưu Ảnh Dưới
Dạng)

Lưu biểu đồ dưới dạng tệp tin hình ảnh. Chọn độ phân giải và kích
thước của ảnh và sau đó chọn dạng tập tin (PNG, JPG, hoặc BMP).

Page Setup (Thiết Lập Trang) Chọn thiết lập trang để in.

Print (In) In biểu đồ.

Bảng 32. Các mục trong menu nhấp chuột phải của biểu hiện gen
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Mục Chức Năng

Set Scale to Default (Đặt Tỷ Lệ
Về Mặc Định)

Show All (Hiển Thị Tất Cả) hiển thị toàn bộ dữ liệu trong biểu đồ thanh.
Scroll Bar (Thanh Cuộn) hiển thị thanh cuộn nếu có quá nhiều mẫu cần
hiển thị trong khung biểu đồ khi duy trì chiều rộng thanh tối thiểu.

Chart Settings (Cài Đặt Biểu Đồ) Mở cửa sổ Chart Settings (Cài Đặt Biểu Đồ) để điều chỉnh đồ thị.

Sort (Sắp Xếp) Sắp xếp thứ tự các mẫu hay mục tiêu xuất hiện trên trục x của biểu đồ.

Use Corrected Std Devs (Sử
Dụng Độ Lệch Chuẩn Đã Chỉnh
Sửa)

Tính toán các thanh sai số theo công thức độ lệch chuẩn đã chỉnh sửa.

Use Solid Bar Colors (Sử Dụng
Màu Thanh Đồng Nhất)

Hiển thị các thanh màu khối đồng nhất trong biểu đồ.

X–Axis Labels (Nhãn Trục X) Hiển thị các nhãn trên trục x theo chiều ngang hoặc xiên góc.

Bảng 32. Các mục trong menu nhấp chuột phải của biểu hiện gen, tiếp

Trang Bảng Tính Dữ Liệu
Bảng 33 chỉ rõ dữ liệu hiển thị trong Bảng Dữ Liệu Biểu Hiện Gen.

Lưu ý: Các giá trị trong bảng được tính dựa trên loại đồ thị và tùy chọn ưu tiên được chọn ở ngăn
bên phải.

Thông Tin Mô Tả

Mục Tiêu Tên mục tiêu (gen khuếch đại) được chọn trong cửa sổ Experiment
Settings (Cài Đặt Thí Nghiệm)

Nhóm Sinh Học

Nhóm Sinh Học Mẫu

Mẫu Nhóm Sinh Học

Tên mẫu và/hoặc nhóm sinh học được chọn trong cửa sổ Experiment
Settings (Cài Đặt Thử Nghiệm).

Bảng 33. Mô tả thông tin trong trang bảng tính trên tab
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Thông Tin Mô Tả

Đối Chứng Tên đối chứng được chọn trong cửa sổ Experiment Settings (Cài Đặt
Thí Nghiệm). Khi Analyze Using (Phân Tích Sử Dụng) được đặt thành
Samples Only (Chỉ Mẫu), Đối Chứng là mẫu được chọn trong cửa sổ
Experiment Settings (Cài Đặt Thử Nghiệm). Khi chọn Biological Group
Only (Chỉ Nhóm Sinh Học), Sample Biological Group (Nhóm Sinh Học
Mẫu), hoặc Biological Group Sample (Mẫu Nhóm Sinh Học), đối chứng
là nhóm sinh học được chọn trong cửa sổ Experiment Settings (Cài
Đặt Thí Nghiệm).

Relative Quantity (Số Lượng
Tương Đối) hoặc
Expression (Biểu Hiện)

Relative Quantity (Số Lượng Tương Đối) (ΔCq) hoặc Normalized
Gene Expression (Biểu Hiện Gen Chuẩn Hóa) (ΔΔCq), tùy vào chế độ
được chọn.

SEM (hoặc SD) của Relative
Quantity (Số Lượng Tương Đối)
hoặc Expression (Biểu Hiện)

Sai số chuẩn của giá trị trung bình (SEM) hoặc độ lệch chuẩn (SD) của
số lượng tương đối hoặc biểu hiện gen chuẩn hóa, tùy thuộc vào tùy
chọn được chọn. Chỉ có sẵn nếu Analyze Using (Phân Tích Sử Dụng)
được đặt thành Samples Only (Chỉ Mẫu), Sample Biological Group
(Nhóm Sinh Học Mẫu) hoặc Biological Group Sample (Mẫu Nhóm Sinh
Học).

SEM (hoặc SD) của Số Lượng
Tương Đối hoặc Biểu Hiện
Được Chỉnh Sửa

Tính toán giá trị được chỉnh sửa cho SEM hoặc SD của số lượng
tương đối hoặc biểu hiện gen chuẩn hóa, tùy thuộc vào tùy chọn được
chọn. Chỉ có sẵn nếu Analyze Using (Phân Tích Sử Dụng) được đặt
thành Samples Only (Chỉ Mẫu), Sample Biological Group (Nhóm Sinh
Học Mẫu) hoặc Biological Group Sample (Mẫu Nhóm Sinh Học).

Cq trung bình Giá trị trung bình của chu kỳ định lượng (không hiển thị nếu Analyze
Using (Phân Tích Sử Dụng) được đặt thành Biological Groups Only
(Chỉ Nhóm Sinh Học)).

Cq SEM (hoặc SD) SEM hoặc SD của chu kỳ định lượng, tùy thuộc vào tùy chọn được
chọn (không hiển thị nếu Analyze Using (Phân Tích Sử Dụng) được
đặt thành Biological Groups Only (Chỉ Nhóm Sinh Học)).

Hướng Dẫn Sử Dụng | 269



Chương 12 Phân Tích Biểu Hiện Gen

Hiển Thị Tùy Chọn Chi Tiết
Bảng 34 xác định dữ liệu được hiển thị khi chọn Show Details (Hiển Thị Chi Tiết) từ menu nhấp chuột phải
của trang bảng tính biểu đồ thanh.

Thông Tin Mô Tả

Bộ Dữ Liệu Dữ liệu huỳnh quang từ một chất huỳnh quang trong tệp dữ liệu

Số Lượng Tương Đối Số lượng tương đối các mẫu được tính toán

Số Lượng Tương Đối SD Tính toán độ lệch chuẩn của số lượng tương đối

Số Lượng Tương Đối Được
Chỉnh Sửa SD

Độ lệch chuẩn được tính toán của số lượng tương đối được chỉnh sửa

Số Lượng Tương Đối SEM Tính toán sai số chuẩn của giá trị trung bình của số lượng tương đối

Số Lượng Tương Đối Được
Chỉnh Sửa SEM

Sai số chuẩn được tính toán của giá trị trung bình của số lượng tương
đối được chỉnh sửa

Số Lượng Tương Đối(lg) Log2 của số lượng tương đối được dùng cho phân tích thống kê

SD RQ(lg) Độ lệch chuẩn của số lượng tương đối (log2)

Biểu Hiện SEM(lg) Độ sai chuẩn của giá trị trung bình của biểu hiện (log2)

Biểu Hiện Không Chia Tỷ Lệ Biểu hiện không chia tỷ lệ được tính toán

Biểu Hiện Không Chia Tỷ Lệ SD Độ lệch chuẩn được tính toán của biểu hiện không chia tỷ lệ

Biểu Hiện Không Chia Tỷ Lệ
Được Chỉnh Sửa SD

Độ lệch chuẩn được tính toán của biểu hiện không chia tỷ lệ được
chỉnh sửa

Biểu Hiện Không Chia Tỷ Lệ
SEM

Sai số chuẩn được tính toán của giá trị trung bình của biểu hiện không
chia tỷ lệ

Biểu Hiện Không Chia Tỷ Lệ
Được Chỉnh Sửa SEM

Sai số chuẩn được tính toán của giá trị trung bình của biểu hiện không
chia tỷ lệ được chỉnh sửa

Biểu Hiện Không Chia Tỷ Lệ(lg) Log2 của biểu hiện không chia tỷ lệ

SD Biểu Hiện Không Chia Tỷ Lệ
(lg)

Độ lệch chuẩn của biểu hiện không chia tỷ lệ (log2)

Bảng 34. Thông tin trong trang bảng tính biểu đồ thanh với Show Details (Hiển Thị Chi Tiết)
được chọn
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Thông Tin Mô Tả

SEM Biểu Hiện Không Chia Tỷ
Lệ(lg)

Sai số chuẩn của giá trị trung bình của biểu hiện không chia tỷ lệ (log2)

Biểu Hiện Biểu hiện gen chuẩn hóa

SD Biểu Hiện Được Chỉnh Sửa Độ lệch chuẩn được tính toán của biểu hiện đã chỉnh sửa

Biểu Hiện SEM Sai số chuẩn của giá trị trung bình của biểu hiện

SEM Biểu Hiện Được Chỉnh
Sửa

Sai số chuẩn được tính toán của giá trị trung bình của biểu hiện đã
chỉnh sửa

Biểu Hiện(lg) Log2 của biểu hiện (biểu hiện gen chuẩn hóa) được dùng cho phân
tích thống kê

Biểu Hiện SD(lg) Độ lệch chuẩn của biểu hiện (log2)

Biểu Hiện SEM(lg) Độ sai chuẩn của giá trị trung bình của biểu hiện (log2)

Cq trung bình Giá trị trung bình của chu kỳ định lượng

SD Cq Độ lệch chuẩn của chu kỳ định lượng

SEM Cq Sai số chuẩn của giá trị trung bình của chu kỳ định lượng

Bảng 34. Thông tin trong trang bảng tính biểu đồ thanh với Show Details (Hiển Thị Chi Tiết)
được chọn, tiếp
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Sơ Đồ Cụm
Sơ đồ cụm hiển thị dữ liệu theo hệ thứ bậc dựa trên mức độ tương đồng của biểu hiện đối với các mục
tiêu và mẫu khác nhau.

Lưu ý: Bạn phải chọn mục tiêu tham chiếu để hiển thị đồ thị dữ liệu khác ngoài biểu hiện tương đối
trên biểu đồ thanh.

Hình ảnh sơ đồ cụmmô tả biểu hiện tương đối của một mẫu hoặc mục tiêu như sau:

n Tăng điều tiết (màu đỏ) — biểu hiện gen cao hơn

n Giảm điều tiết (xanh lá cây hoặc xanh dương) — biểu hiện gen thấp hơn

n Không điều tiết (màu đen)

n Không có giá trị nào được tính (màu đen có chữ X trắng)

Màu đổ bóng càng nhạt thì độ lệch biểu hiện tương đối càng lớn. Nếu không thể tính giá trị Cq chuẩn hóa,
hình vuông sẽ có màu đen với chữ X trắng.

Trên các cạnh ngoài của đồ thị dữ liệu là một sơ đồ cây, biểu thị hệ thứ bậc gom cụm. Các mục tiêu hoặc
mẫu có các mô hình biểu hiện tương tự sẽ có các nhánh liền kề trong khi các mục tiêu hoặc mẫu có mô
hình không tương tự sẽ cách xa hơn.

Cài Đặt
Bạn có thể cài đặt các tùy chọn sau:

n Cluster By (Gom Cụm Theo) – chọn từ Targets (Mục Tiêu), Samples (Mẫu), Both (Cả Hai), hoặc
None (Không).

n Size (Kích Cỡ) – điều chỉnh kích cỡ ảnh và thay đổi góc phóng đại biểu đồ.

n Split Out Replicates (Phân Tách Bản Sao) – hiển thị các giá trị cho các bản sao riêng lẻ.

Lời khuyên: Bạn có thể thay đổi bảng phối màu cho từ Đỏ/Xanh Lá Cây mặc định thành Đỏ/Xanh Dương
bằng cách chọn tùy chọn này từ menu nhấp chuột phải trên biểu đồ này.

Các Tùy Chọn trong Menu Nhấp Chuột Phải
Các tùy chọn trong menu nhấp chuột phải cho sơ đồ cụm tương tự với các tùy chọn cho biểu đồ thanh.
Xem Bảng 32 trên trang 267 để biết các tùy chọn có sẵn. Ngoài ra, chọn Color Scheme (Bảng Phối Màu)
để thay đổi biểu hiện gen giảm điều tiết từ Đỏ/Xanh Lá Cây mặc định thành Đỏ/Xanh Dương trên biểu đồ.

Trang Bảng Tính Dữ Liệu
Trang bảng tính hiển thị giá trị cho mục tiêu, mẫu, và biểu hiện gen chuẩn hóa.
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Biểu Đồ Phân Tán
Biểu đồ phân tán hiển thị biểu hiện gen chuẩn hóa của các mục tiêu cho một đối chứng so với một mẫu thử
nghiệm. Các đường trong đồ thị biểu thị ngưỡng mức độ phiên mã thay đổi. Các điểm dữ liệu giữa các dòng chỉ
ra rằng sự chênh lệch về biểu hiện đối với mục tiêu đó (gen) là không đáng kể giữa các mẫu. Các điểm dữ liệu
bên ngoài các đường vượt quá ngưỡng mức độ phiên mã thay đổi và có thể cần quan tâm.

Hình ảnh trong đồ thị cho thấy những thay đổi sau đây trong biểu hiện gen mục tiêu dựa trên ngưỡng mức độ
phiên mã thay đổi:

n Tăng điều tiết (vòng tròn màu đỏ) — biểu hiện gen tương đối cao hơn

n Giảm điều chỉnh (vòng tròn xanh lá cây hoặc xanh dương) — biểu hiện gen tương đối thấp hơn

n Không thay đổi (vòng tròn màu đen)

Nhấp vào và kéo một trong các đường ngưỡng để điều chỉnh giá trị ngưỡng mức độ phiên mã thay đổi.

Cài Đặt
Bạn có thể cài đặt các tùy chọn sau:

n Mẫu Đối Chứng

n Mẫu Thử Nghiệm

n Ngưỡng Mức Độ Phiên Mã Thay Đổi. Khi bạn tăng hoặc giảm giá trị mức độ phiên mã thay đổi, các
đường ngưỡng trong đồ thị di chuyển tương ứng.

Các Tùy Chọn trong Menu Nhấp Chuột Phải
Các tùy chọn trong menu nhấp chuột phải cho biểu đồ phân tán giống như các tùy chọn cho biểu đồ
thanh. Xem Bảng 32 trên trang 267 để biết các tùy chọn có sẵn. Ngoài ra, chọn Symbol (Biểu Tượng) để
thay đổi biểu tượng được sử dụng trên đồ thị từ vòng tròn mặc định thành một trong các hình sau:

n Hình Tam Giác

n Hình Chữ Thập

n Hình Vuông

n Hình Thoi

Trang Bảng Tính Dữ Liệu
Trang bảng tính hiển thị các giá trị cho mục tiêu và biểu hiện gen chuẩn hóa cho các mẫu đối chứng và
thử nghiệm. Trang tính cũng cho biết các mục tiêu được điều chỉnh lên hay điều chỉnh xuống so với sự
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điều chỉnh mục tiêu.
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Trang Bảng Tính Cho Kết Quả
Trang bảng tính Results (Kết Quả) tóm tắt dữ liệu từ tất cả các biểu đồ. Bảng 35 chỉ rõ dữ liệu được hiển
thị trong trang bảng tính Results (Kết Quả).

Thông Tin Mô Tả

Mục Tiêu Tên mục tiêu (gen khuếch đại)

Mẫu Tên mẫu

Cq trung bình Giá trị trung bình của chu kỳ định lượng

Cq Hiệu Suất Trung Bình Được
Chỉnh Sửa

Giá trị trung bình của chu kỳ định lượng sau khi điều chỉnh hiệu suất
phản ứng

Biểu Hiện Gen Chuẩn Hóa Nhắmmục tiêu biểu hiện gen chuẩn hóa tới mục tiêu tham chiếu
(ΔΔCq)

Biểu Hiện Gen Chuẩn Hóa
Tương Đối

Biểu hiện gen chuẩn hóa liên quan mẫu đối chứng; còn được gọi là
Mức Độ Phiên Mã Thay Đổi

Điều Chỉnh Thay đổi biểu hiện gen liên quan mẫu đối chứng

So sánh với Ngưỡng Điều Chỉnh Điều chỉnh mẫu thử nghiệm lên hoặc xuống dựa trên cài đặt ngưỡng

Bảng 35. Thông tin trong tab Results (Kết Quả)

Lưu ý: Dữ liệu cho các bản sao chỉ có trong trang bảng tính của các tab phân tích dữ liệu, ở đó Split
Out Replicates (Phân Tách Bản Sao) đã được chọn (đó là Sơ Đồ Cụm). Có thể có sai lệch giữa dữ
liệu biểu hiện gen trong các trang bảng tính phân tích biểu hiện gen nếu bạn chọn “none” (không) làm
mẫu đối chứng trên biểu đồ thanh.

Hướng Dẫn Sử Dụng | 275



Chương 12 Phân Tích Biểu Hiện Gen

Nghiên Cứu Gen
Tạo một nghiên cứu gen để so sánh dữ liệu biểu hiện gen từ một hoặc nhiều thử nghiệm real-time PCR
bằng cách sử dụng bộ hiệu chuẩn giữa các lượt chạy để chuẩn hóa giữa các thử nghiệm. Tạo một nghiên
cứu gen bằng cách thêm dữ liệu từ một hoặc nhiều tệp dữ liệu (phần mở rộng .pcrd) vào nghiên cứu gen.
Phần mềm sẽ nhóm chúng thành một tệp duy nhất (phần mở rộng .mgxd).

Lưu ý: Số lượng mẫu tối đa bạn có thể phân tích trong nghiên cứu gen được giới hạn bởi kích thước
RAM và bộ nhớ ảo của máy tính.

Hiệu Chuẩn Giữa Các Lượt Chạy
Việc hiệu chuẩn giữa các lượt chạy được tự động thực hiện trong mỗi nghiên cứu gen cho từng mục tiêu
để chuẩn hóa sự biến đổi giữa các lượt chạy giữa các mục tiêu đã xét nghiệm trong các lượt chạy Real-
Time PCR riêng biệt (nghĩa là các tệp .pcrd khác nhau được tạo ra từ các khay khác nhau).

Để phần mềm có thể công nhận một mẫu là bộ hiệu chuẩn giữa các lượt chạy, mẫu phải có cùng tên mục
tiêu, tên mẫu và, nếu được sử dụng, tên bộ sinh học trên mọi khay được so sánh.

Lưu ý: Phải có ít nhất một mẫu bộ hiệu chuẩn giữa các lượt chạy trong nghiên cứu gen để thực hiện
hiệu chuẩn giữa các lượt chạy. Các mục tiêu không có mẫu bộ hiệu chuẩn giữa các lượt chạy thích
hợp sẽ được xử lý không có hiệu chỉnh trong nghiên cứu gen (không khuyến nghị).

Các bộ hiệu chuẩn giữa các lượt chạy có thể được áp dụng theo hai cách:

n Mỗi mục tiêu – các mồi PCR khác nhau có thể có hiệu quả khác nhau. Theo mặc định, bộ hiệu chuẩn
giữa các lượt chạy được áp dụng cho tất cả các giếng trên cùng một khay có cùng tên mục tiêu, ví dụ
Cq được tạo ra với cùng một xét nghiệm.

n Toàn bộ nghiên cứu—một bộ hiệu chuẩn giữa các lượt chạy được người dùng lựa chọn và áp dụng
cho toàn bộ nghiên cứu gen.
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Hộp Thoại Gene Study (Nghiên Cứu Gen)

Hộp thoại Gene Study (Nghiên Cứu Gen) bao gồm hai tab:

n Trang Study Setup (Thiết Lập Nghiên Cứu) — quản lý các lượt chạy trong nghiên cứu gen.

Quan trọng: Việc thêm hoặc xóa các tệp dữ liệu trong một nghiên cứu gen không làm thay đổi
dữ liệu trong tệp gốc.

n Trang Study Analysis (Phân Tích Nghiên Cứu) — hiển thị dữ liệu biểu hiện gen cho các lượt chạy kết
hợp.

Trang Study Setup (Thiết Lập Nghiên Cứu)
Bảng 36 chỉ rõ dữ liệu xuất hiện trong tab Study Setup (Cài Đặt Nghiên Cứu).

Tiêu Đề Cột Mô Tả

Tên Tập Tin Tên của tệp dữ liệu lượt chạy (phần mở rộng .pcrd)

Thư Mục Tập Tin Thư mục lưu trữ tệp dữ liệu cho mỗi lượt chạy trong nghiên cứu gen

Ngày Tạo Ngày dữ liệu lượt chạy được thu thập

Bảng 36. Trang Study Setup (Cài Đặt Nghiên Cứu) trong hộp thoại Gene Study (Nghiên Cứu
Gen)
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Tiêu Đề Cột Mô Tả

Tên Nhóm Giếng Tên của nhóm giếng được chọn khi tệp được thêm vào nghiên cứu
gen

Lời khuyên: Để phân tích một nhóm giếng trong nghiên cứu gen,
bạn phải chọn nhóm giếng trong cửa sổ Data Analysis (Phân Tích
Dữ Liệu) trước khi nhập tệp dữ liệu vào nghiên cứu gen.

Bước Bước protocol bao gồm đọc khay để thu thập dữ liệu real-time PCR

Loại Lượt Chạy Lượt chạy do người dùng cài đặt hoặc PrimePCR

Đã Chỉnh Sửa Protocol Nếu được chọn, cho thấy rằng protocol được sử dụng cho lượt chạy
PrimePCR đã được chỉnh sửa

Xem Khay Mở bản đồ khay của khay chứa dữ liệu trong mỗi lượt chạy được bao
gồm trong Gene Study (Nghiên Cứu Gen)

Bảng 36. Trang Study Setup (Cài Đặt Nghiên Cứu) trong hộp thoại Gene Study (Nghiên Cứu
Gen), tiếp

Chuẩn Bị Nghiên Cứu Gen
Cách chuẩn bị nghiên cứu gen

1. Trước khi nhập dữ liệu vào một nghiên cứu gen, hãy thực hiện các thao tác sau trong cửa sổ Data
Analysis (Phân Tích Dữ Liệu):

n Xác minh rằng các mẫu có cùng thành phần có tên giống nhau. Trong một nghiên cứu gen, phần
mềm giả định rằng các giếng có cùng tên Mục Tiêu hoặc tên Mẫu chứa các mẫu giống nhau.

n Điều chỉnh đường nền và ngưỡng (Cq) trong tab Quantification (Định Lượng) để tối ưu hóa dữ
liệu trong mỗi lượt chạy.

n Chọn nhóm giếng mà bạn muốn đưa vào nghiên cứu gen.

Để hiển thị dữ liệu từ một nhóm giếng trong nghiên cứu gen, nhóm đó phải được chọn trước khi
nhập tệp dữ liệu.

Tab Study Setup (Thiết Lập Nghiên Cứu) hiển thị danh sách tất cả các lượt chạy trong nghiên cứu
gen.

2. Trong hộp thoại Gene Study (Nghiên Cứu Gen), chọn tab Study Setup (Thiết Lập Nghiên Cứu).

3. Nhấp vào Add Data Files (Thêm Các Tệp Dữ Liệu) để chọn tệp từ cửa sổ trình duyệt.

Lời khuyên: Để nhanh chóng thêm các lượt chạy vào một nghiên cứu gen, kéo các tệp dữ liệu
(phần mở rộng .pcrd) vào hộp thoại Study Setup (Thiết Lập Nghiên Cứu).
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4. CFX Maestro Dx SE tự động thực hiện phân tích nghiên cứu gen khi bạn thêm các tệp dữ liệu. Chọn
tab Study Analysis (Phân Tích Nghiên Cứu) để xem kết quả.

Cách xóa lượt chạy khỏi nghiên cứu gen

u Chọn một hoặc nhiều tệp trong danh sách và nhấp vào Remove (Xóa).

Cách thêm ghi chú về nghiên cứu gen

u Nhập ghi chú về các tệp và phân tích trong ô văn bản Notes (Ghi Chú).

Trang Study Analysis (Phân Tích Nghiên Cứu)
Tab Study Analysis (Phân Tích Nghiên Cứu) hiển thị dữ liệu từ tất cả các lượt chạy trong nghiên cứu gen.
Các sự lựa chọn phân tích dữ liệu biểu hiện gen giống như sự lựa chọn cho tệp dữ liệu đơn với các ngoại
lệ sau:

n Đối với biểu đồ thanh, giá trị hiệu chuẩn giữa các lượt chạy (nếu được tính toán) sẽ xuất hiện khi bạn
nhấp vào Inter-run Calibration (Hiệu Chuẩn Giữa Các Lượt Chạy).

Lưu ý: Chỉ có thể sử dụng các loại mẫu sau làm bộ hiệu chuẩn giữa các lượt chạy:

o Không Xác Định

o Tiêu chuẩn

o Đối Chứng Dương

Không thể sử dụng các loại mẫu negative control (đối chứng âm), no template control (NTC) (đối
chứng không mẫu), và no reverse transcriptase control (NRT) (đối chứng không enzyme phiên mã
ngược) làm bộ định chuẩn giữa các lượt chạy.

n Công cụ Reference Gene Selection (Chọn Gen Tham Chiếu) xác định các gen tham chiếu đã được
thử nghiệm và phân loại chúng thành Ideal (Lý Tưởng), Acceptable (Chấp Nhận Được), hoặc
Unstable (Không Ổn Định) dựa trên độ ổn định của chúng:

o Các gen tham chiếu lý tưởng: ổn định và đại diện cho những biến đổi tối thiểu trên các mẫu đã
thử nghiệm.

o Các gen tham chiếu chấp nhận được: không ổn định một cách lý tưởng và đại diện cho biến đổi
vừa phải trên các mẫu đã thử nghiệm. Sử dụng các gen tham chiếu này trong phân tích nếu
không có gen tham chiếu Lý Tưởng.

o Các gen tham chiếu: không ổn định đại diện cho sự biến đổi quá mức trên các mẫu đã thử
nghiệm. Khuyến nghị loại trừ các gen này ra khỏi phân tích.

n Công cụ PrimePCR Controls (Đối Chứng PrimePCR) hiển thị kết quả của các mẫu đã thử nghiệm
trong bảng:

Hướng Dẫn Sử Dụng | 279



Chương 12 Phân Tích Biểu Hiện Gen

o Trang Summary (Tóm Tắt) hiển thị bản tóm tắt của tất cả các mẫu đã thử nghiệm. Các mẫu đã
vượt qua tất cả các xét nghiệm đối chứng sẽ xuất hiện màu xanh lá cây. Các mẫu không vượt
qua một hoặc nhiều xét nghiệm đối chứng sẽ xuất hiện màu vàng.

o Trang PCR hiển thị kết quả xét nghiệm đối chứng PCR dương. Xét nghiệm này dùng để phát
hiện sự ức chế hoặc các vấn đề thử nghiệm trong phản ứng mà có ảnh hưởng đến biểu hiện
gen.

o Trang RT hiển thị kết quả xét nghiệm đối chứng phiên mã ngược. Xét nghiệm này dùng để đánh
giá định lượng hiệu suất RT và xác định các mẫu trong đó hiệu suất RT có khả năng ảnh hưởng
đến biểu hiện gen.

o Trang gDNA hiển thị kết quả xét nghiệm đối chứng nhiễm bẩn DNA. Xét nghiệm này dùng để
xác định xem DNA thuộc hệ gen (gDNA) có trong mẫu ở mức có thể ảnh hưởng đến kết quả
qPCR hay không.

o Trang RQ hiển thị kết quả các xét nghiệm chất lượng RNA (RQ1 và RQ2). Các xét nghiệm này
đánh giá định tính xem liệu tính toàn vẹn RNA có thể ảnh hưởng xấu đến biểu hiện gen hay
không.

Các Danh Mục Báo Cáo Nghiên Cứu Gen
Sử dụng hộp thoại Gene Study Report (Báo Cáo Nghiên Cứu Gen) để sắp xếp dữ liệu nghiên cứu gen
vào báo cáo. Bảng 37 liệt kê tất cả các tùy chọn có sẵn cho báo cáo nghiên cứu gen.

Danh Mục Tùy Chọn Mô Tả

Header (Tiêu Đề)

Tiêu đề, phụ đề, và logo cho báo cáo

Report Information (Thông
Tin Báo Cáo)

Ngày, tên người dùng, tên tệp dữ liệu, đường
dẫn tệp dữ liệu, và nhóm giếng được chọn

Gene Study File List (Danh
Sách Tệp Tin Nghiên Cứu
Gen)

Danh sách tất cả các tệp dữ liệu trong Nghiên
Cứu Gen

Notes (Lưu Ý) Lưu ý về báo cáo dữ liệu

Study Analysis: Bar Chart (Phân Tích Nghiên Cứu: Biểu Đồ Thanh)

Bảng 37. Các Danh Mục cho báo cáo Nghiên Cứu Gen
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Danh Mục Tùy Chọn Mô Tả

Analysis Settings (Cài Đặt
Phân Tích)

Danh sách các tham số phân tích đã chọn

Chart (Biểu Đồ) Biểu đồ thanh Gene Expression (Biểu Hiện Gen)
hiển thị Dữ Liệu

Target Names (Tên Mục
Tiêu)

Danh sách các mục tiêu trong Nghiên Cứu Gen

Sample Names (Tên Mẫu) Danh sách các mẫu trong Nghiên Cứu Gen

Data (Dữ Liệu) Trang bảng tính hiển thị dữ liệu

Target Stability (Độ Ổn
Định Mục Tiêu)

Dữ liệu về tính ổn định của mục tiêu

Inter-run Calibration (Hiệu
Chuẩn Giữa Các Lượt
Chạy)

Dữ liệu hiệu chuẩn giữa các lượt chạy

Box-and-Whisker Chart
(Biểu Đồ Hộp và Dải Dữ
Liệu Trung Bình)

Biểu đồ hộp và dải dữ liệu trung bình về Gene
Expression (Biểu Hiện Gen)

Dot-Plot Chart (Biểu Đồ Đồ
Thị Điểm)

Biểu đồ đồ thị điểm Gene Expression (Biểu Hiện
Gen)

Study Analysis: Clustergram and Scatter Plot (Phân Tích Nghiên Cứu: Sơ Đồ Cụm và Biểu
Đồ Phân Tán)

Analysis Settings (Cài Đặt
Phân Tích)

Cài đặt cho từng loại biểu đồ

Chart (Biểu Đồ) Biểu đồ Gene Expression (Biểu Hiện Gen) hiển
thị dữ liệu

Data (Dữ Liệu) Trang bảng tính liệt kê dữ liệu trong từng mục
tiêu

Study Analysis: ANOVA Data (Phân Tích
Nghiên Cứu: Dữ Liệu ANOVA)

Bảng 37. Các Danh Mục cho báo cáo Nghiên Cứu Gen, tiếp
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Danh Mục Tùy Chọn Mô Tả

ANOVA Settings (Cài Đặt
ANOVA)

Ngưỡng giá trị P được sử dụng trong phân tích

ANOVA Results (Kết Quả
ANOVA)

Bảng kết quả từ phân tích hậu kiểm HSD của
ANOVA và Tukey

Shapiro-Wilk Normality
Test (Kiểm Tra Tính Chuẩn
Hóa Shapiro-Wilk)

Nhóm sinh học, số lượng, giá trị P, và bất kỳ lỗi
nào xảy ra cho từng mục tiêu trong phân tích

ANOVA Errors (Sai Số
ANOVA)

Sai số được xác định trong các tính toán ANOVA

Bảng 37. Các Danh Mục cho báo cáo Nghiên Cứu Gen, tiếp
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Tạo Báo Cáo Nghiên Cứu Gen
Để tạo báo cáo nghiên cứu gen

1. Điều chỉnh dữ liệu báo cáo nghiên cứu gen và biểu đồ khi cần trước khi tạo báo cáo.

2. Chọn Tools > Reports (Công Cụ > Báo Cáo) trong menu Gene Study (Nghiên Cứu Gen) để mở hộp
thoại Report (Báo Cáo).

3. Chọn các tùy chọn mà bạn muốn đưa vào báo cáo. Báo cáo mở ra với các tùy chọn mặc định được
chọn. Chọn hoặc bỏ chọn các ô kiểm để thay đổi toàn bộ danh mục hoặc các tùy chọn đơn lẻ trong
một danh mục.

Các Danh Mục Báo Cáo Nghiên Cứu Gen trên trang 280 liệt kê các tùy chọn có sẵn để hiển thị.

4. Thay đổi thứ tự các danh mục và các mục trong báo cáo. Kéo các tùy chọn đến vị trí yêu cầu. Các
mục chỉ có thể được sắp xếp lại trong các danh mục mà các mục thuộc về.

5. Nhấp vào Update Report (Cập Nhật Báo Cáo) để cập nhật Report Preview (Xem Trước Báo Cáo) với
bất kỳ thay đổi nào.

6. In hoặc lưu báo cáo. Nhấp vào nút Print Report (In Báo Cáo) trên thanh công cụ để in báo cáo hiện
tại. Chọn File > Save (Tệp > Lưu) để lưu báo cáo dưới định dạng tệp PDF (tệp Adobe Acrobat
Reader) và chọn vị trí để lưu tệp. Chọn File > Save As (Tệp > Lưu Dưới Dạng) để lưu báo cáo bằng
tên mới hoặc ở vị trí mới.

7. (Không bắt buộc) Tạo bảng mẫu báo cáo với thông tin mà bạn muốn. Để lưu cài đặt báo cáo hiện tại
thành một bảng mẫu, chọn Template > Save or Save As (Bảng Mẫu > Lưu hoặc Lưu Dưới Dạng).
Sau đó có thể tải bảng mẫu báo cáo vào lần tiếp theo mà bạn muốn tạo báo cáo mới.
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Phụ lục A Tính Toán Phân Tích Dữ Liệu
Phần mềm CFX Maestro Dx, Phiên bản bảo mật tự động tính toán công thức và hiển thị các kết quả trong
các tab Data Analysis (Phân Tích Dữ Liệu). Phụ lục này giải thích chi tiết cách CFX Maestro Dx SE tính
toán các công thức.

Hiệu Suất Phản Ứng
Bằng chứng cho thấy rằng việc sử dụng một thước đo chính xác về hiệu suất cho mỗi bộ mồi và đoạn dò
sẽ cho bạn kết quả chính xác hơn khi phân tích dữ liệu biểu hiện gen. Giá trị mặc định của hiệu suất được
sử dụng trong tính toán biểu hiện gen là 100%. Để đánh giá hiệu suất phản ứng, tạo một đường cong tiêu
chuẩn bằng cách sử dụng các độ pha loãng nối tiếp của một mẫu đại diện trên một dải động liên quan và
sau đó ghi lại hiệu suất cho phân tích biểu hiện gen sau đó. Nếu lượt chạy của bạn bao gồm đường cong
chuẩn, thì phần mềm sẽ tự động tính toán hiệu suất và hiển thị dưới Standard Curve (Đường Cong Tiêu
Chuẩn) trên tab Quantification (Định Lượng) khi Auto Efficiency (Hiệu Suất Tự Động) được chọn trong
tab Targets (Mục Tiêu) trong cửa sổ Experiment Settings (Cài Đặt Thí Nghiệm).

Hiệu suất (E) trong các công thức hiệu suất đề cập đến "hiệu suất" như được mô tả bởi Pfaffl (2001) và
Vandesompele et al. (2002). Trong các ấn bản này, hiệu suất 2 (hoàn hảo gấp đôi với mỗi chu kỳ) tương
đương với hiệu suất 100% trong phần mềm này. Bạn có tùy chọn để chuyển đổi các tính toán hiệu suất
của mình thành các tính toán được sử dụng trong phần mềm bằng cách sử dụng các mối quan hệ toán
học sau:

n E = (% Hiệu Suất * 0,01) + 1

n %Hiệu Suất = (E – 1) * 100

Số Lượng Tương Đối
Công thức cho số lượng tương đối (ΔCq) đối với mẫu bất kỳ (GOI) là:

Lưu ý: Công thức này được sử dụng để tính toán Relative Quantity (Số Lượng Tương Đối) khi
không xác định được mẫu đối chứng .

Trong đó:
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n E = Hiệu suất của bộ đoạn mồi và đoạn dò. Hiệu suất này được tính theo công thức
(% Hiệu suất * 0,01) + 1, trong đó hiệu suất 100% = 2

n C q (tối thiểu) = Cq trung bình đối với Mẫu có Cq trung bình thấp nhất đối với GOI

n C q (mẫu) = Cq trung bình đối với Mẫu

n GOI = Gen quan tâm (một mục tiêu)

Số Lượng Tương Đối Khi Chọn Đối Chứng
Khi một mẫu đối chứng hoặc nhóm sinh học được gán thì số lượng tương đối (RQ) cho bất kỳ mẫu nào có
gen quan tâm (GOI) được tính theo công thức này:

Trong đó:

n E = Hiệu suất của bộ đoạn mồi và đoạn dò. Hiệu suất này được tính theo công thức
(% Hiệu suất * 0,01) + 1, trong đó 100% hiệu suất = 2

n Cq (đối chứng) = Trung Bình Cq đối với mẫu đối chứng

n Cq (mẫu) = Trung bình Cq đối với bất kỳ mẫu nào có GOI

n GOI = Gen quan tâm (một mục tiêu)

Độ Lệch Chuẩn của Số Lượng Tương Đối
Quan trọng: Tính toán này chỉ có thể áp dụng khi Analyze Using (Phân Tích Sử Dụng) được đặt
thành Samples Only (Chỉ Mẫu), Sample Biological Group (Nhóm Sinh Học Mẫu), hoặc Biological
Group Sample (Mẫu Nhóm Sinh Học).

Công thức cho độ lệch chuẩn của số lượng tương đối là

Trong đó:

n SD Số Lượng Tương Đối = độ lệch chuẩn của số lượng tương đối

n SD CqGOImẫu = Độ lệch chuẩn của Cq đối với mẫu (GOI)

n Số Lượng Tương Đối = Số lượng tương đối của mẫu
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Hiệu Suất Đã Chỉnh Sửa Cq (CqE)

n E = Hiệu suất của bộ đoạn mồi và đoạn dò. Hiệu suất này được tính theo công thức
(% Hiệu suất * 0,01) + 1, trong đó 100% hiệu suất = 2

n GOI = Gen quan tâm (một mục tiêu)

Hiệu Suất Đã Chỉnh Sửa Cq (CqE)
Công thức cho hiệu suất đã chỉnh sửa Cq là

Trong đó:

n E = Hiệu Suất

Hiệu Suất Trung Bình Đã Chỉnh Sửa Cq (MCqE)
Công thức cho hiệu suất trung bình đã chỉnh sửa Cq là

Trong đó:

n CqE = Hiệu suất đã chỉnh sửa Cq

n n = Số bản sao
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Biểu Hiện Gen Chuẩn Hóa
Biểu hiện gen chuẩn hóa (ΔΔCq) là số lượng tương đối của mục tiêu (gen) được chuẩn hóa bằng số
lượng các mục tiêu tham chiếu (gen hoặc chuỗi) trong hệ sinh học của bạn. Để chọn mục tiêu tham chiếu,
mở cửa sổ Experiment Settings (Cài Đặt Thí Nghiệm) và nhấp vào cột tham chiếu cho mỗi mục tiêu đóng
vai trò là gen tham chiếu.

Công thức cho biểu hiện gen chuẩn hóa, sử dụng phép tính Relative Quantity (Số Lượng Tương Đối)
(RQ) được tính toán, là

Trong đó:

n RQ = Số lượng tương đối của mẫu

n Ref = Mục tiêu tham chiếu trong một lượt chạy bao gồmmột hoặc nhiều mục tiêu tham chiếu trong
mỗi mẫu

n GOI = Gen quan tâm (một mục tiêu)

Với điều kiện là các mục tiêu tham chiếu không thay đổi mức biểu hiện gen trong hệ sinh học của bạn,
việc tính toán biểu hiện gen chuẩn hóa sẽ tính đến các chênh lệch lượng nạp hoặc thay đổi trong số
lượng tế bào được thể hiện trong từng mẫu của bạn.
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Biểu Hiện Gen Chuẩn Hóa Khi Chọn Đối Chứng

Biểu Hiện và Số Lượng Tương Đối cho Nhóm Sinh Học
Khi Analyze Using (Phân Tích Sử Dụng) được đặt thành Biological Groups Only (Chỉ Nhóm Sinh Học),
phần mềm sẽ hiển thị biểu thức trung bình (biểu hiện gen chuẩn hóa hoặc số lượng tương đối, tùy thuộc
vào lựa chọn chế độ) của các mẫu trong nhóm sinh học. Bởi vì biểu thức thường được phân phối log
chuẩn, biểu thức được tính trung bình bằng cách sử dụng trung bình nhân:

Trong đó:

n Exp1, Exp2, Expn = Số lượng tương đối hoặc biểu hiện gen chuẩn hóa của các mẫu trong nhóm sinh
học

n n = Số mẫu trong nhóm sinh học

Biểu Hiện Gen Chuẩn Hóa Khi Chọn Đối Chứng
Khi bạn chọn mẫu đối chứng trong cửa sổ Experiment Settings (Cài Đặt Thí Nghiệm), phần mềm sẽ đặt
mức biểu hiện gen của mẫu đối chứng thành 1. Trong trường hợp này, phần mềm chuẩn hóa số lượng
tương đối của tất cả các biểu hiện mục tiêu (gen) bằng số lượng đối chứng (giá trị là 1). Biểu hiện gen
chuẩn hóa này tương đương với phân tích biểu hiện gen chuẩn hóa không được chia tỷ lệ khi chọn đối
chứng.

Lưu ý: Đây còn được gọi là biểu hiện gen chuẩn hóa tương đối (relative normalized expression,
RNE) và mức độ phiên mã thay đổi.

Hướng Dẫn Sử Dụng | 289



Phụ lục A Tính Toán Phân Tích Dữ Liệu

Độ Lệch Chuẩn dành cho Biểu Hiện Gen Chuẩn Hóa
Việc đặt lại tỷ lệ giá trị biểu hiện gen chuẩn hóa được thực hiện bằng cách chia độ lệch chuẩn của biểu
hiện gen chuẩn hóa theo giá trị biểu hiện gen chuẩn hóa cho mức biểu hiện gen cao nhất hoặc thấp nhất,
tùy thuộc vào tùy chọn chia tỷ lệ mà bạn chọn. Công thức cho độ lệch chuẩn (standard deviation, SD) của
hệ số chuẩn hóa là

Trong đó:

n RQ = Số lượng tương đối của mẫu

n SD = Độ lệch chuẩn

n NF = Hệ số chuẩn hóa

n Ref = Mục tiêu tham chiếu

n n = Số mục tiêu tham chiếu

Khi mẫu đối chứng được gán, bạn không cần phải thực hiện chức năng chia lại tỷ lệ này trên độ lệch
chuẩn, như đã cho trong công thức sau:

Trong đó:

n NE = Biểu hiện gen chuẩn hóa

n RQ = Số lượng tương đối của mẫu

n SD = Độ lệch chuẩn

n GOI = Gen quan tâm (một mục tiêu)
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Biểu Hiện Gen Chuẩn Hóa Được Chia Tỷ Lệ thành Mức Biểu Hiện Gen Cao Nhất

Biểu Hiện Gen Chuẩn Hóa Được Chia Tỷ Lệ thành Mức Biểu
Hiện Gen Cao Nhất

Khi lượt chạy không bao gồm các đối chứng, chia tỷ lệ biểu hiện gen chuẩn hóa (normalized expression,
NE) cho mỗi mục tiêu (gen) bằng cách chia mức biểu hiện gen của từng mẫu cho mức biểu hiện gen cao
nhất trong tất cả các mẫu. Phần mềm đặt mức biểu hiện gen cao nhất thành giá trị 1 và đặt lại tỷ lệ tất cả
các mức biểu hiện gen mẫu. Công thức chia tỷ lệ cao nhất là

Trong đó:

n GOI = Gen quan tâm (mục tiêu)

Biểu Hiện Gen Chuẩn Hóa Được Chia Tỷ Lệ thành Mức Biểu
Hiện Gen Thấp Nhất

Khi lượt chạy không bao gồm đối chứng, chia tỷ lệ biểu hiện gen chuẩn hóa (NE) cho từng mục tiêu (gen)
bằng cách chia mức độ biểu hiện của mỗi mẫu bằng mức thấp nhất của biểu hiện trong tất cả các mẫu.
Phần mềm đặt mức biểu hiện thấp nhất thành giá trị 1 và đặt lại tỷ lệ cho tất cả các mức độ biểu hiện mẫu.
Công thức chia tỷ lệ thấp nhất là

Trong đó:

n GOI = Gen quan tâm (mục tiêu)

Biểu Hiện Gen Chuẩn Hóa Được Chia Tỷ Lệ thành Mức Biểu
Hiện Gen Trung Bình

Khi lượt chạy không bao gồm các đối chứng, chia tỷ lệ biểu hiện gen chuẩn hóa (normalized expression,
NE) cho mỗi mục tiêu (gen) bằng cách chia mức biểu hiện gen của mỗi mẫu cho mức trung bình nhân của
biểu hiện gen của tất cả các mẫu. Phần mềm đặt mức biểu hiện gen trung bình thành giá trị 1 và đặt lại tỷ
lệ tất cả các mức biểu hiện gen mẫu. Công thức chia tỷ lệ trung bình là

Trong đó:
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n GOI = Gen quan tâm (mục tiêu)

n GM = Trung bình nhân của biểu hiện gen chuẩn hóa đối với tất cả các mẫu
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Độ Lệch Chuẩn dành cho Biểu Hiện Gen Chuẩn Hóa Được Chia Tỷ Lệ

Độ Lệch Chuẩn dành cho Biểu Hiện Gen Chuẩn Hóa Được
Chia Tỷ Lệ

Việc chia lại tỷ lệ cho biểu hiện gen chuẩn hóa (NE) đã chia tỷ lệ được thực hiện bằng cách chia độ lệch
chuẩn (SD) của biểu hiện gen chuẩn hóa bằng giá trị biểu hiện gen chuẩn hóa đối với mức biểu hiện cao
nhất (MAX) hoặc thấp nhất (MIN), tùy thuộc vào tùy chọn chia tỷ lệ mà bạn chọn.

Lưu ý: Khi một mẫu đối chứng được gán, bạn không cần phải thực hiện chức năng chia lại tỷ lệ này
trên độ lệch chuẩn.

Tính toán cho công thức này là

Trong đó:

n NE = Biểu hiện gen chuẩn hóa

n SD = Độ lệch chuẩn

n GOI = Gen quan tâm (mục tiêu)

n MAX = Mức biểu hiện gen cao nhất

n MIN = Mức biểu hiện gen thấp nhất
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Thanh Sai Số Cho Độ Lệch Chuẩn(lg) Và Độ Sai Chuẩn Của
Giá Trị Trung Bình (lg)

Ngoài việc sử dụng khoảng tin cậy, các thanh sai số có thể được hiển thị cho các nhóm sinh học dựa trên
độ lệch chuẩn hoặc độ sai chuẩn của giá trị trung bình của log2 của biểu hiện gen. Các thanh sai số được
tính toán như sau:

Thanh Sai Số Dưới RQ = 2RQ(lg)-SD RQ(lg) hoặc 2RQ(lg)-SEM RQ(lg)

Thanh Sai Số Trên RQ = 2RQ(lg)+SD RQ(lg) hoặc 2RQ(lg)+SEM RQ(lg)

Trong đó:

n RQ(lg) = log2 của số lượng tương đối với nhóm sinh học

n SD RQ(lg) = độ lệch chuẩn của số lượng tương đối (log2)

n SEM RQ(lg) = sai số chuẩn của giá trị trung bình của số lượng tương đối (log2)

Exp. (Biểu Hiện Gen) Thanh Sai Số Dưới = 2Exp.(lg)-SD Exp.(lg) hoặc 2Exp.(lg)-SEM Exp.(lg)

Exp. (Biểu Hiện Gen) Thanh Sai Số Trên = 2Exp.(lg)+SD Exp.(lg) hoặc 2Exp.(lg)+SEM Exp.(lg)

Trong đó:

n Exp.(lg) = log2 của biểu hiện gen (biểu hiện gen chuẩn hóa) với nhóm sinh học

n SD RQ(lg) = độ lệch chuẩn của biểu hiện gen (log2)

n SEM RQ(lg) = sai số chuẩn của giá trị trung bình của biểu hiện gen (log2)
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Mức Độ Phiên Mã Thay Đổi

Mức Độ Phiên Mã Thay Đổi
Mức độ phiên mã thay đổi là giá trị đo sự tăng hoặc giảm biểu hiện gen của mục tiêu cho một mẫu thử
nghiệm so với mẫu đối chứng hoặc nhóm sinh học và được xác định như sau:

Nếu Biểu Hiện Gen (thử nghiệm) > Biểu Hiện Gen (đối chứng):

Nếu Biểu Hiện Gen (thử nghiệm) < Biểu Hiện Gen (đối chứng):

Lưu ý: Đối với Graphing (Vẽ Đồ Thị), Expression (Biểu Hiện Gen) dựa trên số lượng tương đối hoặc
biểu hiện gen chuẩn hóa, tùy vào chế độ được chọn (xem Vẽ Đồ Thị trên trang 256). Tuy nhiên, đối
với Scatter Plot (Biểu Đồ Phân Tán) và Clustergram (Sơ Đồ Cụm), mức độ phiên mã thay đổi luôn
được tính toán từ biểu hiện gen chuẩn hóa.
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Công Thức Giá Trị Đã Sửa Đổi
Quan trọng: Các tính toán này chỉ có thể áp dụng khi Analyze Using (Phân Tích Sử Dụng) được đặt
thành Samples Only (Chỉ Mẫu), Sample Biological Group (Nhóm Sinh Học Mẫu), hoặc Biological
Group Sample (Mẫu Nhóm Sinh Học).

Sự chênh lệch giữa các giá trị đã sửa đổi và các giá trị không sửa đổi chỉ được nhìn thấy nếu đường cong
chuẩn được tạo ra như một phần của lượt chạy Real-Time PCR. Phần mềm sử dụng ba phương trình để
xác định sự lan truyền sai số:

n Standard Error (Sai Số Chuẩn)

n Standard Error for Normalized Expression (Sai Số Chuẩn đối với Biểu Hiện Gen Chuẩn Hóa)

n Standard Error for Normalized Gene of Interest (Sai Số Chuẩn đối với Gen Quan Tâm Được Chuẩn
Hóa ) (mục tiêu)

Công thức cho lỗi chuẩn là

Trong đó:

n n = Số mục tiêu tham chiếu (gen)

n SD = Độ lệch chuẩn

Sai số chuẩn cho hệ số chuẩn hóa trong công thức biểu hiện gen chuẩn hóa là

Trong đó:

n n = Số mục tiêu tham chiếu

n SE = Sai số chuẩn

n NF = Hệ số chuẩn hóa

n RQ = Số lượng tương đối

Sai số chuẩn cho công thức gen quan tâm (GOI) được chuẩn hóa là

Trong đó:
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Tính Toán Khoảng Tin Cậy cho Phân Tích Nhóm Sinh Học

n SE = Sai số chuẩn

n GOI = Gen quan tâm (một mục tiêu)

n NF = Hệ số chuẩn hóa

n n = Số mục tiêu tham chiếu

Tính Toán Khoảng Tin Cậy cho Phân Tích Nhóm Sinh Học
Khi tiến hành phân tích nhóm sinh học (Analyze Using (Phân Tích Sử Dụng) được đặt thành Biological
Groups Only (Chỉ Nhóm Sinh Học)), khoảng tin cậy được tính cho số lượng tương đối và biểu hiện gen
chuẩn hóa tương đối.

Khoảng tin cậy được tính theo tỷ lệ log dựa trên phân phối t bằng cách sử dụng công thức sau:

Trong đó:

n = Biểu hiện gen trung bình của các mức biểu hiện tỷ lệ log của các mẫu trong nhóm sinh học

n SD = độ lệch chuẩn của các mức biểu hiện tỷ lệ log của các mẫu trong nhóm sinh học

n n = số mẫu trong nhóm sinh học

n t = thu được từ phân phối t dựa trên mức độ tự do và mức alpha

Lưu ý: Có thể đặt mức alpha bằng cách sử dụng trường ngưỡng giá trị P trong tab Graphing
(Vẽ Đồ Thị).

Sau khi các khoảng tin cậy được tính toán, chúng được chuyển thành tỷ lệ tuyến tính và được trình bày
trong Gene Expression Data Table (Bảng Dữ Liệu Biểu Hiện Gen) và biểu đồ thanh trong tab Graphing
(Vẽ Đồ Thị).

Phép Tính Biểu Đồ Hộp và Dải Dữ Liệu Trung Bình
Biểu đồ Hộp và Dải Dữ Liệu Trung Bình hiển thị sự phân phối các giá trị biểu hiện trong một nhóm sinh
học bằng cách vẽ đồ thị dữ liệu dưới dạng các tứ phân vị. Tứ phân vị thứ nhất và thứ 3 được đại diện lần
lượt bởi các giới hạn dưới và trên của ô. Số trung vị được hiển thị dưới dạng đường liền nét qua ô. Dải dữ
liệu trung bình đại diện cho các giá trị tối thiểu và tối đa không phải là giá trị ngoại lai trong tập dữ liệu. Giá
trị ngoại lai là các giá trị vượt quá các tứ phân vị thứ nhất và thứ ba 1,5 lần khoảng cách giữa các tứ phân
vị.
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Lưu ý: Nếu chỉ có một mẫu trong nhóm sinh học, thì sẽ được thể hiện dưới dạng một vòng tròn đơn,
biểu thị một điểm dữ liệu duy nhất.

Biểu đồ Hộp và Dải Dữ Liệu Trung Bình sau đây minh họa cách biểu diễn dữ liệu.

1. Giá trị ngoại lai. Giá trị ngoại lai này > Q3 + (1,5 x [Q3 - Q1]).

Lưu ý: Đặt con trỏ lên trên vòng tròn để xem chú giải công cụ hiển thị tên mẫu và số lượng
tương đối hoặc thông tin biểu hiện gen chuẩn hóa tùy thuộc vào chế độ nào được chọn.

2. Phân định ranh giới phi giá trị ngoại lai tối đa

3. Tứ phân vị trên/thứ 3 (Q3). 75% giá trị biểu hiện nhỏ hơn Q3.

4. Số trung vị, hay giá trị chính giữa, của các giá trị biểu hiện được xếp thứ tự theo thứ hạng

5. Tứ phân vị dưới/thứ nhất (Q1). 25% giá trị biểu hiện nhỏ hơn Q1.

6. Phân định ranh giới phi giá trị ngoại lai tối thiểu

7. Giá trị ngoại lai. Giá trị ngoại lai này < Q1 - (1,5 x [Q3 - Q1]).

CHÚ THÍCH
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Phụ lục B Các Dấu Vết Kiểm Soát
Phần mềm CFX Maestro Dx, Phiên bản bảo mật tạo các dấu vết kiểm soát cho tệp dữ liệu và tệp nghiên
cứu gen (tương ứng là tệp .prcd và .mgxd). Bất kỳ thay đổi hoặc thao tác nào được thực hiện trên tệp dữ
liệu và tệp nghiên cứu gen bảo mật đều được ghi lại trong dấu vết kiểm soát của tệp khi tệp được
lưu.CFX Maestro Dx SE tạo dấu vết kiểm soát riêng cho từng tệp.

Bạn có thể chọn File > Save As (Tệp> Lưu Dưới Dạng) và lưu tệp dữ liệu và tệp nghiên cứu gen bảo mật
có hoặc không có chữ ký vào một thư mục khác hoặc với tên khác. Tệp mới kế thừa dấu vết kiểm soát từ
tệp gốc. Dấu vết kiểm soát cho tệp mới cũng bao gồm hoạt động Save As (Lưu Dưới Dạng). Các thay đổi
hoặc thao tác được thực hiện trên tệp mới được ghi lại trong dấu vết kiểm soát của chính tệp đó. Tệp gốc
vẫn duy trì dấu vết kiểm soát của tệp đó, trong đó có ghi lại hoạt động về sau.

Sự Kiện Có Thể Kiểm Soát trên trang 301 liệt kê các sự kiện có thể kiểm soát được mà phần mềm ghi lại.

Xem Dấu Vết Kiểm Soát
Mỗi dấu vết kiểm soát hiển thị các thông tin sau:

n Chi tiết tiêu đề kiểm soát

o File version (Phiên bản tệp) – phiên bản đã lưu của tệp

o Date (Ngày) – ngày của sự kiện có thể kiểm soát hiện tại

o User (Người dùng) – miền Windows và tên người dùng của người dùng đã đăng nhập

o Comment (Nhận xét) – nhận xét gần nhất được lưu

o Signature (Chữ ký) – chữ ký điện tử của người gần đây nhất đã ký tệp

o Signature reason (Lý do ký) – lý do họ để lại chữ ký

o Application (Ứng dụng) – CFX Maestro Dx SE

o Application version (Phiên bản ứng dụng) – phiên bản hiện tại của CFX Maestro Dx SE

o Full user (Người dùng đầy đủ) – họ tên của người dùng đã đăng nhập

o Machine (Máy) – máy tính đã cài đặt CFX Maestro Dx SE.

n Chi tiết thay đổi kiểm soát

o Object (Đối tượng) – mục đã được thay đổi (mục được kiểm soát)
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o Old value (Giá trị cũ) – giá trị trước đó

o New value (Giá trị mới) – giá trị mới

o Description (Mô tả) – mô tả về sự thay đổi

Cách xem dấu vết kiểm soát

u Trong tệp dữ liệu hoặc tệp nghiên cứu gen mở, chọn View > Audit Trail (Chế Độ Xem > Dấu Vết Kiểm
Soát). Dấu vết kiểm soát của tệp xuất hiện.

Theo mặc định, dữ liệu được sắp xếp theo ngày và giờ, đồng thời tất cả các sự kiện đều xuất hiện
trong chế độ xemmở rộng. Bạn có thể lọc chế độ xem theo tên người dùng và đối tượng, đồng thời
thu gọn chế độ xemmở rộng để dễ dàng sắp xếp theo trường tiêu đề bất kỳ. Bạn cũng có thể xem
dấu vết kiểm soát dưới dạng báo cáo html.

Cách sắp xếp theo tên người dùng

u Chọn người dùng mục tiêu từ danh sách thả xuống User Name (Tên Người Dùng).

Cách sắp xếp theo đối tượng

u Chọn mục tiêu từ danh sách thả xuống Object (Đối Tượng).

Cách ẩn mô tả đầy đủ về các sự kiện

u Nhấp vào Collapse All (Thu Gọn Tất Cả).

Cách sắp xếp dữ liệu trong bảng chi tiết thay đổi

u Nhấp vào biểu tượng hình thoi trong tiêu đề cột dữ liệu để sắp xếp theo thứ tự tăng dần (từ A đến Z,
số nhỏ nhất đến số lớn nhất hoặc sớm nhất đến gần đây nhất).
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Cách in dấu vết kiểm soát

1. Nhấp vào HTML Report (Báo Cáo HTML) để hiển thị dấu vết kiểm soát trong trình duyệt web.

2. Trong cửa sổ trình duyệt của bạn, hãy thực hiện một trong các thao tác sau:

n Chọn File > Print (Tệp> In).

n Nhấp chuột phải vào báo cáo và chọn Print (In).

Sự Kiện Có Thể Kiểm Soát
CFXMaestro Dx SE ghi lại các sự kiện có thể kiểm soát sau đây trong các tệp dữ liệu và tệp nghiên cứu
gen.

Các sự kiện có thể kiểm soát trong lượt chạy

n Thời gian bắt đầu lượt chạy

n Chỉnh sửa khay thời gian lượt chạy

n Chỉnh sửa protocol thời gian lượt chạy

n Thời gian kết thúc lượt chạy

Các sự kiện có thể kiểm soát khi tệp dữ liệu được tạo

n Tệp dữ liệu đã tạo

n Hệ thống thêm lượt đọc khay nội suy

Các sự kiện có thể kiểm soát khi tệp dữ liệu được lưu

n Khái Quát

o Tên

o Ký

o Thiết Lập Khay

o Hiển Thị Giếng

o Chất huỳnh quang đã phân tích

o Chỉnh sửa khay

o Chế độ phân tích

o NhómGiếng Hoạt Động PCR
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n Trang Quantification (Định Lượng)

o Bước hoạt động

o Cài đặt – Chế độ xác định C q

o Cài đặt – Cài đặt đường nền

o Đã áp dụng hiệu chỉnh dấu vết

o Cài đặt – Chu kỳ cần phân tích

o Cài đặt – Chế độ phân tích

o Cài đặt - Ngưỡng đường nền

n Trang Melt Curve (Đường Cong Chảy)

o Bước hoạt động

o Loại đỉnh được hiển thị

o Ngưỡng phân tích đỉnh

n Trang End Point (Điểm Cuối)

o Chất huỳnh quang/mục tiêu hoạt động

o Các chu kỳ cuối cần tính trung bình

o Phương pháp tính toán dung sai

o Phần trăm của khoảng

n Trang Allelic Discrimination (Phân Định Alen)

o Chất huỳnh quang trục X và Y

o Chọn số chu kỳ

o Xem bản đồ kết quả đã quy ra

n Trang Gene Expression (Biểu Hiện Gen) - Tất cả đồ thị

o Cài đặt thí nghiệm – Tham chiếu mục tiêu

o Cài đặt thí nghiệm – Mẫu đối chứng

o Cài đặt thí nghiệm – Hiệu suất tự động

o Cài đặt thí nghiệm – Hiệu suất
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n Trang Gene Expression (Biểu Hiện Gen) - Vẽ biểu đồ

o Chế độ phân tích

o Dữ liệu đồ thị

o Trục X

o Trục Y

o Tùy chọn chia tỷ lệ

o Thanh sai số

o Số nhân thanh sai số trên biểu đồ

o Ngưỡng giá trị P

n Trang Gene Expression (Biểu Hiện Gen) - Sơ đồ cụm

o Cluster By (Gom Cụm Theo)

o Tách các bản sao

n Trang Gene Expression (Biểu Hiện Gen) – Biểu đồ phân tán

o Nhóm sinh học đối chứng

o Nhóm sinh học thử nghiệm

o Ngưỡng mức độ phiên mã thay đổi

n Trang Gene Expression (Biểu Hiện Gen) – ANOVA

o Ngưỡng giá trị P

n Plate Setup (Thiết Lập Khay) – View/Edit Plate (Xem/Chỉnh Sửa Khay)

o Settings (Cài Đặt) – PlateType (Loại Khay)

o Settings (Cài Đặt) - Units (Đơn Vị)

o Editing Tools (Công Cụ Chỉnh Sửa) – Flip Plate (Lật Khay)

o Nhóm giếng

o Chất huỳnh quang trên khay

n Plate Setup (Thiết Lập Khay) – Replace Plate (Thay Thế Khay) và Apply PrimePCR File (Áp Dụng
Tệp PrimePCR)

o Nhập thiết lập khay
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Thay đổi kiểm soát cho tệp nghiên cứu gen

Khái Quát

n Name (Tên)

n Trang Study Setup (Thiết Lập Nghiên Cứu)

o Thêm/xóa tệp dữ liệu

n Trang Study Analysis (Phân Tích Nghiên Cứu)
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Bạn có thể định cấu hình Phần mềm CFX Maestro Dx, Phiên bản bảo mật để sử dụng với hệ thống quản
lý thông tin phòng thí nghiệm (LIMS). Đối với tích hợp LIMS, CFX Maestro Dx SE yêu cầu thông tin thiết
lập khay được tạo bởi nền tảng LIMS (tệp LIMS, *.plrn), tệp protocol được tạo bằng cách sử dụng CFX
Maestro Dx SE (*.prcl), vị trí xuất dữ liệu và định dạng xuất xác định.

Sau khi lượt chạy kết thúc, CFX Maestro Dx SE tạo tệp dữ liệu (.pcrd) và lưu tệp đó vào vị trí thư mục xuất
dữ liệu xác định. CFX Maestro Dx SE cũng có thể tạo tệp dữ liệu tương thích với LIMS ở định dạng .csv
và lưu vào cùng vị trí đó.

Tạo Các Tệp Dữ Liệu Tương Thích LIMS
Phụ lục này giải thích cách thiết lập CFX Maestro Dx SE để tạo, lưu và xuất các tệp dữ liệu tương thích
LIMS.

Thiết Lập Thư Mục LIMS và Các Tùy Chọn Xuất Dữ Liệu
Theo mặc định, CFX Maestro Dx SE lưu các protocol, tệp và tệp xuất dữ liệu LIMS vào thư mục này:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Bạn có thể định cấu hình CFX Maestro Dx SE để lưu các tệp vào thư mục khác và thay đổi tùy chọn xuất
cho dữ liệu LIMS.

Cách thiết lập một thư mục LIMS và tùy chọn xuất dữ liệu

1. Trong cửa sổ Trang Chủ, chọn Tools > Options (Công Cụ > Tùy Chọn).

2. Trong hộp thoại Options (Tùy Chọn), chọn Data Export Settings (Cài Đặt Xuất Dữ Liệu).
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3. (Không bắt buộc) Chọn Automatically export LIMS data at end of run (Tự động xuất dữ liệu LIMS cuối
lượt chạy).

Phần mềm sẽ tự động xuất dữ liệu LIMS sau mỗi lượt chạy và lưu vào vị trí đã chỉ định.

4. Cách thay đổi các tùy chọn xuất mặc định đối với dữ liệu LIMS, nhấp vào LIMS Data Export Settings
(Cài Đặt Xuất Dữ Liệu LIMS).

Quan trọng: Chỉ có dữ liệu LIMS được xuất dưới dạng tệp .csv có thể được nhập trở lại vào
CFX Maestro Dx SE.

5. Trong hộp thoại LIMS Data Export Format Settings (Cài Đặt Định Dạng Xuất Dữ Liệu LIMS), chọn
các tùy chọn xuất bắt buộc và nhấp vào OK.

6. Trong hộp thoại Options (Tùy Chọn), điều hướng đến và chọn một thư mục mặc định mà bạn muốn
lưu các tệp dữ liệu LIMS. Bạn có thể chọn vị trí khác nhau cho từng loại tệp:

n Protocol

n Tệp LIMS

n Xuất dữ liệu

7. Nhấp OK để lưu các thay đổi và đóng hộp thoại Options (Tùy Chọn).
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Tạo Protocol LIMS
Để bắt đầu một lượt chạy LIMS, tạo một tệp protocol CFX Maestro Dx SE (*.prcl) và lưu vào vị trí thư mục
protocol LIMS chỉ định.

Xem Chương 7, Tạo Protocol để biết thêm thông tin.

Tạo Tệp Tin LIMS
Một tệp LIMS (*.plrn) chứa các chi tiết thiết lập khay và tên tệp protocol. Tệp này được tạo bởi LIMS nội
bộ của bạn. CFX Maestro Dx SE sử dụng tệp LIMS để tạo tệp khay dùng với tệp protocol.

CFX Maestro Dx SE cung cấp tệp nhập khay mẫu mà bạn có thể chỉnh sửa để tạo các tệp khay LIMS tùy
chỉnh.

Lời khuyên: Tác vụ này cần được thực hiện bởi một chuyên gia LIMS.

Cách tạo tệp LIMS

1. Trong cửa sổ Trang Chủ, chọn View > Show > LIMS File Folder (Xem > Hiển Thị > Thư Mục Tập Tin
LIMS).

2. Mở thư mục LIMS Templates (Mẫu LIMS) và chọn tệp .csv để nhập vào LIMS nội bộ của bạn.

3. Chỉnh sửa tệp mẫu bằng cách điền vào các phần bắt buộc được liệt kê trong Bảng 38.

4. Thực hiện một trong các thao tác sau:

n Để lưu thay đổi để sử dụng trong tương lai, hãy lưu tệp ở dạng .csv.

n Để lưu các thay đổi và sử dụng tệp ngay lập tức, hãy lưu tệp với phần mở rộng .plrn.

n Lưu mẫu với phần mở rộng tên tệp .plrn vào thư mục LIMS FIle (Tệp LIMS).

Quan trọng: CFXMaestro Dx SE chỉ có thể mở tệp .plrn. Bạn phải lưu tệp .csv là .plrn để bắt
đầu chạy LIMS.
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Cột Hàng Mô Tả Nội Dung
Mục
Đích

A 1 Tiêu Đề Khay Không chỉnh sửa Được Xác
Định
Trước

A,B,C 2 Khoảng
Trống/Dữ
Liệu/Hướng
Dẫn

Không chỉnh sửa Được Xác
Định
Trước

B 3 Phiên Bản Không chỉnh sửa Được Xác
Định
Trước

B 4 Kích Cỡ Khay Không chỉnh sửa Được Xác
Định
Trước

B 5 Loại Khay Nhập “BRWhite” (BR Trắng), “BR
Clear” (BR Trống) hoặc loại khay
được hiệu chuẩn khác

Bắt Buộc

B 6 Chế Độ Quét Nhập “SYBR/FAMOnly:,” ( Chỉ
SYBR/FAM:,) “All Channels,” (Tất
Cả Các Kênh) hoặc “FRET”

Bắt Buộc

Bảng 38. Định nghĩa của nội dung tệp LIMS .csv
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Cột Hàng Mô Tả Nội Dung
Mục
Đích

B 7 Đơn Vị Nhập một trong các tùy chọn sau
“copy number,” (số sao chép) “fold
dilution,” (pha loãng gấp)
“micromoles,” (micromol)
“nanomoles,” (nanomol)
“picomoles,” (picomol) “femtomoles,”
(femtomol) “attomoles,” (attomol)
“milligrams,” (miligam)
“micrograms,” (microgam)
“nanograms,” (nanogam)
“picograms,” (picogam)
“femtograms,” (femtogam)
“attograms,” (attogam) hoặc
“percent” (phần trăm)

Bắt Buộc

B 8 ID Lượt Chạy Nhập mô tả ngắn hoặc mã vạch xác
định lượt chạy này (tối đa 30 ký tự,
không được có dấu phẩy)

Không Bắt
Buộc

B 9 Lưu Ý Cho Lượt
Chạy

Nhập mô tả lượt chạy Không Bắt
Buộc

B 10 Protocol Lượt
Chạy

Nhập tên tệp protocol chính xác như
đã được liệt kê.

Bắt Buộc

A 11 Tệp Dữ Liệu Nhập tên tệp dữ liệu Không Bắt
Buộc

A 12-15 TBD/Trống Không chỉnh sửa Được Xác
Định
Trước

A 16 Dữ Liệu Khay Không chỉnh sửa Được Xác
Định
Trước

A 17-113 Vị Trí Giếng Không chỉnh sửa Được Xác
Định
Trước

Bảng 38. Định nghĩa của nội dung tệp LIMS .csv, tiếp
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Cột Hàng Mô Tả Nội Dung
Mục
Đích

B-G Thuốc Nhuộm
Ch1, Thuốc
Nhuộm Ch2,
Thuốc Nhuộm
Ch3, Thuốc
Nhuộm Ch4,
Thuốc Nhuộm
Ch5, FRET

Nhập một tên thuốc nhuộm được
hiệu chuẩn (ví dụ: “FAM”) cho mỗi
kênh đang được sử dụng

Bắt Buộc

H Loại Mẫu Nhập một trong các loại mẫu sau
“Unknown,” (Không Xác Định)
“Standard,” (Tiêu Chuẩn) “Positive
Control,” (Đối Chứng Dương Tính)
“Negative Control,” (Đối Chứng Âm
Tính) “NTC,” hoặc “NRT”

Bắt Buộc

I Tên Mẫu Nhập tên mẫu Không Bắt
Buộc

J-O Mục tiêu CH1,
Mục tiêu CH2,
Mục tiêu CH3,
Mục tiêu CH4,
Mục tiêu CH5,
Mục tiêu FRET

Nhập tên mục tiêu cho mỗi kênh
được sử dụng

Không Bắt
Buộc

P Tên Bộ Nhập tên tập sinh học Không Bắt
Buộc

Q Bản sao Nhập một số nguyên dương cho mỗi
bộ bản sao. Giá trị không được bằng
0.

Không Bắt
Buộc

Bảng 38. Định nghĩa của nội dung tệp LIMS .csv, tiếp

310 | Phần Mềm CFXMaestro Dx SE



Tạo Các Tệp Dữ Liệu Tương Thích LIMS

Cột Hàng Mô Tả Nội Dung
Mục
Đích

R-W Số Lượng CH1,
Số Lượng CH2,
Số Lượng CH3,
Số Lượng CH4,
Số Lượng CH5,
Số Lượng
FRET

Nhập các giá trị số lượng cho bất kỳ
tiêu chuẩn nào. Nhập nồng độ ở
dạng thập phân.

Bắt buộc
đối với tất
cả các tiêu
chuẩn

X Lưu Ý về Giếng Nhập lưu ý về giếng (tối đa 20 ký tự)

Lưu ý: Mặc dù CFX Maestro
Dx SE có giới hạn 20 ký tự khi
nhập lưu ý vàoWell Note (Lưu
Ý Về Giếng) thông qua phần
mềm, trườngWell Note (Lưu Ý
Về Giếng) có thể chứa tối đa
500 ký tự nếu được bao gồm
trong tệp .plrn đã nhập. Tuy
nhiên, CFX Maestro Dx SE sẽ
chỉ hiển thị 20 ký tự đầu tiên.
Tệp .pcrd được xuất sẽ chứa tất
cả các ký tự trong trườngWell
Note (Lưu Ý Về Giếng), không
có dữ liệu nào bị mất.

Không Bắt
Buộc

Y-AD Màu Giếng
Ch1, Màu
Giếng Ch2,
Màu Giếng
Ch3, Màu
Giếng Ch4,
Màu Giếng
Ch5, Màu
Giếng FRET

Nhập bất kỳ màu kiểu vạch đồ họa
nào do người dùng xác định ở định
dạng thập phân số nguyên 32 bit
(argb)

Không Bắt
Buộc

Bảng 38. Định nghĩa của nội dung tệp LIMS .csv, tiếp
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Bắt Đầu Lượt Chạy LIMS
Cách bắt đầu lượt chạy LIMS

1. Thực hiện một trong các thao tác sau để mở tệp LIMS .plrn:

n Trong cửa sổ Trang Chủ, chọn View > Show > LIMS File Folder (Xem > Hiển Thị > Thư Mục Tệp
LIMS) và mở tệp .plrn mục tiêu.

n Trong cửa sổ Trang Chủ, chọn File > Open > LIMS File (Tệp > Mở > Tệp LIMS) và mở tệp .plrn
mục tiêu.

Tệp mở trong tab Start Run (Bắt Đầu Lượt Chạy) trong trình hướng dẫn Run Setup (Thiết Lập Lượt
Chạy). Tab Start Run (Bắt Đầu Lượt Chạy) hiển thị thông tin về thử nghiệm sẽ chạy. Đồng thời hiển
thị block hoặc các block máy đã kết nối mà bạn có thể chạy thử nghiệm trên đó.

2. Trong tab Start Run (Bắt Đầu Lượt Chạy), chọn một máy và nhấp vào Start Run (Bắt Đầu Lượt
Chạy).

Xuất Dữ Liệu Sang LIMS
Khi lượt chạy hoàn tất, CFX Maestro Dx SE tạo một tệp dữ liệu (.pcrd) và lưu vào vị trí của thư mục xuất
dữ liệu đã được xác định.

Cách xuất tệp dữ liệu sang LIMS

u Mở tệp .pcrd và chọn Export > Export to LIMS Folder (Xuất > Xuất sang Thư Mục LIMS).
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Lời khuyên: Nếu bạn chọn Automatically Export Data after Run (Tự Động Xuất Dữ Liệu Sau Lượt
Chạy) trong LIMS Options (Tùy Chọn LIMS), CFX Maestro Dx SE sẽ tạo một tệp dữ liệu tương thích
LIMS ở định dạng .csv và lưu trong cùng thư mục đó.
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Phụ lục D Khắc Phục Sự Cố Cho Phần mềm
CFX Maestro Dx, Phiên bản bảo mật

Phụ lục này cung cấp các gợi ý để khắc phục sự cố bạn có thể gặp phải khi nâng cấp hoặc chạy Phần
mềm CFX Maestro Dx, Phiên bản bảo mật.

Đưa Tệp Và Thư Mục Phần mềm CFX Maestro Dx, Phiên bản
bảo mật Vào Danh Sách Trắng

Để bảo vệ máy trước vi-rút và phần mềm độc hại, bộ phận CNTT của bạn có thể đã triển khai các biện
pháp bảo mật phần mềm rất chặt chẽ. Các biện pháp này có thể ảnh hưởng đến thời gian nâng cấp hoặc
chạy CFX Maestro Dx SE.

Để cải thiện hiệu suất của CFX Maestro Dx SE, Bio-Rad khuyến nghị bộ phận CNTT của bạn đưa các tệp
và thư mục sau vào danh sách trắng trong phần cài đặt Tường lửa ở phần mềm chống vi-rút của bạn
được cài đặt trên máy tính chạy CFX Maestro Dx SE:

Thư Mục

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Tệp

n Tất cả các tệp .exe nằm trong thư mục C:\Program Files (x86)\Bio-Rad\CFX_MDx

n R.exe và Rscript.exe (nằm trong thư mục C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\bin)
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Nhật Ký Ứng Dụng
Trước khi bắt đầu một lượt chạy mới, hệ thống CFX Opus Dx bắt đầu kiểm tra tự chẩn đoán để xác minh
rằng máy đang chạy theo đúng thông số kỹ thuật. Phần mềm ghi lại kết quả kiểm tra này trong Run Log
(Nhật Ký Lượt Chạy) và tệp Application Log (Nhật Ký Ứng Dụng). Nếu bạn phát hiện sự cố ở một hoặc
nhiều thử nghiệm, hãy mở nhật ký lượt chạy và nhật ký ứng dụng để tìm hiểu thời điểm bắt đầu sự cố.

CFX Maestro Dx SE Dx theo dõi thông tin về trạng thái của máy trong một lượt chạy ở Application Log
(Nhật ký ứng dụng). Sử dụng các nhật ký này để theo dõi sự kiện xảy ra trên máy và trong phần mềm,
cũng như nhằm khắc phục sự cố.

Cách mở Nhật ký ứng dụng

u Trong cửa sổ Trang Chủ, chọn View > Application Log (Xem > Nhật Ký Ứng Dụng).

Để xem Nhật ký ứng dụng dưới dạng tập tin HTML, hãy nhấp vào nút HTML Report (Báo cáo lượt
chạy HTML).
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Truy xuất tập tin nhật ký ứng dụng và chương trình cơ sở
Nhật ký ứng dụng và chương trình cơ sở chứa thông tin chi tiết các hành động được thực hiện trong quá
trình sử dụng phần mềm và hiệu suất của các lần chạy. Các nhật ký này cũng ghi lại bất kỳ lỗi phần mềm
hoặc chương trình cơ sở nào xảy ra trong quá trình vận hành phần mềm hoặc máy.

Để truy cập các tập tin nhật ký ứng dụng và chương trình cơ sở:

1. Trong ô Detected Instruments (Máy đã phát hiện), nhấp chuột phải vào máy.

2. Chọn truy xuất tập tin nhật ký.

3. Trong hộp thoại Duyệt thư mục, chọn thư mục đích trên mạng của bạn hoặc ổ đĩa cục bộ mà bạn
muốn lưu tập tin nhật ký.

Lưu ý: Thư mục có tiêu đề “Logs” (Nhật ký).

4. Bấm OK để lưu các tập tin.

Quan trọng: Lưu tập tin nhật ký có cùng tên tập tin với tập tin nhật ký hiện có sẽ ghi đè lên tập
tin nhật ký hiện có.

Khắc Phục Sự Cố
Thông thường, các vấn đề về truyền thông liên lạc của phần mềm và máy có thể được giải quyết bằng
cách khởi động lại máy tính và hệ thống của bạn. Hãy chắc chắn bạn đã lưu mọi việc đang làm trước khi
khởi động lại.

Lưu ý: Xác minh rằng máy tính của bạn có đủ bộ nhớ RAM và dung lượng đĩa trống. Bộ nhớ RAM tối
thiểu là 4 GB và dung lượng ổ cứng tối thiểu là 128 GB.

Mất Điện
Trong trường hợp mất điện, máy và máy tính sẽ tắt nguồn. Nếu xảy ra trường hợp mất điện trong thời
gian ngắn, máy sẽ tiếp tục chạy một protocol nhưng Nhật Ký Ứng Dụng sẽ ghi lại sự cố mất điện. Tùy
thuộc vào cài đặt máy tính và thời gian mất điện, máy và phần mềm sẽ cố gắng tiếp tục chạy tùy thuộc
vào bước protocol:

n Nếu protocol đang trong bước không đọc khay, protocol sẽ tiếp tục chạy ngay khi máy có điện trở lại.

n Nếu protocol đang trong bước có đọc khay, máy sẽ chờ cho phần mềm khởi động lại và tiếp tục giao
tiếp để thu thập dữ liệu. Trong tình huống này, protocol chỉ tiếp tục nếu phần mềm không bị máy tính
tắt nguồn. Khi máy tính và phần mềm khởi động trở lại, protocol sẽ tiếp tục.
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Chuyển Tệp Sang Máy Tính Chạy CFX Maestro Dx SE
Bạn có thể chuyển dữ liệu và các tệp nhật ký nằm trong máy vào ổ đĩa cứng của máy tính chạy CFX
Maestro Dx SE kèm theo.

Lời khuyên: Tất cả các tệp trong thư mục dữ liệu thời gian thực trên bệ máy được chuyển đến máy
tính.

Lưu ý: Từ các máy CFX Opus Dx, bạn chỉ có thể chuyển các tệp nhật ký. Tất cả các tệp nhật ký trên
máy được chuyển vào máy tính.

Cách truy xuất tệp từ máy

1. Trong ngăn Detected Instruments (Máy Đã Phát Hiện) trên cửa sổ Trang Chủ, nhấp chuột phải vào
máy muốn dùng và chọn Retrieve Log Files (Truy Xuất Tệp Nhật Ký).

2. Chọn vị trí thư mục để lưu các tệp đã truy xuất.

3. Nhấp vào OK.

Cài Đặt Thủ Công Phần mềm CFX Maestro Dx, Phiên bản bảo mật
Cách cài đặt thủ công CFX Maestro Dx SE

1. Nếu cần, ngắt kết nối mọi máy đã kết nối với máy tính.

Định vị và ngắt kết nối cáp USB của máy trên CFX Maestro Dx SE máy tính. Đầu được cắm vào máy
có thể giữ nguyên vị trí.

2. Đăng nhập vào máy tính chạy CFX Maestro Dx SE bằng đặc quyền quản trị viên.

3. Cắm USB cài đặt CFX Maestro Dx SE vào cổng USB của máy tính.

4. TrongWindows Explorer, tìm và mở USB cài đặt CFX Maestro Dx SE.

5. Mở thư mục CFX và nhấp đúp vào CFXMaestro Dx Setup.exe để cài đặt CFX Maestro Dx SE.

6. Làm theo các hướng dẫn trên màn hình để cài đặt phần mềm.

Khi hoàn tất, màn hình chớp khởi động Phần mềm CFX Maestro Dx, Phiên bản bảo mật của Bio-Rad
xuất hiện trên màn hình máy tính và biểu tượng Phần mềm CFX Maestro Dx, Phiên bản bảo mật của
Bio-Rad xuất hiện trên màn hình nền.

7. Lấy thanh USB ra một cách an toàn và khởi động CFX Maestro Dx SE.
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Cài Đặt Lại Các Trình Điều Khiển
Cách cài đặt lại các trình điều khiển máy

u Trong cửa sổ Trang Chủ, chọn Tools > Reinstall Instrument Drivers (Công Cụ > Cài Đặt Lại Các
Trình Điều Khiển Máy).

Lưu ý: Nếu bạn gặp sự cố với việc phần mềm giao tiếp với hệ thống thời gian thực sau khi bạn cài
đặt lại các trình điều khiển và kiểm tra kết nối USB, hãy liên hệ với Bộ Phận Hỗ Trợ Kỹ Thuật của
Bio-Rad.
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This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's

Hướng Dẫn Sử Dụng | 323



Phụ lục E Bio-Rad Free and Open-Source Notices for PCR Products

reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Thông Báo Bản Quyền Minpack (1999) Đạ i Học Chicago. Bảo lưu mọi quyền

Phân phối lại và sử dụng ở dạng nguồn và nhị phân, có hay không có sửa đổi, được cho phép miễn sao
đáp ứng các điều kiện sau:

1. Phân phối lại mã nguồn phải giữ thông báo bản quyền trên, danh sách các điều kiện này, và tuyên bố
khước từ trách nhiệm sau.

2. Phân phối lại ở dạng nhị phân phải sao chép thông báo bản quyền trên, danh sách các điều kiện này,
và tuyên bố khước từ trách nhiệm sau trong tài liệu và/hoặc các tài liệu khác được cung cấp cùng khi
phân phối.

3. Tài liệu người dùng cuối kèm theo phân phối lại, nếu có, phải bao gồm tuyên bố công nhận sau:

“Sản phẩm này bao gồm phần mềm được phát triển bởi Đại Học Chicago, với tư cách là Nhà Vận Hành
Phòng Thí Nghiệm Quốc Gia Argonne.”
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